
Getting Started with Mathematica
Clinton Wolfe, August 1999

Introduction

What is Mathematica?
Mathematica is a computer program for doing mathematics. It is often used for instruction, homework, research, and
writing. Mathematica is extraordinary well-rounded. It is suitable for both numeric and symbolic work, and it has
remarkable word-processing capabilities as well. Mathematicians can (and often do) search for a working model, do
intensive calculation, and write a dissertation on the project (including complex graphics) -- all from within
Mathematica.

Its weaknesses include a somewhat steep learning curve, an interface that is difficult to use from the command line,
and rather complex installation procedures.

Philosophical issues
Mathematica is more than just a program. It is an attempt to redefine the interaction between mathematician and
computer. Every command, function, option, button, menu, or object in Mathematica fits into this philosophy in a
standard way. In the mid-to-long term, this makes Mathematica a very easy-to-use, enjoyable tool. For the new user,
Mathematica can seem opaque and threatening.

Mathematica was created by a mathematician for other mathematicians. A user of Mathematica should be
comfortable dealing with abstraction, generalization, and pattern discovery. If you feel you do not fit this profile,
you might want to learn Maple first.

How to use this document
This document is intended for new users of Mathematica. No prior math software experience is assumed, though we
do point out differences between the major packages along the way. We assume you are familiar with your operating
system, so we will not cover clicking, dragging, etc. Since Mathematica is quite visually oriented, we assume you
will be using it on a computer with a windowing system (such as Windows, Macintosh, or X-windows). If you
intend to use Mathematica from the command line, it would be best to first learn it in a graphic environment, and
then learn to Use Math Software under UNIX.

We will use a few conventions throughout this document.



Example Explanation

File -> Open Select Open from the File menu.

3,Ctl-6,5 Press 3, then hold the Control key and press 6, then press 5.

2+2 Input to be typed at the Mathematica prompt.

4 Output from Mathematica

An important tip.

A tip for Maple users.

A tip for Matlab users.

Where to find Mathematica
Mathematica is available in all Macintosh, SGI, and Sun computer labs at IUB. It is also available on Steel and the
SP (node sp09).

Mathematica is also available for sale in the IU Bookstore.

How to start and exit Mathematica
To start mathematica, follow these instructions.

• Unix: from a command line, type "mathematica &"

• Macintosh: Apple Menu->Stat/Math->Mathematica

If you are using X windows and you get a stream of font errors, follow these instructions from the
Knowledge Base.

To exit Mathematica, you can:

• Choose File->Exit

• Type Quit[].

Orientation
When you first start Mathematica, you should see a "splash" screen with the Mathematica logo, version, and license

http://www.iubookstore.com/


information. When the program loads, you should see several objects on the screen. We will now describe what they
are and what they do.

You may wish to turn on your speakers (or bring headphones if you are in an STC). Mathematica uses audio
cues to notify the user of errors, finished calculations, etc.

Notebooks
A notebook is a collection of Mathematica statements, output, and graphics. The concept is like that of a "document"
in a word processor. You enter information and commands into the notebook window, and the output (if any) is
displayed there.

If the notebook has been modified since it was last saved, an asterisk (*) will appear in the title bar. To save your
work, choose File->Save As... or File->Save.

If Mathematica is ready for new input, the cursor will flip sideways (see above). Just start typing to enter
information. Try typing this (don't press return yet):

2 + 2

To tell Mathematica to evaluate this expression, hold down Shift and type Return. Since Mathematica is also a word
processor, it needs to know if you want to evaluate the expression, or just insert a carriage return-linefeed. This can
be quite confusing to the new user.

System Evaluate Linefeed

Macintosh Enter or Shift-Return Return

Windows Shift-Enter Enter

X Shift-Return Return

Next, look at the blue symbols along the right side of the notebook. Each group of statements enclosed by the
triangle-brackets ( ) is called a cell. The cell is the smallest unit of work in Mathematica. A cell may contain input

or output, math or comments, text or graphics.

Cells in Mathematica are like execution groups in Maple.



Palettes
You should see a box with a lot of symbols floating on the right side of your Mathematica window.
This is called a palette. Palettes allow you to easily insert complicated mathematical notation. For
example, to compute the cube root of 34, you could click on the . Type 34, which should
appear under the root sign. Then click on the small square above the root, and type 3 in the box.
Finally, evaluate the expression.

Using the default palette, you can enter fractions, integrals, summations, matrices, subscripts, and
most greek letters. Of course, there are many other palettes available - choose File->Palettes to see a
list.

Kernels
Mathematica is actually split into two conceptual pieces, the front-end and the kernel. When you start Mathematica,
you are actually only starting the front-end.

The front-end handles input and output to the user, access to the file system, and creates graphics on your screen.
Most users will deal primarily with the front-end.

The kernel does nearly all computation (excluding graphics rendering). When you evaluate any expression, the
kernel does the hard work and sends the results back to the front-end, which then displays it in an attractive format
for the user.

Most users will run the front-end and the kernel on the same computer. If your computer is connected to a network,
you can run the kernel on a more powerful machine, while running the front-end on your favorite computer. To learn
how to do this, choose Kernel->Kernel Configuration Options, click Add, and then click Help.

How to stop a runaway calculation:

• Macintosh - Command-Comma or Control-C

• Windows and X - Alt-Comma or Control-C

This will bring up a menu that allows you to view the state of the kernel, abort the calculation, etc.

Help system
Mathematica has an excellent help system. To get general help, choose Help->Help Browser. Browse among the
topics listed.

Mathematica comes with an excellent resource, The Mathematica Book. It is available through the Help Browser.
See also the Getting Started section, which contains several excellent tutorials.



Doing Math
Arithmetic
Basic arithmetic operations are easy to enter in Mathematica. You may use your choice of notation, and you may
choose to enter symbols via the palettes or the keyboard.

Keystrokes Input Output Comments

4, ,+, ,4
3,-,1,6

4+4
3-16

8
-13

Addition, subtraction.
Spaces are optional.

4,*,4
4, ,4
4,4
4,Esc,*,Esc,4

4*4
4 4
44

4 4

16
16
44
16

Multiplication.
A space can mean multiplication as well...
...but you should be careful.
You can also use the symbol.

3,/,4

3,Esc,d,i,v,Esc,4

3,Ctl-/,4

3/4

3 4 Exact division.

3,^,5
3,Ctl-^,5

3^5
35

243
243

The text version
The symbolic version

3,^,(,1,/,2,)
Ctl-@,3
N,[,Ctl-@,3,Ctl-Space,]

3^(1/2)

N[ ] 1.73205 An approximation.

%,Ctl-^,2 %2 3. Square last output.

Mathematica's data restrictions are as follows:

• Integers can be of any size, up to your computer's memory.

• Real and complex operations are carried out with arbitrary (limitless) precision, up to your computer's
memory, unless N is used.

• See Help->Help Browser: Numerical Computation->Numerical Precision->N, and section 1.4.9 of The
Mathematica Book.

• Mathematica does not set limits on the size of matrices, as Maple does.

• N[...] is just like Maple's feval.

If you want to use double precision, you must explicitly say so. See above.



Algebra
Mathematica is more than a calculator, of course. We will now try out some of Mathematica's Computer Algebra
System (CAS) features.

Keystrokes Input Output Comments

a a a All names are symbols.

a,=,4 a=4 4 Defining a constant.

Esc,a,l,p,h,a,Esc,=,3 =3 3 Greek letters (see palettes).

(,x,+,1,),Ctl-^,2 (x+1)2 (x+1)2 An expression.

E,x,p,a,n,d,[,%,] Expand[%] 1+2x+x2 Algebraic expansion....

S,i,m,p,l,i,f,y,[,%,] Simplify[%] (x+1)2 ...and simplification.

From this point onward, we will assume that you know how to enter keystrokes.

Input Output Comments

p=x3+3x2+3x+1 x3+3x2+3x+1
p is now an alias for the expression.
This is not mathematical equality.

Solve[p==0]
{{x->-1},
{x->-1},
{x->-1}}

Solve the equation p==0. Mathematica returns
a set of transformation rules.
The system has three identical solutions.

p /. x->2 27 Substitute 2 for x (temporarily).

p==0 /. x->2 False 27 does not equal 0.

Transformation rules are like the subs command in Maple.

Go exploring in the Algebra Palette:
File->Palettes->AlgebraicManipulation.

Functions

Using them
A function in Mathematica is a formalized, named transformation rule. A function may return a symbol, a real



number, a complex matrix, another function.... Any mathematical object is an acceptable value for a function. We
have seen several built-in functions so far: Solve, Expand , and N are a few examples. A function may be written
using mathematical notation, it may be created using programming constructs (like for, if/then, etc.), or it could even
be written in another language entirely (Fortran, C, etc.).

All built-in Mathematica functions are named with InitialCapitalLetters (FullSimplify ) and some use
abbreviations (NDSolve - Numerical Differential Equation Solver).

Creating them

Input Output Comments

f[x_]:=x2 (none)
A simple function definition. Note the underscore (_) that follows the dependent variable
name.

f[2]
f[y+z]

4
(y+z)2

The function works with numbers
and expressions.

f[f[f[2]]
]

16348 You can nest functions.

?f

Global
'f
f[x_]
:= x2

What is f?

g[x_,y_]
:= x*y

(none) You can have as many arguments as you like.

Clear[f] (none) Deletes the definition of f.

Procedural Functions
You may wish to create more complex functions. Suppose that you wanted to count to 100, and print out a list of
each number that is divisible by the argument. Here is one way that you could do it:

sillyCount[n_] := ( Do[ If[Mod[i,n]==0, Print[i]] ,{i,100}]; )

For more information on programming in Mathematica, see the online help.



Graphics

2-D Graphics

Input Output Comments

Plot[Sin[x2],{x,0,2Pi}
] A simple plot.

Plot[Tan[x], {x, -2Pi,
2Pi}]

If the plot has singularities,
Mathematica will try to choose a suitable scale....

Plot[
Tan[x],
{x, -2Pi, 2Pi},
PlotRange -> {-

10,10}]

...or you can set it manually.

Plot[
{Sin[x],Sin[2x],Sin

[3x]},
{x, 0, 2Pi}]

You can plot multiple functions by
including them in curly brackets.

Show[GraphicsArray[
{Plot[Sin[x],{x,0,P

i}],
Plot[Sin[2x],{x,0,2

Pi}]
}]]

Plot two plots, side-by-side.

ParametricPlot[
{Cos[7t],

Sin[11t]},
{t, 0, 2Pi}]

Parametric plot.

For more information, see section 1.9.1 in The Mathematica Book.

3-D Graphics

Input Output Comments

Plot3D[
Sin[x y],
{x,0, 3},
{y, 0, 3}]

A basic surface plot.



Plot3D[
Sin[x y],
{x, 0, 3},
{y, 0, 3},
PlotPoints -> 40]

You can get a finer plot if you
increase the number of sample points.

Plot3D[ Sin[x y],
{x, 0, 3},
{y, 0, 3},
ViewPoint -> {1, 1, 0},
PlotPoints -> 40,
Boxed -> False,
Axes -> False]

A variety of options.
Most important is the ViewPoint option,
which tells where to put the "camera".

For more information, see section 1.9.7 of The Mathematica Book.

Further Reading
If you have enjoyed working with Mathematica, you will almost certainly enjoy The Mathematica Book. It is
available on the web, through Stat/Math Center Sales, at your local bookstore, and in the online help.

In addition, be sure to wander through the Wolfram Research Documentation Center, where you will find reference
works on any topic imaginable.

You can find other people who use Mathematica in the following usenet newsgroups:

• comp.soft-sys.math.mathematica

• sci.math.symbolic (Mostly Maple discussion, but some Mathematica)

In addition, your local bookstore or library probably has several books about Mathematica or one of its applications.
WRI keeps a list of current books on their website.

Please send comments and suggestions to: statmath@indiana.edu
Copyright 1995-1999,Indiana University.Last Modified 2 August 1999.

URL http://www.indiana.edu/~statmath/math/mma/gettingstarted/index.html

http://documents.wolfram.com/v4/frames/frames.html
http://documents.wolfram.com/
news:comp.soft-sys.math.mathematica
news:sci.math.symbolic
http://store.wolfram.com/catalog/books/
http://www.indiana.edu/iub/
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Stat/Math: Maple

Stat/Math Math Maple

Search:  In:       

Maple
●     Information 

❍     Maple Overview 
❍     Availability - where to find Maple 
❍     Sales - how to buy Maple 
❍     Licensing Maple 

●     Support 
❍     Local Resources 

■     Getting Started with Maple 
■     Using Math Software under UNIX 
■     Algebra in Maple 
■     Differential Equations in Maple 
■     Fourier Series with Maple 
■     Linear Algebra with Maple 
■     Plotting in Maple 

❍     Web Resources 
■     Maple Links 
■     Maple Vendor's Page 

●     See Also 
❍     Math Sites 

Permission to use this document is granted so long as the author is acknowledged and notified. 
Please send comments and suggestions to:statmath@indiana.edu 

Copyright 1995-1999, Indiana University. 
Last modified: Tuesday, 10-Oct-2000 08:54:21 EST 

URL /~statmath/math/maple/index.html 

http://www.indiana.edu/~statmath/math/maple/index.html [01/07/2002 21:00:07]

http://www.indiana.edu/~statmath/search/index.html
http://www.indiana.edu/~statmath/index.html
http://www.indiana.edu/~statmath/index.html
http://www.indiana.edu/~statmath/math/index.html
http://www.indiana.edu/~statmath/math/maple/links.html
http://www.indiana.edu/


Using Math Software under UNIX

Stat/Math Math Under UNIX

Search:  In:       

Using Math Software Under UNIX
Clinton Wolfe (April 1999)

with material from Dave Hart 

Also availible: printer-friendly version in Adobe PDF(183KB).

●     Introduction 
❍     Purpose 
❍     Who this document will help 
❍     How to use this document 

●     UNIX - The absolute least you need to know 
●     Using the Math Software 
●     Using graphics over the network 
●     Using batch processing 
●     Further Reading 

Introduction

Purpose

Distributed computing puts into practice a favorite Hoosier proverb: "Use the right tool for the job." As 
distributed computing continues to grow, the network is becoming one vast virtual machine, with 
different parts performing different functions. UITS provides a variety of hardware platforms, from 
large shared computers to desktop workstations in Student Technology classrooms and labs. 
Workstations typically provide superior graphics and a more convenient user interface, and offer 

http://www.indiana.edu/~statmath/math/all/mathunix/index.html (1 of 3) [01/07/2002 21:00:36]

http://www.indiana.edu/~statmath/search/index.html
http://www.indiana.edu/~statmath/index.html
http://www.indiana.edu/~statmath/index.html
http://www.indiana.edu/~statmath/math/index.html
http://www.indiana.edu/~statmath/math/all/mathunix/printable.pdf


Using Math Software under UNIX

powerful logical and arithmetic processing capabilities, but generally lack the large memory that shared 
computers provide. On a shared computer, you can use Maple to manipulate formulas thousands of lines 
long, or use Matlab to perform billions of computations -- all within minutes. Using workstations in 
conjunction with multiuser systems, via the network, can combine the best functionality of both. 

Who this document will help

This document is intended for users of Maple, Matlab, and Mathematica who need the computing power 
of very large computers.  This is not a tutorial for any of these software packages; instead see Getting 
Started with Maple, Matlab, or Mathematica.  We assume that you are fairly familiar with one of these 
packages.  We also assume you are comfortable using the basic functionality of network utilities such as 
FTP and Telnet (or SSH).  Our goal is to ease the transition from a window-style desktop environment 
to a command-line based UNIX environment. 

The standard math tools at IUB -- Maple, Mathematica, and Matlab -- have versions that can run on 
many different platforms. The microcomputer version offers a relatively friendly interface, while the 
mainframe version offers raw power. For everyday problems, you'll find the microcomputer version fast 
and easy to use. Even when you need the power of the mainframe, you may still want to develop 
algorithms and debug code on your desktop, then turn to shared systems for production runs that require 
large storage or extended number-crunching. 

This document is designed for users at Indiana University (Bloomington or IUPUI campuses), who have 
accounts on either the SP system, Steel, Cobalt, Nations, DaVinci, or Ships.   The information contained 
herein may not be appropriate for your specific circumstances (especially when refering to 
characteristics of specific computers). 

How to use this document

Everyone should read the UNIX - The Least You Need to Know and Starting the Math Software 
sections, unless you already know this information.  You may then pick among the remaining sections 
to fit your needs. 

Please send errors, omissions, comments, etc. to statmath@indiana.edu, or post to iu.statmath. 

Next : UNIX - The least you need to know 

http://www.indiana.edu/~statmath/math/all/mathunix/index.html (2 of 3) [01/07/2002 21:00:36]

news:iu.statmath


Using Math Software under UNIX

Permission to use this document is granted so long as the author is acknowledged and notified. 
Please send comments and suggestions to:statmath@indiana.edu 

Copyright 1995-1999, Indiana University. 
Last modified: Wednesday, 19-Jan-2000 17:08:32 EST 

URL /~statmath/math/all/mathunix/index.html 

http://www.indiana.edu/~statmath/math/all/mathunix/index.html (3 of 3) [01/07/2002 21:00:36]
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Knowledge Base - In Unix, using the X Window System with the display on my workstation, how do I fix the fonts to run Mathematica?

IT Help Online | Support Center | UITS | Indiana University 

 

Enter your search terms:   
How to Search | Advanced Search 

In Unix, using the X Window System with the 
display on my workstation, how do I fix the fonts to 
run Mathematica?

Mathematica makes heavy use of specialized fonts to display mathematical notation. While you can run 
Mathematica without these fonts, your display may be unintelligible. Mathematica expects to find these 
fonts on your local computer, rather than on the remote Unix computer.

To avoid known conflicts, UITS recommends that you install the fonts in a separate place from your 
standard X Window System fonts. You can get the fonts for Mathematica 3.0 and 4.0 in PCF format from 
Wolfram, the makers of Mathematica, at: 

 http://support.wolfram.com/mathematica/systems/unix/interface/pcf.html

If you need help installing new fonts, see your X Server documentation.

To fix your installed fonts to display properly in Mathematica, follow the directions below: 

1.  After you have installed the fonts, connect to Steel, Ships, Nations, da Vinci, or the Research SP 
systems using telnet or ssh. Start your X Server and enter the following at the remote prompt: 

  mathematica &

Mathematica should launch in your local X Server. 

2.  Errors may appear at the remote prompt. You can safely ignore the following error message:

"Warning: Cannot convert string '....' to type FontStruct". 

However, you will need to issue further commands if one of the following errors appears: 

http://kb.indiana.edu/data/afjk.html (1 of 2) [01/07/2002 21:01:08]

http://ithelp.indiana.edu/
http://www.indiana.edu/~itsc/
http://www.indiana.edu/~uits/
http://www.indiana.edu/
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Knowledge Base - In Unix, using the X Window System with the display on my workstation, how do I fix the fonts to run Mathematica?

"xset: bad font path element (#1)"

"assertion `GenericUnicodeFont != 0' at MathEditFont.c:43 failed" 

3.  In the case above, before you run Mathematica, you need to issue the following commands at the 
remote prompt: 

  xset fp+path_to_fonts

  xset fp rehash 

Replace path_to_fonts with the absolute path to the directory containing fonts.dir on 
your local computer. You can also use this technique if you have a local copy of Mathematica 
installed. 

For additional information about Mathematica, see the Mathematica Resources at Indiana University Web 
page at: 

  http://www.indiana.edu/~statmath/math/mma/index.html 

This is document afjk in domain iu from the Knowledge Base.
Last updated on September 21, 2001 

When you're done reading, please tell us: Did you find the answer to your question?
Yes | No | No, and I'd like to ask a consultant.

Knowledge Base Home | About the Knowledge Base | IT Help Online 
Give us some feedback with our User Survey. 

URL: http://kb.indiana.edu/data/afjk.html
This page is maintained by the Support Center (scweb@indiana.edu)

You can help keep the Knowledge Base up to date with suggestions, corrections, and additions.
Copyright 1997-2002, The Trustees of Indiana University 

http://kb.indiana.edu/data/afjk.html (2 of 2) [01/07/2002 21:01:08]
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Stat/Math - Maple Overview

Stat/Math Math Maple Overview

Search:  In:       

A General Overview of Maple
Maple is a general purpose computer algebra system, designed to solve 
mathematical problems and produce high-quality technical graphics. It is easy to 
learn, but powerful enough to calculate difficult integrals in seconds. Maple 
incorporates a high-level programming language which allows the user to define his 
own procedures; it also has packages of specialized functions which may be loaded 
to do work in group theory, linear algebra, and statistics, as well as in other fields. It 
can be used interactively or in batch mode, for teaching or research.

Maple is classified by UITS as a General Purpose Software. Documentation is 
available in all Student Technology Centers and the Center for Statistical and 
Mathematical Computing. UITS Public Facilities consultants can provide assistance 
in accessing the program. The Center for Statistical and Mathematical Computing 
(812/855-4724 or email to statmath@iu.edu) can answer basic to advanced 
questions. NOTE: If you are a student using Maple for a class exercise, questions 
about your class work should be directed first to your instructors.

Program Functionality: Excellent

Breadth of Functionality: Excellent

Maple has over 2500 functions available. A basic core collection is loaded at 
startup, and specialized packages are available, for topics from statistics to 
geometry.

Reliability and Robustness: Good

Maple is very robust, and reliable. However, no computer program can replace 

http://www.indiana.edu/~statmath/math/maple/overview.html (1 of 4) [01/07/2002 21:02:25]
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understanding! People do mathematics, computers don't.

State of the Art: Excellent

Maple is one of the leading mathematics programs, noted for its algebraic and 
analytic prowess. Export to LaTeX or HTML are provided.

Maple is relatively good about not returning "wrong" answers. Inverse functions 
remain the big problem for computer algebra systems. They appear in places where 
they might not be expected (definite integrals, for example), so any result from a 
CAS should be checked. Maple handles inverse functions fairly well, although the 
resulting fastidiousness can be surprising. Maple can [to some extent] handle 
assumption, such as "n is an integer" or "theta lies between 0 and Pi/2", which 
increases its power and precision, and makes it possible to deal with convergence 
conditions and inverse functions relatively well.

User Friendliness: Fair

Maple is the most user-friendly of the mathematical software available at IUB, but 
Maple's command-line language requires some investment in training before the 
program can be easily used.

Maple's language is easily understood by those trained with any procedural 
language (such as Basic or C); its command names and syntax are mostly 
straightforward and easily understood. 

Electronic Help Resources: Excellent

Network-based help: Excellent

The Knowledge Base has answers to several frequently asked Maple questions.

Program Help System: Excellent

The Help System is excellent; it includes examples and discussion as well as 
syntax. A "New Users' Tour" makes it easy to get started, with hyperlinks to 
additional topics.

To get help on a known command, use the ? command -- for example, ?plot . "?" by 
itself gets help on the help system. When the command is unknown, you can search 

http://www.indiana.edu/~statmath/math/maple/overview.html (2 of 4) [01/07/2002 21:02:25]
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for a topic, or do a full-text search of the help system. At the top of a help window 
is a "Help Browser" which lists topics by category, with up to five levels of 
increasing detail.

Local Availability: Excellent

Indiana University at Bloomington has a site license for Maple; IUPUI also owns 
such a license. Consequently, the latest version of Maple [as of a month before the 
current semester started] will be installed in all UITS public computing facilities, 
and many of the UITS timesharing systems.For details, see the Math Software 
Availability page.

Further, Maple may be obtained at greatly reduced prices for departmental and 
personal workstations at these locations: see the Sales page for more information.

Local Support & Training: Excellent

Document Availability: Excellent

Locally produced documents are also available free of charge from UITS Stat/Math 
Center.

UITS makes basic manuals available in document racks in the Student Technology 
Centers. Full documentation is available for reference and short term loan from 
various Software Manual Locations. Documents are also available for reference at 
the UITS Stat/Math Center.

Training Availability: Excellent

UITS offers Jumpstart classes for Getting Started With Maple free of charge to IUB 
students. Instructors may request a specially arranged class for introducing their 
students to Maple by contacting UITS Education Group (855-3499).

User Group: Good

To join the international Maple Users' Group [mailing list], send e-mail to 
majordomo@daisy.uwaterloo.ca containing the line subscribe maple-list.

UITS Consulting Support: Full Support
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Consulting support is available from Stat/Math Consulting from 9 am to 5 pm (M-
F) via email, phone, and for walkins (an appointment is recommended for walkin 
consulting). 

Other Consulting Support: Good

Registered Maple license owners can contact the vendor directly with the number 
provided with the license agreement: phone 800-267-6563. Students with the 
student edition should contact Brooks-Cole at 800-214-2661, or send e-mail to 
support@brookscole.com. 
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IU Mathematical Software 
Availability

●     IUB 
●     IUPUI 
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Sales
One of our primary functions is to provide software sales and service to the 
university. Our goal is to be largely self-sufficient while offering the buying 
power of the university to the individual.

Our Sales area has recently been reorganized into the following sections:

●     Who Can Buy 
●     About Licensing 
●     About Installation 
●     Price List 
●     How to Buy 
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Maple Licensing Information

Current Version Information

Maple 7 is a computer algebra system with numerical and graphical capabilities. It 
features a built-in programming language including libraries for number theory, 
group theory, linear algebra, statistics, etc., that can be used to solve a range of 
problems, from the most abstract mathematical ones to down-to-earth design tasks. 
Maple 7 is available on a number of platforms. 

License Terms

●     Indiana University (IU) faculty and staff may install Maple 7 on their 
university-owned computers, and on other computers used in support of their 
IU administrative, research, and teaching activities. Our current license does 
not allow sales to students. However, students may purchase a student 
version of Maple 7 from their campus bookstore. 

●     Faculty and staff Maple 7 licenses are available only on an annual basis. 
This annual lease includes any upgrades put out by the vendor as well as 
program maintenance. 

●     Students may obtain a perpetual license for Maple 5.1 from the Stat/Math 
Center. The package comes on two CDs from which the student installs the 
program. While no upgrades are available with this license, there are no 
renewal fees. 

●     For faculty and staff, installation must be done by a UITS representative and 
is included in the price of the package. UITS retains the program disks; 
however, a UITS representative will return for installation service as needed. 
Service fees may be assessed, depending upon the services provided. UITS 
cannot make house calls off campus. If you want Maple installed on a 
personally-owned computer located off campus, you must bring it to campus 
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for the installation.
●     No manuals are supplied with the lease. Please contact the Stat/Math Center 

for information on getting manuals. 

Hardware and Software Requirements

The following are minimum requirements.

Package OS version Chip RAM HD

Maple 7 for 
Windows

95, 98, NT 4.0, 
Windows 2000

Pentium-
compatible

32MB 
(64 MB 
recommended)

80

Maple 7 for 
Macintosh

8.6, 9.0, 9.1
604 processor, 
G3, or G4

24 
(64 recommended)

80

Maple 7 for 
Linux x86

kernel 2.2, glibc 
2.1, x86 
compatible

Pentium 90 or 
better

32 70

Maple 7 for 
DEC Alpha

Digital UNIX 
4.0F,5.1 or 
Compaq Tru64

Any Alpha 32 60

Maple 7 for 
HP/9000

HP-UX 11 All PA-RISC 32 70

Maple 7 for 
IBM RS/6000

AIX 4.3.3
All RS/6000 
CPU's

32 70

Maple 7 for 
SGI

IRIX 6.5.X MIPS R4000 32 70

Maple 7 for 
Solaris

Solaris 
2.6,2.7,2.8

All Sparc and 
x86

32 70
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Getting Started with Maple
Prepared by the staff of the Stat/Math Center 1

Revised August 2001

This document is available in the following formats:

Web-based Tutorial
One Long Web Page

Adobe Acrobat 4.0 (for printing)

Table of Contents

●     Introduction 
❍     What is Maple? 
❍     How to use this tutorial 
❍     Where to find Maple 
❍     Starting and Exiting Maple 

●     Finding Your Way Around 
❍     The Toolbar 
❍     The Kernel 
❍     Worksheets 

●     Using the Help system 
●     Maple Syntax and Built-in Data Capabilities 

❍     Maple Syntax 
❍     Data Capabilities 

●     Using symbolic computation (variables) 
●     Creating your own mathematical functions 
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●     Using packages 
●     Basic Plotting 
●     Further Reading 

1. Jefferson Davis, David Hart, and Clinton Wolfe worked on this document and on subsequent revisions. 
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Stat/Math Math Maple Algebra
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Basic Algebra in Maple
Original by Dave Hart

Updated by Clinton Wolfe
Also available as a Maple 5.1 worksheet

Basic Polynomial Manipulation

> z:=(x+y)^2 + 9*(2+x)*(x+y); 

Here an algebraic expression has been typed. Maple reads in the statement, assigns the right hand side to the variable z, and "prettyprints" it. The letters x, y, and z are here considered variables; legal 
variables start with a letter and have at most 494 characters. Examples of legal variable names are: g, G, new_term, x13a, and the_answer_is. Maple is case sensitive, so the variables g and G are distinct. 

Notice also that the line ends with a semicolon. All commands entered in Maple must end in with a semicolon. If one is not entered at the end of the line, then Maple will wait for one to be entered on the 
next line.

> expand(z); 

This command expanded the algebraic expression assigned to z.

> %^3; 

Here, this command tells Maple to take the previous result and cube it. (The percent sign refers to the most recent result.) Maple does not expand the result. To see the multiplication explicitly, the following 
command is issued: 

> expand(%); 

Notice that Maple does not list the elements in any specific order.

> sort(%); 
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Use the "sort" command to see it in a prettier form.

> factor(%); 

Here Maple factors the previous result. Notice that the result does not look like the expressions previously entered. Maple will not always be able to return an expression to its previous form.

Operations on Polynomials

> integrate(x/(1-x^3), x); 

Maple integrates x/(1-x^3) with respect to x. Because any letter used in a Maple session is considered a variable, you must specify with respect to what variable differentiation and integration should occur.

> diff(%, x); 

Differentiation.

The result is not exactly like the integrand, but it is in a form similar enough to recognize that they are the same expression. Simplification is a difficult problem.

> series(exp(-x)*sin(2*x), x); 

The command will find a series (either Taylor, Laurent, or generalized) around the point x=0 if no value is given. Generally, the last term of the series will be the order term, where the order is decided by a 
global Maple variable which can be defined by the user.
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Maple ODE Examples
Here's a basic ODE:

> deq := diff(y(x),x) + y(x) = 0: deq; 

Here's the basic form of the command for solving differential equations:

> soln := dsolve( deq, y(x) ); 

We can add initial conditions, to determine the "integration constant" _C1:

> subs(x=0, y(0)=y0, soln); solve(", _C1): subs(_C1=", 
soln); 

This could be done in one step:

> dsolve( {diff(y(x),x) + y(x) = 0, y(0)=y0}, y(x) ); 

> dsolve({diff(y(x),x$2) + y(x) = x*cos(x), y(0) = y0, 
D(y)(0) = v0}, y(x)); 
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> sys := diff(y(x),x)=z(x), diff(z(x),x)=y(x): sys; 
inits := y(0)=0, z(0)=1: inits;
fcns := {y(x), z(x)}: 

> dsolve({sys} union {inits}, fcns); 

> dsolve({sys, y(0)=0, z(0)=1}, fcns, type=series); 

This next example (the pendulum equation) is not solvable in terms of elementary 
functions. Maple obtains a "reduction to quadratures" for the inverse functions.

> dsolve({diff(y(x),x$2) + sin(y(x)) = 0}, y(x)); 
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Fourier Series
Fourier Series are a projection method. Here's some code for calculating the coefficients:

> fe := proc(f) fnormal(evalf(f)); end:
> a := proc(f, n) 
if n=0 then fe((1/(2*Pi))*Int(f, x=-Pi..Pi));
else fe((1/Pi)*Int( f*cos(n*x), x=-Pi..Pi)); 
fi;
end:
> b := proc(f, n) 
if n=0 then 0;
else fe((1/Pi)*Int( f*sin(n*x), x=-Pi..Pi)); 
fi;
end:
> fs := (f, n) -> sum('a(f, k)*cos(k*x) + b(f, k)*sin(k*x)', 
k=0..n);

Note that we have chosen to convert the coefficients to floating-point form, to standardize 
the interval length [to the circumference of the unit circle], and to make the coefficients 
functions [whose arguments are expressions]. Other choices also work. Here are some 
examples of the result:

> fs1 := fs(x, 10); 

           fs1 := 1.999999999 sin(x) - .9999999999 sin(2 x)

                  + .6666666664 sin(3 x) - .4999999999 sin(4 x)

                  + .3999999998 sin(5 x) - .3333333332 sin(6 x)

                  + .2857142856 sin(7 x) - .2499999999 sin(8 x)

                  + .2222222222 sin(9 x) - .1999999999 sin(10 x)
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> plot({ x, fs1 }, x=-Pi .. Pi, scaling=constrained); 

> fs2 := fs(x^2,4): 

       fs2 := 3.289868133 - 3.999999998 cos(x) + .9999999999 cos(2 x)

              - .4444444445 cos(3 x) + .2499999999 cos(4 x)

> plot({ x^2, fs2 }, x=-Pi .. Pi, scaling=constrained); 

> f3 := x -> signum(sin(x)): > fs3 := fs(f3(x),10); 

             fs3 := 1.273239544 sin(x) + .4244131814 sin(3 x)

                    + .2546479089 sin(5 x) + .1818913635 sin(7 x)

                    + .1414710605 sin(9 x)

> plot({ f3(x), fs3 }, x=-2*Pi .. 2*Pi, scaling=constrained); 
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>fsexp := fs(exp(x), 10): fsexp; 

               3.676077909 - 3.676077910 cos(x) + 3.676077910 sin(x)
          
                    + 1.470431164 cos(2 x) - 2.940862328 sin(2 x)

                    - .7352155817 cos(3 x) + 2.205646746 sin(3 x)

                    + .4324797542 cos(4 x) - 1.729919016 sin(4 x)

                    - .2827752238 cos(5 x) + 1.413876119 sin(5 x)

                    + .1987069140 cos(6 x) - 1.192241484 sin(6 x)

                    - .1470431164 cos(7 x) + 1.029301815 sin(7 x)

                    + .1131100895 cos(8 x) - .9048807162 sin(8 x)

                    - .08966043682 cos(9 x) + .8069439313 sin(9 x)

                    + .07279362198 cos(10 x) - .7279362198 sin(10 x)

> plot({ exp(x), fsexp }, x=-Pi .. Pi, color=red); 
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Linear Algebra with Maple
The output here is in character mode, rather than the default "high-resolution" mode. It's still formatted in 
two dimensions, so you need a monospaced font (for preformatted material) and a "sufficiently" wide 
window.

> with(linalg); 

BlockDiagonal, GramSchmidt, JordanBlock, Wronskian, add,
    addcol, addrow, adj, adjoint, angle, augment, backsub, band,
    basis, bezout, blockmatrix, charmat, charpoly, col, coldim
    colspace, colspan, companion, concat, cond, copyinto,
    crossprod, curl, definite, delcols, delrows, det, diag,
    diverge, dotprod, eigenvals, eigenvects, entermatrix, equal,
    exponential, extend, ffgausselim, fibonacci, frobenius,
    gausselim, gaussjord, genmatrix, grad, hadamard, hermite,
    hessian, hilbert, htranspose, ihermite, indexfunc,
    innerprod, intbasis, inverse, ismith, iszero, jacobian,
    jordan, kernel, laplacian, leastsqrs, linsolve, matrix,
    minor, minpoly, mulcol, mulrow, multiply, norm, normalize,
    nullspace, orthog, permanent, pivot, potential, randmatrix,
    randvector, rank, ratform, row, rowdim, rowspace, rowspan,
    rref, scalarmul, singularvals, smith, stack, submatrix,
    subvector, sumbasis, swapcol, swaprow, sylvester, toeplitz,
    trace, transpose, vandermonde, vecpotent, vectdim, vector

This is a list of the functions added by loading the "linalg" package. To find out more about vector, for 
example, type ?vector

> v := vector(3, [a, b, c]); m := matrix(2,2, [[a, b], [c, d]]); 

                         v := [ a, b, c ]

                               [ a  b ]
                          m := [      ]
                               [ c  d ]

> evalm( m &* [2,3] ); 

http://www.indiana.edu/~statmath/math/maple/linalg.html (1 of 5) [01/07/2002 21:04:57]

http://www.indiana.edu/~statmath/search/index.html
http://www.indiana.edu/~statmath/index.html
http://www.indiana.edu/~statmath/index.html
http://www.indiana.edu/~statmath/math/index.html


Linear Algebra with Maple

                     [2 a + 3 b, 2 c + 3 d]

> linsolve(m,[2,3]); 

                    - 2 d + 3 b    - 2 c + 3 a
                  [ -----------, - ----------- ]
                     b c - a d      b c - a d

> det(m); 

                            a d - b c

> eigenvals(m); 

                             2            2         1/2
       1/2 a + 1/2 d + 1/2 (a  - 2 a d + d  + 4 b c)   ,

                                 2            2         1/2
           1/2 a + 1/2 d - 1/2 (a  - 2 a d + d  + 4 b c)

> eigenvects(m, radical); 

                                 - 1/2 a + 1/2 d - 1/2 %1
[1/2 a + 1/2 d + 1/2 %1, 1, {[ - ------------------------, 1 ]}]
                                             c

    ,

                                  - 1/2 a + 1/2 d + 1/2 %1
 [1/2 a + 1/2 d - 1/2 %1, 1, {[ - ------------------------, 1 ]}]
                                              c

                        2            2         1/2
     %1 :=            (a  - 2 a d + d  + 4 b c)

A common error is trying to compute the determinant, or eigenvalues, of a large symbolic n by n matrix. 
The problem is called combinatorial explosion -- there might be n2 expressions in the answer which are each 
n! terms long!

The Hilbert matrix is a favorite example of numeric (as opposed to symbolic) linear algebra.

> H5 := hilbert(5); 

                      [  1   1/2  1/3  1/4  1/5 ]
                      [                         ]
                      [ 1/2  1/3  1/4  1/5  1/6 ]
                      [                         ]
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                H5 := [ 1/3  1/4  1/5  1/6  1/7 ]
                      [                         ]
                      [ 1/4  1/5  1/6  1/7  1/8 ]
                      [                         ]
                      [ 1/5  1/6  1/7  1/8  1/9 ]

The Hilbert matrix is badly conditioned, which means that it corresponds to a system of linear equations 
which are hard to solve accurately.

> cond(H5); 

                              943656

This means that errors [for example in the measured values of the right-hand side of the equations] may be 
multiplied by a factor of nearly a million!

A curious feature of the Hilbert matrix is that the entries of its inverse are all integers. Maple computes them 
exactly: 

> inverse(H5); 

           [   25    -300     1050    -1400     630  ]
           [                                         ]
           [  -300   4800    -18900   26880   -12600 ]
           [                                         ]
           [  1050  -18900   79380   -117600   56700 ]
           [                                         ]
           [ -1400   26880  -117600   179200  -88200 ]
           [                                         ]
           [  630   -12600   56700    -88200   44100 ]

The method for finding eigenvectors of m that Maple used above would not be appropriate for this matrix; if 
it were symbolic, this matrix would be too big; but more importantly, since it's numeric, there is another 
method [the QR method] which is less sensative to the numeric instability implied by a big condition 
number, and is also computed more quickly. Maple uses that method, if the inputs are floating-point 
[decimal] numbers.

> eigsys := eigenvects( map( evalf, H5) ); 

eigsys :=

[.01140749151, 1,
   { [ .2142136245, -.7241021311, -.1204532771, .3095739659, .5651934124 ] }],

[1.567050691, 1,
   { [ .7678547356, .4457910609, .3215782948, .2534389442, .2098226368 ] }],

[.2085342186, 1,
   { [-.6018714786, .2759134174, .4248766220, .4439030401, .4290133540 ] }],
               -5
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[.3288052655*10  , 1,
   { [ .006173874786, -.1166928633, .5061638445, -.7671911293, .3762453886 ] }],

[.0003058977746, 1,
   { [ .04716180523, -.4326673028, .6673503032, .2330247284, -.5576000510 ] }] 

"eigsys" is a list of compound objects: the eigenvalues, each with its multiplicity and corresponding 
eigenvector.

To select the second component of the second eigenvector, do this:

> eigsys[2][3][1][2]; 

                           .4457910609

To sort this out, examine in turn 

●     eigsys[2](the "system:" second eigenvector, its eigenvalue and multiplicity), 
●     eigsys[2][3](the set consisting of the second eigenvector system's vector), 
●     eigsys[2][3][1](the vector itself). 

CAUTION: The order of the eigensystem cannot be predicted, from one session to the next. 

The next command finds the singular values to 4 floating-point digits, among other things.

> svdlist := evalf(Svd(H5, 'U', 'V'), 4); 

     svdlist := [ 1.567, .2086, .01136, .0002933, .00001142 

> d := diag( seq(svdlist[k], k=1..5)); 

             [ 1.567    0       0        0         0     ]
             [                                           ]
             [   0    .2086     0        0         0     ]
             [                                           ]
        d := [   0      0    .01136      0         0     ]
             [                                           ]
             [   0      0       0    .0002933      0     ]
             [                                           ]
             [   0      0       0        0     .00001142 ]

This next command checks the accuracy of the result just computed, carrying 20 digits:

> evalf(evalm( (transpose(U) &* H5 &* V) - d), 20); 

      [                                                                        ]
      [       -18            -19           -19            -19           -19    ]
      [ -.1*10         -.5*10         .4*10         -.2*10        -.3*10       ]
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      [                                                                        ]
      [       -20            -19           -20            -20           -20    ]
      [ -.9*10         -.1*10         .2*10          .4*10         .5*10       ]
      [                                                                        ]
      [         -19           -20                         -21            -20   ]
      [ -.108*10        .61*10        0              .9*10        -.49*10      ]
      [                                                                        ]
      [           -19           -20           -20           -20            -20 ]
      [ -.27040*10     -.3301*10      .6147*10      -.973*10      -.5038*10    ]
      [                                                                        ]
      [            -20            -20           -20            -20         -21 ]
      [ -.395257*10    -.619981*10    .750459*10    -.182306*10    .7701*10    ]
      [                                                                        ]
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Plotting with Maple

Stat/Math Math Maple Plotting
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Plotting with Maple

The plot Command

The basic plot command:

> plot( 3*x^2 - x^4, x = -2 .. 2 ); 

Add a restriction on the range:

> plot( exp(x), x=-10..10, y=-10..10); 

Plot several curves simultaneously:

> plot( {cos(x), 1 - x^2/2, 1 - x^2/2 + x^4/24}, x=-6..6, y=-2..2); 
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Fill areas in various colors (one custom, one standard):

> plot([cos(x),4-x^2], x=-2..2, filled=true, color=[COLOR(RGB,.9,.9,.99), 
blue],scaling=constrained); 

Fill a more complicated area:

> plot([min(max(sin(x),cos(x)),0), max(min(sin(x),cos(x)),0), sin(x), 
cos(x)], 
x=-8.75*Pi..11.25*Pi, filled=true, color=[white,white,red,red], 
xtickmarks=[], scaling=constrained );

The plot3d Command

A basic 3D plot:

> plot3d( cos(x) + y^2/2, x=-10..10, y=-2..2); 
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Add some options [most options can also be selected interactively, from menus]:

> plot3d( cos(x) + y^2/2, x=-10..10, y=-5..5, 
scaling=constrained, style=patchcontour, axes=boxed, 
orientation=[135,120], shading=none, lightmodel=light2, numpoints=2000);

Plot a parametric curve in R2:

> plot( [ t*cos(t), t*sin(t), t = 0 .. 2*Pi ] ); 
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and a parametric surface in R3:

> plot3d( [ r*cos(th), r*sin(th), cos(th)*sin(th) ], 
r = 0 .. 1, th = 0 .. 2*Pi, grid = [10,60], 
orientation=[100,25], shading=zhue, lightmodel=light2, style=patch);
z = x*y/(x^2 + y^2);

For more information on plot, plot3d, and their options, from the Maple Help menu do a Topic Search on plot. 
Select from any of approximately 100 related topics.

The plots Package

The "plots" package contains additional, more specialized plotting functions.

> with(plots): 

Plot parametric curves in 3D:

> plotopts:= t=0..20*Pi, orientation=[0,60], numpoints=1000, 
scaling=constrained:
> p1:=spacecurve([cos(1.1*t)*(5+sin(t)),sin(1.1*t)*(5+sin(t)),cos(t)], 
plotopts, shading=ZGREYSCALE, thickness=1): 
> p2:=spacecurve([cos(2*t)*(5+sin(9*t)),sin(2*t)*(5+sin(9*t)),cos(9*t)],
plotopts, shading=zhue, thickness=3): 
> display({p1,p2});
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Display different types of plots, together:

> p1 := gradplot(x*y,x=-1..1,y=-1..1, color=blue):
> p2 := implicitplot( {x*y=.1, x*y=.2, x*y=.3, x*y=-.1, x*y=-.2, x*y=-.3},
x=-1..1, y=-1..1, color=red, thickness=2):
> p3 := textplot( [0, .75, `Gradients are normal to level curves!`],
font=[HELVETICA,BOLDOBLIQUE,14] );
> display({p1,p2,p3});

Some elliptic curves, plotted together:

> plotopts := x=-5..5, y=-5..5, numpoints=2500, color=blue, thickness=2, 
axes=boxed, xtickmarks=[-2,0,2,4], ytickmarks=[-2,0,2]:
> for i to 7 do
q.i := implicitplot(y^2 = x^3 + (4-i)*x^2,plotopts):
od:
> B := array(1..2,1..3,[[q1,q2,q3],[q4,q6,q7]]): display(B);
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A fancy 3D plot, using the tubeplot command:

> f:= [(t-5*Pi)*sin(t)/3, (t-5*Pi)*cos(t)/3, (t-5*Pi)*.9, t=0 .. 5*Pi]:
> tubeplot(f, radius = (t-5*Pi)*.2, 
tubepoints = 25, style=PATCH
lightmodel=light3, shading=zhue, orientation = [-75,90]);

This is one of many examples distributed with Maple.

Often there is more than one way to approach a problem. 

> with(student); > showtangent(x^2, x=1); 

> with(plots): with(plottools):
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> p1:=plot(x^2, x = -1..2, thickness=2, color=green): 
p2:=plot(2*x-1, x = .25 .. 1.75, thickness=3, color=blue):
p3:=circle([1, 1], .05, color=red, thickness=3):
p4:=textplot( [2, .25, `Slope = 2`], font=[HELVETICA,BOLDOBLIQUE,14] ):
p5:=arrow([1.65,.5],[-.5,.4],.05,.2,.2, color=red):
# On PCs, go to ^^^^^^ [1.05,.9] # 
p6:=textplot( [2.5, 2, `y = 2 x - 1`], view=[-1..3, -1..4], 
font=[TIMES,ITALIC,10]):
> display({p1,p2,p3,p4,p5},scaling=constrained);
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Stat/Math By Subject Math Links
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Other Math Links
●     Discussion of Mathematical Computing 

❍     Mathematical Software Guide 
❍     IMACS Conferences on Applications of Computer Algebra 
❍     Berkeley computer algebra papers(Richard Fateman et.al.) 
❍     Computer Algebra Performance (Heinz Kredel) 
❍     Review of CAS Mathematical Capabilities (Michael Wester) 
❍     Computer Algebra and Problem Solving Environments (Stanly 

Steinberg) 
❍     PSEware Project of the IU CS Department's Scientific 

Computing Group et al 
❍     Problem Solving Environments page at Purdue 
❍     Database of Existing Mechanized Reasoning Systems 

●     General Archives 
❍     CAIN (Computer Algebra Information Network) 
❍     INRIA Sophia Antipolis (SAFIR) 
❍     SymbolicNet at Kent State University 
❍     OpenMath Project 
❍     NAOMI - The North American OpenMath Initiative 
❍     Mathematics Archives 

●     Commercial Vendors and Packages 
❍     Waterloo Maple, Inc.(Maple) 

■     IU Maple Page 
❍     The MathWorks (Matlab) 

■     IU Matlab Page 
❍     Wolfram Research Inc. (Mathematica) 

■     IU Mathematica Page 
❍     Key Curriculum Press (Geometer's SketchPad) 
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■     IU Geometer's SketchPad Page 
❍     MathTools (MIDEVA, MATCOM) 
❍     MathWare Inc. (Derive, GyroGraphics) 
❍     MathSoft Inc. (MathCad, S-Plus) 
❍     REDUCE 
❍     Magma 
❍     f(z), "The Complex Variables Program for people who love 

mathematics." 
❍     Future Graph, Inc (f(g)) -- "integrating the functionality of a 

graphing calculator, a spreadsheet, and a drawing package." 
❍     Logic Software from CSLI 
❍     Software for Science - reseller of software 

●     Shareware/Freeware Vendors and Packages 
❍     Math Shareware Archive at Washington University 
❍     Downloadable Software from the Geometry Center. 
❍     CONTENT dynamical system software 
❍     Fermat - a CAS for polynomial and matrix computation, for 

Mac and PC. 
❍     FORM from the Dutch National Institute for Nuclear and High-

Energy Physics 
❍     GAP - Groups, Algorithms and Programming - system for 

computational discrete algebra 
❍     Groups and Graphs, a software package for graphs, digraphs, 

combinatorial designs, and their automorphism groups. 
❍     NTL C++ number theory library 
❍     SAML Simple Algebraic Math Library in C (Thierry Bousch, 

Université Paris-Sud) 
❍     Solutions 

●     Other Resources 
❍     Mathematics page of the WWW Virtual Library at Florida State 
❍     Mathematics Software section of the Big List of Mathematics 

Information Servers at Penn State 
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●     Introduction 
●     UNIX - The absolute least you need to know 

❍     Accounts 
❍     Choosing a machine 
❍     Logging in and Logging out 
❍     Learning More About UNIX 

●     Using the Math Software 
●     Using graphics over the network 
●     Using batch processing 
●     Further Reading 

UNIX - The absolute least you need to know

UNIX is an operating system (like Windows, DOS, or Macintosh System 8) that is designed for very 
large computers.  More than one person (in fact, ususally hundreds!) can use a UNIX machine at the 
same time. 

Accounts

Every person who uses a shared computer has an account.  An account means that you have a place to 
put files (your "home directory"), permission to use the machine (to "log in"), and a way to identify 
yourself (your "username").  For example, the Shakespeare email system at IUB is a UNIX system. 

You will need an account on one of the following systems: DaVinci, Ships, Nations, the SP (formerly 
STARRS), Cobalt, or Steel to use this guide.  If you don't have one, you may get one from  The UITS 
Accounts System.  Or, if you have your own UNIX machine (such as a Sun, Linux, FreeBSD, etc) and 
you have a copy of the math software, you may use your own machine. 
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Choosing a machine

As of now (August 1999),  if you want to run math software on a large computer at IUB, you have the 
option of using the SP System, Cobalt, or Steel. 
If you just want to run math software under UNIX, you could also use the DaVinci, Ships, or Nations 
cluster, or your own machine. 

You must be faculty (or have a faculty sponsor) to get an account on the SP, since it is a research-only 
system.  In addition, the SP is really only designed for batch processing (which we discuss in the Batch 
Processing section), and logging in is a little complex.  More information on the SP is availible here. 

Steel is open to all IUB faculty and students, as well as some members of the IUPUI community.  Its is 
a "general purpose" system; in other words, you aren't required to do batch processing.  If you'd like to 
know Steel's specifications, you can find it here. 

The DaVinci cluster is a cluster of SGI O2 workstations located in FA 215.  While not designed for 
heavy computational use, you can still use the DaVinci cluster to get a feel for using Mathematica under 
UNIX.  To connect to any DaVinci machine, telnet to davinci.ucs.indiana.edu.  All IUB 
faculty, staff and students may apply for an account on the DaVinci cluster. 

To simplify this document, we assume you will be using Steel unless otherwise noted. 

Keep in mind that you will be running the math software on the machine you connect to, not the 
machine you are sitting at. 

Logging in

Since you are (presumably) not in the same physical room as Steel, you will need to log on using 
Telnet.  The address is 
steel.ucs.indiana.edu . 

●     From a UITS NT cluster, go to Start Menu -> Programs -> Communications -> Other WCC 
Computers -> Steel.

●     From a UITS Mac cluster, go to Apple Menu ->Telnet->Steel.

Enter your username and password.  If this is your first time logging in, you may be presented with 
some information about the system.  You should eventually see the UNIX prompt, which should be a $ 
or a %. 

Learning more about UNIX
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At this point, you should have a UNIX prompt in front of you.  This is really all you need to get the 
basic functionality of the math software. 

However, your UNIX experience will be much more satisfactory if you follow an in-depth tutorial.  We 
recommend: 

●     Research Computing at IU: The Basics.  A comprehensive guide to using research computers at 
IU.  It is IU-specific, but not campus specific.

●     UnixTools.com.  A good web directory of UNIX help.  Includes history, flavor-specific help, and 
tutorials.

Previous: Introduction
Next: Starting the Math Software
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●     Introduction 
●     UNIX - The absolute least you need to know 
●     Using the Math Software 

❍     Modes of Use 
❍     Maple 
❍     Matlab 
❍     Mathematica 

●     Using graphics over the network 
●     Using batch processing 
●     Further Reading 

Starting the Math Software

Modes of Use

Before you use the math software, you should be aware of the different ways of using it.  On a desktop 
computer, it is only possible to use it in a fully interactive setting.  On UNIX, it may be preferable to use 
it in a different way. 
There are three ways of running most software under UNIX: 

●     Interactive mode.  You type in input directly, and output is displayed on your screen.  The 
interface may be a full window with pretty graphics, or it could be a terminal-based system.

●     Non-interactive mode.  Over a terminal, you can put all of your input into one file, then have the 
software process the commands and save the output to a file.  You can be doing other tasks while 
it runs.  Graphics output is limited to saving plots as images.

●     Batch mode.  You create an input file as for non-interactive mode, but you also create a "job 
script", which tells the system software to execute the math software (with your input) at a later 
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time.  Jobs are queued, so you may have to wait a while for your results.  Batch jobs allow you 
access to more memory and processor power than the other modes, so it is best for extensive 
number crunching.

At IU, most batch jobs should be done on the SP system.  We'll discuss batch mode later, in the Batch 
Processing Section.  In addition, we'll discuss only terminal-based modes here, and we'll cover 
interactive graphics later, in the X Windows Section. 

Maple

Interactive Mode 
To start maple, just type maple at the UNIX prompt.  Maple will start, and you will see the familiar 
">" Maple prompt. 
To leave Maple, type quit; at the Maple prompt. 
All of the standard packages are available, and you should find that Maple behaves just like it does on 
your desktop. 

Non-interactive Mode 
You can load plain text files with maple commands (one per line, ending in a semicolon - the usual).  Be 
sure the last command is quit;. Then type at the UNIX prompt: 
    maple filename > results.txt 
This will return you to the UNIX prompt while Maple executes the commands in filename and saves 
the results in results.txt . 
To learn more about Maple's file input and output abilities, run Maple interactively and type the 
following: 
    ?writeto 
    ?echo 
    ?save 
    ?read 
    ?interface 
  

Matlab

Interactive Mode 
To start Matlab, type matlab.  Matlab will start, and you will see the familiar ">>" prompt. 
Type quit at the Matlab prompt to exit. 
IUB has licenses to most of the Matlab toolboxes.  Use them as you would at your desktop.  Be 
forewarned that most graphics functions simply won't do anything if your terminal doesn't support 
graphics.  Matlab always looks for m-files in the directory from which it started (as well as the standard 
library locations). 
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Non-interactive Mode 
Put all of your commands in a plain text file as if you had typed them into Matlab. Be sure the last 
command is quit.  Then type 
    matlab < filename > results.txt & 
This runs Matlab, executes the commands in filename and saves the results to results.txt , 
while you are returned to the UNIX prompt. 
To load and save Matlab variables, type the following at the Matlab prompt: 
    help load 
    help save 
    help diary 
  

Mathematica

Interactive Mode 
To start Mathematica, type math.  You should see the familiar Mathematica prompt, "In[1]=".  To exit 
Mathematica, type Quit. 

This actually starts the Mathematica Kernel and lets you type directly into it.  There is no terminal-
based front-end, since the kernel itself can function in this manner.  However, you will have primitive 
graphics or plotting capabilities (but you will not have the ability to export to an image file).  

Non-interactive Mode 
Save all your commands, one per line, in a file.  Be sure the last command is Quit.  Then type 
    math < filename > results.txt & 
This runs Mathematica, executes the commands in filename and saves the results to results.txt 
, while you are returned to the UNIX prompt. 

For more information on saving and loading work, type at the Mathematica prompt: 
    ?Save 
    ?>> 
    ?<< 

Previous: UNIX - the least you need to know
Next: Using Graphics over the Network
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Stat/Math Math Under UNIX Using Graphics over the 
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●     UNIX - The absolute least you need to know 
●     Using the Math Software 
●     Using graphics over the network 

❍     Advice on graphics 
❍     Typewriter graphics 
❍     Terminal Emulation 
❍     Postscript, VRML, and GIF output 
❍     X Windows 
❍     Mathlink 

●     Using batch processing 
●     Further Reading 

Using Graphics Over the Network

Advice on graphics

The goal of this section is to help you use the graphics features of the math packages.  There is no 
perfect way of doing this.  Before you attempt any method other than typewriter graphics, you should 
ask yourself if you really need graphics output from your UNIX session.  UNIX machines are designed 
to crunch a lot of numbers quickly, but they are not designed to draw pretty pictures.  Desktop versions 
of the math software are designed to draw pretty pictures. 

One good way out of this is to use the UNIX machine to do all the hard work, save the results in a file, 
transfer the file to your desktop machine, and then use your desktop package to visualize and interpret 
the results. 
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This area of this document is still changing as we perfect the methods.  If you have any problems, 
suggestions, etc. with the techniques used here, please post to iu.statmath, or email 
statmath@indiana.edu. 

Typewriter Graphics

Typewriter graphics is the default behavior for all three packages (but if you are running an X-server 
and you have set the DISPLAY variable, all three default to X graphical output.). Typewriter graphics 
simply means that  the program will try to draw a picture using ASCII characters.  While not pretty (or 
accurate, for that matter), typewriter graphics are good for drawing formulae with a bit more clarity than 
straight text. 

Postscript, VRML, and GIF Output

All three major math packages offer graphics output to other file formats.  This may be your best 
graphics option if you plan to publish your results on the web, use graphics in other applications (such 
as word processors), or if you are doing batch processing.  All three packages will place output files in 
the current directory if a full path is not given, so make sure that you have write permission on the 
current directory.  After you are done, you will need to retrieve your files using FTP. 

Maple

Maple provides good export capability.  See 
?plottools,vrml - export 2d or 3d graphics to vrml 
?plot,device - export to gif, jpeg, Postscript, and other formats. 
?plot,device,ps - options for Postscript output. 
?plotsetup - output options - especially see section on plotoutput variable. 

Matlab

Matlab provides extensive export capability.  Type the following in Matlab for more information: 
help vrml -export a graphics object to VRML 2.0 
help imwrite -write out a graphics object to a wide variety of formats 
help saveas -save a graphics object to Postscript 
help print -save a graphics object to Postscript 

Mathematica

Graphics output requires the use of a front-end.  Since the only front-end availible for UNIX is the X-
windows client, this method is less useful (since you would already have graphics capability directly 
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from within Mathematica).  However, you can still redirect output to other file formats.  You can use the 
following command to redirect plot output to a GIF file. 
    Plot3d[[Sin[x y],{x,0,4},{y,0,4}, DisplayFunction-> 
Function[Display["foo.gif",#,"GIF"]] 
You use this option with all plot, play, and show commands.  Be sure that your current working 
directory is something reasonable, since that is where the file will end up.  You may also use a full path 
for the filename.  Read about other file formats by using the Mathematica help browser, under "Built-in 
Functions": Graphics and Sound -> Graphics Exporting -> Display. 

X Windows

X Windows is a distributed Graphical User Interface (GUI) environment.  In other words, you can run a 
program on a UNIX machine, but have the window appear on your local machine.  This gives you the 
full functionality of using the graphical interface, while still having the power of a large UNIX 
computer.  The program you are running is called an X-windows client.  You local machine must be 
able to interpret and display the windowing commands that your client sends - in other words, your 
local machine must act as an X-windows server.  Most Solaris, Linux, and IRIX (SGI) workstations are 
capable of acting in this manner directly.  For Mac and Windows users, you must run a seperate 
program that will provide this capability.  Please note that using X-windows requires a fast network 
connection, so using this option over a dial-up line is not recommended. 

●     For Mac users, you will have to install a third-party X-windows server (this is different from the 
Mac OS X Unix Server).  UITS does not support or endorse the use of these programs in the 
public clusters (STCs).  However, you may purchase, install, and use these programs on your 
own Mac.  MI/X is a free X-server for the Mac. UITS provides this link as a service to customers 
and in no way endorses or supports this product.

●     For Windows (3.x, 9x, and NT)  users, you will have to install a third party X-windows server.  
UITS does not support or endorse the use of these programs in the public clusters (STCs).  
However, you may purchase, install, and use these programs on your own PC.  Popular X-
windows servers include X-WinPro , Exceed, and MI/X (free).  UITS provides these links as a 
service to customers and in no way endorses or supports these products.

●     For UNIX workstation users, the Ships and DaVinci machines have X already installed.

To use math software as an X-windows client, follow these steps. 

1.  Setup the X-windows server on your local machine.
❍     If you are using a UNIX local machine, you will have to give the client machine 

permission to connect to your X-server.  Do this by issuing the command    xhost 
+steel.ucs.indiana.edu

❍     PC and Mac users should start their X-server software.  Refer to the documentation of the 
software.

2.  Connect to the remote machine using telnet.
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3.  You need to tell the remote machine where you are.  To do this, you must set the DISPLAY 
environment variable to your local hostname.

❍     Find out what shell you use by typing echo $SHELL
❍     If you use csh, type setenv DISPLAY hostname:0
❍     If you use bash, type DISPLAY=hostname:0;export DISPLAY

4.  Start the X-client version of the math software from your telnet session.
❍     Maple - issue the command xmaple &
❍     Matlab - issue the command matlab.  If your X-server is setup properly, you should be 

able to enter matlab commands in the telnet window, but have graphics displayed in a 
"pretty" new window.  Type demo to try this out.

❍     Mathematica - issue the command mathematica &. You may see errors about fonts. If 
so, follow these instructions.

5.  Do your work, and exit from the math software.
6.  Un-setup your X-server

❍     For UNIX machines, make sure you issue the command xhost -
steel.ucs.indiana.edu after you are done.

❍     For PC and Mac users, consult your X-server's documentation.

Please note that using the X-windows system may open security holes on your system (more info). 
More information on the X-windows system may be found at  www.x11.org. 

Mathlink

Note: This information applies to the Mac edition of Mathematica 4.0. 

Mathlink is a feature of Mathematica.  Users familiar with Mathematica will recall that it is made up of 
two parts: 

●     The Kernel - does all processing, manages variables, and loads packages
●     The Front-end - does all graphics work, input, and output.

Mathlink is a proprietary protocol that allows the kernel and front-end to run on seperate machines.  (It 
also allows compiled programs to access a remote kernel - but that topic is well outside the scope of this 
document).  To use Mathlink, do the following steps: 

●     Go to the Kernel menu and select Kernel Configuration Options,
●     Select Kernels and Tasks,
●     Click the Add button to add a new kernel
●     Assign the new kernel a name. For example, if using Mathematica on DaVinci, you may want to 

use DaVinci as the name of the new kernel.
●     Under Basic Options, click on Remote Machine.
●     Click the Connections button and under Connection Settings Method, select VersaTerm Telnet 
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Tool.
●     In the Host TCP/IP Address box, type in either the hostname or IP address of the remote host and 

click OK.
●     If connecting to a Unix system, click on the Terminal button and select VT102 under Terminal 

Settings Emulation. You may also customize your keyboard mapping here.
●     Note, by default Mathematica looks for the > symbol before launching the program on a remote 

system. If the default prompt on the remote system is not >, then you must either change the 
default prompt or the start up option in the new kernel settings. To change the prompt locally, 
click on Advance Options and in the Communications Toolbox Login box, change the > to 
whatever the last character in your login prompt is. For example, if you were accessing 
Mathematica on a Unix system with the default prompt for Korn shell, you would change > to $.

●     Once all the settings are correct, click OK twice.
●     In the Kernel menu, choose Notebooks Kernel and select the Connection from the list of 

available kernels.
●     Again from the Kernel menu, choose Start Kernel and select the Connection from the list of 

available kernels.

You will then be asked to supply a username and password for the remote system.

Previous: Starting the Math Software
Next: Using Batch Processing

Permission to use this document is granted so long as the author is acknowledged and notified. 
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Using Batch Processing

Using the SP

Batch processing is an extremely powerful way to do computationally-intensive work.  The main system 
for doing batch processing at IU (for research purposes) is the IBM RS/6000 Scalable POWERParallel 
System, known as the Research SP System. 

The Research SP System is made up of several different nodes.  Matlab, Maple and Mathematica are 
available on aries09. The first time you log in to the SP, log into libra.ucs.indiana.edu.  Libra 
manages the SP's password records, and will initialize your account on all the nodes.  Then you may 
telnet or SSH to aries09.ucs.indiana.edu.  If you're doing batch processing, you can log into 
any node and (assuming you follow the instructions) the job will execute on the right node. 

Please note that the SP is intended for use only as a batch processing system.  All processes that 
accumulate more than 20 minutes of CPU time in an interactive (non-batch) setting will be terminated. 
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Preparing to batch process

If this is your first time batch processing, we recommend you first attempt a "smaller" version of your 
task.  Don't try to solve your research problem on the first attempt. 

Create a text file that has the exact command you which to run.  This file will be fed into your math 
package as if you typed it in.  In other words, each line in the text file should be the exact same thing as 
what you would type at the Maple, Matlab, or Mathematica prompt.  You are free to have your text file 
load other files or worksheets, but be sure to use the full path when specifying filenames.  You can find 
out the full path by typing pwd . This tells you the "present working directory".  For example, if you 
want to load a file in your home directory named "work.mws", you should give the filename as 
"/N/u/john_smith/work.mws".  The same goes for all output commands. 

Remember, you won't be able to interact with the math software while it is running.  This means you 
need to save the results of your work in some way.  You should probably use the math package's built-in 
save function.  For graphical output, we recommend outputting to a file format such as VRML, GIF, or 
JPEG. 

Also, you must test your plain text file before executing it on the SP.  We recommend testing it on 
Steel.  If you saved your text file as "foo.txt", you can test it using the command maple < foo.txt 
> foo.out (or matlab, or math).  This feeds foo.txt to Maple one line at a time, and any output that 
would normally go to the screen is redirected to a new file called foo.out.  Make sure that your list of 
commands does exactly what you think it will. 

After you have perfected your math package command script, you are ready to batch proccess it. 

Writing a LoadLeveler Script

The SP uses a program called LoadLeveller to do batch processing.  You wrap up all the commands 
neccesary to do your job in a file called a LoadLeveller Script. 
A good tutorial on using LoadLeveller is  The UITS Research SP System - Submitting Batch Jobs to the 
LoadLeveler .
Sample scripts can be found in the /N/u/statmath/SP/scripts directory on the SP. 

Previous: Using Graphics over the Network
Next: Further Reading
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Further Reading

For general questions, including questions about various platforms and their terminal and X window 
software, call the UITS Support Center at 855-6789, or use the WWW to browse the UITS Knowledge 
Base. 

More information on the X Window System is available from the Unix System Support Group. If you 
have questions about statistical or mathematical software, call the UITS Stat/Math Center at 855-4724, 
or send e-mail to statmath@indiana.edu. 

Previous: Batch Processing
Up: Introduction
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The Knowledge Base is a database of over 7,500 answers to questions about computing at Indiana 
University. Searches will return documents that contain all the words you enter in the search box. 

Enter your search terms:   
How to Search | Advanced Search 

Searching tips: ●     Use more than one word
●     Use only important words

Good examples: ●     norton antivirus scan disk
●     microsoft exchange forward e-mail
●     locate e-mail address

Bad examples: ●     e-mail (too general; will return hundreds of documents)
●     how do I locate my cousin's e-mail address at 
Cornell? (too specific; too many words)

●     analysis of social change (not related to computing or Indiana 
University)

Other ways to access Knowledge Base information: 

●     Menus: A selection of popular Knowledge Base documents organized by topic; a good starting 
place

●     Glossary: An alphabetical list of Knowledge Base documents that define common computing 
terms

Knowledge Base Home | About the Knowledge Base | IT Help Online 
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Getting Started With MATLAB

Revised by Clinton Wolfe (June 1999)
Original by David Hart 

Printer-friendly version: Adobe PDF, 307 KB (Get Acrobat Reader 4.0)

●     Introduction 
❍     What is Matlab? 
❍     How to use this tutorial 
❍     Where to find Matlab 
❍     How to start and exit Matlab 

●     Finding your way around the window 
●     Matlab Syntax 
●     More on Matrices 
●     Graphics 
●     Programming 
●     Further Reading 

What is Matlab?

MATLAB is a computer program for people doing numerical computation, especially linear algebra 
(matrices). It began as a "MATrix LABoratory" program, intended to provide interactive access to the 
libraries Linpack and Eispack. It has since grown well beyond these libraries, to become a powerful tool 
for visualization, programming, research, engineering, and communication. 
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Matlab's strengths include cutting-edge algorithms, enormous data handling abilities, and powerful 
programming tools. Matlab is not designed for symbolic computation, but it makes up for this weakness 
by allowing the user to directly link to Maple. The interface is mostly text-based, which may be 
disconcerting for some users.

Matlab is packaged as a core program with several "toolboxes", sold seperately. We will only cover the 
core package. The current (June 1999) version is Matlab 5.3 release 11. 

How to use this document

This document is intended to be used while sitting at a computer running either NT or the X windows 
system. It is assumed that you will enter the commands shown, and then think about the result. 

The reader of this document should have at least a passing familiarity with linear algebra and be 
comfortable using computers. In order to be more broadly understood, we will not cover any 
engineering topics (e.g. signal processing, spectral analysis), though Matlab is commonly used for these 
tasks. No previous math software experience is necessary, though we will point out important 
differences between the various packages along the way.

If you are using Matlab over a text-based terminal (such as Telnet or SSH), you might want to follow 
the Using Math Software under UNIX tutorial after you are finished with this one. 

Throughout this document, we will use the following conventions. 

Example Explanation

File -> Open Choose the file menu, and select Open.

a = 5 Input to be typed at the Matlab prompt.

a = 
5

Output from Matlab.

An important tip.

Where to find Matlab

MATLAB is available for many different kinds of computers at Indiana University Bloomington. 

●     All Windows NT Student Technology Centers 
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●     Ships, Nations, and DaVinci UNIX clusters 
●     Several of the large timesharing systems - see the availability chart for details. 

A student edition is available from local bookstores for your personal Windows, Macintosh, and Linux 
systems. 

How to Start and Exit Matlab

To start Matlab: 

●     On windows NT, choose Start Menu ->Programs->Statistics-Math->Matlab. 
●     On Ships, Nations, Davinci, and all timesharing systems, type matlab to run it interactively.

Note that plots will be displayed in an X-window, if you have set the DISPLAY variable. You 
may also type matlab -display hostname:0. 

Note that Matlab typically takes 10-15 seconds to load.
Eventually, you should see: 

  To get started, type one of these: helpwin, helpdesk, or demo.
  For product information, type tour or visit www.mathworks.com.
        >> 

The line >> is the Matlab prompt.
To exit Matlab, type (at the matlab prompt) quit or choose File->Exit MATLAB. 

Next: Finding your way around the window
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Mathematica
●     Information 

❍     Overview of Mathematica 
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Enter your search terms:   
How to Search | Advanced Search 

What is Unix?

Unix is a powerful multi-user environment designed primarily for servers and advanced users. It has a 
steeper learning curve than other operating systems, such as Windows or Mac OS, but offers superb 
flexibility and stability. Though inexperienced users sometimes find its complexity daunting, Unix is 
very popular, and in recent years it has become more accessible. 

Unix was developed at Bell Labs in 1969, but in the past three decades many others have contributed to 
its evolution. In reality, Unix is not so much a single operating system as it is a standard upon which 
organizations and companies base their own systems. Examples of Unix implementations include AIX 
(IBM), Solaris (Sun Microsystems), IRIX (SGI), BSD/OS (BSDi), and Linux (GNU). To the casual user, 
these different systems are very similar because they all provide a common interface through the Unix 
shell. 

As with other operating systems, there are many kinds of applications available on a Unix system. E-
mail, newsreading, programming, statistics, and graphics are some of the areas for which Unix software 
exists. Unix was once distinct from other operating systems because of its high level of integration with 
the network and its multi-user environment. Each user who logs in can have an environment distinct 
from any other user. In recent years, however, this distinction has blurred as other operating systems 
have developed these capacities. With the increasing popularity of free Unix systems like Linux and 
FreeBSD, as well as the advanced graphical user interface the X Window system offers, more individuals 
are also using Unix as the operating system for their personal workstations. 

Related online NETg tutorials (IU only)

Unix Fundamentals 

If you haven't used NETg before, see the Knowledge Base document What do I need to know about 
accessing NETg from the Knowledge Base? 

Also see:
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●     Introduction to Unix commands 
●     What books are available for Unix and where can I find them? 
●     In Unix, what is the man command, and how do I use it to read manual pages? 
●     What are some equivalent commands in the electronic mail programs Berkeley mail, Pine, and 

Elm? 
●     Where can I learn about the history of Unix? 
●     In Unix, what do some obscurely named commands stand for? 
●     For Unix, where can I find an online tutorial? 
●     What does Unix stand for? 

This is document agat in domain all from the Knowledge Base.
Last updated on September 06, 2001 

When you're done reading, please tell us: Did you find the answer to your question?
Yes | No | No, and I'd like to ask a consultant.

Knowledge Base Home | About the Knowledge Base | IT Help Online 
Give us some feedback with our User Survey. 

URL: http://kb.indiana.edu/data/agat.html
This page is maintained by the Support Center (scweb@indiana.edu)

You can help keep the Knowledge Base up to date with suggestions, corrections, and additions.
Copyright 1997-2002, The Trustees of Indiana University 
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What is UITS? 

University Information Technology Services (UITS) at Indiana University, with offices on the 
Bloomington and Indianapolis campuses, is responsible for the continued development of a modern 
information technology environment throughout the university in support of IU's vision for excellence in 
research, teaching, outreach, and lifelong learning. 

The information technology environment at IU includes tools and services that support the academic and 
administrative work of the university. Computing tools include a variety of timesharing computers; 
hundreds of public-access, Internet-connected, fully equipped workstations; and a number of 
supercomputers. A high-speed network links these resources. 

The four divisions of UITS (Teaching and Learning Information Technologies, Telecommunications, 
University Information Systems, and Research and Academic Computing) and the Advanced Information 
Technology Laboratory work together to support IU in its use of information technology. UITS reports to 
the Office of the Vice President for Information Technology. 

For a complete listing of UITS services, see the UITS Services Directory (a .pdf file) at: 

  http://www.indiana.edu/%7Eocmhp/092801/text/UITSdirectory.pdf

Visit the UITS home page at: 

  http://www.indiana.edu/~uits/

This information came from the Office of the Vice President for Information Technology. 

Also see:

●     What is the policy for making copies of UITS publications? 
●     Where can I find information about jobs with Indiana University's UITS (University Information 
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Technology Services)? 
●     UITS Directory: Some important phone numbers and addresses 
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What is the X Window System?

The X Window System, often known as X, is a windowing system for graphics workstations developed 
at MIT with support from DEC. It is based on a client/server model: a networked computer or 
workstation runs an X server, and client programs running on connected workstations request services 
from the server. The server handles input and output devices and generates the graphical displays used by 
the clients.

Like many popular graphical user interfaces, the X Window System displays information and 
applications in rectangular windows arrayed on a desktop-style screen, known as the root window. 
Windows can be resized, moved, and otherwise manipulated with a mouse. The use of multiple windows 
lets you perform tasks concurrently in ways that are cumbersome or impossible in text-only displays. For 
example, in a particular X session, you could have several windows open at the same time containing 
login sessions to different computers, an editor, a paint program, and a mathematical application, and be 
able to cut and paste information between the windows.

For more information about X, visit X.Org's Web page at: 

  http://www.X.org/

X.Org is part of the Open Group and is responsible for managing development of the X Window System. 

On many Unix computers, X user applications are in the /usr/bin/X11/ directory, but in Solaris, 
they are in /usr/openwin/bin, while in most Linux distributions, they are in /usr/bin. 

X server programs exist for many platforms, including all modern Unix implementations (e.g., Solaris, 
Linux, AIX, IRIX, FreeBSD), as well as Mac OS, Mac OS X, Windows, and even VMS. 

Also see:

●     In the X Window System, what is a window manager, and how do I find out which ones are 
available? 
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●     Why does my X Window System application fail with the message "Cannot open display"? 
●     Do you have an introduction to installing and using the X Window System? 
●     For the X Window system, what programs can I use to view graphics? 
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CalculationCenter 2, a new version of our 
easy-to-learn, easy-to-use calculation 
solution, is now shipping and features a 
broad range of new capabilities...

Supporting the MathML standard it 
helped to create, Wolfram Research 
again hosted the MathML International 
Conference June 28-30. Premiering at 
the conference was MathML Central, a 
new Wolfram web resource.
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Where do I get PCF versions of the Mathematica fonts? 

In the most recent releases of Mathematica 3.0 and 4.0, the PCF fonts are available directly 
from the CD in the following directory (mounted as a Unix volume). 

/cdrom/Unix/Files/SystemFiles/Fonts/PCF 

The files cannot be copied from the CD on Windows because the pcf file extension will be 
removed. 

If you do not have these fonts on your CD (from using the initial Mathematica 3.0 release), 
you can download the PCF version of the fonts from the following URL's. 

http://support.wolfram.com/mathematica/systems/unix/interface/PCF.tar.Z 
http://support.wolfram.com/mathematica/systems/unix/interface/PCF.zip 

The compressed tar archive is intended for Unix systems; the zip archive is intended for 
Windows and Macintosh systems. 

Extracting these archives creates a directory PCF. 

Last modified January 18, 2000.

Questions or comments about this FAQ? Send email to support@wolfram.com. 

  

   © 2002 Wolfram Research, Inc.
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What is Steel? 

Steel is a cluster of four Sun UltraSPARC workstations running Solaris 2.8. Each workstation is 
equipped with dual 200MHz processors and 1GB of memory. Though there are four computers in the 
cluster, if you have a Steel account, you access it via SSH or SFTP through a single address: 
steel.ucs.indiana.edu. User files are stored on the NFS system.

In addition to the four UltraSPARCs, the Steel cluster has a silent partner, an applications server named 
Forge. While the front end Steels provide CPU cycles to users, Forge provides the mettle that makes 
Steel a viable system. As a user, you do not log into Forge, but rather access the software, licenses, 
databases, etc., which are served from Forge. By having a single applications server, you are assured of 
seeing a consistent suite of products and services on Steel. 

Forge is a Sun E3500 server running Solaris 2.8, configured with: 

●     Four 400MHz UltraSPARC-II processors 

●     4GB memory 

●     10/100Mb Ethernet and Gigabit Ethernet 

●     4mm tape drive 

●     Sun A1000 disk array with 80GB RAID disk 

Steel's primary purpose is to provide an interactive environment for general purpose Unix computing. It 
is also the location for editing personal Web pages served by Php. While research computing tools are 
available, instructional and general-purpose computing takes precedence. CPU-intensive batch jobs 
should be run on dedicated research systems, such as the Research SP. 

You can find more information about what software is available on Steel at: 

  http://www.indiana.edu/~rats/research/steel/software.shtml
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All IU students, staff, and faculty may have accounts on Steel. To create one, point your Web browser 
(which must support secure authentication) to the Network ID Services page: 

  https://iuaccts.ucs.indiana.edu/

At IUPUI, to add Steel privileges to your Network ID, point your Web browser to the Network ID Web 
page at: 

  https://iupui-accts.iupui.edu/
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What are the Ships?

The Ships are a cluster of SGI workstations located in Student Building 230 at IU Bloomington. The 
Ships machines are equipped with CD-ROM drives. 

Students, faculty, and staff may create accounts on the Ships cluster by visiting the Network ID Services 
page at: 

  https://iuaccts.ucs.indiana.edu/

You will not be able to use the workstations in Student Building 230 until you have created a Ships 
account.
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What is the Nations cluster?

The Nations cluster, presently located in Geology 226, originally opened in Student Building 231 in 
October 1996. 

This site consists of 21 Sun Ultra 10 workstations. Each workstation is equipped with 256MB of RAM, a 
CD-ROM drive, a floppy disk drive, a 9GB hard drive, and 24-bit color graphics on a 21" monitor. The 
site also has an HP LaserJet 8000 for PostScript printing. 

Primarily a development site, the Nations cluster offers C, C++, Pascal, Fortran 77 and 90, and the Java 
Development Kit. 

Other available software includes a suite of Stat/Math and GIS software and a wide variety of public 
domain packages. Netscape Navigator 4.7 is the standard Web browser. 

Note: As with the other Unix systems in the Student Technology Centers, you will need to obtain an 
account on these computers in order to use them. You need to get a Nations account to use this facility 
even if you had an account on the old Nations cluster. To request an account, visit the Network ID 
Services page at: 

  https://iuaccts.ucs.indiana.edu/

Also see:

●     Descriptions of available accounts at Indiana University Bloomington 

This is document acsp in domain iu from the Knowledge Base.
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What is the da Vinci cluster in Fine Arts 215, and 
how do I get an account?

The da Vinci Student Technology Center (STC) in FA 215, available to all IUB students, faculty, and 
staff, provides high-end visual arts computing tools on Mac OS and SGI computers. To use the da Vinci 
SGIs, you must first create a da Vinci account through Network ID Services at: 

  https://iuaccts.ucs.indiana.edu/

You do not need a da Vinci account to use the Mac OS computers in the da Vinci STC.

For more information on what is available in the da Vinci lab, see the Student Technology Centers Web 
page about FA 215 at: 

  http://stcweb.uits.indiana.edu/apps/public/labs.cfm?lab_id=173

For information regarding policies governing the STCs, see: 

  http://stcweb.uits.indiana.edu/apps/public/policylist.cfm

Also see:

●     Where can I find information about Silicon Graphics (SGI) systems and software? 
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What is the Research SP system?

The Research SP cluster is dedicated to the research needs of IU Bloomington and IUPUI faculty, staff, 
and graduate students. Over 600 researchers from over 60 departments on the IUB and IUPUI campuses 
currently have accounts on the Research SP. Graduate students and staff who would like to have an 
account on the Research SP must have a faculty sponsor. 

The Research SP currently consists of 11 frames containing a 2-CPU 332MHz PowerPC (aka Silver) thin 
node, a 2-CPU 375MHz Power3+ wide node, 126 4-CPU 375MHz Power3+ thin (aka Winterhawk2) 
nodes, four 16-CPU 375MHz Power3+ high (aka Nighthawk2) nodes, and a 16-cpu 1.3GHz Power4 
node, for a total of 144 nodes and 632 processors. The Research SP's theoretical peak capacity is about 1 
trillion floating point operations per second. 

Operating system and networking

Each node on the Research SP runs its own copy of IBM's flavor of Unix, AIX. Additional IBM 
software, PSSP (Parallel System Support Program), allows the nodes to function as one system, 
facilitating their use, administration, and maintenance. All nodes are interconnected with the Research SP 
high-speed switch. 

This crossbar switch provides four paths between any pair of nodes at 150MB/second peak bandwidth, 
an aggregate bandwidth of 1.2GB/second, and an application latency of less than 40 microseconds 
transfer; it supports both IP protocol and the proprietary US (user space) protocol developed by IBM. 

An externally connected specialized router allows the Research SP switch network to connect to the 
other Research SP switch, 10/100Mb Ethernet, Gigabit Ethernet, FDDI, HIPPI, or ATM networks. The 
Research SP's routers connect to the HPSS Research SP switch network, as well as to the 10/100Mb 
Ethernet and Gigabit Ethernet networks within Wrubel Computing Center. 

Accessing the Research SP
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All Research SP nodes are accessible via SSH. The hostnames are aries01-
127.ucs.indiana.edu and orion01-09.ucs.indiana.edu . The aries nodes are called the 
Aries Complex and the orion nodes are called the Orion Complex. 

Software and programming tools

IBM compilers, commercial stat/math products, and several public domain software packages are 
available on the Research SP. 

Several IBM software products designed to use the Research SP switch for message transfer are available 
on all Research SP nodes. These products include Parallel ESSL, High-Performance Fortran, Distributed 
Debugger, and Parallel Environment. In addition, these products offer tools for compiling, running, 
monitoring, profiling, tuning, and debugging parallel programs. 

The Research SP nodes process batch jobs via the LoadLeveler load balancing, batch queuing system. 
You may submit both serial and parallel jobs to the Research SP nodes. UITS discourages interactive use 
of Research SP nodes, and strictly enforces a limit of 20 minutes of elapsed CPU time per interactive 
process.

History

The Research SP began in July of 1996, when UITS (then University Computing Services) acquired an 
IBM SP for research computing. The original 24-node system was expanded to 47 nodes in September of 
1998, and was expanded again to 71 research nodes in December of 1999. In subsequent expansions (the 
latest in January 2002), the Research SP has grown to its present configuration. 

For more information on the Research SP, see: 

  http://sp-www.iu.edu/

Also see:

●     What are CISC and RISC technologies, and how do they compare? 
●     What is superscalar architecture? 
●     At Indiana University, where can I find high performance computing documentation online? 

This is document beku in domain iu from the Knowledge Base.
Last updated on June 27, 2002 

When you're done reading, please tell us: Did you find the answer to your question?
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What is telnet?

Telnet is a protocol that allows you to connect to remote computers (called hosts) over a TCP/IP network 
(such as the Internet). There is a telnet server on the remote host, which the telnet client negotiates with 
to establish a connection. Once connected, the client becomes a virtual terminal, and allows you to 
interface with the host computer from your computer. In most cases, you'll be asked to log into the 
remote system. This usually requires an account on that host. Occasionally you can log in as guest or 
public without having an account.

There are telnet clients available for all major operating systems.

Command-line telnet clients are built into most versions of Mac OS X, Windows (95 and later), Unix, 
and Linux. To use them, go to their respective command lines (i.e., the shell or DOS prompt), and then 
enter: 

  telnet host

Replace host with the name of the remote computer you wish to connect to.

Also see:

●     I have a functioning PPP connection using Windows 95, 98, Me, NT, or 2000. What can I do 
now? 

●     What is FTP, and how do I use it to transfer files? 
●     With MacSSH, BetterTelnet, and NCSA Telnet, how do I use FTP to transfer files between my 

computer and a remote host? 
●     What is PPP (Point-to-Point Protocol), and why would I want it? 
●     What are SSH and SSH2? 
●     In Mac OS, with MacSSH, NCSA Telnet, or BetterTelnet, why do I get an error that says "Host or 

Gateway not Responding"? 
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What are SSH and SSH2?

The program SSH (Secure Shell) is a secure replacement for telnet and the Berkeley r-utilities (rlogin, 
rsh, rcp, and rdist). It provides an encrypted channel for logging into another computer over a 
network, executing commands on a remote computer, and moving files from one computer to another. 
SSH provides strong host-to-host and user authentication as well as secure encrypted communications 
over an insecure Internet. 

SSH2 is a more secure, efficient, and portable version of SSH that includes SFTP, an SSH2 tunneled 
FTP. At Indiana University Bloomington, UITS has upgraded most central systems from SSH to SSH2, 
and encourages users who are concerned with secure communications to connect using an SSH2 client. 

IU licenses the SSH Communications Security SSH Secure Shell software for Windows and MacSSH for 
Mac OS. If you are an IU student, staff member, or faculty member, you can download this software 
from IUware Online at: 

  http://iuware.iu.edu/

Note: To access this software on IUware, you must be connected to the Internet from an on-campus 
Ethernet connection, through the IU modem pools, or through the IU VPN. 

When connecting to a server for the first time, SSH Secure Shell will ask you to confirm that you wish to 
save the new host key to the local database. Click the Yes button in order to avoid this message the next 
time you connect. 

Rather than validating identities via passwords, SSH2 can also use public key encryption to authenticate 
remote hosts. For example, if you were to connect to a remote host called global.conspiracy.org 
(also running SSH2), SSH2 would use this system to verify that the remote system is the real 
global.conspiracy.org and not a computer set up to imitate it. If you wish, you can set up SSH2 
to use public key authentication rather than passwords for logging into your other accounts, much like 
the Unix rlogin program. For more information on how to set up SSH and SSH2 to use public key 
authentication, see the Knowledge Base document In SSH and SSH2 for Unix, how do I set up public 
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key authentication? 

You can find additional information on SSH and SSH2 at these sites: 

●     The ITSO SSH2 Howto Guide at: 

  http://www.itso.iu.edu/howto/ssh2.epl

●     The SSH FAQ at: 

  http://www.employees.org/~satch/ssh/faq/ssh-faq.html

●     The SSH Communications Security SSH Secure Shell home page at: 

  http://www.ssh.com/products/ssh/

●     The OpenSSH home page at: 

  http://www.openssh.org

●     The IU Unix Workstation Support Group security resources page at: 

  http://uwsg.iu.edu/security/

Also see:

●     What is cryptography, and where can I find more information about it? 
●     What is PGP? 
●     In SSH and SSH2 for Unix, how do I set up public key authentication? 
●     For Unix, what are ssh-agent and ssh-add, and how do I use them? 
●     For Mac OS, what is MacSSH, and where can I get it? 

This is document aelc in domain all from the Knowledge Base.
Last updated on January 31, 2002 

When you're done reading, please tell us: Did you find the answer to your question?
Yes | No | No, and I'd like to ask a consultant.
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The Knowledge Base is a database of over 7,500 answers to questions about computing at Indiana 
University. Searches will return documents that contain all the words you enter in the search box. 

Enter your search terms:   
How to Search | Advanced Search 

Searching tips: ●     Use more than one word
●     Use only important words

Good examples: ●     norton antivirus scan disk
●     microsoft exchange forward e-mail
●     locate e-mail address

Bad examples: ●     e-mail (too general; will return hundreds of documents)
●     how do I locate my cousin's e-mail address at 
Cornell? (too specific; too many words)

●     analysis of social change (not related to computing or Indiana 
University)

Other ways to access Knowledge Base information: 

●     Menus: A selection of popular Knowledge Base documents organized by topic; a good starting 
place

●     Glossary: An alphabetical list of Knowledge Base documents that define common computing 
terms

Knowledge Base Home | About the Knowledge Base | IT Help Online 
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Software Manuals by Location

Stat/Math Info Manuals By Location

Search:  In:       

Software Manuals by Location

●     Bloomington Campus Libraries 
❍     Business-SPEA Library 
❍     Education Library 
❍     Language and Computer Lab 
❍     Swain Hall Library 

●     Indianapolis Campus Libraries 
❍     IUPUI University Library 

●     Student Technology Centers 
❍     Business 101 
❍     Education 2011 
❍     HPER 154 
❍     Lindley Hall 
❍     Psychology 120 
❍     SPEA 151 
❍     Student Building 
❍     Woodburn 211 
❍     Wylie 125 

Bloomington Campus Libraries

Package Title Location
Loan 
Policy

Call 
Number

Business-SPEA Library
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AMOS
AMOS User's Guide 
v 3.6

Business-
SPEA

4 hour CM-248

AUTOCAD
Release 13, 
Command Reference

Business-
SPEA

4 hour CM-256

AUTOCAD
Release 13, 
Customization 
Guide

Business-
SPEA

4 hour CM-254

AUTOCAD
Release 13, 
Installation Guide 
for DOS

Business-
SPEA

4 hour CM-253

AUTOCAD
Release 13, 
Installation Guide 
for Windows

Business-
SPEA

4 hour CM-252

AUTOCAD
Release 13, Master 
Index

Business-
SPEA

4 hour CM-251

AUTOCAD
Release 13, User's 
Guide

Business-
SPEA

4 hour CM-255

AUTOCAD
Release 14, 
Command Reference

Business-
SPEA

4 hour CM-260

AUTOCAD
Release 14, 
Customization 
Guide

Business-
SPEA

4 hour CM-258

AUTOCAD
Release 14, 
Installation Guide

Business-
SPEA

4 hour CM-257

AUTOCAD
Release 14, User's 
Guide

Business-
SPEA

4 hour CM-259

BMDP
ANOVA and 
Regression with 
BMDP 5V

Business-
SPEA

4 hour CM-120

BMDP
BMDP Statistical 
Software Manual, 
Vol. 1

Business-
SPEA

4 hour CM-117

BMDP
BMDP Statistical 
Software Manual, 
Vol. 2

Business-
SPEA

4 hour CM-118

BMDP
BMDP Statistical 
Software Manual, 
Vol. 3

Business-
SPEA

4 hour CM-119
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BMDP
Graphical BMDP 
User's Guide

Business-
SPEA

4 hour CM-115

DBMS/COPY

The Tool for 
Software 
Connectivity, 
Version 5.0, 
Windows & DOS

Business-
SPEA

4 hour CM-250

DBMS/COPY

The Tool for 
Software 
Connectivity, 
Version 5.10 
Addendum

Business-
SPEA

4 hour CM-249

DBMS/COPY Version 6
Business-
SPEA

4 hour CM-261

GAUSS
Applications, 
Descriptive Statistics

Business-
SPEA

4 hour CM-157

GAUSS
Applications, Linear 
Programming

Business-
SPEA

4 hour CM-158

GAUSS
Applications, Linear 
Regression

Business-
SPEA

4 hour CM-155

GAUSS
Applications, 
Loglinear Analysis

Business-
SPEA

4 hour CM-162

GAUSS
Applications, 
Maximum 
Likelihood

Business-
SPEA

4 hour CM-156

GAUSS
Applications, 
Nonlinear Equations

Business-
SPEA

4 hour CM-159

GAUSS
Applications, 
Optimization

Business-
SPEA

4 hour CM-154

GAUSS
Applications, 
Quantal Response

Business-
SPEA

4 hour CM-160

GAUSS
Applications, Time 
Series

Business-
SPEA

4 hour CM-161

GAUSS

GAUSS 
Applications: 
Constrained 
Maximum 
Likelihood

Business-
SPEA

4 hour CM-22
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GAUSS

GAUSS 
Applications: 
Constrained 
Optimization

Business-
SPEA

4 hour CM-23

GAUSS
GAUSS Version 3.0 
Command 
Reference, Vol. 2

Business-
SPEA

4 hour CM-27

GAUSS
GAUSS Version 3.0 
System and Graphics 
Manual, Vol. 1

Business-
SPEA

4 hour CM-26

GAUSS
GAUSS Version 3.0 
System and Graphics 
Manual, Volume 1

Business-
SPEA

4 hour CM-28

GAUSS
GAUSS Version 3.0 
System and Graphics 
Manual, Volume 2

Business-
SPEA

4 hour CM-29

GAUSS
GAUSS Version 3.1 
System & Graphics 
Manual, Vol. 1

Business-
SPEA

4 hour CM-24

GAUSS
GAUSS Version 3.1 
System & Graphics 
Manual, Vol. 2

Business-
SPEA

4 hour CM-25

GAUSS

Markov Version 2.0: 
A Statistical 
Environment for 
GAUSS 3.1

Business-
SPEA

4 hour CM-145

GAUSS

Markov, Version 
2.0, Statistical 
Environment for 
GAUSS 3.1

Business-
SPEA

4 hour CM-168

GLIM GLIM 4
Business-
SPEA

4 hour CM-185

GSP

Geometer's 
Sketchpad, User 
Guide & Reference 
Manual Windows 
Version

Business-
SPEA

4 hour CM-164
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GSP
User Guide & 
Reference Manual, 
Macintosh

Business-
SPEA

4 hour CM-200

GSP
User Guide & 
Reference Manual, 
Windows

Business-
SPEA

4 hour CM-199

IMSL C/Math/Library
Business-
SPEA

4 hour CM-226

IMSL C/Stat/Library
Business-
SPEA

4 hour CM-225

IMSL
IMSL: Math/Library 
Quick Reference

Business-
SPEA

4 hour CM-30

IMSL

IMSL: 
Math/Library: 
Fortran Subroutines 
for Math 
Applications

Business-
SPEA

4 hour CM-31

IMSL

IMSL: Stat/Library: 
Fortran Subroutines 
for Statistical 
Analysis

Business-
SPEA

4 hour CM-35

IMSL

Math/Library 
Special Functions: 
Fortran Subroutines 
for Mathematical 
Applications

Business-
SPEA

4 hour CM-212

IMSL

Math/Library: 
Fortran Subroutines 
for Mathematical 
Applications, 
Volume 1

Business-
SPEA

4 hour CM-213

IMSL

Math/Library: 
Fortran Subroutines 
for Mathematical 
Applications, 
Volume 2

Business-
SPEA

4 hour CM-214

http://www.indiana.edu/~statmath/smdoc/bylocation.html (5 of 64) [01/07/2002 21:19:26]



Software Manuals by Location

IMSL

Stat/Library: Fortran 
Subroutines for 
Statistical 
Applications, 
Volume 1

Business-
SPEA

4 hour CM-215

IMSL

Stat/Library: Fortran 
Subroutines for 
Statistical 
Applications, 
Volume 2

Business-
SPEA

4 hour CM-216

LIMDEP
Reference Guide, 
Version 7.0

Business-
SPEA

4 hour CM-220

LIMDEP
User's Manual, 
Version 7.0

Business-
SPEA

4 hour CM-219

LIMDEP
Version 6.0, 
Abridged User's 
Manual

Business-
SPEA

4 hour CM-104

LIMDEP
Version 6.0, Quick 
Reference Guide

Business-
SPEA

4 hour CM-106

LIMDEP
Version 6.0, User's 
Manual and 
Reference Guide

Business-
SPEA

4 hour CM-105

LISREL
LISREL 7 User's 
Reference Guide

Business-
SPEA

4 hour CM-112

LISREL LISREL 8
Business-
SPEA

4 hour CM-147

LISREL

LISREL 8: 
Structural Equation 
Modeling with the 
SIMPLIS Command 
Language

Business-
SPEA

4 hour CM-206

LISREL PRELIS 2
Business-
SPEA

4 hour CM-146

LISREL
PRELIS, A 
Preprocessor for 
LISREL

Business-
SPEA

4 hour CM-113
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MAPLE

Essential Maple: An 
Introduction for 
Scientific 
Programmers

Business-
SPEA

4 hour CM-211

MAPLE
Maple 5, Learning 
Guide

Business-
SPEA

4 hour CM-235

MAPLE
Maple 5, 
Programming Guide

Business-
SPEA

4 hour CM-236

MAPLE
Maple V, Learning 
Guide

Business-
SPEA

4 hour CM-263

MAPLE
Maple V, 
Programming Guide

Business-
SPEA

4 hour CM-264

MAPLE

Maple V: First 
Leaves: A Tutorial 
to Introduction to 
Maple, 3rd ed.

Business-
SPEA

4 hour CM-44

MAPLE
Maple V: Language 
Reference Manual

Business-
SPEA

4 hour CM-42

MAPLE
MAPLE VIA 
CALCULUS, 
Tutorial Approach

Business-
SPEA

4 hour CM-198

MATHEMATICA

Guide to Standard 
Mathematica 
Packages, Technical 
Report

Business-
SPEA

4 hour CM-108

MATHEMATICA

Mathematica: A 
System for Doing 
Mathematics by 
Computer: 2nd ed. 

Business-
SPEA

4 hour CM-47

MATHEMATICA

Mathematica: 
Programming in 
Mathematica: 2nd 
ed.

Business-
SPEA

4 hour CM-48

MATLAB
5.2 Product Family 
New Features, 
Version 5

Business-
SPEA

4 hour CM-269
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MATLAB
Application Program 
Interface Guide, 
Version 5

Business-
SPEA

4 hour CM-268

MATLAB
Building GUIs with 
MATLAB, Version 
5

Business-
SPEA

4 hour CM-266

MATLAB
ECONOMETRICS 
TOOLKIT, Version 
3.0

Business-
SPEA

4 hour CM-205

MATLAB
Getting Started with 
MATLAB, Version 
5

Business-
SPEA

4 hour CM-270

MATLAB

IMAGE 
PROCESSING 
TOOLBOX for Use 
with MATLAB

Business-
SPEA

4 hour CM-204

MATLAB

NEURAL 
NETWORK 
TOOLBOX for Use 
with MATLAB

Business-
SPEA

4 hour CM-201

MATLAB
Notebook User's 
Guide, Version 5

Business-
SPEA

4 hour CM-272

MATLAB
Read Me First, 
Version 5.2

Business-
SPEA

4 hour CM-271

MATLAB

SIGNAL 
PROCESSING 
TOOLBOX for Use 
with MATLAB

Business-
SPEA

4 hour CM-202

MATLAB
STATISTICS 
TOOLBOX for Use 
with MATLAB

Business-
SPEA

4 hour CM-203

MATLAB
Statistics Toolbox, 
User's Guide (for use 
with MATLAB)

Business-
SPEA

4 hour CM-262

MATLAB User's Guide
Business-
SPEA

4 hour CM-126

MATLAB
Using MATLAB 
Graphics, Version 5

Business-
SPEA

4 hour CM-267
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MATLAB
Using MATLAB, 
Version 5

Business-
SPEA

4 hour CM-265

MICROFIT
Microfit 3.0 User 
Manual

Business-
SPEA

4 hour CM-141

MICROFIT Microfit 4.0
Business-
SPEA

4 hour CM-163

MINITAB
Release 9, Reference 
Manual

Business-
SPEA

4 hour CM-107

MINITAB

Meet Minitab, 
Release 12, 
Windows 95, 
Windows NT

Business-
SPEA

4 hour CM-273

MINITAB
Minitab for the PC, 
Release 8

Business-
SPEA

4 hour CM-49

MINITAB Reference Manual
Business-
SPEA

4 hour CM-230

MINITAB
Release 11 for 
Windows, Quick 
Reference

Business-
SPEA

4 hour CM-228

MINITAB User's Guide
Business-
SPEA

4 hour CM-229

MINITAB

User's Guide 1: 
Data, Graphics, and 
Macros, Release 12, 
Windows 95 & NT

Business-
SPEA

4 hour CM-274

MINITAB

User's Guide 2: Data 
Analysis and Quality 
Tools, Release 12, 
Windows 95 & NT

Business-
SPEA

4 hour CM-275

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 1

Business-
SPEA

4 hour CM-51

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 10

Business-
SPEA

4 hour CM-60

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 11

Business-
SPEA

4 hour
CM-
60.1
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NAG
Fortran Library 
Manual, Mark 17, 
Vol. 12 (incomplete)

Business-
SPEA

4 hour
CM-
60.15

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 2

Business-
SPEA

4 hour CM-52

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 3

Business-
SPEA

4 hour CM-53

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 4

Business-
SPEA

4 hour CM-54

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 5

Business-
SPEA

4 hour CM-55

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 6

Business-
SPEA

4 hour CM-56

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 7

Business-
SPEA

4 hour CM-57

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 8

Business-
SPEA

4 hour CM-58

NAG
Fortran Library 
Manual, Mark 17, 
Vol. 9

Business-
SPEA

4 hour CM-59

OTHER Execustate 3.0
Business-
SPEA

4 hour CM-148

OTHER
Financial Data Sets: 
COMPUSTAT, 
Technical Guide

Business-
SPEA

4 hour CM-207

OTHER
IFPS/Personal User's 
Manual Tutorial, 
Release 2.5

Business-
SPEA

4 hour CM-103

OTHER
Paradox 3.5, 
Introduction

Business-
SPEA

4 hour CM-37
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OTHER

Paradox 3.5, 
Network 
Administrator's 
Guide

Business-
SPEA

4 hour CM-40

OTHER
Paradox 3.5, PAL 
User's Guide

Business-
SPEA

4 hour CM-41

OTHER
Paradox 3.5, 
Personal 
Programmer Guide

Business-
SPEA

4 hour CM-38

OTHER
Paradox 3.5, 
Presenting Data

Business-
SPEA

4 hour CM-39

OTHER
Paradox 3.5, User's 
Guide

Business-
SPEA

4 hour CM-36

OTHER

SLAM II: 
Introduction to 
Simulation and 
SLAM II

Business-
SPEA

4 hour CM-86

OTHER
STORM, Personal 
Version 3.0

Business-
SPEA

4 hour CM-166

OTHER
SyBase: Master 
Index for Server 
Publications

Business-
SPEA

4 hour CM-194

OTHER
SyBase: SQL Server 
Quick Reference 
Guide

Business-
SPEA

4 hour CM-195

OTHER
SyBase: SQL Server 
Reference Manual, 
Vol. 1

Business-
SPEA

4 hour CM-196

OTHER
SyBase: SQL Server 
Reference Manual, 
Vol. 2

Business-
SPEA

4 hour CM-197

OTHER
SyBase: SQL 
Server, Utility 
Programs for UNIX

Business-
SPEA

4 hour CM-193

OTHER
SyBase: System 
Administration 
Guide

Business-
SPEA

4 hour CM-191
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OTHER
SyBase: Transact-
SQL User's Guide

Business-
SPEA

4 hour CM-192

OTHER
X-Windows: EZ-
X11

Business-
SPEA

4 hour CM-222

RATS Cats in Rats
Business-
SPEA

4 hour CM-223

RATS

Cats in Rats: 
Cointegration 
Analysis of Time 
Series

Business-
SPEA

4 hour
CM-
223.1

RATS Version 4.0
Business-
SPEA

4 hour CM-61

SAS
Companion for the 
CMS Environment, 
Ver. 6

Business-
SPEA

4 hour CM-62

SAS
Companion for the 
Microsoft Windows 
Environment

Business-
SPEA

4 hour CM-227

SAS

Companion for the 
Microsoft Windows 
Environment, 
Version 6

Business-
SPEA

4 hour CM-210

SAS

Companion for the 
UNIX Environment 
& Derivatives, 
Version 6

Business-
SPEA

4 hour CM-165

SAS

Companion for 
UNIX 
Environments: 
Language, Version 6 
1st ed.

Business-
SPEA

4 hour CM-76

SAS

Companion for 
UNIX 
Environments: User 
Interfaces, Version 
6, 1st ed.

Business-
SPEA

4 hour
CM-
76.1

SAS
CONNECT 
Software Usage & 
Reference, Ver. 6

Business-
SPEA

4 hour CM-74

http://www.indiana.edu/~statmath/smdoc/bylocation.html (12 of 64) [01/07/2002 21:19:27]



Software Manuals by Location

SAS
Connect Software, 
Usage and 
Reference, Version 6

Business-
SPEA

4 hour CM-208

SAS
ETS User's Guide, 
Ver. 6 ed.

Business-
SPEA

4 hour CM-75

SAS GRAPH Software
Business-
SPEA

4 hour CM-80

SAS
GRAPH Software 
Introduction, Ver. 6

Business-
SPEA

4 hour CM-77

SAS
GRAPH Software, 
Vol. 1

Business-
SPEA

4 hour CM-81

SAS
GRAPH Software, 
Vol. 2

Business-
SPEA

4 hour CM-82

SAS
Guide to Macro 
Processing, Ver. 6

Business-
SPEA

4 hour CM-64

SAS
Guide to SQL 
Procedure: Usage & 
Reference, Ver. 6

Business-
SPEA

4 hour CM-65

SAS
Guide to 
TABULATE 
Processing

Business-
SPEA

4 hour CM-78

SAS
Guide to the 
REPORT Procedure

Business-
SPEA

4 hour CM-67

SAS
IML Usage & 
Reference, Ver. 6

Business-
SPEA

4 hour CM-79

SAS
INSIGHT User's 
Guide

Business-
SPEA

4 hour CM-73

SAS
Introductory Guide 
for Personal 
Computers, 6.03

Business-
SPEA

4 hour CM-142

SAS
Language & 
Procedures, Usage, 
Ver. 6

Business-
SPEA

4 hour CM-66

SAS
Language & 
Procedures: 
Introduction, Ver. 6

Business-
SPEA

4 hour CM-68
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SAS
OR User's Guide, 
Version 6

Business-
SPEA

4 hour CM-102

SAS
Procedures Guide, 
Version 6, 3rd ed.

Business-
SPEA

4 hour CM-98

SAS
QC Software, 
Reference, Version 6

Business-
SPEA

4 hour CM-101

SAS
QC Software, Usage 
& Reference, Vol. 1

Business-
SPEA

4 hour CM-217

SAS
QC Software, Usage 
& Reference, Vol. 2

Business-
SPEA

4 hour CM-218

SAS
SAS/STAT User's 
Guide, 6.03

Business-
SPEA

4 hour CM-143

SAS
Screen Control 
Language, 
Reference, Version 6

Business-
SPEA

4 hour CM-99

SAS
Screen Control 
Language, 
Reference, Version 6

Business-
SPEA

4 hour CM-209

SAS
Screen Control 
Language, Usage, 
Version 6

Business-
SPEA

4 hour CM-100

SAS

STAT Software: 
Changes and 
Enhancements, 
through Release 6.11

Business-
SPEA

4 hour CM-221

SAS
STAT User's Guide, 
Vol. 1, ANOVA-
FREQ, Ver. 6

Business-
SPEA

4 hour CM-83

SAS
STAT User's Guide, 
Vol. 2, GLM-
VARCOMP, Ver. 6

Business-
SPEA

4 hour CM-84

SAS
Technical Report P-
188, Version 6

Business-
SPEA

4 hour CM-116

SAS
Technical Report P-
195

Business-
SPEA

4 hour CM-69

SAS
Technical Report P-
222

Business-
SPEA

4 hour CM-70
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SAS

Technical Report P-
229, SAS/STAT 
Software: Changes 
& Enhancements, 
Release 6.07

Business-
SPEA

4 hour CM-167

SAS
Technical Report P-
243

Business-
SPEA

4 hour CM-144

SAS
Technical Report: P-
196, Ver. 6

Business-
SPEA

4 hour CM-71

SAS
Technical Report: P-
204, Ver. 6

Business-
SPEA

4 hour CM-72

S-PLUS
for Windows: A 
Crash Course

Business-
SPEA

4 hour CM-239

S-PLUS
for Windows: A 
General Introduction

Business-
SPEA

4 hour CM-238

S-PLUS
Gentle Introduction, 
UNIX

Business-
SPEA

4 hour CM-245

S-PLUS
Guide to Statistical 
& Mathematical 
Analysis

Business-
SPEA

4 hour CM-243

S-PLUS
Programmer's 
Manual

Business-
SPEA

4 hour CM-241

S-PLUS
Trellis Graphics 
User's Manual, 
Windows & UNIX

Business-
SPEA

4 hour CM-244

S-PLUS User's Manual
Business-
SPEA

4 hour CM-242

S-PLUS
User's Manual, 
UNIX

Business-
SPEA

4 hour CM-247

S-PLUS

Version 3.3 for 
Windows: Guide to 
Statistical & 
Mathematical 
Analysis

Business-
SPEA

4 hour CM-240

S-PLUS
Version 3.3 
Supplement Unix

Business-
SPEA

4 hour CM-237

S-PLUS
Version 3.4 for 
UNIX, Supplement

Business-
SPEA

4 hour CM-246
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SPSS
6.1 Base System 
User's Guide, Part 1, 
Unix Version

Business-
SPEA

4 hour
CM-
152c

SPSS
6.1 Base System 
User's Guide, Part 2

Business-
SPEA

4 hour
CM-
152d

SPSS
6.1 Syntax 
Reference Guide

Business-
SPEA

4 hour
CM-
152e

SPSS
Advanced Statistics 
7.5

Business-
SPEA

4 hour CM-151

SPSS
Advanced Statistics 
User's Guide, 1990

Business-
SPEA

4 hour CM-88

SPSS
Base 7.5 
Applications Guide

Business-
SPEA

4 hour
CM-
151c

SPSS
Base 7.5 for 
Windows, User's 
Guide

Business-
SPEA

4 hour CM-150

SPSS
Base System User's 
Guide

Business-
SPEA

4 hour CM-92

SPSS Categories 6.1
Business-
SPEA

4 hour
CM-
152b

SPSS Categories, 1989
Business-
SPEA

4 hour CM-90

SPSS
for the Macintosh: 
Operations Guide

Business-
SPEA

4 hour CM-169

SPSS
for Windows, 
Advanced Statistics

Business-
SPEA

4 hour CM-140

SPSS
for Windows, Base 
System User's 
Guide, 6.0

Business-
SPEA

4 hour CM-138

SPSS
for Windows, 
CHAID, 6.0

Business-
SPEA

4 hour CM-149

SPSS
for Windows, 
Professional 
Statistics

Business-
SPEA

4 hour CM-139

SPSS Graphics
Business-
SPEA

4 hour CM-97
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SPSS
Introductory 
Statistics Student 
Guide, 1990

Business-
SPEA

4 hour CM-93

SPSS
LISREL 7 and 
PRELIS User's 
Guide and Reference

Business-
SPEA

4 hour CM-95

SPSS
PC+ Advanced 
Statistics, Version 
5.0

Business-
SPEA

4 hour CM-124

SPSS
PC+ Base System 
User's Guide, 
Version 5.0

Business-
SPEA

4 hour CM-123

SPSS
PC+ Professional 
Statistics, Version 
5.0

Business-
SPEA

4 hour CM-125

SPSS
PC+4.0 Base 
Manual

Business-
SPEA

4 hour
CM-
152f

SPSS
Professional 
Statistics 7.5

Business-
SPEA

4 hour
CM-
151b

SPSS
QI Analyst Gage 
R&R 1.0

Business-
SPEA

4 hour
CM-
152a

SPSS Reference Guide
Business-
SPEA

4 hour CM-94

SPSS
Statistical 
Algorithms, 2nd ed.

Business-
SPEA

4 hour CM-96

SPSS Tables 7.5
Business-
SPEA

4 hour
CM-
151a

SPSS Trends 6.1
Business-
SPEA

4 hour CM-152

STATA
Getting Started, 
Windows, Release 5

Business-
SPEA

4 hour CM-109

STATA
Stata: Getting 
Started (Windows)

Business-
SPEA

4 hour CM-224

STATA
Statistics User's 
Guide, Release 5

Business-
SPEA

4 hour CM-110
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STATA

Statistics, Data 
Management, 
Graphics, Reference 
A-F, Release 5

Business-
SPEA

4 hour CM-111

STATA

Statistics, Data 
Management, 
Graphics, Reference 
G-O, Release 5

Business-
SPEA

4 hour
CM-
111.1

STATA

Statistics, Data 
Management, 
Graphics, Reference 
P-Z, Release 5

Business-
SPEA

4 hour
CM-
111.2

SYSTAT
SYSTAT 7.0 for 
Windows, Command 
Reference

Business-
SPEA

4 hour CM-231

SYSTAT
SYSTAT 7.0 for 
Windows, Data

Business-
SPEA

4 hour CM-232

SYSTAT
SYSTAT 7.0 for 
Windows, Graphics

Business-
SPEA

4 hour CM-234

SYSTAT
SYSTAT 7.0 for 
Windows, New 
Statistics

Business-
SPEA

4 hour
CM-
234.5

SYSTAT
SYSTAT 7.0 for 
Windows, Statistics

Business-
SPEA

4 hour CM-233

TSP
Reference Manual, 
Version 4.2

Business-
SPEA

4 hour CM-122

TSP
User's Guide, 
Version 4.2

Business-
SPEA

4 hour CM-121

Education Library

AMOS
AMOS User's Guide 
v 3.6

Education 2 hour  

BMDP
BMDP Statistical 
Software Manual, 
Vol. 1

Education 2 hour  

BMDP
BMDP Statistical 
Software Manual, 
Vol. 2

Education 2 hour  
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BMDP
BMDP Statistical 
Software Manual, 
Vol. 3

Education 2 hour  

BMDP User's Digest Education 2 hour  

DBMS/COPY Version 5.0 Education 2 hour  

DBMS/COPY
Version 5.10 
Addendum

Education 2 hour  

DBMS/COPY Version 6.0 Education 2 hour  

GSP
Macintosh Quick 
Reference

Education 2 hour  

GSP
Teaching Geometry 
(Notes & Activities)

Education 2 hour  

GSP
User Guide & 
Reference Manual 
(Mac)

Education 2 hour  

GSP
User Guide & 
Reference Manual 
(Windows)

Education 2 hour  

IMSL
C/Math/Library-
Mathematical 
Analyis

Education 2 hour  

IMSL
C/Math/Library-
Statistical Analysis

Education 2 hour  

IMSL
FORTRAN: 
Mathematical 
Applications

Education 2 hour  

IMSL

FORTRAN: 
Mathematical 
Applications - 
Special Functions

Education 2 hour  

IMSL
FORTRAN: 
Statistical Analysis

Education 2 hour  

LIMDEP
LIMDEP 6.0 
Abridged User's 
Manual

Education 2 hour  

LIMDEP
LIMDEP 6.0 Quick 
Reference Guide

Education 2 hour  
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LIMDEP
LIMDEP 6.0 User 
Manual & Reference 
Guide

Education 2 hour  

LISREL
Advanced Statistics 
7.5

Education 2 hour  

LISREL
Base 7.5 
Applications Guide

Education 2 hour  

LISREL
Base 7.5 for 
Windows (User's 
Guide)

Education 2 hour  

LISREL
Base 8.0 
Applications Guide

Education 2 hour  

LISREL
Base 8.0 Interactive 
Graphics

Education 2 hour  

LISREL
Base 8.0 Syntax 
Reference Guide

Education 2 hour  

LISREL
Base 8.0 User's 
Guide

Education 2 hour  

LISREL
LISREL 8 (User's 
Reference Guide)

Education 2 hour  

LISREL
PC+ Base System 
User's Guide (5.0)

Education 2 hour  

LISREL
PRELIS 2 
(Documentation)

Education 2 hour  

LISREL
Professional 
Statistics 6.1

Education 2 hour  

LISREL
Professional 
Statistics 7.5

Education 2 hour  

LISREL Tables 7.0 Education 2 hour  

LISREL Tables 7.5 Education 2 hour  

LISREL
Windows CHAID 
Release 6.0

Education 2 hour  

MAPLE Learning Guide Education 2 hour  

MAPLE Programming Guide Education 2 hour  

MAPLE Quick Reference Education 2 hour  
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MATLAB
Statistics Toolbox 
User's Guide

Education 2 hour  

MATLAB
Version 5: 
Documentation Set

Education 2 hour  

MINITAB
Meet Minitab 
Release 12 

Education 2 hour  

MINITAB
Release 12: User's 
Guide 1

Education 2 hour  

MINITAB
Release 12: User's 
Guide 2

Education 2 hour  

NAG
FORTRAN Mark 17 
Introductory Guide

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 1

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 10

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 11

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 12

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 2

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 3

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 4

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 5

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 6

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 7

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 8

Education 2 hour  

NAG
FORTRAN Mark 17 
Volume 9

Education 2 hour  
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OTHER
X-Windows: EZ-Xll 
User's Manual 2.00

Education 2 hour  

RATS
CATS in RATS: 
Cointegration 
Analysis...

Education 2 hour  

RATS
RATS: Regression 
Analysis of Time 
Series

Education 2 hour  

SAS
Companion...UNIX 
Environments: 
Language

Education 2 hour  

SAS
Companion...UNIX 
Environments: User 
Int.

Education 2 hour  

SAS
Doing More with 
SAS/ASSIST 
Software

Education 2 hour  

SAS ETS User's Guide Education 2 hour  

SAS
Getting Started with 
the SAS System

Education 2 hour  

SAS
GRAPH Software 
Reference Volume 1

Education 2 hour  

SAS
GRAPH Software 
Reference Volume 2

Education 2 hour  

SAS
GRAPH Software 
Syntax

Education 2 hour  

SAS
INSIGHT User's 
Guide

Education 2 hour  

SAS Language Education 2 hour  

SAS Procedures Guide Education 2 hour  

SAS QC Software Education 2 hour  

SAS
STAT Software: 
Changes & 
Enhancements Copy

Education 2 hour  

SAS
STAT User's Guide 
Volume 1

Education 2 hour  
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SAS
STAT User's Guide 
Volume 2

Education 2 hour  

SPSS
6.1 Base System 
User's Guide 
(UNIX) pt.2

Education 2 hour  

SPSS
6.1 Base System 
User's Guide 
(UNIX) pt.l

Education 2 hour  

SPSS
Advanced Statistics 
6.1

Education 2 hour  

SPSS
Advanced Statistics 
7.0 Update

Education 2 hour  

SPSS
Base 7.0 for 
Windows (User's 
Guide)

Education 2 hour  

SPSS
Base 7.0 Syntax 
Reference Guide

Education 2 hour  

SPSS
Base System User's 
Guide

Education 2 hour  

SPSS Categories 6.1 Education 2 hour  

SPSS Reference Guide Education 2 hour  

SPSS Trends 6.1 Education 2 hour  

STATA
Reference Manual 
Release 4 (v.1)

Education 2 hour  

STATA
Reference Manual 
Release 4 (v.2)

Education 2 hour  

STATA
Reference Manual 
Release 4 (v.3)

Education 2 hour  

SYSTAT
6.0: Command 
Reference

Education 2 hour  

SYSTAT 6.0: Data Education 2 hour  

SYSTAT 6.0: Graphics Education 2 hour  

SYSTAT 6.0: Statistics Education 2 hour  

SYSTAT
7.0: Comand 
Reference

Education 2 hour  

SYSTAT 7.0: Data Education 2 hour  
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SYSTAT 7.0: Graphics Education 2 hour  

SYSTAT 7.0: New Statistics Education 2 hour  

SYSTAT 7.0: Statistics Education 2 hour  

Language and Computer Lab

DBMS/COPY DBMS/COPY, v. 6

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

ETHNOGRAPH
The Ethnograph, v. 
5.0, User's Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

LIMDEP
Limdep, v. 7, User's 
Manual

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MAPLE
Maple V, Learning 
Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MAPLE
Maple V, 
Programming Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MATHEMATICA
Mathematica, second 
Edition

Language 
and 
Computer 
Lab 
(BH120)

On-
Site
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MATLAB
MatLab, v. 5, 
Getting Started

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MATLAB
MatLab, v. 5, 
Graphics

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MATLAB
MatLab, v. 5, Using 
MatLab

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MICROFIT
Microfit 4.0, 
Windows Version

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MINITAB
Minitab, Release 12, 
Meet Minitab

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MINITAB
Minitab, Release 12, 
User's Guide 1

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

MINITAB
Minitab, Release 12, 
User's Guide 2

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

NUDIST
QSR*NUDIST 
Merge, 4, User's 
Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site
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NUDIST
QSR*NUDIST, 4, 
User's Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

RATS
RATS, v. 4, 
Analysis of Time 
Series 

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

RESAMPLING 
STATS

Resampling Stats, 
User's Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SAS

SAS, v. 6, first 
edition, Language 
and Procedures, 
Introduction

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SAS
SAS, v. 6, first 
edition, Language 
Reference

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SAS
SAS, v. 6, third 
edition, Procedures 
Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SAS
SAS/STAT, v. 6, 
fourth edition, User's 
Guide, Vol. 1

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SAS
SAS/STAT, v. 6, 
fourth edition, User's 
Guide, Vol. 2

Language 
and 
Computer 
Lab 
(BH120)

On-
Site
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SIGMAPLOT
SigmaPlot, v. 5.0, 
Programming Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SIGMAPLOT
SigmaPlot, v. 5.0, 
User's Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SPSS
SPSS, v. 8.0, Base, 
User's Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SPSS
SPSS, v. 8.0, 
Interactive Graphics

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SPSS
SPSS, v. 9.0, 
Advanced Models

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SPSS
SPSS, v. 9.0, Base, 
Applications Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SPSS
SPSS, v. 9.0, Base, 
Syntax Ref. Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SPSS
SPSS, v. 9.0, Base, 
User's Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

http://www.indiana.edu/~statmath/smdoc/bylocation.html (27 of 64) [01/07/2002 21:19:28]



Software Manuals by Location

SPSS
SPSS, v. 9.0, 
Interactive Graphics

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SPSS
SPSS, v. 9.0, 
Regression Models

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

STATA
STATA, Release 4, 
Ref. Manual, Vol. 1

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

STATA
STATA, Release 4, 
Ref. Manual, Vol. 2

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

STATA
STATA, Release 4, 
Ref. Manual, Vol. 3

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

STATA
STATA, Release 5, 
Getting Started

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

STATA
STATA, Release 5, 
Ref. A-F

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

STATA
STATA, Release 5, 
Ref. G-O

Language 
and 
Computer 
Lab 
(BH120)

On-
Site
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STATA
STATA, Release 5, 
Ref. P-Z

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

STATA
STATA, Release 5, 
User's Guide

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SYSTAT
SYSTAT, v. 7, 
Command Reference

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SYSTAT
SYSTAT, v. 7, 
DATA

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SYSTAT
SYSTAT, v. 7, 
Graphics

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SYSTAT
SYSTAT, v. 7, New 
Statistics

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

SYSTAT
SYSTAT, v. 7, 
Statistics

Language 
and 
Computer 
Lab 
(BH120)

On-
Site

 

Swain Hall Library

AMOS
AMOS User's Guide 
v 3.6

Swain 
Hall

3 day
swn 
UITS 
093
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AUTOCAD
AutoCAD 14 
Installation Guide

Swain 
Hall

3 day
swn 
UITS 
432

AUTOCAD
AutoCAD 
Command Reference

Swain 
Hall

3 day
swn 
UITS 
433

AUTOCAD
AutoCAD 
Customization 
Guide

Swain 
Hall

3 day
swn 
UITS 
435

AUTOCAD
AutoCAD User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
434

BMDP Data Manage vol. 3
Swain 
Hall

3 day
swn 
UITS 
069

BMDP
Statistical Software 
Manual vol. 1

Swain 
Hall

3 day
swn 
UITS 
258

BMDP
Statistical Software 
Manual vol. 2

Swain 
Hall

3 day
swn 
UITS 
259

ETHNOGRAPH User's Guide
Swain 
Hall

3 day
swn 
UITS 
060

GAUSS Command Reference
Swain 
Hall

3 day
swn 
UITS 
411

GAUSS
Constrained 
Maximum 
Likelihood

Swain 
Hall

3 day
swn 
UITS 
411B

GAUSS
Constrained 
Optimization

Swain 
Hall

3 day
swn 
UITS 
411A

GAUSS Descriptive Statistics
Swain 
Hall

3 day
swn 
UITS 
420
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GAUSS Linear Programming
Swain 
Hall

3 day
swn 
UITS 
419

GAUSS Linear Regression
Swain 
Hall

3 day
swn 
UITS 
422

GAUSS Loglinear Analysis
Swain 
Hall

3 day
swn 
UITS 
416

GAUSS

MARKOV 
Statistical 
Environment for 
GAUSS 3.1

Swain 
Hall

3 day
swn 
UITS 
412

GAUSS
Maximum 
Likelihood

Swain 
Hall

3 day
swn 
UITS 
421

GAUSS Nonlinear Equations
Swain 
Hall

3 day
swn 
UITS 
414

GAUSS Optimization
Swain 
Hall

3 day
swn 
UITS 
418

GAUSS Quantal Response
Swain 
Hall

3 day
swn 
UITS 
417

GAUSS
System and Graphics 
Manual

Swain 
Hall

3 day
swn 
UITS 
410

GAUSS Time Series
Swain 
Hall

3 day
swn 
UITS 
415

GLIM GLIM system rel. 4
Swain 
Hall

3 day
swn 
UITS 
431

GSP

Exploring Conic 
Sections with the 
Geometer's 
Sketchpad

Swain 
Hall

3 day
swn 
UITS 
233
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GSP

Exploring 
Trigonometry with 
The Geometer's 
Sketchpad (Copy 
NBR)

Swain 
Hall

3 day
swn 
UITS 
230

GSP
Perspective Drawing 
with the Geometer's 
Sketchpad

Swain 
Hall

3 day
swn 
UITS 
231

GSP

Pythagoras Plugged 
in Proofs and 
Problems for the 
Geometer's.

Swain 
Hall

3 day
swn 
UITS 
232

IMSL
C functions for 
mathematical 
applications

Swain 
Hall

3 day
swn 
UITS 
185

IMSL
C functions for 
statistical analysis

Swain 
Hall

3 day
swn 
UITS 
186

IMSL

FORTRAN 
subroutines for 
mathematical 
applications, special 

Swain 
Hall

3 day
swn 
UITS 
065

IMSL

FORTRAN 
subroutines for 
mathematical 
applications, vol. 1

Swain 
Hall

3 day
swn 
UITS 
063

IMSL

FORTRAN 
subroutines for 
mathematical 
applications, vol. 2

Swain 
Hall

3 day
swn 
UITS 
064

IMSL

FORTRAN 
subroutines for 
statistical 
applications, vol. 1

Swain 
Hall

3 day
swn 
UITS 
061

IMSL

FORTRAN 
subroutines for 
statistical 
applications, vol. 2

Swain 
Hall

3 day
swn 
UITS 
062
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LIMDEP
Reference Guide, 
version 7.0

Swain 
Hall

3 day
swn 
UITS 
002

LIMDEP
User's Manual, 
version 7.0

Swain 
Hall

3 day
swn 
UITS 
003

LINDO
An Optimization 
Modelling System

Swain 
Hall

3 day
swn 
UITS 
079

LINDO User's Manual
Swain 
Hall

3 day
swn 
UITS 
078

LISREL
LISREL 8 and 
PRELIS 2 
Documentation

Swain 
Hall

3 day
swn 
UITS 
072

LISREL

Structural Equation 
Modeling with the 
SIMPLIS Command 
Lang.

Swain 
Hall

3 day
swn 
UITS 
070

LISREL
User's Reference 
Guide

Swain 
Hall

3 day
swn 
UITS 
071

MAPLE
Calculus with Maple 
V

Swain 
Hall

3 day
swn 
UITS 
249

MAPLE Essential MAPLE
Swain 
Hall

3 day
swn 
UITS 
253

MAPLE
Introduction to 
MAPLE

Swain 
Hall

3 day
swn 
UITS 
252

MAPLE
Maple V Library 
Reference Manual

Swain 
Hall

3 day
swn 
UITS 
251

MAPLE
Maple via Calculas: 
A Tutorial Approach

Swain 
Hall

3 day
swn 
UITS 
250
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MAPLE

Mathematical 
Computation with 
Maple V: Ideas and 
Appl. 

Swain 
Hall

3 day
swn 
UITS 
251A

MAPLE
Quantum Mechanics 
Using Maple

Swain 
Hall

3 day
swn 
UITS 
223

MATHEMATICA
A first look at 
Mathematica

Swain 
Hall

3 day
swn 
UITS 
262

MATHEMATICA Mathematica Book
Swain 
Hall

3 day
swn 
UITS 
264

MATHEMATICA
Mathematica 
Standard Add-on 
Packages

Swain 
Hall

3 day
swn 
UITS 
263

MATHEMATICA
Programming in 
Mathematica, 2nd 
Edition

Swain 
Hall

3 day
swn 
UITS 
051

MATLAB
Application Program 
Interface Guide

Swain 
Hall

3 day
swn 
UITS 
265E

MATLAB
Building GUIs with 
Matlab

Swain 
Hall

3 day
swn 
UITS 
265H

MATLAB
Excel Link User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
265J

MATLAB
Mapping Toolbox 
Reference Guide

Swain 
Hall

3 day
swn 
UITS 
265D

MATLAB
Mapping Toolbox 
User's Guide

Swain 
Hall

3 day
swn 
UITS 
265C

MATLAB
MATLAB Notebook 
User's Guide

Swain 
Hall

3 day
swn 
UITS 
265G
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MATLAB
Matlab Primer, 5th 
edition

Swain 
Hall

3 day
swn 
UITS 
224

MATLAB
Neural Network 
Toolbox

Swain 
Hall

3 day
swn 
UITS 
265A

MATLAB
SIMULINK User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
430

MATLAB Statistics Toolbox
Swain 
Hall

3 day
swn 
UITS 
265B

MATLAB Using MATLAB
Swain 
Hall

3 day
swn 
UITS 
265I

MATLAB
Using Matlab 
Graphics

Swain 
Hall

3 day
swn 
UITS 
265F

MINITAB Minitab Primer
Swain 
Hall

3 day
swn 
UITS 
261

MINITAB
Minitab Reference 
Manual. Release 9

Swain 
Hall

3 day
swn 
UITS 
260

NAG
FORTRAN Library 
Manual, vol. 1

Swain 
Hall

3 day
swn 
UITS 
153

NAG
FORTRAN Library 
Manual, vol. 10

Swain 
Hall

3 day
swn 
UITS 
162

NAG
FORTRAN Library 
Manual, vol. 11

Swain 
Hall

3 day
swn 
UITS 
163

NAG
FORTRAN Library 
Manual, vol. 12

Swain 
Hall

3 day
swn 
UITS 
164
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NAG
FORTRAN Library 
Manual, vol. 2

Swain 
Hall

3 day
swn 
UITS 
154

NAG
FORTRAN Library 
Manual, vol. 3

Swain 
Hall

3 day
swn 
UITS 
155

NAG
FORTRAN Library 
Manual, vol. 4

Swain 
Hall

3 day
swn 
UITS 
156

NAG
FORTRAN Library 
Manual, vol. 5

Swain 
Hall

3 day
swn 
UITS 
157

NAG
FORTRAN Library 
Manual, vol. 6

Swain 
Hall

3 day
swn 
UITS 
158

NAG
FORTRAN Library 
Manual, vol. 7

Swain 
Hall

3 day
swn 
UITS 
159

NAG
FORTRAN Library 
Manual, vol. 8

Swain 
Hall

3 day
swn 
UITS 
160

NAG
FORTRAN Library 
Manual, vol. 9

Swain 
Hall

3 day
swn 
UITS 
161

NAG
FORTRAN Library, 
Introductory Guide

Swain 
Hall

3 day
swn 
UITS 
152

OTHER
Econometrics 
Toolkit Version 3.0

Swain 
Hall

3 day
swn 
UITS 
083

OTHER

Ingres-SQL: 
Database 
Administrator's 
Guide for the UNIX 
Operating System

Swain 
Hall

3 day
swn 
UITS 
442

OTHER

Ingres-SQL: 
Embedded 
OpenSQL Forms 
Reference Manual

Swain 
Hall

3 day
swn 
UITS 
438
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OTHER

Ingres-SQL: 
ESQL/QUEL 
Companion Guide 
For C

Swain 
Hall

3 day
swn 
UITS 
439

OTHER

Ingres-SQL: 
Interactive 
Performance 
Monitor User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
179

OTHER

Ingres-SQL: 
Interactive 
Performance 
Monitor User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
449

OTHER
Ingres-SQL: Net 
User's Guide rel. 6.4

Swain 
Hall

3 day
swn 
UITS 
448

OTHER

Ingres-SQL: 
OpenSQL Reference 
Manual for the 
UNIX and VMS 
Operating Sys

Swain 
Hall

3 day
swn 
UITS 
443

OTHER

Ingres-SQL: QUEL 
Reference Manual 
for UNIX and VMS 
Operating System

Swain 
Hall

3 day
swn 
UITS 
445

OTHER
Ingres-SQL: Report-
Writer Reference 
Manual

Swain 
Hall

3 day
swn 
UITS 
446

OTHER
Ingres-SQL: SQL 
Reference Manual

Swain 
Hall

3 day
swn 
UITS 
437

OTHER
Ingres-SQL: Vision 
User's Guide rel. 6.4

Swain 
Hall

3 day
swn 
UITS 
447

OTHER
SyBase: APT 
Workbench 
Reference Manuals

Swain 
Hall

3 day
swn 
UITS 
459
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OTHER
SyBase: APT 
Workbench User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
460

OTHER
SyBase: Data 
Workbench User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
461

OTHER
SyBase: Master 
Index For Server 
Publications

Swain 
Hall

3 day
swn 
UITS 
456

OTHER
SyBase: Report 
Workbench User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
457

OTHER
SyBase: SQL Server 
Quick Reference 
Guide

Swain 
Hall

3 day
swn 
UITS 
454

OTHER
SyBase: SQL Server 
Reference Manual 
vol. 2

Swain 
Hall

3 day
swn 
UITS 
451

OTHER
SyBase: SQL Server 
Reference 
Manualvol. 1

Swain 
Hall

3 day
swn 
UITS 
450

OTHER

SyBase: SQL Server 
System 
Administration 
Guide

Swain 
Hall

3 day
swn 
UITS 
453

OTHER
SyBase: SQL Server 
Utility Programs For 
Unix

Swain 
Hall

3 day
swn 
UITS 
452

OTHER

SyBase: SQL 
Toolset 
Administration 
Guide

Swain 
Hall

3 day
swn 
UITS 
458

OTHER
SyBase: Transact-
SQL User's Guide

Swain 
Hall

3 day
swn 
UITS 
455
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OTHER

X-Windows: User 
Commands MIT X 
Consortium 
StandardX version 
11

Swain 
Hall

3 day
swn 
UITS 
269

OTHER

X-Windows: C 
Language Interface 
X Window System 
X version 11 (Copy 
NBR)

Swain 
Hall

3 day
swn 
UITS 
274

OTHER

X-Windows: C 
Language Interface 
X Window System 
X version 11

Swain 
Hall

3 day
swn 
UITS 
275

OTHER

X-Windows: Inter-
client 
Communication 
Conventions Manual 
...

Swain 
Hall

3 day
swn 
UITS 
273

OTHER

X-Windows: MIT X 
Consortium 
Standard X version 
11

Swain 
Hall

3 day
swn 
UITS 
276

RATS

CATS in RATS: 
Cointegration 
Analysis of Time 
Series

Swain 
Hall

3 day
swn 
UITS 
279

RATS
EZ-X11 User's 
Manual

Swain 
Hall

3 day
swn 
UITS 
277

RATS
Regression Analysis 
of Time Series

Swain 
Hall

3 day
swn 
UITS 
278

RESAMPLING 
STATS

User's Guide; IBM 
Version 3.14

Swain 
Hall

3 day
swn 
UITS 
148

SAS
AF Software: Usage 
and Reference

Swain 
Hall

3 day
swn 
UITS 
009
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SAS
Companion for the 
CMS Environment, 
ver. 6

Swain 
Hall

3 day
swn 
UITS 
010

SAS

Companion for the 
Microsoft Windows 
Environment, 
version 6

Swain 
Hall

3 day
swn 
UITS 
029

SAS
Companion for the 
VMS Environment, 
ver. 6

Swain 
Hall

3 day
swn 
UITS 
011

SAS

Companion for 
UNIX 
Environments: 
Language

Swain 
Hall

3 day
swn 
UITS 
031

SAS

Companion for 
UNIX 
Environments: User 
Interfaces (Copy 
NB)

Swain 
Hall

3 day
swn 
UITS 
032

SAS
CONNECT 
Software: Usage and 
Reference, ver. 6

Swain 
Hall

3 day
swn 
UITS 
012

SAS
ETS User's Guide, 
ver. 6

Swain 
Hall

3 day
swn 
UITS 
013

SAS
FSP Software: 
Usage and 
Reference, ver. 6

Swain 
Hall

3 day
swn 
UITS 
014

SAS

Guide to SQL 
Procedure: Usage 
and Reference, ver. 
6

Swain 
Hall

3 day
swn 
UITS 
019

SAS
IML Software: 
Usage and 
Reference, ver. 6

Swain 
Hall

3 day
swn 
UITS 
020

SAS
INSIGHT User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
033
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SAS

Introductory Guide 
for Personal 
Computers, release 
6.03

Swain 
Hall

3 day
swn 
UITS 
008

SAS

Language and 
Procedures: 
Introduction, version 
6

Swain 
Hall

3 day
swn 
UITS 
007

SAS
Language and 
Procedures: Usage, 
ver. 6

Swain 
Hall

3 day
swn 
UITS 
021

SAS
Language: 
Reference, ver. 6

Swain 
Hall

3 day
swn 
UITS 
022

SAS
OR User's Guide, 
ver. 6

Swain 
Hall

3 day
swn 
UITS 
023

SAS
Procedure's Guide, 
ver. 6

Swain 
Hall

3 day
swn 
UITS 
024

SAS
QC Software: 
Reference, ver. 6

Swain 
Hall

3 day
swn 
UITS 
025

SAS
STAT Software: 
Changes and 
Enhancements

Swain 
Hall

3 day
swn 
UITS 
030

SAS
STAT User's Guide 
v.2

Swain 
Hall

3 day
swn 
UITS 
028

SAS
STAT User's Guide, 
v.1

Swain 
Hall

3 day
swn 
UITS 
027

SIGMAPLOT Programming Guide
Swain 
Hall

3 day
swn 
UITS 
049

SIGMAPLOT User's Guide
Swain 
Hall

3 day
swn 
UITS 
050
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S-PLUS
S-Plus: A Crash 
Course in S-Plus

Swain 
Hall

3 day
swn 
UITS 
301

S-PLUS
S-Plus: A Gentle 
Introduction to S-
Plus

Swain 
Hall

3 day
swn 
UITS 
302

S-PLUS
S-Plus: 
Programmer's 
Manual

Swain 
Hall

3 day
swn 
UITS 
306

S-PLUS
S-Plus: Version 3.3 
Supplement

Swain 
Hall

3 day
swn 
UITS 
300

S-PLUS User's Manual vol.1
Swain 
Hall

3 day
swn 
UITS 
304

S-PLUS User's Manual Vol.2
Swain 
Hall

3 day
swn 
UITS 
305

S-PLUS
Version 3.2 
Supplement

Swain 
Hall

3 day
swn 
UITS 
303

SPSS
Advanced Models 
9.0

Swain 
Hall

3 day
swn 
UITS 
106

SPSS
Advanced Statistics 
7.5

Swain 
Hall

3 day
swn 
UITS 
096

SPSS
Advanced Statistics 
Student Guide

Swain 
Hall

3 day
swn 
UITS 
044

SPSS
Advanced Statistics 
User's Guide

Swain 
Hall

3 day
swn 
UITS 
045

SPSS
Base System User's 
Guide

Swain 
Hall

3 day
swn 
UITS 
039
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SPSS
Base System User's 
Guide, Part 2

Swain 
Hall

3 day
swn 
UITS 
092

SPSS
Base System, Part 1, 
UNIX

Swain 
Hall

3 day
swn 
UITS 
091

SPSS Categories
Swain 
Hall

3 day
swn 
UITS 
043

SPSS Categories 8.0
Swain 
Hall

3 day
swn 
UITS 
098

SPSS Categories 8.0
Swain 
Hall

3 day
swn 
UITS 
107

SPSS Conjoist 8.0
Swain 
Hall

3 day
swn 
UITS 
099

SPSS
Data Entry Builder 
1.0

Swain 
Hall

3 day
swn 
UITS 
100

SPSS
Interactive Graphics 
9.0

Swain 
Hall

3 day
swn 
UITS 
104

SPSS
Introductory 
Statistics Student 
Guide

Swain 
Hall

3 day
swn 
UITS 
040

SPSS
Professional 
Statistics 7.5

Swain 
Hall

3 day
swn 
UITS 
095

SPSS Reference Guide
Swain 
Hall

3 day
swn 
UITS 
038

SPSS
Regression Models 
9.0

Swain 
Hall

3 day
swn 
UITS 
105
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SPSS
SPSS Base 9.0 
Applications Guide

Swain 
Hall

3 day
swn 
UITS 
101

SPSS
SPSS Base 9.0 
Syntax Reference 
Guide

Swain 
Hall

3 day
swn 
UITS 
097

SPSS
SPSS Base 9.0 
User's Guide

Swain 
Hall

3 day
swn 
UITS 
102

SPSS
SPSS for UNIX 
Operations Guide

Swain 
Hall

3 day
swn 
UITS 
404

SPSS Tables 8.0
Swain 
Hall

3 day
swn 
UITS 
103

SPSS Trends 6.1
Swain 
Hall

3 day
swn 
UITS 
094

SPSS User Code
Swain 
Hall

3 day
swn 
UITS 
090

STATA
Reference Manual 
Release 4: vol. 1

Swain 
Hall

3 day
swn 
UITS 
195

STATA
Reference Manual 
Release 4: vol. 2

Swain 
Hall

3 day
swn 
UITS 
196

STATA
Reference Manual 
Release 4: vol. 3

Swain 
Hall

3 day
swn 
UITS 
197

SYSTAT (Macintosh) Data
Swain 
Hall

3 day
swn 
UITS 
288

SYSTAT
(Macintosh) Getting 
Started

Swain 
Hall

3 day
swn 
UITS 
287
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SYSTAT
(Macintosh) 
Graphics

Swain 
Hall

3 day
swn 
UITS 
286

SYSTAT
(Macintosh) 
Statistics

Swain 
Hall

3 day
swn 
UITS 
289

SYSTAT
(Windows) 
Command Reference

Swain 
Hall

3 day
swn 
UITS 
284

SYSTAT (Windows) Data
Swain 
Hall

3 day
swn 
UITS 
283

SYSTAT (Windows) Graphics
Swain 
Hall

3 day
swn 
UITS 
282

SYSTAT
(Windows) New 
Statistics

Swain 
Hall

3 day
swn 
UITS 
284a

SYSTAT (Windows) Statistics
Swain 
Hall

3 day
swn 
UITS 
285

TSP
Reference Manual 
ver. 4.3

Swain 
Hall

3 day
swn 
UITS 
281

TSP User's Guide ver. 4.3
Swain 
Hall

3 day
swn 
UITS 
280

MATLAB
Image Processing 
Toolbox User's 
Guide

Swain 
Hall 

3 day
swn 
UITS 
265K

Indianapolis Campus Libraries

Package Title Location
Loan 
Policy

Call 
Number

IUPUI University Library
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AMOS
AMOS User's Guide v 
4.0

IUPUI 
University 
Library

1 
week

 

ANSWERTREE
AnswerTree 1.0 
User's Guide

IUPUI 
University 
Library

1 
week

 

AUTOCAD Command Reference
IUPUI 
University 
Library

1 
week

 

AUTOCAD Customization Guide
IUPUI 
University 
Library

1 
week

 

AUTOCAD Installation Guide
IUPUI 
University 
Library

1 
week

 

AUTOCAD User's Guide
IUPUI 
University 
Library

1 
week

 

BMDP
BMDP Statistical 
Software Manual, 
Vol. 1

IUPUI 
University 
Library

1 
week

 

BMDP
BMDP Statistical 
Software Manual, 
Vol. 2

IUPUI 
University 
Library

1 
week

 

BMDP
BMDP Statistical 
Software Manual, 
Vol. 3

IUPUI 
University 
Library

1 
week

 

BMDP User's Digest
IUPUI 
University 
Library

1 
week

 

DBMS/COPY
Databases, 
Spreadsheets, 
Statistics

IUPUI 
University 
Library

1 
week

 

DBMS/COPY Version 7.0
IUPUI 
University 
Library

1 
week
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ETHNOGRAPH
Ethnograph v. 5.0 A 
User's Guide

IUPUI 
University 
Library

1 
week

 

MAPLE
Introduction to 
MAPLE

IUPUI 
University 
Library

1 
week

 

MAPLE
Introduction to Maple 
(release 6)

IUPUI 
University 
Library

1 
week

 

MAPLE
Learning Guide 
(release 6)

IUPUI 
University 
Library

1 
week

 

MATLAB
Release 11 New 
Features

IUPUI 
University 
Library

1 
week

 

MATLAB
Getting Started with 
MATLAB (ver. 5)

IUPUI 
University 
Library

1 
week

 

MATLAB
MATLAB Notebook 
User's Guide

IUPUI 
University 
Library

1 
week

 

MATLAB
Using MATLAB (ver. 
5) (ver. 5)

IUPUI 
University 
Library

1 
week

 

MATLAB
Using MATLAB 
Graphics (ver. 5)

IUPUI 
University 
Library

1 
week

 

MATLAB

MATLAB 
Application Program 
Interface Guide (ver. 
5)

IUPUI 
University 
Library

1 
week

 

MATLAB
Mapping Toolbox 
User's Guide (ver. 1)

IUPUI 
University 
Library 1 
week

 

MATLAB
Excel Link User's 
Guide

IUPUI 
University 
Library

1 
week
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MATLAB
Control System 
Toolbox User's Guide 
(ver. 4)

IUPUI 
University 
Library

1 
week

 

MATLAB
Fuzzy Logic Toolbox 
User's Guide (ver. 2)

IUPUI 
University 
Library

1 
week

 

MATLAB
Image Processing 
Toolbox User's Guide 
(ver. 2)

IUPUI 
University 
Library

1 
week

 

MATLAB
Neural Network 
Toolbox User's Guide 
(ver. 3)

IUPUI 
University 
Library

1 
week

 

MATLAB
Optimization Toolbox 
User's Guide (ver. 2)

IUPUI 
University 
Library

1 
week

 

MATLAB
Building GUIs with 
MATLAB (ver. 5)

IUPUI 
University 
Library

1 
week

 

MATLAB
Partial Differential 
Equation Toolbox 
User's Guide (ver. 1)

IUPUI 
University 
Library

1 
week

 

MATLAB
Spline Toolbox User's 
Guide (ver. 2)

IUPUI 
University 
Library

1 
week

 

MATLAB
Statistics Toolbox: 
User's Guide (ver. 2)

IUPUI 
University 
Library

1 
week

 

MATLAB
Symbolic Math 
Toolbox User's Guide 
(ver. 2)

IUPUI 
University 
Library

1 
week

 

MATLAB
Wavelet Toolbox 
User's Guide (ver. 1)

IUPUI 
University 
Library

1 
week

 

MATLAB
Signal Processing 
Toolbox User's Guide 
(ver. 4)

IUPUI 
University 
Library

1 
week
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MATLAB

SIMULINK Dynamic 
System Simulation for 
MATLAB: Using 
SIMULINK (ver. 3)

IUPUI 
University 
Library

1 
week

 

MATLAB
SIMULINK Writing S-
Functions (ver. 3)

IUPUI 
University 
Library

1 
week

 

MATLAB
DSP Blockset for Use 
with Simulink User's 
Guide (ver. 3)

IUPUI 
University 
Library

1 
week

 

MINITAB
Minitab Reference 
Manual (release 9)

IUPUI 
University 
Library

1 
week

 

MINITAB
Mintab Quality 
Control Manual 
(release 9)

IUPUI 
University 
Library

1 
week

 

MINITAB
User's Guide 1: Data, 
Graphics, and Macros 
(release 13)

IUPUI 
University 
Library

1 
week

 

MINITAB
User's Guide 2: Data 
Analysis and Quality 
Tools (release 13)

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Introduction Guide 

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 1

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 10

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 11

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 12

IUPUI 
University 
Library

1 
week
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NAG
FORTRAN Mark 17 
Volume 2

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 3

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 4 

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 5 

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 6

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 7

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 8

IUPUI 
University 
Library

1 
week

 

NAG
FORTRAN Mark 17 
Volume 9

IUPUI 
University 
Library

1 
week

 

NUDIST
Merge User Guide 
Rel. 4

IUPUI 
University 
Library

1 
week

 

NUDIST User Guide Rel. 4
IUPUI 
University 
Library

1 
week

 

RATS

CATS in RATS 
(Cointegration 
Analysis of Time 
Series)

IUPUI 
University 
Library

1 
week

 

RATS
RATS (Regression 
Analysis of Time 
Series)

IUPUI 
University 
Library

1 
week
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RESAMPLING 
STATS

User's Guide
IUPUI 
University 
Library

1 
week

 

SAS
Procedures Guide, 
Version 6

IUPUI 
University 
Library

1 
week

 

SAS
User's Guide, Version 
6, Volume 1

IUPUI 
University 
Library

1 
week

 

SAS
User's Guide, Version 
6, Volume 1

IUPUI 
University 
Library

1 
week

 

SAS
What's New in SAS 
Software for Version 
8

IUPUI 
University 
Library

1 
week

 

SAS

SAS Companion for 
the Microsoft 
Windows 
Environment, Version 
8

IUPUI 
University 
Library

1 
week

 

SAS
SAS Companion for 
UNIX Environments, 
Version 8

IUPUI 
University 
Library

1 
week

 

SAS
User's Guide, Version 
8, Volume 1

IUPUI 
University 
Library

1 
week

 

SAS
User's Guide, Version 
8, Volume 2

IUPUI 
University 
Library

1 
week

 

SAS
User's Guide, Version 
8, Volume 3

IUPUI 
University 
Library

1 
week

 

SAS
Procedures Guide, 
Version 8, Volume 1

IUPUI 
University 
Library

1 
week

 

SAS 
Procedures Guide, 
Version 8, Volume 2

IUPUI 
University 
Library

1 
week

 

http://www.indiana.edu/~statmath/smdoc/bylocation.html (51 of 64) [01/07/2002 21:19:29]



Software Manuals by Location

SAS 

SAS Language 
Reference : 
Dictionary, Version 8, 
Volume 1

IUPUI 
University 
Library

1 
week

 

SAS 

SAS Language 
Reference : 
Dictionary, Version 8, 
Volume 2

IUPUI 
University 
Library

1 
week

 

SAS 
SAS Macro Language 
Reference : Concepts, 
Version 8

IUPUI 
University 
Library

1 
week

 

SAS 
SAS Language 
Reference : Concepts, 
Version 8

IUPUI 
University 
Library

1 
week

 

SAS 

Complete Guide to 
the SAS Output 
Delivery System, 
Version 8

IUPUI 
University 
Library

1 
week

 

SIGMAPLOT
SigmaPlot 5.0 
Programming Guide

IUPUI 
University 
Library

1 
week

 

SIGMAPLOT
SigmaPlot 5.0 User's 
Guide

IUPUI 
University 
Library

1 
week

 

SIGMAPLOT

Transforms and 
Regressions for 
Windows 95, NT & 
3.1:

IUPUI 
University 
Library

1 
week

 

SIGMAPLOT
User's Manual 4.0 for 
Windows 95, NT & 
3.1

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Advanced 
Models 9.0

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Advanced 
Statistics 7.5

IUPUI 
University 
Library

1 
week
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SPSS
SPSS Base 8.0 
Applications Guide

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Base 8.0 Syntax 
Reference Guide

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Base 8.0 User's 
Guide

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Base 9.0 
Applications Guide

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Base 9.0 Syntax 
Reference Guide 

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Base 9.0 User's 
Guide

IUPUI 
University 
Library

1 
week

 

SPSS SPSS Categories 8.0
IUPUI 
University 
Library

1 
week

 

SPSS SPSS Conjoint 8.0
IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Data Entry 
Builder 1.0 User's 
Guide

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Exact Tests 7.0 
for Windows

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Interactive 
Graphics 8.0

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Interactive 
Graphics 9.0

IUPUI 
University 
Library

1 
week
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SPSS
SPSS Professional 
Statistics 7.5

IUPUI 
University 
Library

1 
week

 

SPSS
SPSS Regression 
Models 9.0

IUPUI 
University 
Library

1 
week

 

SPSS SPSS Tables 8.0
IUPUI 
University 
Library

1 
week

 

SPSS SPSS Trends. 6.1
IUPUI 
University 
Library

1 
week

 

STATA
Stata Graphics 
Manual Release 6

IUPUI 
University 
Library

1 
week

 

STATA
Stata Reference 
Manual Release 6 
Vol. 1 A-G

IUPUI 
University 
Library

1 
week

 

STATA
Stata Reference 
Manual Release 6 
Vol. 2 H-O

IUPUI 
University 
Library

1 
week

 

STATA
Stata Reference 
Manual Release 6 
Vol. 3 P-St

IUPUI 
University 
Library

1 
week

 

STATA
Stata Reference 
Manual Release 6 
Vol. 4 Su-Z

IUPUI 
University 
Library

1 
week

 

STATA
Stata User's Guide 
Release 6

IUPUI 
University 
Library

1 
week

 

SYSTAT
6.0 for Windows: 
Command Reference

IUPUI 
University 
Library

1 
week

 

SYSTAT
6.0 for Windows: 
Data

IUPUI 
University 
Library

1 
week
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SYSTAT
6.0 for Windows: 
Graphics

IUPUI 
University 
Library

1 
week

 

SYSTAT
6.0 for Windows: 
Statistics

IUPUI 
University 
Library

1 
week

 

SYSTAT
7.0 Command 
Reference

IUPUI 
University 
Library

1 
week

 

SYSTAT 7.0 New Statistics
IUPUI 
University 
Library

1 
week

 

Student Technology Centers

Package Title Location
Loan 
Policy

Call 
Number

Business 101 STC

MAPLE MapleV Learning Guide
STC (BUS 
101)

On-
Site

 

MAPLE
MapleV Programming 
Guide

STC (BUS 
101)

On-
Site

 

MATLAB
Matlab Reference Guide 
(UNIX)

STC (BUS 
101)

On-
Site

 

MATLAB
Matlab User's Guide 
(UNIX)

STC (BUS 
101)

On-
Site

 

SAS SAS 6.03 Statistics
STC (BUS 
101)

On-
Site

 

SAS SAS 6.03 Users Guide
STC (BUS 
101)

On-
Site

 

SPSS
SPSS 7.0 Applications 
Guide

STC (BUS 
101)

On-
Site

 

SPSS
SPSS 7.0 Base User's 
Guide

STC (BUS 
101)

On-
Site

 

SPSS
SPSS 7.0 Syntax Reference 
Guide

STC (BUS 
101)

On-
Site
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Education 2011 STC

MAPLE
MapleV First Leaves: A 
Tutorial to Introduction to 
Maple

STC 
(EDUC 
2011)

On-
Site

 

MAPLE MapleV Flight Manual
STC 
(EDUC 
2011)

On-
Site

 

MAPLE MapleV Library
STC 
(EDUC 
2011)

On-
Site

 

MAPLE MapleV Reference
STC 
(EDUC 
2011)

On-
Site

 

MAPLE
Matlab Reference Guide 
(UNIX)

STC 
(EDUC 
2011)

On-
Site

 

MATLAB
Matlab User's Guide 
(UNIX)

STC 
(EDUC 
2011)

On-
Site

 

SAS Language 
STC 
(EDUC 
2011)

On-
Site

 

SAS Procedures
STC 
(EDUC 
2011)

On-
Site

 

SPSS SPSS 4 Base System 
STC 
(EDUC 
2011)

On-
Site

 

SPSS SPSS 4 User's Guide
STC 
(EDUC 
2011)

On-
Site

 

SPSS
SPSS 6.0 Syntax Reference 
Guide 

STC 
(EDUC 
2011)

On-
Site

 

SPSS SPSS 6.0 User's Guide
STC 
(EDUC 
2011)

On-
Site
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SYSTAT Systat 5 Data 
STC 
(EDUC 
2011)

On-
Site

 

SYSTAT Systat 5 Getting Started 
STC 
(EDUC 
2011)

On-
Site

 

SYSTAT Systat 5 Graphics
STC 
(EDUC 
2011)

On-
Site

 

SYSTAT Systat 5 Statistics 
STC 
(EDUC 
2011)

On-
Site

 

HPER 154 STC

MAPLE
MapleV First Leaves: A 
Tutorial to Introduction to 
Maple

STC 
(HPER 
154)

On-
Site

 

MAPLE
MapleV Programming 
Guide

STC 
(HPER 
154)

On-
Site

 

MAPLE MapleV Reference Guide
STC 
(HPER 
154)

On-
Site

 

MATLAB
Matlab Reference Guide 
(UNIX)

STC 
(HPER 
154)

On-
Site

 

MATLAB
Matlab User's Guide 
(UNIX)

STC 
(HPER 
154)

On-
Site

 

OTHER Econometric Toolkit
STC 
(HPER 
154)

On-
Site

 

SAS Language and Procedures 
STC 
(HPER 
154)

On-
Site

 

SAS Stat User's Guide vol 1 & 2
STC 
(HPER 
154)

On-
Site
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SPSS SPSS 4 Base System 
STC 
(HPER 
154)

On-
Site

 

SPSS SPSS 4 Reference Guide
STC 
(HPER 
154)

On-
Site

 

SPSS
SPSS 7.0 - Applications 
Guide

STC 
(HPER 
154)

On-
Site

 

SPSS
SPSS 7.0 Syntax Reference 
Guide

STC 
(HPER 
154)

On-
Site

 

SPSS SPSS 7.0 User's Guide
STC 
(HPER 
154)

On-
Site

 

Lindley Hall STCs

MATLAB
Matlab Reference Guide 
(UNIX)

STC 
(Lindley 
Hall)

On-
Site

 

MATLAB
Matlab Users Guide 
(UNIX)

STC 
(Lindley 
Hall)

On-
Site

 

SAS Companion for Windows
STC 
(Lindley 
Hall)

On-
Site

 

SAS
Language and Procedures 
Intro 

STC 
(Lindley 
Hall)

On-
Site

 

SAS Stat User's Guide vol 1 & 2
STC 
(Lindley 
Hall)

On-
Site

 

SPSS
SPSS 6.1 Syntax Reference 
Guide

STC 
(Lindley 
Hall)

On-
Site

 

SYSTAT
Systat 7 Command 
Reference

STC 
(Lindley 
Hall)

On-
Site
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SYSTAT Systat 7 Graphics 
STC 
(Lindley 
Hall)

On-
Site

 

SYSTAT Systat 7 New Statistics 
STC 
(Lindley 
Hall)

On-
Site

 

SYSTAT Systat 7 Statistics 
STC 
(Lindley 
Hall)

On-
Site

 

Psychology 120 STC

MAPLE MapleV Learning Guide
STC 
(Psych 
120)

On-
Site

 

MAPLE
MapleV Programming 
Guide

STC 
(Psych 
120)

On-
Site

 

MATLAB Matlab Reference Guide
STC 
(Psych 
120)

On-
Site

 

MINITAB Minitab 11 Reference
STC 
(Psych 
120)

On-
Site

 

SAS
Language and Procedures 
Usage 

STC 
(Psych 
120)

On-
Site

 

SAS Procedures
STC 
(Psych 
120)

On-
Site

 

SPSS
SPSS 6.1 Syntax Reference 
Guide

STC 
(Psych 
120)

On-
Site

 

SYSTAT
Systat 6 Command 
Reference

STC 
(Psych 
120)

On-
Site

 

SYSTAT Systat 6 for Windows Data
STC 
(Psych 
120)

On-
Site
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SYSTAT
Systat 6 for Windows 
Graphics

STC 
(Psych 
120)

On-
Site

 

SYSTAT
Systat 6 for Windows 
Statistics

STC 
(Psych 
120)

On-
Site

 

SPEA 151 STC

MAPLE
MapleV First Leaves: A 
Tutorial to Introduction to 
Maple

STC 
(SPEA 
151)

On-
Site

 

MAPLE MapleV Learning Guide 
STC 
(SPEA 
151)

On-
Site

 

MAPLE
MapleV Programming 
Guide

STC 
(SPEA 
151)

On-
Site

 

MATLAB
Matlab Reference Guide 
(UNIX)

STC 
(SPEA 
151)

On-
Site

 

MATLAB
Matlab User's Guide 
(UNIX) 

STC 
(SPEA 
151)

On-
Site

 

MINITAB Minitab 11 Reference
STC 
(SPEA 
151)

On-
Site

 

OTHER Econometric Toolkit
STC 
(SPEA 
151)

On-
Site

 

SAS Companion for Windows
STC 
(SPEA 
151)

On-
Site

 

SAS Language and Procedures 
STC 
(SPEA 
151)

On-
Site

 

SPSS SPSS 4 Reference Guide
STC 
(SPEA 
151)

On-
Site
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SPSS
SPSS 7.0 Applications 
Guide 

STC 
(SPEA 
151)

On-
Site

 

SPSS
SPSS 7.0 Syntax Reference 
Guide 

STC 
(SPEA 
151)

On-
Site

 

SPSS SPSS 7.0 User's Guide
STC 
(SPEA 
151)

On-
Site

 

SYSTAT
Systat 6 Command 
Reference

STC 
(SPEA 
151)

On-
Site

 

SYSTAT Systat 6 for Windows Data
STC 
(SPEA 
151)

On-
Site

 

SYSTAT
Systat 6 for Windows 
Graphics

STC 
(SPEA 
151)

On-
Site

 

SYSTAT
Systat 6 for Windows 
Statistics

STC 
(SPEA 
151)

On-
Site

 

Student Building STCs

MAPLE MapleV Reference
STC 
(Student 
Building)

On-
Site

 

MATLAB
Matlab Reference Guide 
(UNIX)

STC 
(Student 
Building)

On-
Site

 

MATLAB
Matlab Users Guide 
(UNIX)

STC 
(Student 
Building)

On-
Site

 

MINITAB Minitab 11 Reference
STC 
(Student 
Building)

On-
Site

 

OTHER Econometric Toolkit
STC 
(Student 
Building)

On-
Site
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RATS Rats 386
STC 
(Student 
Building)

On-
Site

 

SAS Companion for Windows 
STC 
(Student 
Building)

On-
Site

 

SAS Language & Procedures
STC 
(Student 
Building)

On-
Site

 

SAS Stat vol. 1 & 2 
STC 
(Student 
Building)

On-
Site

 

SPSS SPSS 4 Reference guide
STC 
(Student 
Building)

On-
Site

 

SPSS
SPSS 7.0 Applications 
Guide 

STC 
(Student 
Building)

On-
Site

 

SPSS
SPSS 7.0 Syntax Reference 
Guide 

STC 
(Student 
Building)

On-
Site

 

SPSS SPSS 7.0 User's Guide
STC 
(Student 
Building)

On-
Site

 

SYSTAT
Systat 6 Command 
Reference

STC 
(Student 
Building)

On-
Site

 

SYSTAT Systat 6 for Windows Data
STC 
(Student 
Building)

On-
Site

 

SYSTAT
Systat 6 for Windows 
Graphics 

STC 
(Student 
Building)

On-
Site

 

SYSTAT
Systat 6 for Windows 
Statistics

STC 
(Student 
Building)

On-
Site

 

Woodburn 211 STC
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BMDP
BMDP Statistical Software 
Manual, Vol. 1

WH 211 
STC

On-
Site

 

BMDP
BMDP Statistical Software 
Manual, Vol. 2

WH 211 
STC

On-
Site

 

MAPLE MapleV Reference Library
STC 
(Woodburn 
211)

On-
Site

 

MATLAB
Matlab Reference Guide 
(UNIX)

STC 
(Woodburn 
211)

On-
Site

 

MATLAB
Matlab User's Guide 
(UNIX) 

STC 
(Woodburn 
211)

On-
Site

 

SPSS SPSS 4 Reference Guide 
STC 
(Woodburn 
211)

On-
Site

 

SPSS SPSS 4 User's Guide
STC 
(Woodburn 
211)

On-
Site

 

SPSS
SPSS 7.0 Applications 
Guide

STC 
(Woodburn 
211)

On-
Site

 

SPSS
SPSS 7.0 Syntax Reference 
Guide 

STC 
(Woodburn 
211)

On-
Site

 

SPSS SPSS 7.0 User's Guide 
STC 
(Woodburn 
211)

On-
Site

 

SYSTAT
Systat 6 Command 
Reference

STC 
(Woodburn 
211)

On-
Site

 

SYSTAT Systat 6 for Windows Data 
STC 
(Woodburn 
211)

On-
Site

 

SYSTAT
Systat 6 for Windows 
Graphics

STC 
(Woodburn 
211)

On-
Site
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SYSTAT
Systat 6 for Windows 
Statistics

STC 
(Woodburn 
211)

On-
Site

 

Wylie 125 STC

RATS
Rats 4.2 - complete 
documentation

STC 
(Wylie 
125)

On-
Site

 

SYSTAT
Systat 7.0 - complete 
documentation

STC 
(Wylie 
125)

On-
Site
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Search:  In:       

IUB Math Software Availability

 

Microcomputers Workstations Shared
Research 
Systems

Matlab - A A A A A A

Maple A A A A A A A

Mathematica B - B B B B B

Geometer's 
SketchPad

C C - - - - -

LINDO - - - - - - B

LINGO - B - - - - -

Support Levels:

A = General Purpose Software B = Special Purpose Software

C = Departmental Software D = To Be Retired
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Search:  In:       

IUPUI Mathematical Software 
Availability

Microcomputers

Maple - A

Note: IUPUI researchers can also request accounts on IUB Shared 
Systems. Contact the IUPUI UITS Support Center for more information 
(helpdesk@iupui.edu, 317-274-HELP).

Support Levels:

A = General Purpose Software
B = Special Purpose 
Software

C = Departmental (Customer Sponsored) 
Software

D = To Be Retired
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Stat/Math Contact Us

Search:  In:       

Contact Us

About our Website Brochure Consulting Map Mission Staff Welcome

Phone Numbers

●     Stat/Math Main Line: (812) 855-4724, M-F, 9am-5pm 
●     After hours, call (812) 855-6789 (UITS Support Center) for computer 

assistance 
●     Stat/Math Fax Number: (812) 855-8802 

E-mail

Note: Unfortunately, we do not have the resources to provide computing support 
for persons not associated with Indiana University. This means, unless you are a 
student, faculty, or staff member of Indiana University, your questions will 
probably not be answered.
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To: Stat/Math Center, IU <statmath@indiana.edu>  
Your Name: 

Email Address: 
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Stat/Math Math Maple Getting Started Introduction

Search:  In:       

Introduction

What is Maple?

Maple is a computer program for people doing mathematics. Using Maple to do 
your calculations should make the work more interesting, allow you to focus more 
on the concepts, and help you to avoid mistakes in calculation.

How to use this tutorial

This document is intended to get you started, and show you how to learn more. It is 
intended to be used while sitting at a terminal running Maple in a windowed 
environment, by entering the commands and thinking about the output.

To use any software effectively, some knowledge of the computer's operating 
system is required. This document will assume that you are already familiar with 
the rudiments of windows -- things like point, click and drag, how to use menus, 
and the standard way to open and close files. Maple is essentially the same on 
Microsoft Windows, Macintosh, and the X windows system, but there are minor 
differences in their interface. 

This tutorial assumes that you are running Maple in one of the previously listed 
environments. If you are using a character-based terminal, for example in a telnet 
session, the Maple commands will be the same although the interface is different 
(no mouse, no menus, and typewriter graphics). If you are using Maple over telnet, 
ssh, or through any other terminal, you may wish to read Using Math Software 
under UNIX  after you are done with this tutorial.

In order to be more broadly understood, we don't include some things which require 
a lot of mathematical knowledge, for example linear algebra. Subject oriented 
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guides are also available -see our By Subject page.

We'll be using some standard conventions throughout this document.

Example Explanation

File -> Open Choose the file menu, and select Open.

a := 5; Input to be typed at the Maple prompt.

a := 5 Output from Maple.

 An important tip.

Where to find Maple

Maple is available for many different kinds of computers at Indiana University 
Bloomington.

●     All Windows and Macintosh Student Technology Centers. 
●     Ships, Nations, and DaVinci UNIX clusters 
●     Several of the large timesharing systems - see the availability chart for 

details. 

How to start and exit Maple

To start maple:

●     On Windows 2000 computers, go to Start Menu -> Programs -> Statistics 
and Math -> Maple 7 -> Maple 7 

●     On Macintosh computers, go to Apple Menu -> Statistics and Math -> 
Maple 7. 

●     On UNIX workstations, the X windows version is invoked by the command 
xmaple &. 

To exit Maple in a windowed environment choose File -> Exit. To exit from a 
terminal session type quit;.

Next: Finding Your Way Around
Up: Table of Contents
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Stat/Math Math Maple Getting Started One Long Page

Search:  In:       

Introduction

What is Maple?

Maple is a computer program for people doing mathematics. Using Maple to do your calculations 
should make the work more interesting, allow you to focus more on the concepts, and help you to 
avoid mistakes in calculation.

How to use this tutorial

This document is intended to get you started, and show you how to learn more. It is intended to be 
used while sitting at a terminal running Maple in a windowed environment, by entering the 
commands and thinking about the output.

To use any software effectively, some knowledge of the computer's operating system is required. This 
document will assume that you are already familiar with the rudiments of windows -- things like 
point, click and drag, how to use menus, and the standard way to open and close files. Maple is 
essentially the same on Microsoft Windows, Macintosh, and the X windows system, but there are 
minor differences in their interface. 

This tutorial assumes that you are running Maple in one of the previously listed environments. If you 
are using a character-based terminal, for example in a telnet session, the Maple commands will be the 
same although the interface is different (no mouse, no menus, and typewriter graphics). If you are 
using Maple over telnet, ssh, or through any other terminal, you may wish to read Using Math 
Software under UNIX  after you are done with this tutorial.

In order to be more broadly understood, we don't include some things which require a lot of 
mathematical knowledge, for example linear algebra. Subject oriented guides are also available -see 
our By Subject page.

We'll be using some standard conventions throughout this document.

Example Explanation

File -> Open Choose the file menu, and select Open.

a := 5; Input to be typed at the Maple prompt.
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a := 5 Output from Maple.

 An important tip.

Where to find Maple

Maple is available for many different kinds of computers at Indiana University Bloomington.

●     All Windows and Macintosh Student Technology Centers. 
●     Ships, Nations, and DaVinci UNIX clusters 
●     Several of the large timesharing systems - see the availability chart for details. 

How to start and exit Maple

To start maple:

●     On Windows 2000 computers, go to Start Menu -> Programs -> Statistics and Math -> Maple 
7 -> Maple 7 

●     On Macintosh computers, go to Apple Menu -> Statistics and Math -> Maple 7. 
●     On UNIX workstations, the X windows version is invoked by the command xmaple &. 

To exit Maple in a windowed environment choose File -> Exit. To exit from a terminal session type 
quit;.

Finding your way around the window

The Toolbar

First of all, locate the toolbar at the top of the window.  On Windows, it looks like this:

Other operating systems have a similar toolbar.

Every time you work with maple, you will use a "worksheet".  The worksheet is the big, blank area in 
the middle of the screen. You may have more than one worksheet open at a time.  The following 
toolbar buttons let you work with the worksheet.

 

The first five buttons on the toolbar, in order, do the following: open a new, 
blank worksheet; open an existing worksheet; open a hyperlink; save the 
current worksheet; and print the current worksheet.

The next three buttons are the standard cut, copy, and paste functions.
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The next two buttons let you "undo" and "redo" your last action.

The next three buttons let you manage what "mode" Maple is currently in.  The 
standard mode is represented by the capital Sigma button. This means that 
anything you type will be considered to be mathematical input.  If you click the 
capital T, Maple switches to Text mode. Anything you type will be considered 
as text commentary, and Maple won't try to treat it as math.  To switch back to 
math input mode, click the [> button.  Notice that the prompt in the worksheet 
window changes to let you know what mode you are in.

The next two buttons let you un-indent and indent lines in your worksheet.

The next button has a stop sign on it.  It is used as a "panic" button.  If you start 
a computation and you would like to stop, click the stop sign. (Cntl-C will also 
do this.)

The next three buttons control the amount of zoom.

The next button displays non-printing characters in the worksheet.

The next button expands the active worksheet to fill the available space.

The last button clears all variables of their values. It is the same as typing the 
maple command 
restart;

The Kernel

The kernel is the part of Maple that does the actual calculation. The kernel is invisible, but you do 
need to know about it.  You talk to the kernel by typing mathematical statements and commands at 
the Maple prompt.  Here is an example.

If you're using a graphics-enabled browser, you'll notice that input appears in red.  Output from the 
kernel appears in blue, with variable names in italics.

The Maple prompt looks like [>.

The kernel will execute when you press the Enter key.  The kernel decides what to execute by looking 
at the current execution group. An execution group is a set of input lines connected (along the left-
hand margin) by a long, thin [.  When you press Enter anywhere in the execution group, the entire 
group is executed.  By default, each input line (along with its output) is an execution group unto 
itself.  You can join execution groups together using the F4 key, or split them apart using the F3 key.
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Execution only occurs when you press the Enter key, or if you choose Edit->Execute-
>Worksheet.  Execution does not occur when you open a worksheet.

Worksheets

The worksheet is the basic unit of work in Maple, like a document in a word processor.  A worksheet 
stores every line of input and every line of output.

To save your worksheet, choose File->Save As.

To open a worksheet, choose File->Open.

You may have more than one worksheet open at a time.  However, they all share the same kernel.  So 
any work you do in one worksheet is accessible from another open worksheet.  This can lead to 
confusing results.

Using the Help System

Maple has an extremely in-depth help system.  To access it, choose Help -> Topic Search.  Enter the 
word you are looking for (e.g., matrix) and you should see a list of topics.  Clicking on one will open 
a "help browser", a window that lets you wander through  related topics.  We suggest that you "surf" 
the help system - casually browse, looking at anything that seems interesting.  That way you will have 
some idea of what is available to you in the future.

If you know exactly what you need help on, you may also type (in Maple)

? simplify 

(for example) to get help on the Maple command  "simplify".

A very useful feature of the help system is the examples section. Use the Edit->Copy Examples menu 
command to copy the examples.  Then switch to your worksheet (or open a fresh one) and use the 
Edit->Paste menu command. Now you can execute the examples, and experiment until you are 
comfortable with the commands.

Maple Syntax and Built-in Data Capabilities

Syntax

As with any computer language, Maple has its own syntax.  As a new user of Maple, you can save 
yourself a lot of head-scratching if you get to know these symbols.
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Enter the commands given or make up similar problems.

Symbol Description Examples Sample Output

;
End-of-line.  Tells Maple to process the line and 
show the output.

hello; hello

:
End-of-line.  Tells Maple to process the line and 
hide the output.

hello:  

:= Assignment.  Lets you assign values to variables.
a := 3;
a;

a := 3
3

+, - Addition, subtraction.
1 + 3;
1 - 3;

4
-2

*, / Multiplication, division
3*412;
1236/3;
7/3;

1236
412
7/3

^, sqrt Power, square root
2^3;
sqrt(2);
2^(1/2);

8

evalf, . Floating-point (decimal) evaluation
evalf(7/3);
7.0/3;

2.333333333
2.333333333

I,Pi Imaginary unit, Pi.
2 + 3*I;
(2*I)^2;
evalf(Pi);

2+3I
-4
3.141592654

%, %%
Recall the last output, recall the second-to-last 
output, etc.

%;
%%%;

3.141592654
-4

Some syntactical caveats:

●     Maple is case sensitive.  foo, Foo, and FOO are three different things. 
●     Maple requries you to show multiplication with the * character. Entering x*y gives the 

product of x and y, but entering xy gives one variable with the name xy. 
●     To get the constant e use exp(1). 
●     Using the % operator can give confusing results.  It always returns the last output from the 

Kernel, which may have nothing to do with where the cursor is (or which worksheet is active). 
●     If Maple doesn't recognize something, it will assume it is a variable. For example, typing i^2 

will give you i2, while you may have wanted -1. 
●     You can move your cursor up to a previous line, press Enter, and the line will re-execute. 
●     When copying and pasting using a mouse, by sure to also highlight the execution group 

symbol ([).  If you don't, the lines will be pasted in reverse order due to a bug. 
●     Spaces are optional. 
●     Greek letters may be entered by spelling their name.  For example, alpha is always displayed 
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as , and Gamma is displayed as  (note upper-case). 

Built-in Data Capabilities

Maple can handle arbitrary-precision floating point numbers.  In other words, Maple can store as 
many digits for a number as you like, up to the physical limits of your computer's memory.  To 
control this, use the Digits variable.

    sqrt(2.0);
       1.414213562
    Digits := 20:
    sqrt(2.0);
       1.4142135623730950488

Maple sets Digits to be 10 by default. You can also temporarily get precision results by calling evalf 
with a second argument.

    evalf(sqrt(2), 15);
       1.41421356237310

Large integers are handled automatically.

Using symbolic computation

The main feature of Maple is symbolic computation.  In other words, Maple does algebra. Here are 
some examples.

Example Output Comments

(x + y)^2; (x + y)2 A basic expression.

k := x*y + y^2; k := xy + y2

k is now an alias for the expression.  
Note that k is simply another name for 
the expression - they are not equal in 
the mathematical sense.

p := k /(x+y);
You can now use k to refer to the 
expression.  Maple immediately 
substitutes the value of k.

k := 'k'; k
You can unassign a variable by 
assigning it to its own name in single 
quotes.
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simplify(p); y
The simplify command does 
algebraic simplification.

p := x^2 - 8*x +15; p := x2 - 8x  + 15
Maple doesn't mind if you re-use 
names.  The old value is lost.

solve(p=3,x); 2,6

Use the solve command to solve 
equations.  Note the use of the = sign.  
Here, it is used in a mathematical 
sense.  Maple will try different values 
for x until it finds all of them that 
make the mathematical statement x2 - 
8x  + 15 = 3 true.

dpdx := diff(p,x); dpdx := 2x - 8
The diff command differentiates an 
expression with respect to a variable.

int(p,x);
The int command integrates an 
expression.  Note that the constant of 
integration is left off.

subs(x=4,p);
subs(x=t^2,p);

-1
t4 - 8t2 + 15

The subs command substitutes 
expressions into other 
expressions. Notice that p's value is 
unchanged.

Each of the commands listed here has many powerful, advanced features. See the help files for more 
information.

Use the restart; command to unassign all variables, reset built-in variables (such as 
Digits) to their original values, and unload all packages. Of course, this should be used 
with care. 

Creating your own Mathematical Functions

We have been working with expressions so far. Maple also supports the mathematical notion of a 
function.  To define a function, you must specify a rule for going from one number to another. 
Consider the following commands:

f := x^2; f := x2
This defines f to be an abbreviation for the expression 
x2.

f := x -> x^2; f := x -> x2 This defines f to be a function, such that f(x) = x2.

f(3);
f(t);

9
t2

The function works as standard notation.
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A common mistake is to write f(x) := x^2;. This does not define a function. Instead, it 
makes the four characters on the left an abbreviation for the three characters on the right. 

Functions are often more useful than expressions. However, many Maple commands (for example, 
diff) expect an expression as input. If f := x -> x^2, then diff(f,x); doesn't work. 
However, diff(f(x),x); will work, since f(x) produces the expression x2. 

To convert an expression into a function, use the unapply command.

    p := x^3 + 1;
       p := x3 + 1
    f := unapply(p, x); f(3);
       f := x -> x3 + 1
       28

Using packages

When you first load Maple, it knows how to execute several different functions. For example, we 
used the evalf and simplify functions without having to load them first.  Maple comes with a 
huge number of other useful functions, bundled up in units known as packages.  Maple has a modular 
design -- not all of its functions are loaded at startup. The more specialized capabilities must be 
explicitly loaded.

For example, if you want to work with matrices and vectors, you would want to load the linalg 
package.

    with(linalg);

The output from with is a list of the new commands that you now have access to.  If you don't want 
to see the list (which can be rather long), use a colon as your end-of-line marker.

    with(linalg):

Even if you use a colon, you may see warning messages.  These usually indicate that a command has 
a new definition.  In most cases, this should not be a concern. 

Some Maple functions are not in packages; instead, they are stored in the older library format.  For 
example, to add the multivarate Taylor series function, mtaylor,  use the command

readlib(mtaylor);
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Go exploring among the packages.  These are some of the most commonly used packages: 

student  Includes commands for use in a classroom/homework setting.

plots Tools for graphics, 3-d, animation, and visualization.

linalg Matrices, vectors, and many linear algebra functions.

detools Tools for working with ODEs and PDEs.

To get a comprehensive list of available packages, choose Help->Introduction, then browse 
to Mathematics->Packages->Overview. 

Basic Plotting

Maple can produce graphs very easily.  Here are some examples, showcasing the basic capabilities.

plot( x^2, x=-2..2);

A basic plot.

plot( x^2, x=-2..2, y=-10..10);

A plot with vertical axis control.

plot([x, x^2, x^3], x=-
2..2);

Plot multiple expressions by enclosing 
them in brackets.

plot([sin(t),cos(t),t=0..3*Pi/2]);

Parametric plots include the plotting range in the 
brackets.
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plot3d(4-x^2-y^2, x=-3..3, 
y=-2..2);

A basic 3-d plot.

smartplot3d(x^2-y^2);

Using smartplot to let maple set it's own scaling.

You can control where plots are drawn by choosing Options->Plot Display->Inline or Window.  
Either way, if you select a plot with the mouse, you can use the toolbar to change the rendering style, 
axes, and lighting. 

To copy a plot to the clipboard (as a graphics file), right-click (or Option-Click for Mac users) on the 
plot and select Copy.

Look into these commonly used plotting commands: 

textplot, textplot3d Draw text anywhere in a plot

display Display several plots at once

animate, animate3d Adds a dimension of time to your plot.

plotoptions Various options, including line weight, color, sampling, etc.

Further Reading

For further guidance as a new user, try the tour.  Choose Help->New User's Tour.

Other sources of information include:

●     The UITS Knowledge Base 
●     UITS Education Program 
●     Software Manual Locations 
●     If you are affiliated with Indiana University, you may also get use Stat/Math Consulting . 

Permission to use this document is granted so long as the author is acknowledged and notified. 
Please send comments and suggestions to:statmath@indiana.edu 

Copyright 1995-1999, Indiana University. 
Last modified: Monday, 25-Feb-2002 15:59:22 EST 

URL /~statmath/math/maple/gettingstarted/giant.html 
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Introduction

What is Maple?

Maple is a computer program for people doing mathematics. Using Maple to do your calculations should
make the work more interesting, allow you to focus more on the concepts, and help you to avoid silly
calculation mistakes.

How to use this tutorial

This document is intended to get you started, and show you how to learn more. It is intended to be used
while sitting at a terminal running Maple in a windowed environment, by entering the commands and
thinking about the output.

To use any software effectively, some knowledge of the computer's operating system is required. This
document will assume that you are already familiar with the rudiments of windows -- things like point,
click and drag, how to use menus, and the standard way to open and close files. Maple is essentially the
same on Microsoft Windows, Macintosh, and the X windows system, but there are minor differences in
their interface.

This tutorial assumes that you are running Maple V release 5.1 in one of the previously listed
environments. If you are using a character-based terminal, for example in a telnet session, the Maple
commands will be the same although the interface is different (no mouse, no menus, and typewriter
graphics). If you are using Maple over telnet, ssh, or through any other terminal, you may wish to read
Using Math Software under UNIX  after you are done with this tutorial.

In order to be more broadly understood, we don't include some things which require a lot of
mathematical knowledge, for example linear algebra. Subject oriented guides are also available -see our
By Subject page.

We'll be using some standard conventions throughout this document.

Example Explanation

File -> Open Choose the file menu, and select Open.

a := 5; Input to be typed at the Maple prompt.

a := 5 Output from Maple.

An important tip.

Where can I find Maple?

Maple is available in all IUB Student Technology Centers.

On NT (PC) computers, go to Start Menu -> Programs -> Statistics and Math -> Maple V Release
5.1 -> Maple V Release 5.1.

●   

Getting Started with Maple
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On Macintosh computers, go to Apple Menu -> Statistics and Math -> Maple V Release 5.1
(PowerPC).

●   

On UNIX workstations, the X windows version is invoked by the command xmaple &.●   

Maple is also available on most IU central systems - see the Availability page.●   

How to start and exit Maple

To start maple:

On NT (PC) computers, go to Start Menu -> Programs -> Statistics and Math -> Maple V Release
5.1 -> Maple V Release 5.1.

●   

On Macintosh computers, go to Apple Menu -> Statistics and Math -> Maple V Release 5.1
(PowerPC).

●   

On UNIX workstations, the X windows version is invoked by the command xmaple &.●   

To exit Maple, choose File -> Exit or type exit;.

Finding your way around the window

The Toolbar

First of all, locate the toolbar at the top of the window.  On NT, it looks like this:

Other operating systems have a similar toolbar.

Every time you work with maple, you will use a "worksheet".  The worksheet is the big, blank area in the
middle of the screen. You may have more than one worksheet open at a time.  The following toolbar
buttons let you work with the worksheet.

The first four buttons on the toolbar, in order, do the following: open a new, blank
worksheet; open an existing worksheet; save the current worksheet; and print the
current worksheet.

The next three buttons are the standard cut, copy, and paste functions.

The next two buttons let you "undo" and "redo" your last action.

The next three buttons let you manage what "mode" Maple is currently in.  The
standard mode is represented by the capital Sigma button. This means that anything
you type will be considered to be mathematical input.  If you click the capital T, Maple
switches to Text mode. Anything you type will be considered as text commentary, and
Maple won't try to treat it as math.  To switch back to math input mode, click the [>
button.  Notice that the prompt in the worksheet window changes to let you know what
mode you are in.
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The next two buttons let you un-indent and indent lines in your worksheet.

The next button has a stop sign on it.  It is used as a "panic" button.  If you start a
computation and you would like to stop, click the stop sign. (Cntl-C will also do this.)

The next three buttons control the amount of zoom.

The Kernel

The kernel is the part of Maple that does the actual calculation. The kernel is invisible, but you do need
to know about it.  You talk to the kernel by typing mathematical statements and commands at the Maple
prompt.  Here is an example.

If you're using a graphics-enabled browser, you'll notice that input appears in red.  Output from the
kernel appears in blue, with variable names in italics.

The Maple prompt looks like [>.

The kernel will execute when you press the Enter key.  The kernel decides what to execute by looking at
the current execution group. An execution group is a set of input lines connected (along the left-hand
margin) by a long, thin [.  When you press Enter anywhere in the execution group, the entire group is
executed.  By default, each input line (along with its output) is an execution group unto itself.  You can
join execution groups together using the F4 key, or split them apart using the F3 key.

Execution only occurs when you press the Enter key, or if you choose
Edit->Execute->Worksheet.  Execution does not occur when you open a worksheet.

Worksheets

The worksheet is the basic unit of work in Maple, like a document in a word processor.  A worksheet
stores every line of input and every line of output.

To save your worksheet, choose File->Save As.

To open a worksheet, choose File->Open.

You may have more than one worksheet open at a time.  However, they all share the same kernel.  So
any work you do in one worksheet is accessible from another open worksheet.  This can lead to
confusing results.
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http://pytheas.ucs.indiana.edu/~statmath/math/maple/gettingstarted/printable.html (3 of 10) [3/30/2000 11:01:37 AM]



Using the Help System
Maple has an extremely in-depth help system.  To access it, choose Help -> Topic Search.  Enter the
word you are looking for (e.g., matrix) and you should see a list of topics.  Clicking on one will open a
"help browser", a window that lets you wander through  related topics.  We suggest that you "surf" the
help system - casually browse, looking at anything that seems interesting.  That way you will have some
idea of what is available to you in the future.

If you know exactly what you need help on, you may also type (in Maple)

> ? simplify

(for example) to get help on the Maple command  "simplify".

A very useful feature of the help system is the examples section. Use the Edit->Copy Examples menu
command to copy the examples.  Then switch to your worksheet (or open a fresh one) and use the
Edit->Paste menu command. Now you can execute the examples, and experiment until you are
comfortable with the commands.

Maple Syntax and Built-in Data Capabilities

Syntax

As with any computer language, Maple has its own syntax.  As a new user of Maple, you can save
yourself a lot of head-scratching if you get to know these symbols.

Enter the commands given or make up similar problems.

Symbol Description Examples Sample Output

;
End-of-line.  Tells Maple to process the line and show the
output.

hello; hello

:
End-of-line.  Tells Maple to process the line and hide the
output.

hello:  

:= Assignment.  Lets you assign values to variables.
a := 3;
a;

a := 3
3

+, - Addition, subtraction.
1 + 3;
1 - 3;

4
-2

*, / Multiplication, division
3*412;
1236/3;
7/3;

1236
412
7/3
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^, sqrt Power, square root
2^3;
sqrt(2);
2^(1/2);

8

evalf, . Floating-point (decimal) evaluation
evalf(7/3);
7.0/3;

2.333333333
2.333333333

I,Pi Imaginary number, Pi.
2 + 3*I;
(2*I)^2;
evalf(Pi);

2+3I
-4
3.141592654

%, %% Recall the last output, recall the second-to-last output, etc.
%;
%%%;

3.141592654
-4

Some syntactical caveats:

Maple is case sensitive.  foo, Foo, and FOO are three different things.●   

Using the % operator can give confusing results.  It always returns the last output from the Kernel,
which may have nothing to do with where the cursor is (or which worksheet is active).

●   

If Maple doesn't recognize something, it will assume it is a variable. For example, typing i^2 will
give you i2, while you may have wanted -1.

●   

You can move your cursor up to a previous line, press Enter, and the line will re-execute.●   

When copying and pasting using a mouse, by sure to also highlight the execution group symbol
([).  If you don't, the lines will be pasted in reverse order due to a bug.

●   

Spaces are optional.●   

Greek letters may be entered by spelling their name.  For example, alpha is always displayed as 

, and Gamma is displayed as   (note upper-case).

●   

Built-in Data Capabilities

Maple can handle arbitrary-precision floating point numbers.  In other words, Maple can store as many
digits for a number as you like, up to the physical limits of your computer's memory.  To control this, use
the Digits variable.

    sqrt(2.0);

       1.414213562

    Digits := 20:

    sqrt(2.0);

       1.4142135623730950488

Maple sets Digits to be 10 by default. You can also temporarily get precision results by calling evalf with
a second argument.
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    evalf(sqrt(2), 15);

       1.41421356237310

Large integers are handled automatically.

Using symbolic computation
The main feature of Maple is symbolic computation.  In other words, Maple does algebra. Here are some
examples.

Example Output Comments

(x + y)^2; (x + y)2 A basic expression.

k := x*y + y^2; k := xy + y2
k is now an alias for the expression.  Note that k is
simply another name for the expression - they are
not equal in the mathematical sense.

p := k /(x+y);
You can now use k to refer to the expression. 
Maple immediately substitutes the value of k.

k := 'k'; k
You can unassign a variable by assigning it to its
own name in single quotes.

simplify(p); y
The simplify command does algebraic
simplification.

p := x^2 - 8*x +15; p := x2 - 8x  + 15
Maple doesn't mind if you re-use names.  The old
value is lost.

solve(p=3,x); 2,6

Use the solve command to solve equations.  Note
the use of the = sign.  Here, it is used in a
mathematical sense.  Maple will try different values
for x until it finds all of them that make the
mathematical statement x2 - 8x  + 15 = 3 true.

dpdx := diff(p,x); dpdx := 2x - 8
The diff command differentiates an expression with
respect to a variable.

int(p,x);
The int command integrates an expression.  Note
that the constant of integration is left off.
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subs(x=4,p);
subs(x=t^2,p);

-1
t4 - 8t2 + 15

The subs command substitutes expressions into
other expressions. Notice that p's value is
unchanged.

Each of the commands listed here has many powerful, advanced features. See the help files for more
information.

Use the restart; command to unassign all variables, reset built-in variables (such as Digits) to
their original values, and unload all packages. Of course, this should be used with care. 

Creating your own Mathematical Functions
We have been working with expressions so far. Maple also supports the mathematical notion of a
function.  To define a function, you must specify a rule for going from one number to another. Consider
the following commands:

f := x^2; f := x2 This defines f to be an abbreviation for the expression x2.

f := x -> x^2; f := x -> x2 This defines f to be a function, such that f(x) = x2.

f(3);
f(t);

9
t2

The function works as standard notation.

A common mistake is to write f(x) := x^2;. This does not define a function. Instead, it makes the
four characters on the left an abbreviation for the three characters on the right. 

Functions are often more useful than expressions. However, many Maple commands (for example, diff)
expect an expression as input. If f := x -> x^2, then diff(f,x); doesn't work. However, diff(f(x),x); will
work, since f(x) produces the expression x2.

To convert an expression into a function, use the unapply command.

    p := x^3 + 1;

       p := x3 + 1

    f := unapply(p, x); f(3);

       f := x -> x3 + 1

       28

Using packages
When you first load Maple, it knows how to execute several different functions. For example, we used
the evalf and simplify functions without having to load them first.  Maple comes with a huge number of
other useful functions, bundled up in units known as packages.  Maple has a modular design -- not all of
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its functions are loaded at startup. The more specialized capabilities must be explicitly loaded.

For example, if you want to work with matrices and vectors, you would want to load the linalg package.

    with(linalg);

The output from with is a list of the new commands that you now have access to.  If you don't want to see
the list (which can be rather long), use a colon as your end-of-line marker.

    with(linalg):

Even if you use a colon, you may see warning messages.  These usually indicate that a command has a
new definition.  In most cases, this should not be a concern.

Some Maple functions are not in packages; instead, they are stored in the older library format.  For
example, to add the multivarate Taylor series function, mtaylor,  use the command

readlib(mtaylor);

Go exploring among the packages.  These are some of the most commonly used packages:

student  Includes commands for use in a classroom/homework setting.
plots Tools for graphics, 3-d, animation, and visualization.
linalg Matrices, vectors, and many linear algebra functions.
detools Tools for working with ODEs and PDEs.

To get a comprehensive list of available packages, choose Help->Introduction, then browse to
Mathematics->Packages->Overview. 

Basic Plotting
Maple can produce graphs very easily.  Here are some examples, showcasing the basic capabilities.

plot( x^2, x=-2..2);
A basic plot.

plot( x^2, x=-2..2, y=-10..10);
A plot with vertical axis control.
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plot([x, x^2, x^3], x=-2..2);
Plot multiple expressions by enclosing them in

brackets.

plot([sin(t),cos(t),t=0..3*Pi/2]);
Parametric plots include the plotting range in the

brackets.

plot3d(4-x^2-y^2, x=-3..3, y=-2..2);
A basic 3-d plot.

plot( x^2, x=-2..2, labels=["Time","Growth"]);
A basic plot, with axis labels.

You can control where plots are drawn by choosing Options->Plot Display->Inline or Window.  Either
way, if you select a plot with the mouse, you can use the toolbar to change the rendering style, axes, and
lighting.

To copy a plot to the clipboard (as a graphics file), right-click (or Option-Click for Mac users) on the plot
and select Copy.

Look into these commonly used plotting commands:

textplot, textplot3d Draw text anywhere in a plot
display Display several plots at once
animate, animate3d Adds a dimension of time to your plot.
plotoptions Various options, including line weight, color, sampling, etc.

Further Reading
For further guidance as a new user, try the tour.  Choose Help->New User's Tour.

Other sources of information include:
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The UITS Knowledge Base●   

UITS Education Program●   

Software Manual Locations●   

If you are affiliated with Indiana University, you may also get use Stat/Math Consulting .●   

Permission to use this document is granted so long as the author is acknowledged and notified.
Please send comments and suggestions to:statmath@indiana.edu

Copyright 1995-1999, Indiana University.
Last modified: Wednesday, 01-Mar-2000 16:42:46 EST

URL /~statmath/math/maple/gettingstarted/printable.html
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Finding your way around the window

The Toolbar

First of all, locate the toolbar at the top of the window.  On Windows, it looks like this:

Other operating systems have a similar toolbar.

Every time you work with maple, you will use a "worksheet".  The worksheet is the big, blank area in 
the middle of the screen. You may have more than one worksheet open at a time.  The following 
toolbar buttons let you work with the worksheet.

 

The first five buttons on the toolbar, in order, do the following: open a new, 
blank worksheet; open an existing worksheet; open a hyperlink; save the 
current worksheet; and print the current worksheet.

The next three buttons are the standard cut, copy, and paste functions.

The next two buttons let you "undo" and "redo" your last action.

The next three buttons let you manage what "mode" Maple is currently in.  The 
standard mode is represented by the capital Sigma button. This means that 
anything you type will be considered to be mathematical input.  If you click the 
capital T, Maple switches to Text mode. Anything you type will be considered 
as text commentary, and Maple won't try to treat it as math.  To switch back to 
math input mode, click the [> button.  Notice that the prompt in the worksheet 
window changes to let you know what mode you are in.

The next two buttons let you un-indent and indent lines in your worksheet.

The next button has a stop sign on it.  It is used as a "panic" button.  If you start 
a computation and you would like to stop, click the stop sign. (Cntl-C will also 
do this.)

The next three buttons control the amount of zoom.

The next button displays non-printing characters in the worksheet.
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The next button expands the active worksheet to fill the available space.

The last button clears all variables of their values. It is the same as typing the 
maple command 
restart;

The Kernel

The kernel is the part of Maple that does the actual calculation. The kernel is invisible, but you do 
need to know about it.  You talk to the kernel by typing mathematical statements and commands at 
the Maple prompt.  Here is an example.

If you're using a graphics-enabled browser, you'll notice that input appears in red.  Output from the 
kernel appears in blue, with variable names in italics.

The Maple prompt looks like [>.

The kernel will execute when you press the Enter key.  The kernel decides what to execute by looking 
at the current execution group. An execution group is a set of input lines connected (along the left-
hand margin) by a long, thin [.  When you press Enter anywhere in the execution group, the entire 
group is executed.  By default, each input line (along with its output) is an execution group unto 
itself.  You can join execution groups together using the F4 key, or split them apart using the F3 key.

Execution only occurs when you press the Enter key, or if you choose Edit->Execute-
>Worksheet.  Execution does not occur when you open a worksheet.

Worksheets

The worksheet is the basic unit of work in Maple, like a document in a word processor.  A worksheet 
stores every line of input and every line of output.

To save your worksheet, choose File->Save As.

To open a worksheet, choose File->Open.

You may have more than one worksheet open at a time.  However, they all share the same kernel.  So 
any work you do in one worksheet is accessible from another open worksheet.  This can lead to 
confusing results.
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Using the Help System

Maple has an extremely in-depth help system.  To access it, choose Help -> Topic 
Search.  Enter the word you are looking for (e.g., matrix) and you should see a list 
of topics.  Clicking on one will open a "help browser", a window that lets you 
wander through  related topics.  We suggest that you "surf" the help system - 
casually browse, looking at anything that seems interesting.  That way you will 
have some idea of what is available to you in the future.

If you know exactly what you need help on, you may also type (in Maple)

? simplify 

(for example) to get help on the Maple command  "simplify".

A very useful feature of the help system is the examples section. Use the Edit-
>Copy Examples menu command to copy the examples.  Then switch to your 
worksheet (or open a fresh one) and use the Edit->Paste menu command. Now you 
can execute the examples, and experiment until you are comfortable with the 
commands.
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Maple Syntax and Built-in Data 
Capabilities

Syntax

As with any computer language, Maple has its own syntax.  As a new user of 
Maple, you can save yourself a lot of head-scratching if you get to know these 
symbols.

Enter the commands given or make up similar problems.

Symbol Description Examples Sample Output

;
End-of-line.  Tells Maple to 
process the line and show the 
output.

hello; hello

:
End-of-line.  Tells Maple to 
process the line and hide the 
output.

hello:  

:=
Assignment.  Lets you assign 
values to variables.

a := 3;
a;

a := 3
3

+, - Addition, subtraction.
1 + 3;
1 - 3;

4
-2

*, / Multiplication, division
3*412;
1236/3;
7/3;

1236
412
7/3
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^, sqrt Power, square root
2^3;
sqrt(2);
2^(1/2);

8

evalf, .
Floating-point (decimal) 
evaluation

evalf(7/3);
7.0/3;

2.333333333
2.333333333

I,Pi Imaginary unit, Pi.
2 + 3*I;
(2*I)^2;
evalf(Pi);

2+3I
-4
3.141592654

%, %%
Recall the last output, recall the 
second-to-last output, etc.

%;
%%%;

3.141592654
-4

Some syntactical caveats:

●     Maple is case sensitive.  foo, Foo, and FOO are three different things. 
●     Maple requries you to show multiplication with the * character. Entering 
x*y gives the product of x and y, but entering xy gives one variable with 
the name xy. 

●     To get the constant e use exp(1). 
●     Using the % operator can give confusing results.  It always returns the last 

output from the Kernel, which may have nothing to do with where the cursor 
is (or which worksheet is active). 

●     If Maple doesn't recognize something, it will assume it is a variable. For 
example, typing i^2 will give you i2, while you may have wanted -1. 

●     You can move your cursor up to a previous line, press Enter, and the line 
will re-execute. 

●     When copying and pasting using a mouse, by sure to also highlight the 
execution group symbol ([).  If you don't, the lines will be pasted in reverse 
order due to a bug. 

●     Spaces are optional. 
●     Greek letters may be entered by spelling their name.  For example, alpha is 

always displayed as , and Gamma is displayed as  (note upper-case). 

Built-in Data Capabilities

Maple can handle arbitrary-precision floating point numbers.  In other words, 
Maple can store as many digits for a number as you like, up to the physical limits of 
your computer's memory.  To control this, use the Digits variable.
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    sqrt(2.0);
       1.414213562
    Digits := 20:
    sqrt(2.0);
       1.4142135623730950488

Maple sets Digits to be 10 by default. You can also temporarily get precision results 
by calling evalf with a second argument.

    evalf(sqrt(2), 15);
       1.41421356237310

Large integers are handled automatically.

Next: Using Symbolic Computation (Variables)
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Up: Table of Contents
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Using symbolic computation

The main feature of Maple is symbolic computation.  In other words, Maple does 
algebra. Here are some examples.

Example Output Comments

(x + y)^2; (x + y)2 A basic expression.

k := x*y + y^2; k := xy + y2

k is now an alias for 
the expression.  Note 
that k is simply another 
name for the 
expression - they are 
not equal in the 
mathematical sense.

p := k /(x+y);

You can now use k to 
refer to the expression.  
Maple immediately 
substitutes the value of 
k.

k := 'k'; k

You can unassign a 
variable by assigning it 
to its own name in 
single quotes.
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simplify(p); y

The simplify 
command does 
algebraic 
simplification.

p := x^2 - 8*x 
+15;

p := x2 - 8x  + 15
Maple doesn't mind if 
you re-use names.  The 
old value is lost.

solve(p=3,x); 2,6

Use the solve 
command to solve 
equations.  Note the 
use of the = sign.  
Here, it is used in a 
mathematical sense.  
Maple will try different 
values for x until it 
finds all of them that 
make the mathematical 
statement x2 - 8x  + 15 
= 3 true.

dpdx := 
diff(p,x);

dpdx := 2x - 8

The diff command 
differentiates an 
expression with respect 
to a variable.

int(p,x);

The int command 
integrates an 
expression.  Note that 
the constant of 
integration is left off.

subs(x=4,p);
subs(x=t^2,p);

-1
t4 - 8t2 + 15

The subs command 
substitutes expressions 
into other 
expressions. Notice 
that p's value is 
unchanged.

Each of the commands listed here has many powerful, advanced features. See the 
help files for more information.
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Use the restart; command to unassign all variables, reset built-in 
variables (such as Digits) to their original values, and unload all 
packages. Of course, this should be used with care. 

Next: Functions
Prev: Syntax
Up: Table of Contents
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Creating your own Mathematical 
Functions

We have been working with expressions so far. Maple also supports the 
mathematical notion of a function.  To define a function, you must specify a rule for 
going from one number to another. Consider the following commands:

f := x^2; f := x2
This defines f to be an abbreviation for 
the expression x2.

f := x -> x^2;
f := x -
> x2

This defines f to be a function, such that 
f(x) = x2.

f(3);
f(t);

9
t2

The function works as standard notation.

A common mistake is to write f(x) := x^2;. This does not define a 
function. Instead, it makes the four characters on the left an abbreviation 
for the three characters on the right. 

Functions are often more useful than expressions. However, many Maple 
commands (for example, diff) expect an expression as input. If f := x -> 
x^2, then diff(f,x); doesn't work. However, diff(f(x),x); will work, 
since f(x) produces the expression x2. 

To convert an expression into a function, use the unapply command.

    p := x^3 + 1;
       p := x3 + 1
    f := unapply(p, x); f(3);
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       f := x -> x3 + 1
       28

Next: Using Packages
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Using packages

When you first load Maple, it knows how to execute several different functions. For 
example, we used the evalf and simplify functions without having to load 
them first.  Maple comes with a huge number of other useful functions, bundled up 
in units known as packages.  Maple has a modular design -- not all of its functions 
are loaded at startup. The more specialized capabilities must be explicitly loaded.

For example, if you want to work with matrices and vectors, you would want to 
load the linalg package.

    with(linalg);

The output from with is a list of the new commands that you now have access to.  
If you don't want to see the list (which can be rather long), use a colon as your end-
of-line marker.

    with(linalg):

Even if you use a colon, you may see warning messages.  These usually indicate 
that a command has a new definition.  In most cases, this should not be a concern. 

Some Maple functions are not in packages; instead, they are stored in the older 
library format.  For example, to add the multivarate Taylor series function, 
mtaylor,  use the command

readlib(mtaylor);
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Go exploring among the packages.  These are some of the most 
commonly used packages: 

student
 Includes commands for use in a classroom/homework 
setting.

plots Tools for graphics, 3-d, animation, and visualization.

linalg Matrices, vectors, and many linear algebra functions.

detools Tools for working with ODEs and PDEs.

To get a comprehensive list of available packages, choose Help-
>Introduction, then browse to Mathematics->Packages->Overview. 

Next: Plotting
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Basic Plotting

Maple can produce graphs very easily.  Here are some examples, showcasing the 
basic capabilities.

plot( x^2, x=-2..2);

A basic plot.

plot( x^2, x=-2..2, y=-10..10);

A plot with vertical axis control.

plot([x, x^2, x^3], x=-
2..2);

Plot multiple expressions by 
enclosing them in brackets.

plot([sin(t),cos(t),t=0..3*Pi/2]);

Parametric plots include the plotting range in the 
brackets.
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plot3d(4-x^2-y^2, x=-
3..3, y=-2..2);

A basic 3-d plot.

smartplot3d(x^2-y^2);

Using smartplot to let maple set it's own scaling.

You can control where plots are drawn by choosing Options->Plot Display->Inline 
or Window.  Either way, if you select a plot with the mouse, you can use the toolbar 
to change the rendering style, axes, and lighting. 

To copy a plot to the clipboard (as a graphics file), right-click (or Option-Click for 
Mac users) on the plot and select Copy.

Look into these commonly used plotting commands: 

textplot, textplot3d Draw text anywhere in a plot

display Display several plots at once

animate, animate3d Adds a dimension of time to your plot.

plotoptions
Various options, including line weight, 
color, sampling, etc.

Next: Further Reading
Prev: Packages
Up: Table of Contents

Permission to use this document is granted so long as the author is acknowledged and notified. 
Please send comments and suggestions to:statmath@indiana.edu 

Copyright 1995-1999, Indiana University. 
Last modified: Monday, 25-Feb-2002 15:59:22 EST 

URL /~statmath/math/maple/gettingstarted/8.html 

http://www.indiana.edu/~statmath/math/maple/gettingstarted/8.html (2 of 2) [01/07/2002 21:26:24]

http://www.indiana.edu/


Stat/Math - Further Reading

Stat/Math Math Maple Getting Started Further Reading

Search:  In:       

Further Reading

For further guidance as a new user, try the tour.  Choose Help->New User's Tour.

Other sources of information include:

●     The UITS Knowledge Base 
●     UITS Education Program 
●     Software Manual Locations 
●     If you are affiliated with Indiana University, you may also get use Stat/Math 

Consulting . 
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{VERSION 3 0 "IBM INTEL NT" "3.0" }
{USTYLETAB {CSTYLE "Maple Input" -1 0 "Courier" 0 1 255 0 0 1 0 1 0 0 
1 0 0 0 0 }{CSTYLE "2D Math" -1 2 "Times" 0 1 0 0 0 0 0 0 2 0 0 0 0 0 
0 }{CSTYLE "2D Output" 2 20 "" 0 1 0 0 255 1 0 0 0 0 0 0 0 0 0 }
{PSTYLE "Normal" -1 0 1 {CSTYLE "" -1 -1 "" 0 1 0 0 0 0 0 0 0 0 0 0 0 
0 0 }0 0 0 -1 -1 -1 0 0 0 0 0 0 -1 0 }{PSTYLE "Heading 1" 0 3 1 
{CSTYLE "" -1 -1 "" 1 18 0 0 0 0 0 1 0 0 0 0 0 0 0 }1 0 0 0 8 4 0 0 0 
0 0 0 -1 0 }{PSTYLE "Maple Output" 0 11 1 {CSTYLE "" -1 -1 "" 0 1 0 0 
0 0 0 0 0 0 0 0 0 0 0 }3 3 0 -1 -1 -1 0 0 0 0 0 0 -1 0 }{PSTYLE "" 11 
12 1 {CSTYLE "" -1 -1 "" 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 }1 0 0 -1 -1 
-1 0 0 0 0 0 0 -1 0 }{PSTYLE "Title" 0 18 1 {CSTYLE "" -1 -1 "" 1 18 
0 0 0 0 0 1 1 0 0 0 0 0 0 }3 0 0 -1 12 12 0 0 0 0 0 0 19 0 }{PSTYLE "A
uthor" 0 19 1 {CSTYLE "" -1 -1 "" 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 }3 0 
0 -1 8 8 0 0 0 0 0 0 -1 0 }}
{SECT 0 {EXCHG {PARA 18 "" 0 "" {TEXT -1 22 "Basic Algebra in Maple" }
}{PARA 19 "" 0 "" {TEXT -1 21 "Original by Dave Hart" }}{PARA 19 "" 0 
"" {TEXT -1 24 "Updated by Clinton Wolfe" }}{PARA 0 "" 0 "" {TEXT -1 
0 "" }}{PARA 0 "" 0 "" {TEXT -1 0 "" }}}{SECT 0 {PARA 3 "" 0 "" {TEXT 
-1 29 "Basic Polynomial Manipulation" }}{EXCHG {PARA 0 "> " 0 "" 
{MPLTEXT 1 0 27 "z:=(x+y)^2 + 9*(2+x)*(x+y);" }}{PARA 11 "" 1 "" 
{XPPMATH 20 "6#>%\"zG,&*$),&%\"xG\"\"\"%\"yGF*\"\"#\"\"\"F**&,&F,F*F)F
*F*F(F*\"\"*" }}}{EXCHG {PARA 0 "" 0 "" {TEXT -1 632 "Here an algebrai
c expression has been typed. Maple reads in the\nstatement, assigns th
e right hand side to the variable z, and\n\"prettyprints\" it. The let
ters x, y, and z are here considered\nvariables; legal variables start
 with a letter and have at most 494\ncharacters. Examples of legal var
iable names are: g, G, new_term,\nx13a, and the_answer_is. Maple is ca
se sensitive, so the variables g\nand G are distinct. \n\nNotice also \+
that the line ends with a semicolon. All commands entered \nin Maple m
ust end in with a semicolon. If one is not entered at the \nend of the
 line, then Maple will wait for one to be entered on the \nnext line.
" }}}{EXCHG {PARA 0 "> " 0 "" {MPLTEXT 1 0 10 "expand(z);" }}{PARA 11 
"" 1 "" {XPPMATH 20 "6#,,*$)%\"xG\"\"#\"\"\"\"#5*&F&\"\"\"%\"yGF+\"#6*
$)F,F'F(F+F&\"#=F,F0" }}}{EXCHG {PARA 0 "" 0 "" {TEXT -1 61 "This comm
and expanded the algebraic expression assigned to z." }}}{EXCHG {PARA 
0 "> " 0 "" {MPLTEXT 1 0 4 "%^3;" }}{PARA 11 "" 1 "" {XPPMATH 20 "6#*$
),,*$)%\"xG\"\"#\"\"\"\"#5*&F(\"\"\"%\"yGF-\"#6*$)F.F)F*F-F(\"#=F.F2\"
\"$F*" }}}{EXCHG {PARA 0 "" 0 "" {TEXT -1 231 "Here, this command tell
s Maple to take the previous result and cube\nit. (The percent sign re
fers to the most recent result.) \nMaple does not expand the result. T
o see the\nmultiplication explicitly, the following command is issued:
 " }}}{EXCHG {PARA 0 "> " 0 "" {MPLTEXT 1 0 10 "expand(%);" }}{PARA 
12 "" 1 "" {XPPMATH 20 "6#,N*$)%\"xG\"\"'\"\"\"\"%+5*&)F&\"\"&F(%\"yG
\"\"\"\"%+L*&)F&\"\"%F()F-\"\"#F(\"%IR*&)F&\"\"$F()F-F8F(\"%\"*>*&)F&F
4F()F-F2F(\"$$R*&F&F.)F-F,F(\"#L*$)F-F'F(F.*$F+F(\"%+a*&F1F(F-F(\"&!G<
*&F7F(F3F(\"&%\\>*&F<F(F9F(\"%-))*&F&F(F=F(\"%U7*$F@F(\"#a*$F1F(\"%?(*
*&F7F(F-F(\"&K,$*&F<F(F3F(\"&w?$*&F&F(F9F(\"&OE\"*$F=F(\"$s**$F7F(\"%K
e*&F<F(F-F(\"&'\\<*&F&F(F3F(Fgn*$F9F(Fen" }}}{EXCHG {PARA 0 "" 0 "" 
{TEXT -1 68 "Notice that Maple does not list the elements in any speci
fic order. " }}}{EXCHG {PARA 0 "> " 0 "" {MPLTEXT 1 0 8 "sort(%);" }}
{PARA 12 "" 1 "" {XPPMATH 20 "6#,N*$)%\"xG\"\"'\"\"\"\"%+5*&)F&\"\"&F(
%\"yG\"\"\"\"%+L*&)F&\"\"%F()F-\"\"#F(\"%IR*&)F&\"\"$F()F-F8F(\"%\"*>*
&)F&F4F()F-F2F(\"$$R*&F&F.)F-F,F(\"#L*$)F-F'F(F.*$F+F(\"%+a*&F1F(F-F(
\"&!G<*&F7F(F3F(\"&%\\>*&F<F(F9F(\"%-))*&F&F(F=F(\"%U7*$F@F(\"#a*$F1F(
\"%?(**&F7F(F-F(\"&K,$*&F<F(F3F(\"&w?$*&F&F(F9F(\"&OE\"*$F=F(\"$s**$F7
F(\"%Ke*&F<F(F-F(\"&'\\<*&F&F(F3F(Fgn*$F9F(Fen" }}}{EXCHG {PARA 0 "" 
0 "" {TEXT -1 52 "Use the \"sort\" command to see it in a prettier for
m." }}}{EXCHG {PARA 0 "> " 0 "" {MPLTEXT 1 0 10 "factor(%);" }}{PARA 
11 "" 1 "" {XPPMATH 20 "6#*&),&%\"xG\"\"\"%\"yGF'\"\"$\"\"\"),(F&\"#5F
(F'\"#=F'F)F*" }}}{EXCHG {PARA 0 "" 0 "" {TEXT -1 195 "Here Maple fact
ors the previous result. Notice that the result does \nnot look like t
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he expressions previously entered. Maple will not \nalways be able to \+
return an expression to its previous form." }}}}{SECT 0 {PARA 3 "" 0 "
" {TEXT -1 25 "Operations on Polynomials" }}{EXCHG {PARA 0 "> " 0 "" 
{MPLTEXT 1 0 24 "integrate(x/(1-x^3), x);" }}{PARA 11 "" 1 "" 
{XPPMATH 20 "6#,(-%#lnG6#,&%\"xG\"\"\"!\"\"F)#F*\"\"$-F%6#,(*$)F(\"\"#
\"\"\"F)F(F)F)F)#F)\"\"'*&-%%sqrtG6#F,F3-%'arctanG6#,$*&,&F(F2F)F)F)F7
F3#F)F,F)F+" }}}{EXCHG {PARA 0 "" 0 "" {TEXT -1 208 "Maple integrates \+
x/(1-x^3) with respect to x. Because any letter used\nin a Maple sessi
on is considered a variable, you must specify with\nrespect to what va
riable differentiation and integration should \noccur." }}}{EXCHG 
{PARA 0 "> " 0 "" {MPLTEXT 1 0 11 "diff(%, x);" }}{PARA 11 "" 1 "" 
{XPPMATH 20 "6#,(*&\"\"\"F%,&%\"xG\"\"\"!\"\"F(!\"\"#F)\"\"$*&,&F'\"\"
#F(F(F%,(*$)F'F/F%F(F'F(F(F(F*#F(\"\"'*&F%F%,&F(F(*$)F.F/F%#F(F,F*#!\"
#F," }}}{EXCHG {PARA 0 "" 0 "" {TEXT -1 16 "Differentiation." }}{PARA 
0 "" 0 "" {TEXT -1 170 "The result is not exactly like the integrand, \+
but it is in a form \nsimilar enough to recognize that they are the sa
me expression.  \nSimplification is a difficult problem." }}}{EXCHG 
{PARA 0 "> " 0 "" {MPLTEXT 1 0 28 "series(exp(-x)*sin(2*x), x);" }}
{PARA 11 "" 1 "" {XPPMATH 20 "6#+/%\"xG\"\"#\"\"\"!\"#\"\"##!\"\"\"\"$
\"\"$\"\"\"\"\"%#!#>\"#g\"\"&-%\"OG6#F-\"\"'" }}}{EXCHG {PARA 0 "" 0 "
" {TEXT -1 269 "The command will find a series (either Taylor, Laurent
, or \ngeneralized) around the point x=0 if no value is given. General
ly, \nthe last term of the series will be the order term, where the or
der \nis decided by a global Maple variable which can be defined by th
e \nuser." }}}}}{MARK "2 6 0 0" 2 }{VIEWOPTS 1 1 0 1 1 1803 }
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Conferences on Applications of Computer Algebra

IMACS Sponsored

Join the ACA mailing list!

Conferences on Applications of 
Computer Algebra

Attend ACA'2002

Past and Future Conferences

●     ACA'2004 to be held at Beaumont, Texas, USA
(Quoc-Nam Tran)

●     ACA'2003 to be held in Raleigh, North Carolina, USA
(Hoon Hong, Erich Kaltofen)

●     ACA'2002 to be held in Volos, Greece (June 25-June 28)
●     ACA'2001 held in Albuquerque, New Mexico, USA (May 31-June 3)

(electronic proceedings) 
●     ACA'2000 held in Saint Petersburg, Russia (June 25-28)

(electronic proceedings) 
●     ACA'99 held in El Escorial, Spain (June 24-27)

(electronic proceedings) 
●     ACA'98 held in Prague, Czech Republic (August 9-11)

(electronic proceedings) 
●     IMACS-ACA'97 held in Wailea, Maui, Hawaii, USA (July 24-26)

(electronic proceedings) 
●     IMACS-ACA'96 held at RISC, Linz, Austria (July 17-20)
●     IMACS-ACA'95 held in Albuquerque, New Mexico, USA (May 16-19)

(electronic proceedings) 
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The ACA Working Group 

Past and Future Published Collections of ACA Papers
Note: Publication of a full article in the ACA web archive is not considered to be an archival journal 
publication, so it is proper and reasonable to also publish such an article or revised article in a journal. 

Upcoming Computer Algebra Conferences 

For more information on symbolic computing or computer algebra, consult the Computer Algebra 
Nederlands WWW server and the SymbolicNet directory at Kent State. For more information on 
computer algebra in education, consult the Computer Algebra Systems in Education (CASE) Newsletter 
page. 

Stanly Steinberg (stanly@math.unm.edu) & Michael Wester (wester@math.unm.edu) 

http://math.unm.edu/aca.html (2 of 2) [01/07/2002 21:31:20]

http://math.unm.edu/ACA/WG.html
http://math.unm.edu/ACA/publish.html
http://www-sop.inria.fr/saga/conf.html
http://www.can.nl/
http://www.can.nl/
http://www.symbolicnet.org/toc.html
http://www.dean.usma.edu/math/resource/pubs/case/index.htm
http://math.unm.edu/~stanly/
mailto:stanly@math.unm.edu
http://math.unm.edu/~wester/
mailto:wester@math.unm.edu


UC Berkeley computer algebra papers 

Here's an index to some recent and some older papers. A number of them have appeared in Proceedings 
of the International Symposium on Symbolic and Algebraic Computation (ISSAC), an annual conference 
usually co-sponsored by the Association for Computing Machinery's Special Interest Group on Symbolic 
and Algebraic Manipulation (SIGSAM), along with other cooperating organizations. If you wish to refer 
to material listed here that is not specifically marked as published, send me a note so I can tell you its 
current status. 

Rough drafts of two papers concerning code-generation from mathematical program descriptions are 
stored here: Compiling functional pipe/stream abstractions into conventional programs: Software 
Pipelines Code generation: evaluating polynomials 

Richard Fateman and Eylon Caspi: Parsing TeX into Mathematics, presented at a poster session at 
ISSAC-99 in Vancouver. Powerpoint slides for it are available as well. or look at this html slides for it 
are available as well. 

Richard Fateman and Timothy James: Analysis of a Web User Interface for Mathematics: Experiences 
with Integral Queries for TILU (Table of Integrals Look Up) , was presented at Workshop on Internet 
Accessible Mathematical Computation at ISSAC-99. See the powerpoint slides for a somewhat different 
presentation that is based loosely on the paper but shows more recent statistics and also discusses what 
we hope to do next, 

Richard Fateman: Network Servers for Symbolic Mathematics, ISSAC-97, Hawaii July, 1997. 

Richard Fateman: A review of the CD ROM version of the 5th edition of the Gradshteyn and Rhyzik 
Table of Integrals and Series. This is a (mostly negative) review of the technological transformation of a 
book to an electronic form. It could have been much better. I sent this to the SIGSAM Bulletin. There is 
in fact another version being put together by Daniel Zwillinger, taking into account some of the issues 
raised in the review. 

My current views of what computer algebra systems should do for problem solving environments 
appears in this paper recently (1999) revised for a book-length collection of PSE papers edited by E. 
Houstis and published by Kluwer Problem Solving Environments and Symbolic Computation . 

Here's a paper on the use of symbolic execution for diagnostics, and a kind of shortcut implementation 
using the "Not a Number" or NaN operands in IEEE 754 standard binary floating-point numbers: 
Symbolic Execution and NaNs: Diagnostic Tools for Tracking Scientific Computation. After sitting 
around for 8 years or so, this was presented as a poster at ISSAC-99. See the powerpoint slides for a 
somewhat different presentation that arose as I was reviewing the paper for presentation. 

Here's a paper on some work showing how one might incorporate (for example) David H. Bailey's 
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MPFUN multiprecision floating point package into Lisp: Importing Pre-packaged Software into Lisp: 
Experience with Arbitrary-Precision Floating-Point Numbers}. This will be presented as a poster at 
ISSAC-2000 (St. Andrews, Scotland UK, August, 2000). 

Why Computer Algebra Systems Can't Solve Simple Equations ACM SIGSAM Bulletin. vol. 30, no. 2, 
June 1996, Issue 116, 8-11. 

Richard Fateman and Mark Hayden: Speeding up Lisp-based Symbolic Mathematics ACM SIGSAM 
Bulletin. vol. 30 no. 1 (issue 115) March, 1996 25-30. 

A survey of Symbolic Mathematics System Evaluators appears in Proceedings ISSAC-96. Actually, this 
on-line version is 16 pages long and contains about twice as much material as was permitted for 
publication in the Proceedings. A newer (longish) version appears as a chapter in Michael Wester's 
``Computer Algebra Systems'' published by Wiley, 1999.

Ted Einwohner and Richard Fateman: Searching Techniques for Integral Tables appeared in ISSAC-95. 

H-C (Phil) Liao and Richard Fateman: Evaluation of the Heuristic Polynomial GCD appeared in ISSAC-
95. 

Richard Fateman, Kevin A. Broughan, Diane K. Willcock, and Duane Rettig: Fast Floating-Point 
Processing in Common Lisp appeared in ACM Trans. on Math. Software, vol 21 no. 1, March 1995, 26-
62.

Adam Dingle and Richard Fateman: Branch Cuts in Computer Algebra appeared in ISSAC-94. 

Benjamin Berman and Richard Fateman: Optical Character Recognition for Typeset Mathematics 
appeared in ISSAC-94. 
But you might prefer the longer, more recent, and more polished paper (with Taku Tokuyasu, Benjamin 
P. Berman, and Nicholas Mitchell) Optical Character Recognition and Parsing of Typeset Mathematics. 
that appeared Journal of Visual Communication and Image Representation vol 7 no. 1 (March 1996), 
pages 2-15. (This is the version as sent to them.) They re-typeset it by hand. 

In 1993 I attended a conference on problem solving environments (3rd IMACS International Conference 
on Expert Systems for Numerical Computing), and wrote a paper for that, relating computer algebra to 
such matters. In my view, researchers "selling" Problem Solving Environments, and the people "buying" 
for them (i.e. the funding agencies) are not particularly matched up with a commitment to computer 
algebra. I think they would rather spend money on the nearly infinite sink of parallel computing. 
Anyway, the paper has continued to grow and change. I've sent it to various places for publication, but so 
far no one has been so keen on it as to publish it. Frankly, there are lot of small neat ideas that can and 
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should be adopted by a problem solving environment. There are no revolutionary general ideas that have 
emerged. That is not to say that there are no really good specific ideas for particular tasks. Anyway, you 
can read a version of it as Problem Solving Environments and Symbolic Computing. And as previously 
noted, a more concise and recently updated version of some of the ideas, plus some new ones, appears in 
the Excerpts from a proposal to the National Science Foundation on Programming Environments and 
Tools for Advanced Scientific Computation . 

Here's a paper that influenced the Macintosh graphing program that comes with every PowerPC based 
system. This paper, Honest Plotting, Global Extrema, and Interval Arithmetic appeared in ISSAC-92. 

A serious critique of Mathematica appears in Review of Mathematica from the J. of Symbolic 
Computation (13, no. 5, May 1992) in its postscript form (instead of html), Although it is now quite a 
few years old (especially for a paper about a computer program that continues to evolve), I think a 
careful reading shows that the broad comments are still valid. 

Some people (Dec '96) on sci.math.symbolic have expressed interest in computing with 1/0. Here is a 
(previously) unpublished paper by R. Fateman and Tak W. Yan from 1994 that discusses such things: 
Computing with the Extended Rational Numbers. 

Here's a link to A Lisp-language Mathematica-to-Lisp Translator, a paper which first appeared in 
SIGSAM Bulletin 24, no. 2 p 19-21 (April, 1990). It ws also reprinted in Computer Algebra Nederland 
Nieuwsbrief 6, October, 1990. 

On the Design and Construction of Algebraic Manipulation Systems contrasts computer algebra system 
building approaches as prototype/hacker vs. mathematical-hierarchy approach. Some people feel I've 
maligned their systems in this paper because the anomalies I report have since been fixed. This was an 
invited paper presented at ISSAC-90 (Tokyo). The posted text is based on a slightly revised version 
presented to an American Society of Mechanical Engineers annual conference. The mini-proceedings, 
which by the way is an excellent collection of application articles, was edited by A.K. Noor, I. 
Elishakoff, G. Hulbert, and appears as Symbolic Computations and their Impact on Mechanics, PVP Vol. 
205, Amer. Soc. of Mech. Eng. 1990. 

Series solutions of algebraic and differential equations is an ISSAC '91 paper that discusses Newton and 
Hensel iteration in the solution of parameterized algebraic and differential equations. Newton (quadratic) 
convergence is only marginally faster than Hensel (linear) convergence because the Hensel iteration 
takes much less time per step. 

Improving Exact Integrals From Symbolic Algebra Systems is a paper with W. Kahan that appeared as 
technical report PAM 386, (1986) of the Center for Pure and Applied Mathematics University of 
California, Berkeley, The paper has changed since that time, but is in some respects still a work in 
progress. This will be presented as a poster at ISSAC-2000 (St. Andrews, Scotland UK, August, 2000) 
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Symbolic Computation of Divided Differences is a rather old paper (circa 1985, but with parts from circa 
1975) with W. Kahan that has not appeared in print. I recently successfully converted it to PDF. 
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Computer Algebra Benchmarks

Benchmark Initiative, Computer Algebra Fachgruppe of GI, DMV and GAMM

Abstract:
The initiative will discuss, develop, define, collect all facettes of this challenging problem. It should 
analyse and develop test suites but also define standard examples for the various topics of computer 
algebra where algorithm and system developer can test their newly developed and improved methods. 
Furthermore, all kinds of test examples should be collected and consolidated. 

●     Directory of Activities (new) 
●     Slides of the Meeting at ISSAC'98 

Computer Algebra Benchmarks Collection from July 1998. 

The CASBENCH Computer Algebra Benchmarks, a proposal from 1995 for the beginning of some 
computer algebra benchmarking, discussed by the Computer Algebra Fachgruppe. 

More Links:

Additional Computer Algebra WWW Pages 

CAIS der Computeralgebra Fachgruppe 

This servers homepage 

Heinz Kredel, e-mail: kredel@rz.uni-mannheim.de 

Last modified: Mon Jun 28 16:50:34 MEST 1999 
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A Critique of the Mathematical Abilities 
of CA Systems
This article can be found in Computer Algebra Systems: A Practical Guide (1999).
A PostScript version of the article (last revised January 4, 1999) [40 pages]. 

An earlier review of the same ilk is A Review of CAS Mathematical Capabilities. Also see a Comparison 
of Polynomial-Oriented Computer Algebra Systems for some timing studies. 

Results: 

Boolean Logic and Quantifier Elimination 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Set Theory 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Numbers 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Numerical Analysis 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Statistics 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Combinatorial Theory 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Number Theory 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Algebra 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Trigonometry 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Special Functions 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

The Complex Domain 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Determining Zero Equivalence 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Equations 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Inequalities 
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Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Vector Analysis 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Matrix Theory 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Tensor Analysis 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Sums 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Products 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Limits 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Calculus 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Indefinite Integrals 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Definite Integrals 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Series 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Transforms 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Axiom, 
Ordinary Difference and Differential Equations 

Axiom, Derive, Derive (ODE), Macsyma, Maple, Mathematica, MuPAD, Reduce 
Partial Differential Equations 

Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce (Heat equation) 

Operators 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 

Programming and Miscellaneous 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce (differentiation) 

Mathematics vs Computer Science 
Axiom, Derive, Macsyma, Maple, Mathematica, MuPAD, Reduce (local variables) 
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A one-page table of CAS synonyms. 
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Computer Algebra and Problem Solving 
Environments

Stanly Steinberg (stanly@math.unm.edu) 

in Comparative CAS Reviews and Philosophy, organized by Michael Wester 

Abstract:

Problem Solving Environments provide a promising new approach for solving modeling problems that 
occur in engineering and science [1]. Such environments will provide easy access to integrated symbolic 
and numeric computing and this will greatly enhance the tools available to modelers. However, this will 
place new demands on computer algebra systems. 

1.  It is important to have a true paper and pencil system. Such systems will not assume that the user 
wishes to compute something, but that the user wishes to reason about some problem and then, 
possibly later, either compute something numerically or symbolically. The attitude of "I know the 
chain rule and will use it if I can" must be replaced by a system that can apply the chain rule in the 
standard way, or apply it in reverse, and have tools for helping decide which is appropriate. 
Clearly, heuristic reasoning systems are critical. 

2.  Computer algebra systems should be able to write both numerical and symbolic programs in their 
own language. It will then be a relatively simple matter to translate such programs to other 
languages. In some sense this can be done in all CASs, but the available utilities are not helpful. 
This will be illustrated by some work the author is doing on a problem solving environment called 
SciNapse. 

3.  The geometric parts of modeling problems are typically the most difficult and the most expensive, 
so the problem solving environment must contain, or have access to, a geometric modeler. Then, at 
least for simple problems, it should be possible to answer simple questions like, is a given region 
convex? It should always be possible to compute an integral of some function over the region 
being considered and to apply Stokes' theorem to the region. 

4.  There still are important basic algorithms that are missing from CASs, for example, quantifier-
elimination algorithms. Fast "approximate" algorithms are critically needed. Good "approximate" 
algorithms for simplifying polynomial inequalities are desperately needed (these are special QE 
algorithms). 

5.  The are numerous advanced applied mathematics areas that are poorly represented in CASs. For 
example, in the early part of this century, mathematicians and physicists built an algebraic theory 
for analysis: the theory of Hilbert and Banach spaces. The fact that this theory is algebraic (and 
geometric) implies that it should be easy to implement in a CAS system, but then there is the 
question of convergence. 

6.  The online documentation should allow the user to look up any term commonly used in 
mathematics textbooks and find all relevant information in the system. This doesn't mean a list of 
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commands available. 

Some things that are done pretty well now are the basic symbolic algorithms, particularly for multivariate 
polynomials, integrals, and ordinary differential equations, notebook interfaces, equation display, 
graphics, and inter-program communication. 

[1] Future Research Directions in Problem Solving Environments for
    Computational Science, E. Gallopoulos, E. Houstis, J.R. Rice, 1991.
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The MathWorks: Developers of MATLAB and Simulink for Technical Computing

 

 
MATLAB  the language

of technical computing

Simulink  for model-based
and system-level design

Site Search:

  
Worldwide Offices:

About The MathWorks
Job openings
Press room
Downloads
Access member login
Newsletters
MATLAB Central

 
The MathWorks Announces Support for Mac 
OS X

 MATLAB Digest: May 2002

 
Logic modeling of the Simon Game Using 
Stateflow® and the Virtual Reality Toolbox

 
Training: Register today for MATLAB and 
Simulink training in New Orleans - July 15-19th

 
Seminars: Now accepting registrations for 
System-Level Design in Denver and the DC area

 

Live Interactive Webinars:
• Documenting, Testing, and Verifying Designs in 
Simulink, Aug 21st
• System-Level Design for DSP and 
Communications, July 25th

 • xPC TargetBox™ 
 • Aerospace Blockset

 • Embedded Target for Motorola® MPC555

 • SimMechanics for mechanical modeling 
 • MATLAB Excel Builder 

 • Instrument Control Toolbox 
 • Data Acquisition Toolbox 
 • xPC Target for rapid control prototyping

 • Real-Time Workshop Embedded Coder for 
production code 
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Stat/Math - Geometer's SketchPad

Stat/Math Math GSP

Search:  In:       

Geometer's SketchPad
●     Information 

❍     Availability - where to find Geometer's SketchPad 
❍     Sales - how to buy Geometer's SketchPad 
❍     Licensing - Geometer's SketchPad 

●     Support 
❍     Web Resources 

■     Geometer's SketchPad Vendor's Page 
■     Geometer's SketchPad MathForum Page 

●     See Also 
❍     Math Sites 

Permission to use this document is granted so long as the author is acknowledged and notified. 
Please send comments and suggestions to:statmath@indiana.edu 

Copyright 1995-1999, Indiana University. 
Last modified: Tuesday, 29-Feb-2000 15:11:26 EST 
URL /~statmath/math/gsp/index.html 
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Mathtools.com web site

 

For technical computing products, visit the MATLAB 
Compiler,  C/C++ Math Library, MATLAB and MatrixVB 
pages.

 

 

Mathtools.net - the technical computing portal for all 
your scientific and engineering needs - will continue to 
serve the technical computing community . 

You will automatically be transferred to Mathtools.net 
in 30 seconds. 
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Mathtools.net: The technical computing portal for all your scientific and engineering needs.

 

MATLAB 
Add-on functions, Algorithms and Data structures, Astronomy, Biology and 
Medicine, Biotechnology, Books and Tutorials, Calculus, Chemometrics, 
Compilers, Computational geometry, Control... 

Excel 
Accounting and organizers, Add-on functions, Algorithms and Data structures, 
Astronomy, Auditing, Biology and Medicine, Book Keeping, Books and 
Tutorials, Cell Tools, Chemometrics, Communication... 

Scientific C/C++ 
Algorithms and Data structures, Astronomy, Biotechnology, Books and 
Tutorials, Calculus, Chemometrics, Communication, Compilers, Compression, 
Computational geometry, Control... 

Scientific Fortran 
Algorithms and Data structures, Biology and Medicine, Biotechnology, Books 
and Tutorials, Calculus, Chemometrics, Communication, Compilers, Control, 
Converters, Data Analysis... 

Scientific Java 
Algorithms and Data structures, Astronomy, Biology and Medicine, 
Biotechnology, Books and Tutorials, Calculus, Chemometrics, Communication, 
Compilers, Computational geometry, Converters... 

Visual Basic 
Add-on functions, Biotechnology, Books and Tutorials, Converters, Database, 
Editors and IDE, FAQs, Games, Jobs, Mathematics, Newsgroups... 
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Mathtools.net: The technical computing portal for all your scientific and engineering needs.

Applications and Industries 
Aerospace, Astronomy, Automotive, Biology and Medicine, Biotechnology, 
Communication, Control, Data Acquisition, DSP, Electronics, Finance and 
Economics... 

Learning and Education 
Books and Tutorials, FAQs, Jobs, Newsgroups, Newsletters, Reference and 
documentation, Seminars Conferences and Tradeshows, Training and Courses, 
Universities... 

 

 

New additions | Add Link | Feedback | Privacy | Trademarks | Powered by The MathWorks

Copyright © 2002 MathWorks, Inc. All rights reserved. 
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Home

Improving math skills with the aid of technology ...

! Sale 
Items

New! 

The Mathematical 
Explorer.

from the makers 
of Mathematica

MathType 5. 

easily transform 
documents into web 
pages

Derive 5 a Mathematical Assistant

the popular symbolic 
algebra program.

Math software should be useful and thought- provoking as well as an aid to the 
teacher who wants to challenge students. Derive 5, Mathematica, Mathpert Plus, and 
Scientific Notebook represent creative and intelligently designed software that can be 
used to learn algebra, trig, pre-calculus, and calculus. 

We also have a collection of books for use with the TI graphing calculators (TI-82, 83, 
83 plus, 85, 86, 89, and 92). We welcome questions and suggestions so contact us at 
info@mathware.com.

Shop on-line . . . 

Enter a secure site and enjoy the convenience of shopping for educational 
software and books.

Check out prices on our Sale items click here.

http://www.mathware.com/ (1 of 3) [01/07/2002 21:40:50]

http://www.mathware.com/index.html
http://www.mathware.com/Books/books.html
http://www.mathware.com/Software/software.html
http://www.mathware.com/Ordering/ordering.html
http://www.stores.yahoo.com/mathware/saleitems.html
http://www.stores.yahoo.com/mathware/saleitems.html
http://www.mathware.com/html/explorer.html
http://www.mathware.com/html/explorer.html
http://www.mathware.com/Software/MathType/mathtype.html
http://www.mathware.com/Software/Derive/derive_5.html
mailto:info@mathware.com
http://www.stores.yahoo.com/mathware
http://www.stores.yahoo.com/mathware/saleitems.html


Home

Derive Version 5

Derive, the popular symbolic algebra program, has taken 
the next step with significant mathematical, 
programming, and graphic improvements. 

Mathpert Plus:  A  powerful tool for teaching and learning 
math for both Mac and Windows.

Mathematica: A special pre-college  
teacher's edition and student version. 
New book to accompany Mathematica 
Version 4. 

Mathtype: The best thing for writing 
equations since chalk. Site license 
pricing now available for  K-12, 
Community College, and Universities

Scientific Notebook: New version 3.5! A word processor and 

math processor all in one with an easy to use interface. 

 

 

NEW! Calculus WIZ: Interactive software 
designed for students looking for a homework 
partner for their first, second, and third 
semester calculus courses 

Also, books to accompany the TI calculators. 
Look for the shopping cart icon to buy your 
selection on-line. 

New Electronic books for Mathematica, the TI-89 and the TI-92.

New Mathematica Book 
New Catalog available !
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Home

MathWare, Ltd.
P.O. Box 3025
Urbana, IL 61803

EMail:  info@mathware.com
Webmaster: info@mathware.com

Copyright ©1997 MathWare.Ltd.  
Phone: 800-255-2468
Fax: 217-384-7043
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Webserver

ERROR
The address www.rrz.uni-koeln.de is not used as webserver. Please use www.uni-koeln.de instead. 

The full URL is http://www.uni-koeln.de/REDUCE/. 

http://www.rrz.uni-koeln.de/REDUCE/ [01/07/2002 21:41:14]
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Magma Computational Algebra System Home Page

The Magma Computational Algebra 
System 

for 

Algebra, Number Theory and Geometry

Magma is a large, well-supported software package designed to solve computationally hard problems in 
algebra, number theory, geometry and combinatorics. It provides a mathematically rigorous environment 
for computing with algebraic, number-theoretic, combinatoric and geometric objects. 

Recent Notices: 

May 2002: Magma version 2.9 is ready for export. See Release Notes 2.9 for the release notes. 

About Magma 

What's New 

Magma on-line help 

FAQ 

Links 

How to get Magma 

Special Offers 
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Magma Computational Algebra System Home Page

Contact Us 

Download Magma (Registered Users Only) 

Change Password (Registered Users Only) 

Magma is produced and distributed by the Computational Algebra Group within the School of 
Mathematics and Statistics of the University of Sydney. 
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f(z)

f(z) - The Complex Variables Program

"For people who love mathematics."

f(z) is a graphics program for Windows and Win95 that puts the world of complex variables at your finger tips - with absolutely no 
programming! 

Single copies of f(z) are $135.00. (Site licenses are available. Call or e-mail for pricing.)

Download a free Demo version of f(z)!

f(z) and the literature. See a list of Complex Variables textbooks that refer to f(z).

These examples show just some of the ways you can use f(z).

●     1/z (Linear fractional transformations)
●     Symmetry in the exponential
●     Exponential in four dimensions (Riemann surfaces too)
●     The logarithm
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Math Forum: Page moved

The page 

http://forum.swarthmore.edu/~fgi/

has been moved to 

http://www.futuregraph.com/

Please update your bookmarks. If you followed a link from another website, 
please tell us where you came from so we can inform them of the change.

http://forum.swarthmore.edu/~fgi/ [01/07/2002 21:43:00]
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Logic Software from CSLI 

 

Logic Software from CSLI
By Jon Barwise and John Etchemendy

Prospective Users

The award-winning text/software packages described here -- 
Hyperproof, The Language of First-order Logic, Tarski's 
World and Turing's World -- are all published by the Center for 
the Study of Language and Information and distributed by 
Cambridge University Press. Click here for ordering information. 

 We also have an exciting text/software package for use in 
introductory logic courses. Language, Proof and Logic is 
published by CSLI Publications, where individual or examination 
copies may be ordered. 

Current Users

If you already own any 
of these packages, 
click here for up-to-
date version 
information and other 
information of interest 
to current users. We 
welcome your 
comments, suggestions 
or questions. 

 Turing's World 
users: There's a new 
six-state Busy Beaver 
candidate. 

 We also have a 
text/software package 
for use in introductory 
logic courses. 
Language, Proof and 
Logic is published by 
CSLI Publications, 
where individual or 
examination copies 
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Logic Software from CSLI 

may be ordered. 

Educom Medal 

Barwise and Etchemendy were awarded the 
1997 Educom Medal for the innovative 
software described on this page. A 
description of the Educom Medal Awards 
Program is available at the EDUCAUSE 
site, created by the 1998 consolidation of 
CAUSE and Educom.

 

Paper Available

If you would like to 
read a 1996 paper by 
Barwise and 
Etchemendy 
explaining why they 
developed this 
software and how it 
has changed their view 
of logic, check out 
"Computers, 
Visualization, and the 
Nature of Reasoning." 
You will need Adobe's 
Acrobat Reader to read 
this file. 

Hyperproof 

 

Hyperproof is a system for learning the principles of analytical reasoning and proof construction, 
consisting of a text and a Macintosh software program. Unlike traditional treatments of first-order logic, 
Hyperproof combines graphical and sentential information, presenting a set of logical rules for 
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Logic Software from CSLI 

integrating these different forms of information. This strategy allows students to focus on the information 
content of proofs rather than the syntactic structure of sentences. It also reflects the heterogeneity of 
information encountered in everyday reasoning. 

Using Hyperproof the student learns to construct proofs of both consequence and non-consequence 
using an intuitive proof system that extends the standard set of sentential rules to incorporate information 
represented graphically. Proofs of consistency and inconsistency are also covered as well as 
independence proofs. The Hyperproof software checks the logical validity of each type of proof. 

Hyperproof is compatible with various natural-deduction-style proof systems, including the system used 
in the authors' The Language of First-order Logic. 

"Hyperproof is wonderful! With it you can construct and check proofs in an expanded 
version of the language of Tarski's World. And there is more, much more, another whole 
dimension. Hyperproof lets you use pictorially-presented information and pictorially-
oriented deduction techniques, in combination with sentences and syntactic rules, to reason 
about its block worlds. It is an extraordinarily impressive programming achievement. 
Hyperproof will make learning first-order logic enormously more fun." --Carl Ginet, 
Cornell University

Hyperproof is designed to be used in a first course in logic. Since it presupposes familiarity with the 
program Tarski's World , it should be used in tandem with either the textbook The Language of First-
order Logic or the stand-alone version of Tarski's World (Tarski "Lite"). Hyperproof is currently 
available only for the Macintosh. 

  Ordering information  Show me Hyperproof 

 [Top | Hyperproof Table of Contents | Information for current users | Acknowledgements]  

The Language of First-order Logic (Mac or PC) 
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The Language of First-order Logic presents a new approach to teaching first-order logic. Taking 
advantage of the accompanying program Tarski's World, the text skillfully balances the semantic 
conception of logic with methods of proof. The book contains eleven chapters, in four parts. Part I is 
about propositional logic and Part II covers quantifier logic. Part III contains chapters on set theory and 
inductive definitions. Part IV contains advanced topics in logic, including topics of importance in 
applications of logic in computer science. The Language of First-order Logic contains hundreds of 
problems and exercises. 

An instructor's manual and instructor's disk are available to accompany this book. The instructor's 
manual, written by Ruth Eberle, provides a wealth of material to make grading exercises and teaching 
from the text easier. The instructor's disk allows you to grade most of the Tarski's World problems 
automatically, directly off the student's disks. It is possible to grade both IBM PC and Macintosh disks 
using the Macintosh version of the program. 

"[The Language of First-order Logic] is packed with interesting exercises and problems 
which make imaginative use of [Tarski's World]. This is an excellent package and we 
recommend it highly as the basis of either a complete first course in logic or as an initial 
part of such a course." --Doug Goldson, Steve Reeves and Richard Bornat, University of 
London

"The Language of First-order Logic and Tarski's World redress one of the main 
shortcomings of traditional beginning-level logic texts which emphasize the formal aspects 
of logic and pay scant attention to semantics. Tarski's World sets a high standard for 
those who follow." --Kevin Compton, Journal of Symbolic Logic.

"The emphasis throughout is on the user doing logic by working the many problems in the 
text. Recommended unreservedly as a fascinating approach to a fascinating subject." --R. J. 
Wernick, Choice

The Language of First-order Logic comes packaged with the program Tarski's World. Since 
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Hyperproof uses an extension of the natural-deduction-style proof system taught in The Language of 
First-order Logic, it can be used to accompany this text. The Language of First-order Logic is 
available in versions for Macintosh and Microsoft Windows. A version of the software for computers 
running NeXTstep is also available. To receive it, purchase a copy of either the Macintosh or Windows 
version and follow the instructions contained in the book. 

  Ordering information  Show me Tarski's World 

 [Top | LOFOL Table of Contents | Information for current users | Acknowledgements]  

Tarski "Lite" (Mac or PC) 

  

  

Tarski's World is an innovative and enjoyable way to introduce your students to the language of first-
order logic. Using this program students quickly master the meaning of the connectives and quantifiers, 
and soon become fluent in the symbolic language at the core of modern logic. Tarski's World allows the 
students to build three-dimensional worlds and to describe them in first-order logic. They evaluate the 
sentences in the constructed worlds and if their evaluation is incorrect, the program provides them with a 
game that leads them to understand where they went wrong. 

Tarski's World is available in two ways, either alone (called Tarski's World 4.0 or Tarski "Lite") or 
as part of the logic textbook/software package called The Language of First-order Logic. 

Tarski "Lite", the stand-alone package, is intended as a supplement to any standard logic text or for use 
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by anyone who wants to learn the language. The disk and manual contain over a hundred exercises from 
very basic to highly sophisticated. 

"If you have had a small amount of experience with a Macintosh and enjoy logical matters, 
then you will almost certainly enjoy using (or just playing with) this software for the Mac." 
--George Boolos, Journal of Symbolic Logic

"The authors are pioneers. [Tarski's World] is the only program that I know for teaching 
first-order semantics, and it sets a high standard. I warmly recommend it." --Wilfrid 
Hodges, Queen Mary College

Tarski "Lite" is available for Macintosh or Microsoft Windows. A version of the software for 
computers running NeXTstep is also available. To receive it, purchase a copy of either the Macintosh or 
Windows version and follow the instructions contained in the book. 

  Ordering information  Show me Tarski's World 

 [Top | Tarski "Lite" Table of Contents | Information for current users | Acknowledgements]  

Turing's World 

 

Turing's World is a self-contained introduction to Turing machines, one of the fundamental notions of 
logic and computer science. The text and accompanying diskette allow the user to design, debug, and run 
sophisticated Turing machines in a graphical environment on the Macintosh. 
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Turing's World introduces users to the key concepts in computability theory through a sequence of over 
100 exercises and projects. Within minutes, users learn to build simple Turing machines using a 
convenient package of graphical functions. Exercises then progress through a significant portion of 
elementary computability theory, covering such topics as the Halting problem, the Busy Beaver function, 
recursive functions, and undecidability. 

Version 3.0 is an extensive revision and enhancement of earlier releases of the program, allowing the 
construction of one-way and two-way finite state machines (finite automata), as well as nondeterministic 
Turing and finite-state machines. Special exercises allow users to expore these alternative machines. 

"Turing's World is a delight.... I heartily recommend [it]." --James Moor, Teaching 
Philosophy

"Turing's World quite literally revolutionizes the way the fundamental theoretical issues 
of computing can be taught." --Keith Devlin, The Guardian

"There is not the slightest hint of jargon anywhere in [Turing's World]. The explanations 
are so direct that a beginner will understand them and an old hand will enjoy them." --
Wilfrid Hodges, Queen Mary College

"The program and manual are the best introduction to Turing machines the reviewer knows 
of, or can imagine." --George Boolos, Journal of Symbolic Logic

 Ordering information  Show me Turing's World 

 [Top | Turing's World Table of Contents | Information for current users | Acknowledgements]  

 John Etchemendy (left) and Jon Barwise (right) 
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Jon Barwise is a professor of philosophy, mathematics, and computer science at Indiana University in 
Bloomington. His email address is barwise@cs.indiana.edu. 

John Etchemendy is a professor of philosophy and symbolic systems at Stanford University. His email 
address is etch@csli.stanford.edu. 

  

Stanford Home Page  CSLI Home Page;  

CSLI Publications Home Page   
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Math Archive Removed

----------------------------------------------------
The Math archive has been removed from wuarchive.  

Please go to the source, which is up-to-date:
        http://archives.math.utk.edu/   

Saturday, February 23, 2002
-dpd (David P. Discher)

----------------------------------------------------
Return-Path: 
Date: Sat, 23 Feb 2002 16:23:49 -0500 (EST)
From: Larry Husch 
To: "David P. Discher" 
Subject: Re: Mathematics Archives at WUARCHIVE.wustl.edu
Message-ID: 
MIME-Version: 1.0
Content-Type: TEXT/PLAIN; charset=US-ASCII

David-

Yes, this is quite out of date.  You can remove the mirror.

Best,
Larry

On Sat, 23 Feb 2002, David P. Discher wrote:

> 
> 
> It appears that the "Mathematics Archives" has a mirror at
> wuarchive.wustl.edu at the following URL:
> 
>     ftp://wuarchive.wustl.edu/edu/math/
> 
> Wuarchive has recent changed over control to the Computer Science Department
> from the central network authority at Washington University in St. Louis,
> MO. This math archive seem out-of-date, and possibly not necessary anymore.
> 
> I would ideally like to remove this mirror as it seems like you may already
> have suitable hosting resources. Please advise our your current use of
> wuarchive and needs.
> 
> Thank you.
> 
> -- ****************************************************************** --
> | David P. Discher           * (314) 518-3795      *  |
> |   * AOL/MSN: "DavidDPD" * ICQ:4222899       |
> -- ****************************************************************** --

http://wuarchive.wustl.edu/edu/math/ (1 of 2) [01/07/2002 21:46:50]
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> 
> 

-- 
------------------------------------------------------------------------
Larry Husch                phone: 865-974-4162    fax: 865-974-6576
Mathematics Department     
University of Tennessee    Co-Director, Mathematics Archives
Knoxville, TN 37996-1300   http://archives.math.utk.edu/
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Downloadable Software from the Geometry Center

Register: Tell Us What You Think
Up: Software Projects at the Center

Downloadable Software:
Part of the mission of the Geometry Center is to develop software tools to support the computation and 
visualization of mathematics. A considerable portion of the Center's efforts have gone to designing such 
tools, and to making them available to the mathematical and scientific communities, and to the world at 
large. 

With the exception of WebEQ, the packages listed below may be obtained free of charge, but, unless 
otherwise stated, are subject to our copyright statement. A free evaulation copy of WebEQ is available, 
but it is commercial software, and is subject to its own licensing terms. 

Binaries can be downloaded for the architectures listed in parentheses. 

Main Attractions: 

●     WebEQ 2.2: Full-featured Java software suite for creating and displaying interactive math 
equations. The most powerful, complete MathML implementation available. (Win 95/NT, MacOS, 
most Unix) 

●     HTML2LaTeX: A Perl script that converts an HTML file (with WebEQ applets) into a LaTeX2e 
file. (source) 

●     Geomview: 3D object viewer (SGI, Sun, NeXT, HP, Linux, IBM RS/6000, Dec Alpha, source) 
●     StageTools: Geomview animation tools (TCL/TK code and documentation for Geomview 

external modules) 

For an interactive use of a Java version of Geomview, go to ScienceU 

●     Orrery: Solar System Visualizer (requires Geomview)

For an interactive web Orrery, Night Sky planetarium and more, go to ScienceU 

●     Evolver: Surface evolver (unix, Mac, Windows, DOS, source) 
●     Snappea: Hyperbolic manifold analyzer (Mac, OS/2, Win95) 
●     qhull: Computes convex hulls, Delaunay triangulations, Voronoi diagrams, and halfspace 

intersections (source, Win32, Mac) 
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●     KaleidoTile: Creates tilings of the sphere, plane, or hyperbolic space (SGI, Mac) 
●     Kali: 2D symmetry pattern editor (Java/source, Mac binaries, SGI source/binary) 

For more about tilings and symmetry, go to ScienceU 

●     IDVI: Java DVI viewer (java, source) 
●     W3Kit: World-Wide Web application builder (SGI, Sun, source) 
●     WebOOGL: Integrates 3D graphics with the World-Wide Web (SGI,Sun,source) 
●     Mpeg_play: Animation player (SGI, Sun, HP, Dec Alpha) 

More Software from the Geometry Center
Directory of Computational Geometry Software on the Web
A Brief Guide to Tiling Software on the Web

The Geometry Center FTP archive 

Register: Tell Us What You Think
Up: Software Projects at the Center

 The Geometry Center Home Page 

Comments to: webmaster@geom.umn.edu
Created: Feb 27 1995 --- Last modified: Tue Apr 28 00:00:11 1998 
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Fermat, Computer Algebra System

Above graphic created with the float version of Fermat. 

(For best viewing, set your monitor to at least thousands of colors.)

Fermat is a computer algebra system for Macintosh and Windows by me, Robert H. Lewis of 
Fordham University, that does arithmetic of arbitrarily long integers and fractions, symbolic 
calculations, matrices over polynomial rings, graphics, and other numerical calculations. It is 
extremely fast and extremely economical of space. The main version that I care most about is 
oriented toward polynomial and matrix algebra over the rationals Qand finite fields (hence the 
name "QFermat"). On the Mac side, there are versions that run under MPW for 68K Macs and 
stand-alone versions for PPC. There is also a "float" version for graphics. All versions are 
available here.

Fermat is a state-of-the-art research tool for real problems. 

http://www.bway.net/~lewis/ (1 of 10) [01/07/2002 21:52:42]
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See for example: 

 Compare Your Computer Algebra System. Take 
the Fermat Tests!

There are now three tests. One test involves evaluation of rational functions, the second involves 
Smith Normal Form, the third resultants. 

 Fermat Very Impressive in Comparison of 
Computer Algebra Systems

Look at this preprintof a comparison of small polynomial-oriented computer algebra systems. 
This paper appeared in the SIGSAM Bulletin in January 2000. 

 New HTML and PDF Versions of the Manuals

There are revised (January 20, 2002) HTML versions of the QFermat manual, for both Windows 
and Mac, and of the FFermat manual (FFermat, the float version, is Mac only). In addition, there 
are revised pdf versions of the manuals. See below. 

 Version 2.6.4 is here, January 20, 2002. 
       Improved Polynomial gcd algorithms. Excellent 
interface for Windows.

Fermat version 2.0 was a major overhaul (click here to see the changes that were made then, in 
February 1998). The 2.2 revision for both Mac and Windows had vastly improved Smith Normal 
Form procedures. The graphics version added color graphics capabilities. 2.4 added new matrix 
functions for large powers and LU decompositions. 2.5.x speeds up rational number arithmetic 
and integer division. 2.6.0 has massive revisions and new features, mostly concerning sparse 
arrays. New builtin functions, new sparse array functions, significant speedups of many kinds. 
2.6.2 has significant improvements in Pseudet, SDivide, and storage management in general. The 
Windows version has a great new interface, a Viewer to replace the crude DOS window. 2.6.3 and 
2.6.4 are mostly concerned with even faster polynomial gcd algorithms, thereby speeding up 
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almost all computations. More details on revision history are here. 

 Fermat for Windows95/98/NT/whatever. 

 Macintosh Downloading Instructions 

 Fermat FAQ frequently asked questions. 

 Why should I use this system? 

Because it works. Fermat has proven to be extremely good at what it does. If you tackle real 
problems with computer algebra you have probably found that some well known systems are too 
slow, use too much space, crash too often, or have weird limitations built into them. If all you do 
is make up examples for your undergraduate students, you probably don't need Fermat. If you try 
to compute the characteristic polynomial of a 400 X 400 matrix over Q, you need Fermat or 
something like it. Time and again, Fermat has bested the well known expensive systems in both 
time and space, often by enormous, almost unbelievable, ratios. Look at this paperthat later 
appeared in the SIGSAM Bulletin. 

Fermat is especially good at polynomial and rational function arithmetic; Smith normal form 
(extended and improved with version 2.6, December 2000); determinant, normal forms, and 
inverse of matrices with multivariate polynomial entries over Z, Q, Zp, finite fields, or more 
complex fields; sparse matrices; characteristic polynomials; and gcd of multivariate polynomials 
over Z, Zp, or finite fields. In addition, I have striven to make it easy to use. For example, in the 
Mac version it is very easy to edit the output of Fermat (on the screen) and make it the input. This 
is a great boon in experiments with matrices. Extensive facilities exist for saving data to files and 
reading such data. Fermat has the ability to be interrupted and then later return to the computation, 
picking up where it left off. On the Mac side, this is very useful if you are running a long program 
on your home computer and your five year old daughter wants to use KidPix. With 
Windows95/98/NT, the operating system itself makes some of this possible -- but not all. 

To retrieve the two ReadMe files click here and here. 
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The ReadMes contain the latest update information, especially the second one. The first one has 
some history. The second is about the Mac PPC versions and the Windows version. 

 Fermat Features Summary 

To get a quick idea of the polynomial and matrix features of QFermat (the rational version), look 
at this html version of Appendix 4of the Windows manual. If you viewing on a Mac, you need to 
go to the "View" menu of your browser, then under "Character Set" set it to "Western(Mac 
Roman)." (Apparently, on a PC there is less choice so no need to do this. I don't know what 
happens on UNIX.)

 Fermat in Actual Use 

Some research projects that used Fermat -- and needed it! 

Brumer, Armand. "The Rank of Jo(N)," Asterisque 228 (1995) p. 41-68.

Lewis, Robert H. and Peter F. Stiller, "Solving the recognition problem for six lines using the 
Dixon resultant," Mathematics and Computers in Simulation 49 (1999) 205-219. download pdf 
version.

Lewis, Robert H. and George Nakos, "Solving the Six Line Problem with Resultants," presented 
to the "Grand Challenges" session at IMACS, Prague, August 1998. 

Lewis, Robert H. "The Six Line Problem and Resultants," presented to the "Grand Challenges" 
session at IMACS, Hawaii, July 1997. 

Lewis, Robert H. and Guy D. Moore. "Computer Search for Nilpotent Complexes," Experimental 
Mathematics 6:3 (1997) p. 239-246.

Lewis, Robert H. and Sal Liriano. "Isomorphism Classes and Derived Series of Almost-Free 
Groups," Experimental Mathematics 3 (1994) p.255-258. 
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 The Manual

HTML versions of the QFermat manual for both Mac and Windows are available, and of the 
FFermat manual (FFermat, the float version, is Mac only). They were produced from the TeX 
versions by the program TTH (TeX to HTML), http://hutchinson.belmont.ma.us/tth/. You can 
find the Mac manual here and the Windows manual here. The FFermat Manual is here. 

PDF: In addition there are now pdf versions of all three Windows and Mac manuals. They contain 
all the graphic images and are much more convenient than earlier postscript or dvi versions of the 
manual. 

 Download the Windows manual. 

 Download the Mac manual. 

 Download the FFermat manual. 

 Update History 

January 20, 2002: Version 2.6.4. Significant speedups in polynomial gcd, up to 50% saved on 
some benchmark problems. The Macintosh MPW version, which works under MPW on 68K 
Macs, no longer requires an fpu or a math coprocessor chip. This also makes it easy to use on PPC 
Macs (any Mac bought in the last five years or so), as a software fpu is no longer required. See the 
second ReadMe. 

October 15, 2001: Version 2.6.3. Modularmode (i.e., ground ring Z/p) is now implemented for 
modulus up to 2^24 - 1 = 16,777,215. The limit had been 2^16 - 1 = 65535. Improved the speed 
of polygcd by handling content better. Removed a few annoying features of saving data to a file. 
See the second ReadMe. 

July 13, 2001: New improved Viewer for Windows95/98/whatever. Full support for change of 
fonts, non-ASCII characters. The Windows interface is now better than the Mac interface, thanks 
to Bill Hastings of Fordham University. 

June 24, 2001: All Version 2.6.2 manuals now available. See above. 

June 20, 2001: Version 2.6.2. New Viewer interface for the Windows version, otherwise mostly 
geared towards memory management efficiency. See the second ReadMe. 

March 22, 2001: Version 2.6.1. Fixed a small bug in 2.6.0. for-loops wouldn't parse when a third 
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control value for indexing was present. New toggle switch command &b. When set, if a syntax 
error occurs when reading a file, the file is closed immediately. This makes it easier to return to a 
word processor and edit the file. 

January 30, 2001: New revised manuals (pdf and html) for version 2.6.0 of QFermat and 2.1 of 
FFermat now on the web site. See above. 

December 28, 2000: Version 2.6.0 of QFermat. Massive revisions and new features, mostly 
concerning sparse arrays. None of these are documented in the manuals. New builtin functions 
Equal and Equalneg, new sparse array functions Minors and Rowreduce, significant speedups of 
many kinds. See the second ReadMe. 

September 5, 2000: Version 2.5.8 of QFermat. A few small new features. Fixed some small bugs 
in all versions. Fixed some more annoying problems in the Windows version. See the second 
ReadMe. 

August 28, 2000: Version 2.5.7 of QFermat. Fixed two bugs in multivariate polynomial gcd. See 
the second ReadMe. 

August 3, 2000: small patch to 2.5.6 of QFermat for Windows. The parser would fail at times to 
recognize the keywords Trans and Diag. The Mac version is unaffected. 

June 14, 2000: Version 2.5.6 of QFermat. Sped up integer division and fixed a few small bugs. 
See the second ReadMe. 

February 12, 2000: Version 2.5.5 of QFermat. Changed the syntax of booleans, comments, and 
some loops in the Mac version to match the Windows version. Added flexibility to characteristic 
polynomial for sparse matrices. See the second ReadMe. 

September 29, 1999: Version 2.5 of QFermat. Some small improvements, including speed up of 
rational number arithmetic by improving the integer gcd algorithm. See the second ReadMe. 

May 9, 1999: PDF (Adobe Acrobat) version of the Mac manual. 

May 4, 1999: Added a very complete HTML version of the FFermat (float version) manual. See 
this page. 

April 27, 1999: Changed the names of the auxiliary files in the Windows version to conform to 
the DOS standard "eight characters dot three." Then put it all in a zip archive. Some people had 
trouble with the previous names, which were more than eight characters. 
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Fermat, Computer Algebra System

April 11, 1999: PDF (Adobe Acrobat) version of the Windows manual. 

April 6, 1999: Version 2.4 of QFermat for Mac and Windows, with new functions MPowermod, 
for raising matrices to large powers modulo an integer or polynomial, and fraction-free matrix LU 
factorization functions FFLU and FFLUC. See the second Readme above for details. 

March 6, 1999: HTML versions of the QFermat manual for both Mac and Windows. 

December 11, 1998: Version 2.3 of QFermat for Mac and Windows, with one bug fix and a 
revision of functions Mcoef (monomial coefficient) and Mfact (monomial factor). See the second 
Readme above for details. 

October 7, 1998: Added two more challenges to the "Fermat Test" page (see above for link). 

September 30, 1998: Produced a manual specific to the Windows version. Fixed a few small 
mistakes in the Mac manual, the changes document (Mac to Windows), and the file of Windows 
examples. 

September 25, 1998: Updated the manual to reflect recent extentions to Smith Normal Form. New 
versions of the plain ASCII files, the postscript versions, etc. are on the web pages. 

September 22, 1998: Added the Fermat Test (see above for link). 

August 4, 1998: Version 2.2.1, a small revision of 2.2. Smith and MSmith now return strictly non-
negative matrices. MHermite wasn't working, so I disabled it. See the second Readme above for 
details. 

July 24, 1998: Version 2.2 of QFermat for Mac and Windows. Some bug fixes, and greatly 
improved and expanded Smith and Hermite Normal Form procedures. Sparse matrices with 
thousands of rows and columns can be handled in seconds. See the second Readme above for 
details. 

June 16, 1998: Version 2.1 of QFermat for Mac and Windows. Many bug fixes and new features. 
See the second Readme (above) for more details. The Windows version is more user friendly than 
before. 

 Legal Matters

http://www.bway.net/~lewis/ (7 of 10) [01/07/2002 21:52:42]
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This Software is provided on an "AS IS" basis, without warranty of any kind, including without 
limitation the warranties of merchantability, fitness for a particular purpose and non-infringement. 
The entire risk as to the quality and performance of the Software is borne by you. Should the 
Software prove defective, you assume the entire cost of any service and repair. This disclaimer of 
warranty constitutes an essential part of the agreement. Even if parts of the disclaimer violates 
legal rights of some jurisdiction, only these parts are invalid, but not the entire disclaimer. 

Please note that although the author plans to release enhanced versions of this software, the author 
cannot guarantee indefinite software support. 

Copyright Statement: 

This website contains a variety of copyrighted material. Some of this is the intellectual property of 
individuals as named, some is owned and copyrighted by Robert Lewis, and some is in the public 
domain. Except for material which is unambiguously and unarguably in the public domain, no 
material anywhere on this website, graphical or text, may be copied or further disseminated 
without the express and written permission of the legal holder of that copyright. This implies that 
no permission is granted for any commercial use or sale of any of this material, nor for 
transmission to electronic information and retrieval systems, nor for publication in any journal or 
compilation, written or electronic, without the written permission of the author. 

The information on this Web Page is for personal use only and is provided in good faith without 
any express or implied warranty. There is no guarantee given as to the accuracy or currency of 
any individual item on any page. Persons accessing the page who require such confirmation 
should refer enquires to Robert Lewis, who may or may not be able to provide such. Neither 
Robert Lewis nor Fordham University accepts any responsibility for any loss or damage 
occasioned by use of the information contained on the page nor from any access to the page. All 
access and use is at the risk of the user. This site provides hypertext links to a number of other 
websites as a service to users. This service does not mean that Fordham University or Robert 
Lewis endorses those sites or material on them in any way. Neither Fordham University nor 
Robert Lewis is responsible for the use of any hypertext link which may incur a commercial 
charge. Individual users are responsible for any charges that result from their use. Any user 
linking directly to pages of this website bypassing this disclaimer assumes complete responsibility 
for any resulting inappropriate use of those pages by any or all parties. 

 Register
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Fermat, Computer Algebra System

Please sign in and register to receive news of frequent updates: 

Email:

Name:

Address/Affiliation:

Comments:

  

Number of accesses to this page since 10 January 1997:  

(Linked toruses: another graphic created with Fermat)
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Fermat, Computer Algebra System

 More Comments, Questions, etc.

You can also send comments or questions to me at: 

 
rlewis@fordham.edu 

The address of this web page is http://www.bway.net/~lewis/ 
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GAP - Groups, Algorithms and Programming.

GAP - Groups, Algorithms and 
Programming. 
This is the home page of GAP at Mathematical Sciences Institute , Australian National University.

This page is no longer being maintained as of 2001. PLease refer to the UK site for the latest 
version. 

Choose the server closest to you: UK| Germany| USA| Australia 

GAP is a free system for computational discrete algebra. 

About GAP

Introduction to GAP 
Examples of GAP use 
The Authors of GAP 
...more 

Get GAP

FTP Server 
GAP 4 Distribution, bug fixes. 
GAP 4 Share Packages, 
...more 

GAP Support

GAP-Forum 
The GAP 4 manual, 
The GAP 4 mailing list, 
How to contact the GAP group 
How to cite GAP 3 and GAP 4 
...more 

GAP Miscellanea

Slides and handouts 
from some talks about GAP 

Slides from the Linz Workshop, April 1999 
GAP Events 
A GAP Bibliography 
Try GAP ... and more 

Keyword Index
Search the manuals and 
the forum

Black and White version
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GAP - Groups, Algorithms and Programming.

[Home] | [About GAP] | [Support] | [Get GAP] | [Miscellanea] |    [Index] | [Search] 

GAP Group (gap@dcs.st-and.ac.uk), 21 Dec 00 
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Groups & Graphs

  

Using G&G

FtpSite

Site Design by: 
Mike Chernecki 

 

 

 
Last update = July 9, 2001.

Groups & Graphs
      is a software package for graphs, digraphs, geometric 
configurations, combinatorial designs, and their automorphism 
groups. New in version 3.0 is support for torus maps. A new file 
structure allows the Mac and Windows versions to read and write the 
same files. Normalizer and centralizer subgroups can now be 
computed. 

Current versions

Groups & Graphs 3.1.0 for Macintosh. 
Groups & Graphs 0.9 for Windows. 

Click for info on using G&G. The overview contains sample graph, 
digraph, group, torus, and projective plane windows. It also contains 
sources of information for some of the algorithms.

Some Features of G&G 

●     Visual graph/digraph editor; 
●     Automorphism group computation; 
●     Graph certificate which identifies a graph uniquely up to 

isomorphism; 
●     Hamiltonian cycles, planarity test, planar layout, torus maps; 
●     Line graphs, neighbour graphs, bipartite doubles, distance-k 

graphs, antipodal graphs; 
●     Orbits, generators, elements of permutation groups; 
●     Block systems, commutator subgroups, stabilisers, quotient 

groups, Sylow subgroups; 
●     Cayley graphs, double cosets, normalizers, centralizers; 
●     Geometric configurations in the real projective plane; 
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Groups & Graphs

 

   Go to Bill Kocay's Home Page. 
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NTL: A Library for doing Number Theory 

NTL: A Library for doing Number Theory 

NTL is a high-performance, portable C++ library providing data structures and algorithms for 
manipulating signed, arbitrary length integers, and for vectors, matrices, and polynomials over the 
integers and over finite fields. 

●     A Tour of NTL 

●     Download NTL 

●     Trouble-shooting guide 

●     Contact Info and Mailing Lists 

●     Related Links 

Now available: NTL 5.2 

[More detailed information about recent changes] 

Back to Victor Shoup's Home Page 
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Elan Software

Solutions: A powerful symbolic math software, 
FREE!

Solutions is a mathematical windows software built for engineers and scientists. It is powerful yet 
easier and more flexible to use than your standard or your RPN calculator. Solutions will provide 
you with 20 classes of function from Algebra to Statistics. It will plot and print your work. You 
can even program it if you need more power! 

Solutions will do quick work of your calculations. All Solutions' functions work with both 
symbolic and numeric data. Numeric data can be real or complex numbers, as well as vectors and 
matrices. 

You work interactively with Solutions as with a calculator (but it is much more powerful) so you 
will use it within minutes. Solutions fully supports algebraic computations. For example, you can 
instantly compute the derivative of any equation. The answer is given to you directly or one step 
at a time so you see all the intermediate results. 

Should you need it, Solutions' programming language is simple to learn and will provide you with 
even more power for solving complex problems. It is a much quicker and efficient alternative than 
FORTRAN, BASIC or C.

Free? What's the catch?

None. Solutions was originally developped by me (Paul Dubé) when I was a student. After a 
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Elan Software

while, my friend (Louis-Marius Gendreau) and I decided to start our own software company. We 
worked 60 hours a week for 3 years to port Solutions from the Atari ST to the Windows platform, 
to complete the software and to test it. 

We really wanted to commercialize the software but we became internet providers along the way. 
This has been keeping us so busy, that we have not had the time to work on Solutions since. 
Instead of letting it gather cosmic particules on our hard drive, we think the software would be put 
to much better use by a million students and scientists! So, we have decided to give it away...

Click here to see screen snapshots as well as what Solutions can do 
for you

Download Solutions now! It's FREE!

Download Solutions! 

Solutions' official mailing list

Subscribe to the Solutions mailing list to get the latest on Solutions and to swap information and tips with 
fellow Solutions enthusiasts.

We need volunteers!... (Should you happen to become totally nuts for this program and have a little spare 
time)

Link to us! 

Include the "Download" button in your own pages. Simply insert this string:
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Elan Software

<A HREF="http://www.clic.net/Elan/">
<IMG SRC="http://www.clic.net/Elan/sol_dl.gif" ALIGN=MIDDLE><BR>
<FONT SIZE=-2>Download Solutions!</FONT></A>

If you are interested, part or all of Solutions' code may be 
licensed or sold. 

This page has been accessed  times since April 11, 1996. 

400 boul. Jean-Lesage, bur. 215 ;Québec, Québec; G1K 8W1; CANADA 
Phone: +1 (418) 529-5700; Fax: +1 (418) 529-5530 
Since Solutions is freeware, we will not answer calls for support.
elan@clic.net 

 Try Poke, the research assistant! 
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Software

Mathematics Software

3D-Filmstrip 
ACE/gr 
Addison-Wesley Interactive 
ARPACK 
Artlandia, Mathematica-based software for creating mathematical art 
Axiom (NAG) 
Aztec 
Bardware (ODEs and functional equations) 
Cami Mathematics Software 
Compass Modeling Solutions, Inc. 
Computational Fluid Dynamics (CFD codes) 
The Computational Mechanics Company, Inc (COMCO) 
Computer Algebra Information Network 
CPLEX 
Decision Tree for Optimization Software 
Derive 
Diffpack 
FEMLAB 
FElt 
Fields & Operators 
FORM 
FreeLIP (Large Integer Package) 
GAMS Development Corp. (modeling) 
GAP 
GB 
GNU-calc 
GrafEq 
Graphics and analysis software 
Guide to Available Mathematical Software 
Guide to Optimization Software 
Hermetic Systems: Mathematical Software 
HiQ technical computing environment 
IMPS, an Interactive Mathematical Proof System 
IMSL 
KANT 
LAPACK Users' Guide 
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Software

LASPack 
Learning in Motion 
Linear Programming and Nonlinear Programming FAQs 
LiveMath Maker 
A Numerical Library in C for Scientists and Engineers 
Macsyma 
Magma (U Sydney) 
UK Magma mirror (Bath) 
Maple 
MATCOM 
Mathbrowser 
Mathcad (MathSoft, Inc.) 
MatheAss 
Mathematica (wri.com) 
Mathematica Related URL's 
Mathematics Archives 
MatheMatrix, Inc. 
MathType 
MathWare 
The New Mathwright Library 
Matlab (mathworks.com) 
Matrix Market 
MGNet 
Minitab 
MODULEF (INRIA) 
Multigrid Algorithm Library 
MuPAD 
National Software Exchange 
Netlib (AT&T) 
Netlib (Univ of Tenn and Oak Ridge National Lab) 
Numerical Methods resource list 
Numerical Recipes Software (nr.com) 
Octave 
O-Matrix (Visual Data Analysis) 
Otter (ANL) 
Parallel Iterative Methods package (PIM) 
PARAMAX 
Pari 
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http://www.livemath.com/
http://www.crcpress.com/catalog/7376.htm
http://www.macsyma.com/
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http://www.mathsoft.com/browser/index.html
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Software

PEST Model Independent Parameter Optimization 
PseudoPack (Numerical differentiation by pseudospectral methods) 
PV-WAVE 
Reduce (Köln) 
Ricci 
RICHplot 
Schur 
Scientific WorkPlace, Scientific Word 
SciMath C/C++ Scientific Math Library
SENAC 
SHAPES 
SIMATH 
SLEIGN2 
Sound Waves 
Symbolic Computation Group (Maple) 
Symbolic Mathematical Software (Berkeley) 
SymbolicNet 
SYMMETRICA 
Techno-Pulsar 
Tela 
UG (Unstructured Grids) 
The UNDERSTANDING MATH Programs 
VisSim 
Visual Software Support Lab 
WWWMath Mathematica email discussion group 

Contents
Penn State Overview Page 

http://www.math.psu.edu/MathLists/Software.html (3 of 3) [01/07/2002 21:55:46]

http://gil.ipswichcity.qld.gov.au/comm/pest/index.html
http://www.cfm.brown.edu/people/wsdon/pseudopack.html
http://www.vni.com/pvwave.dir/wavehome.html
http://www.math.washington.edu/~lee/Ricci/
http://www.cs.may.ie/web/students/mq9402/RICHplot.html
http://smc.vnet.net/Schur.html
http://www.mackichan.com/
http://www.kaiwan.com/~asa/scimath.html
http://cand.can.nl/SystemsOverview/General/SENAC/
http://www.xox.com/
http://emmy.math.uni-sb.de/~simath/
http://www.math.niu.edu/~zettl/SL2/
http://www.physics.wisc.edu/~cross/FAQ/Sound_Waves.html
http://daisy.uwaterloo.ca/
ftp://math.berkeley.edu/pub/Symbolic_Soft
http://symbolicnet.mcs.kent.edu/
http://btm2xd.mat.uni-bayreuth.de/axel/symmetrica.html
http://www.orc.ru/~pulsar/
http://www.geo.fmi.fi/prog/tela.html
http://www.ica3.uni-stuttgart.de/~ug
http://www.neufeldmath.com/
http://www.ultranet.com/biz/vissim/
http://sslab.colorado.edu:2222/sw_list.html
http://library.wolfram.com/mathgroup/
http://www.math.psu.edu/MathLists/Contents.html
http://www.math.psu.edu/


Finding Your Way

4

Stat/Math Math Matlab Getting Started Finding Your Way

Search:  In:       

Finding Your Way Around the Window

●     The Command Window 
●     The Toolbar 
●     The Help System 

The Command Window

The Command window is where you can interact with Matlab directly. Try typing the following:
foo = ones(2) 
The output should look like this:

foo =

       1       1
       1       1

This represents a 2x2 matrix of ones. Matlab inserts extra blank lines between practically everything. To 
turn off this feature, type
format compact 

Unlike Maple and Mathematica, previous input lines cannot be edited. You can recall previous input 
lines by typing the "up" cursor button (similar to bash and DOSKEY).

Cutting, copying and pasting is supported using the standards for your operating system. 
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The Toolbar

Systems that support graphics have a toolbar at the top of the screen, like this: 

The buttons have the following functions: 

 
New File, Open File

 
Cut, Copy, and Paste

 
Undo last action

 
Workspace Browser. Use this to graphically edit variables.

 
Path browser. Use this to edit the paths that Matlab will look in for functions.

 
Simulink Library Browser (not covered in this tutorial).

 
Open help window.

The Help System

Unfortunately for the new user, Matlab's help system is rather primitive.

Built-in Help
If you know the name of a Matlab function you need help with, type
help function-name
to see the "helpful" information contained in the function definition itself. If you don't know the name of 
the function you need, try lookfor keyword . However, the search is very slow, and often deluges 
the user with a great many unhelpful items. In addition, a search for a concept, such as "matrix" will 
almost never return what you need.

You can get the same "helpful" information by choosing Help -> Help Window, or typing helpwin .

HTML Help
A more useful (but more difficult to access) set of help files is included in HTML. To access it, choose 
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Help->Help Desk, or type helpdesk .
This will launch your system's default web browser and open a web page. This process can fail in 
entertaining ways on UNIX systems. Even more frustrating, the system makes extensive use of 
Javascript, Adobe PDF, frames, and Java, so lynx users may wish to avoid it altogether.

While the content is essentially the same as the built-in help, it is presented in a much less hostile 
format. The Java-based full-text search and index-by-subject are two extremely useful features. In 
addition, the entire set of printed manuals is available as Adobe PDF documents. 

Most of the help files list function names in all capital letters. 
This is extremely misleading - all built-in matlab functions are in small letters. 

Next: Matlab Syntax
Previous: Introduction
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Syntax

●     How Matlab works 
●     Symbols and Punctuation 
●     Controlling Output 

How Matlab Works

Matlab works by executing the mathematical statements you enter in the command window. By default, 
any output is immediately printed to the window.

You are also allowed to assign a name to an expression for your convenience. Keep in mind that the 
name you assign is only a name, and it does not represent a mathematical variable (as it would in Maple, 
for example). Every name must have a value at all times. If you try to read the value of an unassigned 
name, you will get an error. 

Nearly everything in Matlab in a matrix, whether it looks like it or not. This takes some getting used to. 
We'll be introducing matrix-style operations along with their scalar counterparts so you can understand 
the patterns that arise in the syntax. 

Symbols and Punctuation

Matlab was designed to use fairly standard notation. Try these examples on your own computer. 

Input Output Comments
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2 + 3
7-5
34*212
1234/5786
2^5

ans = 5
ans = 2
ans = 7208
ans = 0.2173
ans = 32

Arithmetic works as 
expected. Note that the 
result is given the name 
"ans" each time.

a = sqrt(2) a = 1.4142
You can choose your own 
names for things.

b = a, pi, 2 + 3i
b = 1.4142
ans = 3.1416
ans = 2.0000 + 3.0000i

You can use commas to put 
more than one command on 
a line. Pi, i, and j are 
contants.

c = sin(pi)
eps

c = 1.2246e-016
ans = 2.2204e-016

"eps" is the current limit of 
precision. Anything smaller 
than eps is probably zero. 
Note that Matlab 
understands (and expects 
you to understand!) 
scientific notation.

d = [1 2 3 4 5 6 7 8 9]
e = [1:9]
f = 1:9

d = 1 2 3 4 5 6 7 8 9
e = 1 2 3 4 5 6 7 8 9 
f = 1 2 3 4 5 6 7 8 9

"d", "e", and "f" are all 
vectors. They are equal. 
Note the use of the ":" 
operator - it counts (by 
ones) from one number to 
the next.

g = 0:2:10
f(3)
f(2:7)
f(:)

g = 0 2 4 6 8 10
ans = 3
ans = 2 3 4 5 6 7
1 2 3 4 5 6 7 8 9

More uses of the colon. 
Note that you can use it to 
get slices of a vector (or 
matrix, or cube, etc), or get 
the whole thing.

h = [1 2 3];
h'
 
 

(nothing)
ans = 1
      2
      3

A semi-colon ";" will 
prevent the output from 
being displayed. A single 
quote " ' " computes the 
transpose of a matrix, or in 
this case, switches between 
row and column vectors.
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h * h'
h .* h
h + h

ans = 14
ans = 1 4 9
ans = 2 6 8

Operations on vectors. * is 
matrix multiplication, and 
so the dimensions must line 
up correctly. 
" .* " is entry-by-entry 
multiplication.

g = [ 1 2 3; 4 5 6; 7 8 9]
g = 1 2 3
    4 5 6
    7 8 9

Entering a matrix.

g(2,3)
g(3,:)
g(2,3) = 4
 
 

ans = 6
ans = 7 8 9
g = 1 2 3
    4 5 4
    7 8 9

Accessing matrix elements.
Note use of ":" to access an 
entire row.

g^2
 
 
g .^ 2
 
 

ans =  30  36  42
       66  81  96
      102 126 150
ans =  1  4  9 
      16 25 36
      49 64 81

The first multiplies the 
matrix by itself. The second 
squares each entry in the 
matrix.

How to Control Output

Before we go any deeper into matrices, it would be wise to mention formatting issues.

The command to know is format . 

●     To control linespacing, use format compact . 
●     To see all 15 digits that were used in calculation, use format long . 
●     To see just 5 digits, use format short . 
●     To supress output completely, use a semi-colon at the end of the command. 

To see other options, type help format . 

Note that Matlab always uses "double" precision (about 15 digits) in its calculations. These commands 
merely adjust the display.

Next: More on Matrices
Previous: Finding Your Way Around
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More on Matrices

●     More ways of contructing matrices 
●     More Matrix operations 
●     Using matrices to solve systems of equations 
●     Saving and loading matrices 

More ways of contructing matrices

Built-in Constructions
There are many built-in matrix constructions. Here are a few: 

Input Output Comments

rand(2)
 
rand(2,3)
 

ans = 0.9501 0.6068 
      0.2311 0.4860
ans = 0.8913 0.4565 0.8214
      0.7621 0.0185 0.4447

Generates a matrix with entries randomly 
distributed between 0 and 1

zeros(2)
 
ones(2)
 

ans = 0 0
      0 0
ans = 1 1
      1 1

Generates a 2x2 matrix with all zero (or all 
ones) entries.

eye(2)
 

ans = 1 0
      0 1

Identity matrix I.

hilb(3)
 
 

ans = 1.0000 0.5000 0.3333
      0.5000 0.3333 0.2500
      0.3333 0.2500 0.2000

3x3 Hilbert matrix.
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To get more information on these, look at the help page for special matrices- type help elmat .

Concatenation
New matrices may be formed out of old ones. Suppose we have
a = [1 2; 3 4]
a = 1 2
    3 4
Then we can make a new matrix in any of the following ways.

Input Output

[a, a, a]
 

ans = 1 2 1 2 1 2
      3 4 3 4 3 4

[a; a; a]
 
 
 
 
 

ans = 1 2
      3 4
      1 2
      3 4
      1 2
      3 4

[a, zeros(2); zeros(2), a']
 
 
 

ans = 1 2 0 0
      3 4 0 0
      0 0 1 3
      0 0 2 4

Programming
Matrices may also be constructed by programming. Here is an example using two "for" loops.

for i=1:10,
   for j=1:10,
      t(i,j) = i/j;
   end
end

Notice that there isn't any output, since the only line that would produce any (t(i,j) = i/j;) ends 
in a semi-colon. Without the semi-colon, Matlab would print the matrix t 100 times!

We'll cover programming in more detail later. 

More matrix operations
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As we saw earlier, +, -, *, and / are defined in an intuitive manner for matrices. When there is ambiguity 
about whether an operation will do matrix arithmetic (versus entry-by-entry arithmetic), note that ".*" 
(dot-star) will multiply entry-by-entry, and "*" (star) will do matrix multiplication.

Scalars
A scalar is just a number. Matlab stores them internally as 1x1 matrices, but treats them as if they were 
numbers.

All operation involving a scalar and a matrix affect the matrix on an entry-by-entry basis, with one 
exception: the power ("^") operator. With a as defined above, try these: 

Input Output Comments

b=2 b=2 Define b to be a scalar.

a + b
ans = 3 4
      5 6

Addition works entry-by-entry.

a * b
ans = 2 4
      6 8

So does multiplication.

a ^ b
ans = 7 10
      15 22

This is matrix power - a*a

a .^ b
ans = 1 4
      9 16

Entry-by-entry power.

Vectors
A vector is just a matrix with only one row (or column). Matlab makes a distinction between row 
vectors and column vectors, and will complain if it doesn't get what it expects. 

In all arithmetic operations, Matlab treats a vector as a matrix, so we already know how to multiply a 
vector by a scalar. Matlab also gives you the following operations: 

Input Output Comments

v = [1 2 3]
u = [3 2 1]

v = [1 2 3]
u = [3 2 1]

Define a pair of vectors.

v * u Error The dimensions don't agree.

v * u' ans = 10 Taking the transpose works.

dot(v,u) ans = 10 The dot product is the same thing.

cross(v,u) ans = -4 8 -4 The cross product works only for 3-d vectors.
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Matrices
Matlab has all the common operations built-in, as well as most of the obscure ones. 

Input Output Comments

k = 16  2  3
     5 11 10
     9  7  6

k = 16  2  3
     5 11 10
     9  7  6

Define a matrix.

rref(k)
ans = 1  0  0
      0  1  0
      0  0  1

Row-reduced echelon form

rank(k) ans = 3 The rank.

det(k) ans = -136 The determinant.

inv(k)
ans =  0.0294 -0.0662  0.0956
      -0.4412 -0.5074  1.0662
       0.4706  0.6912 -1.2206

Inverse of the matrix

[vec,val] = eig(k)

vec = -0.4712 -0.4975 -0.0621
      -0.6884  0.8282 -0.6379
      -0.5514  0.2581  0.7676
val = 22.4319       0       0
            0 11.1136       0
            0       0 -0.5455

Eigenvectors and eigenvalues 
of the matrix.
The columns of "vec" are the 
eigenvectors, 
and the diagonal entries of 
"val" are the eigenvaules.

There are many more functions like these. Type help matfun to see them all.

Solving Equations

One of the main uses of matrices is in representing systems of linear equations. If a is a matrix 
containing the coefficients of a system of linear equations, x is a column vector containing the 
"unknowns," and b is the column vector of "right-hand sides," the constant terms, then the matrix 
equation 

a x =b 
represents the system of equations. 

If you know a little linear algebra, you could use the Matlab commands from above to augment the 
matrix and then find the row-reduced echelon form. However, Matlab provides a more simple 
mechanism for solving linear equations: 
x = a \ b
This can be read "x equals a-inverse times b."
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Try it with 
a = [1 2 3; 4 5 6; 7 8 10]; b = [1 1 1]';
You should get
x = -1 1 0
To verify this assertion, try this:
a*x, a*x - b, eps
The results are:
ans = 1 1 1
ans = 1.0e-015 *
    -0.1110
    -0.6661
    -0.2220
ans = 2.2204e-016
Notice that a*x - b is very close to eps - which means that it is as close to zero as possible. 

If there is no solution, a "least-squares" solution is provided (a*x - b is as small as possible). Enter 
a(3,3) = 9; b = [1 1 0]';
(which makes the matrix singular and changes b) and enter the above commands again, using the up-
arrow to recall them. Notice that the solution is quite inaccurate.

Saving and loading matrices

Unlike Maple and Mathematica, Matlab has no notion of a "worksheet." When you exit Matlab, you 
will not be prompted to save your work.

If you would like a record of your work, you can turn on "logging" by typing 

diary 'c:\scratch\session.txt' on NT machines
diary '~/session.txt' on UNIX.

Notice that output will be saved alongside your input, so the file can't be used directly as a script.

You may just want to save one or more matrices. The diary is a very clumsy way to do this.
To save the value of the variable "x" to a plain text file named "x.value" use 
save x.value x -ascii
To save all variables in a file named "mysession.mat" in reloadable format, use 
save mysession
To restore the session, use 
load mysession
Then, to see the saved files from your session, on UNIX systems type the commands: 
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        % more session.txt
        % more x.value

Under Windows NT, open the appropriate file with Notepad. 

Next: Graphics
Previous: Syntax
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Matlab has outstanding graphics capabilities (you must be using a terminal which supports graphics to 
use them). However, graphing in Matlab is conceptually different than graphing in Maple or 
Mathematica. 

Graphics Concepts

Before looking at the plotting capabilities of Matlab, consider what a graph really is. A graph is a 
collection of points, in 2,3 or even 4 dimensions, that may or may not be connected by lines or 
polygons. Most math software packages hide this from the user by sampling a continuous function to 
generate the points.

Matlab is designed to work with matrices, rather than functions. Matrices are a convenient way to store 
a collection of numbers - which is exactly what is needed when graphing. Thus all graphing commands 
in Matlab accept matrices as their argument, rather than a function. If you are used to function-style 
plotting, Matlab may take some getting used to. On the other hand, Matlab's approach makes it very 
easy to visualize data and to create graphics based on lists of points.

Another unique feature of Matlab's graphics engine is the way in which it displays graphical output. In 
Matlab, there is (usually) only one plotting window. Subsequent plotting commands will add to the old 
plot, unless you request a new one be made. This allows a plot to be made, then adjusted later to suit 
your needs. 
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Basic 2-D Graphics

Now that you understand a bit more about graphing, try these examples. Be sure to follow along 
exactly, or you may not get the same results. 

Input Output Comments

x = -10:0.5:10;
y = x .^ 2;

(none)

Create a 1x41 matrix that counts from -10 
to 10,
and a 1x41 matrix made by squaring the 
entries of the first matrix.

plot(x,y)
Plot the points. Each pair is plotted, so 
<x(1), y(1)> is a point, <x(2), y(2)> is a 
point, etc.

t = 0:0.1:2*pi;
x = cos(t);
y = sin(t);

(none) Generate some new 1x63 matrices.

plot(x,y)
Plot the points. This is called a parametric 
plot. Notice that it replaces the previous 
plot.

t = 0:pi/5:2*pi;
u = cos(t);
v = sin(t);

(none)
Generate some new 1x11 matrices. This 
shows how to control the "resolution" of 
the plot.

figure
plot(u,v)

Create a new plot window, and plot the 
points.
Notice how jagged the circle is, since we 
only used 11 sample points.

plot(x,y, 'ro-')

Plot the hi-res version again in red, with 
circles at the data points, connected by 
lines.

plot(x,y, 'r-', u,v,'b*:')
On the same plot, plot the hi-res version in 
red, and plot the lo-res version with blue 
stars at the data points and dotted lines.
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figure
subplot(1,2,1)
plot(x,y)
title('Fine Mesh')
subplot(1,2,2)
plot(u,v)
title('Coarse Mesh')

Create a new figure.
Divide it into one row, two columns, and 
pay attention to the first cell.
Plot.
Give the current plot a title.
Pay attention to the second cell.
Plot.
Give it a title.

See the following help files for more options and ideas: help plot, help comet, help 
semilogy and help fill .

Matlab provides very powerful features in the figure window. Use the toolbar at the top to add arrows, 
lines, and text comments to your plot. 

Basic 3-D Graphics

Input Output Comments

t = -4*pi:pi/16:4*pi;
x = cos(t);
y = sin(t);
z = t;

(none) Generate the data...

plot3(x,y,z) ... and draw a helix.

[x, y] = meshgrid(-3:0.1:3,-
3:0.1:3);
z = x.^2 - y.^2;

(none)
Generate data for a surface 
plot.

mesh(x,y,z)
Draw the surface using a 
mesh.

surf(x,y,z)
Draw the surface as a 
"patched" surface.
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plot3(x,y,z)
Notice that it still plots, 
but as a set of arches.

Advanced Plotting

Of course, Matlab can do a lot more than these simple exercises. If you'd like to know more, try these 
help files:
help slice , help movie , help getframe , help graph2d , help graph3d , help 
graphics . 

Next: Programming
Previous: More on Matrices 
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How to program

Matlab statements can be prepared with any editor, and stored in a file for later use. The file is referred 
to as a script, or an "m-file" (since they must have names of the form foo.m). You may prefer to do 
this, if you use the same data repeatedly, or have an editor that you like to use. Writing m-files will 
make you much more productive. 

Select File -> New ->M-file to open Matlab's built-in editor/debugger, or use your favorite editor. Then 
create the following file, and save it as sketch.m: 

        [x y] = meshgrid(-3:.1:3, -3:.1:3);
        z = x.^2 - y.^2;
        mesh(x,y,z);

Next, in Matlab, be sure that the directory where the m-file resides is in the path. Check this by typing 
pathtool and making sure that your directory is present. (Users without graphics can use addpath 
directory .) 

Now enter
sketch 
The result is the same as if you had entered the three lines of the file, at the prompt.
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You can also enter data this way: if a file named mymatrix.m in the current working directory contains 
the lines 

        A = [2 3 4; 5 6 7; 8 9 0];

then the command mymatrix reads that file and generates A. However, for large matrices, Matlab's 
own save and load commands are much safer to use. 

Functions

Functions are like any other m-file, but they accept arguments, and they are compiled the first time they 
are used in a given session (for speed). 

Use your favorite editor to create a file named sqroot.m, containing the following lines. 

        function sqroot(x)
        % Compute square root by Newton's method

        % Initial guess
        xstart = 1;

        for i = 1:100
                xnew = ( xstart + x/xstart)/2;
                disp(xnew);
                if abs(xnew - xstart)/xnew < eps, break, end;
                xstart = xnew;
        end

In Matlab enter the commands
format long
sqroot(19)
You should see the output from your function.

Two caveats: 

●     A function has access to the variables in the "workspace" from which it was called, but the 
variables created within the function (xstart and xnew, in the preceeding example) are local, 
which means that they are not shared with the calling workspace. For more information, see the 
chapter "M-File Programming" in the manual, Using Matlab. 

●     Note: if you edit a function during a session, use clear function_name to remove the 
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compiled version, so that the new one will be read. 

Batch Programming

MATLAB may be ran in "batch mode," in a very similar way. If a file named "test.m" contains the (non-
graphics) commands you want processed, at the UNIX prompt type: 

        % matlab < test.m > homework.out

This is read, "Run MATLAB, with input from test.in, and output to test.out." The input file does not 
need to be named "something-dot-m," but it must end with quit . 

Programming ideas

The "m-files" which came with MATLAB provide lots of examples! To find their location, use path 
.This will also lead you to some demos.

You might also try typing demo to get a feel for the breadth of tasks that can be accomplished with 
Matlab.

See help function for an exercise for programmers. 

Next: Further Reading
Previous: Graphics 
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Further Reading

●     The Matlab page should be especially useful. 
●     If you use UNIX, Using Math Software under UNIX may be helpful. 
●     Manuals for statistical and mathematical software are kept in the Swain Hall, Business/SPEA, 

Education, and IUPUI University Libraries, and at the IU Center for Statistical and Mathematical 
Computing. The manuals which come with Matlab are especially good, and provide much more 
information than this short course. 

●     If you are affiliated with Indiana University, you may also get help from the Stat/Math Center. 

Up: Introduction 
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A General Overview of Mathematica
Standard disclaimers apply!

Mathematica is an interactive system for doing mathematical computation. It handles numerical, 
graphic, and symbolic calculations, and it incorporates a high-level programming language 
which allows the user to define his own procedures.

Program Functionality: Good

Breadth of Functionality: Excellent

Mathematica has hundreds of functions available. A large core collection is loaded at startup, 
and specialized packages are available for many topics, from statistics to geometry. Mathematica 
also has a wide variety of specialized packages written by users and available from the electronic 
library, MathSource, maintained by the vendor.

Reliability and Robustness: Fair

Mathematica has fewer bugs as time goes on, generally. However, no computer program can 
replace understanding! People do mathematics, computers don't.

State of the Art: Excellent

Mathematica is one of the leading mathematics programs, noted for its outstanding graphics and 
its pattern-matching language.

User Friendliness: Fair

Mathematica's language, command names and syntax are mostly straightforward, and easily 
understood by anyone proficient in C and Perl, but Mathematica requires a major investment in 
training before the program can be easily used.
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Help Resources: Good

Network-based help: Fair

The UITS Knowledge Base has answers to several frequently asked Mathematica questions. In 
addition, Wolfram Research provides some technical FAQs on its web site.

Program Help System: Good

For information on a topic, enter ? -- for example, ?NIntegrate returns

     NIntegrate[f, {x, xmin, xmax}] gives a numerical approximation to
     the integral of f with respect to x over the interval xmin to xmax.

For a bit more information, enter ??. The name of the topic must be known, and spelled 
correctly: for example, ?plot returns an error message -- ?Plot is needed, and no hint about the 
problem is offered. However, the menu at the top contains a choice, Help, which brings down a 
list containing Help, which brings up a Help Browser, with up to four levels of detail [for 
example Graphics and Sound, 2D Plots, Plot], and also access to The Mathematica Book, 600 
Mb of documentation.

Local Availability: Fair

Mathematica is classified by UITS as Special Purpose software. See the Software Availability 
Matrix for details about where Mathematica is installed. 

Local Support & Training: Minimal

Document Availability: Fair

UITS makes full documentation is available for reference via short term loan from various 
locations. Documents are also available for reference at the UITS Stat/Math Center.

Training Availability: None

User Goup: None

UITS Consulting Support: Full Support

The UITS Center for Statistical and Mathematical Computing (call 812/855-4724 or send email 
to statmath@indiana.edu) can answer basic to advanced questions about the use of Mathematica.
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Note: If you are a student using Mathematica for a class exercise, questions about your class 
work should be first directed to your instructors.

Other Consulting Support: Minimal

Anyone using Mathematica licenses belonging to UITS must obtain support through the UITS 
Stat/Math Center; such users are not eligible for technical support from Wolfram Research, and 
they have been known to refuse it.

Registered Mathematica license owners may contact the vendor directly, with the license number 
provided with their license agreement: phone 217-398-6500 [there is no toll-free support 
number], or send e-mail to support@wri.com.

WRI Technical Support states that students with the student edition will not receive technical 
support beyond help with installation.
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Getting Started with Mathematica
Clinton Wolfe, August 1999 

Also availible: Printer-Friendly Version in Adobe PDF 4.0(120 KB) (Get Acrobat Reader 4.0)

●     Introduction 
❍     What is Mathematica? 
❍     Philosophical Issues 
❍     How to Use this Document 
❍     Where to Find Mathematica 
❍     How to Start and Exit Mathematica 

●     Orientation 
●     Doing Math 
●     Functions 
●     Graphics 
●     Further Reading 

Introduction

What is Mathematica?

Mathematica is a computer program for doing mathematics. It is often used for instruction, homework, 
research, and writing. Mathematica is extraordinary well-rounded. It is suitable for both numeric and 
symbolic work, and it has remarkable word-processing capabilities as well. Mathematicians can (and 
often do) search for a working model, do intensive calculation, and write a dissertation on the project 
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(including complex graphics) -- all from within Mathematica.

Its weaknesses include a somewhat steep learning curve, an interface that is difficult to use from the 
command line, and rather complex installation procedures. 

Philosophical issues

Mathematica is more than just a program. It is an attempt to redefine the interaction between 
mathematician and computer. Every command, function, option, button, menu, or object in Mathematica 
fits into this philosophy in a standard way. In the mid-to-long term, this makes Mathematica a very easy-
to-use, enjoyable tool. For the new user, Mathematica can seem opaque and threatening.

Mathematica was created by a mathematician for other mathematicians. A user of Mathematica should 
be comfortable dealing with abstraction, generalization, and pattern discovery. If you feel you do not fit 
this profile, you might want to learn Maple first.

How to use this document

This document is intended for new users of Mathematica. No prior math software experience is 
assumed, though we do point out differences between the major packages along the way. We assume 
you are familiar with your operating system, so we will not cover clicking, dragging, etc. Since 
Mathematica is quite visually oriented, we assume you will be using it on a computer with a windowing 
system (such as Windows, Macintosh, or X-windows). If you intend to use Mathematica from the 
command line, it would be best to first learn it in a graphic environment, and then learn to Use Math 
Software under UNIX.

We will use a few conventions throughout this document.

Example Explanation

File -> Open Select Open from the File menu.

3,Ctl-6,5 Press 3, then hold the Control key and press 6, then press 5.

2+2 Input to be typed at the Mathematica prompt.

4 Output from Mathematica

An important tip.

A tip for Maple users.

A tip for Matlab users.
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Where to find Mathematica

Mathematica is available in all Macintosh, SGI, and Sun computer labs at IUB. It is also available on 
Steel and the SP (node sp09).

Mathematica is also available for sale in the IU Bookstore.

How to start and exit Mathematica

To start mathematica, follow these instructions.

●     Unix: from a command line, type "mathematica &"
●     Macintosh: Apple Menu->Stat/Math->Mathematica

If you are using X windows and you get a stream of font errors, follow these instructions 
from the Knowledge Base.

To exit Mathematica, you can:

●     Choose File->Exit
●     Type Quit[].

Next:Orientation
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Other Tutorials On the Web
●     Wolfram Research Inc. - the vendor 

❍     Mathematica Support 
❍     The Mathematica Journal 
❍     Mathematica Users' Group 

●     In English 
❍     Colorado University - Boulder 
❍     University of Illinois Urbana-Champaign Excellent tutorial 
❍     Imperial College (postscript) 
❍     Los Alamos National Laboratory 
❍     Purdue University 
❍     South Alabama 
❍     University of Tennessee, Knoxville 
❍     Texas 
❍     Yale 

●     In German 
❍     Humboldt-Universität zu Berlin 

Teaching Resources
●     Graphics for calculus, Doug Arnold 
●     Mathematica in Education and Research 
●     Technology Based Problems in Calculus, Rose-Hulman 

Examples Using Mathematica
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By Academic Subject

●     Basic Math 
❍     Interactive Exercises on Conic Sections (in Finnish) 

●     Calculus 
❍     Calculus and Differential Equations with Mathematica, Indiana 

University of Pennsylvania 
❍     Calculus and Mathematica, University of Illinois, Urbana-

Champaign 
❍     Graphics for calculus, Doug Arnold 
❍     Technology Based Problems in Calculus, Rose-Hulman 

●     Other 
❍     Some planar isospectral domains, by Peter Buser, John 

Conway, Peter Doyle, and Klaus-Dieter Semmler 

Graphics

●     Mathematica Gallery 

Packages

These bundles of related functions let you easily extend Mathematica's 
functionality.

●     Archives of Mathematica Packages 
❍     Stanford University 
❍     Technion 
❍     Mathematische Physik / Computeralgebra (in English) 

●     MathTensor 
●     EinS is a package for calculations involving sums of indexed objects 

(e.g., tensors). 
●     Mathsym is a Mathematica based software package to assist in the 

computation of Lie point symmetries. 

Accessories
These accessories add versatility to Mathematica.

http://www.indiana.edu/~statmath/math/mma/links.html (2 of 3) [01/07/2002 22:01:53]

http://matwww.ee.tut.fi/hmlab/teaching.html
http://www.geom.umn.edu/docs/doyle/drum/cover/cover.html
http://library.wolfram.com/graphics/
ftp://otter.stanford.edu/mma/
ftp://ftp.technion.ac.il/pub/supported/Mathematica/
http://www.uni-giessen.de/www-Mathematische-Physik/programs/programs.html
http://smc.vnet.net/MathTensor.html
http://rcswww.urz.tu-dresden.de/~klioner/eins.html
http://amath.colorado.edu/appm/faculty/sherod/


Mathematica Links

●     Mathematica-to-Matlab Converter -Harri Ojanen at Rutgers University 
●     Mathematica-to-Maple Converter (MapleForm) 
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Introduction to Unix commands

This is a very brief introduction to some useful Unix commands, including examples of how to use each 
command. For more extensive information about any of these commands, use the man command as 
described below.

cal find man rmdir 

cat finger mesg set 

cd jobs mkdir vi 

chmod kill more w 

cp less mv who 

date lpr and lp pwd 

du ls rm 

At the end of this document you will find sources for more information. 

cal

This command will print a calendar for a specified month and/or year. 

To show this month's calendar, enter: 

  cal 
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To show a twelve-month calendar for 2000, enter: 

  cal 2000

To show a calendar for just the month of June, 1970, enter: 

  cal 6 1970

For more detailed information, see the Knowledge Base document In Unix, how can I display a calendar? 

cat

This command outputs the contents of a text file. You can use it to read brief files or to concatenate files 
together. 

To append file1 onto the end of file2, enter: 

  cat file1 >> file2 

To view the contents of a file named myfile, enter: 

  cat myfile

Because cat displays text without pausing, its output may quickly scroll off your screen. Use the less 
command (described below) or an editor for reading longer text files.

For more detailed information, see the Knowledge Base document In Unix, how do I combine several 
files into a single file? 

cd 

This command changes your current directory location. By default, your Unix login session begins in 
your home directory. 

To switch to a subdirectory (of the current directory) named myfiles, enter: 

  cd myfiles

To switch to a directory named /home/dvader/empire_docs, enter: 
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  cd /home/dvader/empire_docs 

To move to the parent directory of the current directory, enter: 

  cd .. 

To move to the root directory, enter: 

  cd /

To return to your home directory, enter: 

  cd

chmod 

This command changes the permission information associated with a file. Every file (including 
directories, which Unix treats as files) on a Unix system is stored with records indicating who has 
permission to read, write, or execute the file, abbreviated as r, w, and x. These permissions are broken 
down for three categories of user: first, the owner of the file; second, a group with which both the user 
and the file may be associated; and third, all other users. These categories are abbreviated as u for owner 
(or user), g for group, and o for other.

To allow yourself to execute a file that you own named myfile, enter: 

  chmod u+x myfile 

To allow anyone who has access to the directory in which myfile is stored to read or execute myfile, 
enter: 

  chmod o+rx myfile 

You can view the permission settings of a file using the ls command, described below. 

Note: Be careful with the chmod command! If you tamper with the directory permissions of your home 
directory, for example, you could lock yourself out or allow others unrestricted access to your account 
and its contents.

For more detailed information, see the Knowledge Base document In Unix, how do I change the 
permissions for a file? 
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cp

This command copies a file, preserving the original and creating an identical copy. If you already have a 
file with the new name, cp will overwrite and destroy the duplicate. For this reason, it's safest to always 
add  -i  after the cp command, to force the system to ask for your approval before it destroys any 
files. The general syntax for cp is: 

  cp -i oldfile newfile 

To copy a file named meeting1 in the directory /home/dvader/notes to your current directory, 
enter: 

  cp -i /home/dvader/notes/meeting1 . 

The  .  (period) indicates the current directory as destination, and the  -i  ensures that if there is 
another file named meeting1 in the current directory, you will not overwrite it by accident. 

To copy a file named oldfile in the current directory to the new name newfile in the mystuff 
subdirectory of your home directory, enter: 

  cp -i oldfile ~/mystuff/newfile 

The  ~  character (tilde) is interpreted as the path of your home directory. 

Note: You must have permission to read a file in order to copy it. 

date 

The date command displays the current day, date, time, and year. 

To see this information, enter: 

  date 

du 

This command reports disk usage (i.e., the amount of space taken up by a group of files). du descends all 
subdirectories from the directory in which you enter the command, reporting the size of their contents, 
and finally reporting a total size for all the files it finds. 
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To find out how much disk space your files take up, switch to your home directory with the cd 
command, and enter: 

  du 

The numbers reported are the sizes of the files; on different systems, these sizes will be in units of either 
512 byte blocks or kilobytes. To learn which is the case, use the man command, described below. On 
most systems, du -k will give sizes in kilobytes. 

find

The find command lists all of the files within a directory and its subdirectories that match a set of 
conditions. This command is most commonly used to find all of the files that have a certain name. 

To find all of the files named myfile.txt in your current directory and all of its subdirectories, enter: 

  find . -name myfile.txt -print 

To look in your current directory and its subdirectories for all of the files that end in the extension 
.txt , enter: 

  find . -name "*.txt" -print 

In these examples, the  .  (period) represents your current directory. It can be replaced by the full 
pathname of another directory to search. For instance, to search for files named myfile.txt in the 
directory /home/user/myusername and its subdirectories, enter: 

  find /home/user/myusername/ -name myfile.txt -print 

On some systems, omitting the final  /  (slash) after the directory name can cause find to fail to return 
any results. 

As a shortcut for searching in your home directory, enter: 

  find "$HOME/" -name myfile.txt -print 

For more detailed information, see the Knowledge Base document In Unix, what is the find command, 
and how do I use it to search through directories for files? 

finger
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The finger command reports information about an account holder, including name, office, phone 
number (if any), last login, and other optional information. 

To find out more about user dvader, enter: 

  finger dvader 

If the computer on which dvader has his account is different from the system you are using, you may 
need to specify the other computer's name, for example: 

  finger dvader@deathstar 

If dvader has his account on a computer at a different campus, university, or organization, you will 
need to specify his complete address, for example: 

  finger dvader@deathstar.empire.gov 

For more detailed information, see the Knowledge Base document In Unix, what is the finger command? 

jobs

This command reports any programs that you suspended and still have running or waiting in the 
background (if you had pressed Ctrl-z to suspend an editing session, for example). For a list of 
suspended jobs, enter: 

  jobs 

Each job will be listed with a number; to resume a job, enter  %  (percent sign) followed by the number 
of the job. To restart job number two, for example, enter: 

  %2 

This command is only available in the csh, bash, tcsh, and ksh shells. 

kill

Use this command as a last resort to destroy any jobs or programs that you suspended and are unable to 
restart. Use the jobs command to see a list of suspended jobs. To kill suspended job number three, for 
example, enter: 
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  kill %3 

Now check the jobs command again. If the job has not been cancelled, harsher measures may be 
necessary. Enter: 

  kill -9 %3

less

This utility displays the contents of a text file one screen at a time, waiting for you to press the Spacebar 
between screens. This lets you read text without it scrolling quickly off your screen. The less utility is a 
more flexible and powerful version of more. For example, unlike more, less allows you to scroll 
backwards by pressing b . 

To read the contents of a file named textfile in the current directory, enter: 

  less textfile 

The less utility is often used for reading the output of other commands. For example, to read the output 
of the ls command one screen at a time, enter: 

  ls -la | less 

To exit less after viewing the file, press q .

Note: Don't use less with executables (binary files), such as output files produced by compilers. Doing 
so will display garbage and may lock up your terminal. 

lpr and lp

These commands print a file on a printer connected to the computer network. The lpr command is used 
on BSD systems, and the lp command is used in System V. 

To print a file named myfile on a printer named lp1 with lpr, enter: 

  lpr -Plp1 myfile

To print the same file to the same printer with lp, enter: 

  lp -dlp1 myfile

http://kb.indiana.edu/data/afsk.html?cust=260 (7 of 14) [01/07/2002 22:05:32]

http://kb.indiana.edu/data/afrw.html?cust=812
http://kb.indiana.edu/data/agom.html?cust=812
http://kb.indiana.edu/data/agjs.html?cust=812


Knowledge Base - Introduction to Unix commands

Note: Do not print to a printer whose name or location is unfamiliar to you; you may annoy its owners.

For more detailed information, see the Knowledge Base document In Unix, how do I print files and list 
or remove print jobs?

ls

This command will list the files stored in a directory. To see a brief, multi-column list of the files in the 
current directory, enter: 

  ls 

To also see "dot" files (configuration files that begin with a period, such as .login ), enter: 

  ls -a 

To see the file permissions, owners, and sizes of all files, enter: 

  ls -la 

If the listing is long and scrolls off your screen before you can read it, combine ls with the less utility, 
for example: 

  ls -la | less 

For more detailed information, see the Knowledge Base document In Unix, how do I list the files in a 
directory?

man

This command displays the manual page for a particular command. If you are unsure how to use a 
command or want to find out all its options, you might want to try using man to view the manual page. 

For example, to learn more about the ls command, enter: 

  man ls 

To learn more about man, enter: 
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  man man 

If you aren't sure of the exact command name, you can use man with the -k option to help you find the 
command you need. To see one line summaries of each reference page that contains the keyword you 
specify, enter: 

  man -k keyword 

Replace keyword in the above example with the keyword which you want to reference. Also see the 
Knowledge Base document In Unix, what is the man command, and how do I use it to read manual 
pages? 

mesg

This command toggles permission for others to send messages to your terminal. If someone were 
bothering you with requests to use talk, for example, you could disable the messages and ignore the 
person by entering: 

  mesg n 

If you had a change of heart, you could again enable messages by entering: 

  mesg y

Note: In most applications, you can restore screen contents that were disrupted by incoming messages by 
pressing Ctrl-l (the letter l). 

mkdir

This command will make a new subdirectory. 

To create a subdirectory named mystuff in the current directory, enter: 

  mkdir mystuff 

To create a subdirectory named morestuff in the existing directory named /tmp, enter: 

  mkdir /tmp/morestuff 

Note: To make a subdirectory in a particular directory, you must have permission to write to that 
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directory. 

more

This utility displays the contents of a text file, one screen at a time, waiting for you to press the Spacebar 
between screens. This lets you read text without it scrolling quickly off your screen. less, described 
above, is a more powerful version of more. 

To read the contents of a file named textfile in the current directory, enter: 

  more textfile 

The more utility is often used for reading the output of other commands. For example, to read the output 
of the ls command one screen at a time, enter: 

  ls -la | more 

Note: Don't use more with executables (binary files), such as output files produced by compilers. Doing 
so will display garbage and may lock up your terminal. 

mv

This command will move a file. You can use mv not only to change the directory location of a file, but 
also to rename files. Unlike the cp command, mv will not preserve the original file. 

Note: As with the cp command, you should always use  -i  to make sure you don't overwrite an 
existing file. 

To rename a file named oldname in the current directory to the new name newname, enter: 

  mv -i oldname newname 

To move a file named hw1 from a subdirectory named newhw to another subdirectory named oldhw 
(both subdirectories of the current directory), enter: 

  mv -i newhw/hw1 oldhw

If, in this last operation, you also wanted to give the file a new name, such as firsthw, you would 
enter: 
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  mv -i newhw/hw1 oldhw/firsthw 

pwd

This command reports the current directory path. Enter the command by itself: 

  pwd

For more detailed information, see the Knowledge Base document In Unix, how do I determine my 
current working directory? 

rm

This command will remove (destroy) a file. You should enter this command with the  -i  option, so 
that you'll be asked to confirm each file deletion. To remove a file named junk, enter: 

  rm -i junk

Note: Using rm will remove a file permanently, so be sure you really want to get rid of the file before 
you use rm. 

rmdir

This command will remove a subdirectory. To remove a subdirectory named oldstuff, enter: 

  rmdir oldstuff 

Note: The directory you specify for removal must be empty. To clean it out, switch to the directory and 
use the ls and rm commands to inspect and delete files. 

set

This command displays or changes various settings and options associated with your Unix session. 

To see the status of all settings, enter the command without options: 

  set 

If the output scrolls off your screen, combine set with less: 
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  set | less

The syntax used for changing settings is different for the various kinds of Unix shells; see the man 
entries for set and the references listed at the end of this document for more information. 

vi 

This command starts the vi text editor. To edit a file named myfile in the current directory, enter: 

  vi myfile 

The vi editor works fairly differently from other text editors. If you haven't used it before, you should 
probably look at a tutorial, such as the Knowledge Base document How do I use the vi text editor? 
Another helpful document for getting started with vi is A quick reference list of vi editor commands. 

The very least you need to know to start using vi is that in order to enter text, you need to switch the 
program from command mode to insert mode by pressing  i . To navigate around the document with 
the cursor keys, you must switch back to command mode by pressing Esc. To execute any of the 
following commands, you must switch from command mode to ex mode by pressing  :  (the colon 
key): Enter  w  to save;  wq  to save and quit;  q!  to quit without saving. 

w

This command lists all users currently logged into the computer, and includes brief information about 
what they are doing. To see the listing, just enter  w . 

who

This command will list all users logged into the computer, and the dialup connection or host computer 
from which they are connected. To see the listing, just enter who . 

More information

See the UITS publications Unix Commands: A Quick Guide and Unix: The least you need to know, as 
well as the online manual pages. You can also view a collection of Unix tutorials and introductory help 
files at: 

  http://www.mcsr.olemiss.edu/unixhelp/
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Related online NETg tutorials (IU only)

Unix Fundamentals 

Also see:

●     In Unix, how do I list the files in a directory? 
●     In Unix, what dot files do the various shells use? 
●     In Unix, how do I set an environment variable? 
●     In Unix, how do I change my password? 
●     In Unix, what is chsh, and how do I use it to change my shell? 
●     In Unix, what is a symbolic link, and how do I create one? 
●     For Unix, where can I find an online tutorial? 
●     What books are available for Unix and where can I find them? 
●     In Unix, how do I define, view, and delete aliases? 
●     In Unix, how can I find the correct path to an executable file? 
●     In Unix, how do I get a printed copy of a manual page? 
●     In Unix, how do I undelete a file? 
●     In Unix, how do I change the permissions for a file? 
●     In Unix, how do I remove a directory? 
●     In Unix, where can I get information on differences between the various shells? 
●     In Unix, how do I remove files with names that contain strange characters, such as spaces, 

semicolons, and backslashes? 
●     In Unix, how do I set my default (preferred) editor? 
●     In Pine, how do I access Unix commands? 
●     In Unix, what is the find command, and how do I use it to search through directories for files? 
●     In Unix, how can I split large files into a number of smaller files? 
●     In Unix, how do I combine several files into a single file? 

This is document afsk in domain all from the Knowledge Base.
Last updated on May 03, 2002 

When you're done reading, please tell us: Did you find the answer to your question?
Yes | No | No, and I'd like to ask a consultant.

Knowledge Base Home | About the Knowledge Base | IT Help Online 
Give us some feedback with our User Survey. 
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IUPUI Student Technology Centers

The Student Technology Centers:

●     BS 3000 Business 
●     CA 231 Cavanaugh Hall 
●     DS 122 Dental School 
●     ES 2116/2124/2119/2121 Education Consortium 
●     HF 305 Herron 
●     IH 235 Law School 
●     NU 342 Nursing 
●     SL 070 Science / Engineering / Technology 
●     UC 2137 University College 
●     UL 3135 Adaptive Learning Center 

Helpful Links: 

Consulting and Lab Information 

Handy Student Information Web Page 

Student Technology Center Baseline Software 

Instructor Software Installation Request Form 

Copyright Information 

Changing/Synchronizing Your Password 

Student Technology Center Equipment Index

Note: 
Some of the Technology Centers are reservable for classes. When the centers are occupied by 
classes they are not available for public use. Room reservation times are posted in the Learning 
Centers. 

Use of these facilities is contingent upon adherence to the Computer Users' Privileges and 
Responsibilities .
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Stat/Math By Subject

Search:  In:       

Support By Subject
Please note this feature is still in development

Statistical Topics

●     Data Management 
❍     Data Sources - where to find data 
❍     Input - how to get the data into your program 

●     Visualization - generating and customizing plots, charts, and graphs 
●     Statistical Analysis 

❍     Parametric Techniques 
❍     Non-Parametric Techniques 

●     Other Statistical Resources 

Mathematical Topics

●     Algebra 
❍     General Algebra - equations, polynomials 
❍     Linear Algebra - matrices, vectors 
❍     Abstract Algebra - groups, rings, fields 

●     Applied Mathematics 
❍     Numerical Computing 
❍     Operations Research and Decision Support 
❍     Signal Processing 

●     Calculus 
❍     General Calculus 
❍     Differential Equations - ODE's and PDE's 
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❍     Analysis 
●     Formatting - TEX, MathML, and web publishing. 
●     Programming 

❍     Interfacing math software with programming languages - 
Maple, Matlab, C, Fortran 

❍     Subroutine libraries - NAG, IMSL 
●     Teaching and Education 
●     Visualization 

❍     Simple Plotting 
❍     3,4,5-D Plotting 

●     Other Math Resources 
❍     Mathematical Organizations 
❍     Math Journals 
❍     Other Math Links 

Qualitative Analysis 

●     Data Management 
❍     Data Sources - where to find surveys, etc. 
❍     Input - how to enter data 

●     Analysis - techniques 
●     Other Qualitative Analysis Resources 

Permission to use this document is granted so long as the author is acknowledged and notified. 
Please send comments and suggestions to:statmath@indiana.edu 

Copyright 1995-1999, Indiana University. 
Last modified: Monday, 03-Apr-2000 16:12:26 EST 
URL /~statmath/bysubject/index.html 
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Windows/MSDos Software Collection

Public domain and shareware software for Windows/MSDOS computers on the Mathematics Archives 
has been organized by the mathematics courses in which they can be used. If the software is suitable for 
several classes, then it is placed in each of those categories. In addition, information on many 
commercial packages is also provided together with links to other sites which have additional 
information on the packages. 

  

Choose one of the following subjects:

 Advanced Calculus 

 Advanced Differential Equations 

 Calculus 

 College Algebra 

 Complex Variables 

 Discrete Mathematics 

 Dynamics 

 Fractals 

 Geometry 

 Graphing Programs 

 K-12 

 Life Sciences 

 Linear and Matrix Algebra 

 Miscellaneous 

 Modelling 

 Modern Algebra 

 Number Theory 

 Numerical Analysis 

 Numerical Partial Differential Equations 

http://archives.math.utk.edu/software/.msdos.directory.html (1 of 2) [01/07/2002 22:17:14]

http://archives.math.utk.edu/index.html
http://archives.math.utk.edu/software/msdos/dynamics/.html
http://archives.math.utk.edu/software/msdos/dynamics/.html
http://archives.math.utk.edu/software/msdos/fractals/.html
http://archives.math.utk.edu/software/msdos/fractals/.html
http://archives.math.utk.edu/software/msdos/geometry/.html
http://archives.math.utk.edu/software/msdos/geometry/.html
http://archives.math.utk.edu/software/msdos/k-12/.html
http://archives.math.utk.edu/software/msdos/k-12/.html
http://archives.math.utk.edu/software/msdos/life.sciences/.html
http://archives.math.utk.edu/software/msdos/life.sciences/.html
http://archives.math.utk.edu/software/msdos/miscellaneous/.html
http://archives.math.utk.edu/software/msdos/miscellaneous/.html


Mathematics Archives MSDOS Software

 Ordinary Differential Equations 

 Partial Differential Equations 

 Probability 

 Statistics 

 Utilities 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 

This page is best viewed with either Netscape 4.0 (or higher) or Microsoft's Internet Explorer 4.0 (or higher)

 Table of Contents 
 Contact Moderators 

 What's New 

 Table of Contents*  Search Archives 
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K-12 Teaching Materials
The following are Internet sites which contain significant collections of materials which can be 
used in the teaching of mathematics at the K-12 level. We have organized these materials into 
the following categories: 

●     Lesson Plans 
●     Software 
●     Topics in Mathematics 
●     Contests and Competitions 
●     Professional Societies 
●     Other 

  

Lesson Plans

Columbia Education Center Mathematics Lesson Plans 

Computers & Maths Teaching 
Peter Hobson, a teacher in Canberra, Australia, created these pages containing "Low cost ... 
Resources for years 11 & 12". Included are worksheets designed to be used with a maths class 
working on graph sketching in a computer lab, spreadsheets, assessment items, worksheets on 
modelling, and information on shareware and graphics. 

Explorer 
The Explorer is part of the Unified Network Informatics Technology for Education (UNITE) 
efforts at the University of Kansas. The Explorer is part of a research and development effort to 
establish an on time and user friendly means of delivering a full range of information resources to 
educators and students. This site includes information on software, lab materials, lesson plans, 
video tapes, etc. for the teaching of mathematics at the k-12 grade levels. 

ExploreMath.com
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Lesson Plans for the Graphing Calculator 

Lesson Plans using Geometer's Sketchpad 

Math Activities for K-12 Teachers 
In December, 1997, NASA Dryden Flight Research Center funded Dan Biezad, Professor of 
Aerospace Engineering, and Robin Ward, Assistant Professor of Mathematics, both of California 
Polytechnic State University, San Luis Obispo, to develop materials for K-12 teachers based on 
aeronautical themes and NASA projects. One major goal of this project was to make the learning 
of mathematics more engaging and realistic for students, by using real-world applications. 

Math Central's Resource Room 

Math Forum's Math Lesson Plans 

MEPP - Learning Units 

Neufeld & Associates 
Publishers of The UNDERSTANDING MATH Programs, collection of programs for 
interactive learning for grades 6-10. Topics include algebra, equations, exponents, geometry and 
integers. Software is available in both English and French. Demos are available. The company 
also provides lessons plans related to these packages and organizes workshops. 

New York Times - Daily Lesson Plans - Mathematics 

Partnership for Excellence 
The Partnership for Excellence represents a collaborative alliance between the University of 
South Carolina Spartanburg and the school districts in Cherokee, Greenville, Spartanburg, and 
Union Counties in South Carolina. Formed in 1990-91, the alliance focuses its efforts on 
increasing teachers' knowledge of content and pedagogy, and promoting the sense of community 
and professionalism among area mathematics teachers. 

PI Mathematics 
PI Mathematics, a collaborative project, using the concept of PI as the focus, is a home page on 
the WWW. This multidisciplinary project which includes math, history, English and thinking 
skills is designed for fifth through eighth graders. It will allow students to discover the 
approximate value of PI, an irrational number, using measurement and reporting the data, 
applying formulas, problem solving and participating in a collaborative project utilizing Internet 
resources. Students will also explore the history of PI, using Internet references. 
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Project Interactivate 
The goals of Project Interactivate are the creation, collection, evaluation, and dissemination of 
java-based courseware for middle school mathematics explorations. "Interactivated" lessons, 
discussions, and activities enable the teacher to extend hands-on activities and to teach new 
content areas with professional competence and confidence, incorporating technology in 
appropriate ways. 

PUMAS - Practical Uses of Math and Science 
PUMAS (poo' · mas) -- is a collection of one-page examples of how math and science topics 
taught in K-12 classes can be used in interesting settings, including everyday life. The examples 
are written primarily by scientists and engineers, and are available to teachers, students, and other 
interested parties via the PUMAS Web Site. 

SCORE Mathematics Lessons
These SCORE Mathematics Lessons have been written by teachers selected to participate in 
SCORE Mathematics workshops. This page is designed especially for mathematics teachers and 
students in California. Its contents and links reflect our state's Mathematics Standards and the 
NCTM Standards. 

SMILE - Science and Mathematics Initiative for Learning Enhancement 
The SMILE program is designed to enhance the elementary and high school learning of Science 
and Mathematics through the use of the phenomenological approach. Since 1986 each summer 
session participant has been asked to create and publish a single concept lesson plan. These lesson 
plans include the materials needed, a suggested strategy and expected outcomes. There are 
currently almost 800 lesson plans available. 

South Carolina SSI K-12 Lesson Plans for Math and Science 
Mostly a collection of links to other sites; the value of this site is the short description of many 
lesson plans. 

Spacelink - Lesson Plans from NASA 
Various lessons plans about space and mathematics from NASA. Most lesson plans are in pdf 
format. 

Teachers Helping Teachers - Math Section 
A collection of teaching ideas and tips for k-12 mathematics teachers. 

Teacher Talk Forum - Math Section 

Teacher's Edition Online - Lesson Ideas 
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Tennessee Sports Math Project 
The project was designed to provide sports-related activities for mathematics teachers in the sixth 
through ninth grade classrooms. Our goal is to stimulate "at-risk" students who might be willing 
to do activities related to their interests. 

University of Missouri - Lesson Plans 
This site contains well over 100 lesson plans that are helpful for anyone in elementary education. 
They include some of Kyle Yamnitz's own assignments and lesson plans that were developed 
during his work at the University of Missouri as well as a collection of lesson plans written by 
other members of the University. 

Weather Here and There 
WEATHER HERE AND THERE is an integrated weather unit which incorporates interaction 
with the Internet and hands-on collaborative, problem solving activites for students in grades four 
through six. This unit is divided into six lessons. The lessons integrate math, science, geography, 
and language arts in the process of teaching and learning about weather phenomena. 

WNETSchool - Mathematics Lesson Plans 
Our original lesson plans are developed by wNetSchool Master Teachers. Starting with tried-and-
true lessons that work in the classroom, our Web-savvy teachers have built Web-based activities 
that use the rich resources of Thirteen/WNET and the Internet. 

Software
Since this page has been getting quite long, we have separated the software entries into a separate 
page. You have two choices: 

●     List of all K-12 software sites. 
●     You can choose specific categories and platforms on the Mathematics Archives' Other 

Software Sites Page. 
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Topics in Mathematics
Materials covering specific areas of mathemtics are listed in these pages. Icons are used to indicated 
the level of a significant part of the materials: 

 K-6 Pre-Algebra 

 7-12 High School Mathematics 

Topics of interest to K-12: 

●     Algebra 
●     Arithmetic
●     Art & Music
●     Calculus
●     Combinatorics 
●     Fractals 
●     Geometry
●     History of Mathematics 
●     Pre-Calculus 
●     Statistics 
●     Trigonometry 

Two of other pages on the Mathematics which may be of interest to students and teachers at the K-12 
level is POPMathematics and Numbers. 

Contests and Competitions
We have now included all of the links to contests and competitions on the Math Archives' 
Mathematics Contests, Competitions, and Problem Sets Page. 
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Professional Societies 
We have now included all of the links to Professional Societies on the Math Archives' Professional 
Societies page. The icon  indicates those societies that have a significant amount of materials 
for K-12 teachers.

Other K-12 Internet Sites

AAAS Project 2061 
Project 2061 of the American Association for the Advancement of Science is a long-term 
initiative to reform K-12 education nationwide so that all high-school graduates are science 
literate. In the first stage of its work, Project 2061 commissioned panels of scientists, 
mathematicians, and technologists to identify the knowledge and skills students should have in 
five subject areas. These panel reports--Biological and Health Sciences, Mathematics, Physical & 
Information Sciences and Engineering, Social and Behavioral Sciences, and Technology were 
integrated into the Project's 1989 report, Science for All Americans (SFAA), which outlines what 
all students should know and be able to do in science, mathematics, and technology after 13 years 
of schooling. 

Abacus 
The Abacus is a publication that focuses on the needs of the elementary mathematics teacher. 

Advocates for Women in Science, Engineering and Mathematics 
The mission of AWSEM is to create and support a regional network of science and technology 
practitioners, educators, parents, businesses and community organizations committed to the 
enrichment of opportunities in Science, Engineering and Mathematics for young women. 

AIMS Education Foundation 
AIMS is the acronym for "Activities Integrating Mathematics and Science." The mission of the 
AIMS Education Foundation is to enrich the education of students in K-9 through hands-on 
activities that integrate mathematics, science, and other disciplines. AIMS implements the 
recommendations put forth in reform documents such as Science for All Americans (American 
Association for the Advancement of Science),Curriculum and Evaluation Standards for School 
Mathematics (National Council of Teachers of Mathematics) and the National Research Council's 
Standards. 

Alan Selby's Home Page 
Alan Selby is the author of three books on Understanding and Explaining Math and Reason. 
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AP Calculus - College Board 
Contains information about the College Board's AP Calculus Exams and Courses. 

Appalachia Educational Laboratory - Math & Science Education 
The mission of the Eisenhower Regional Consortium for Mathematics and Science Education at 
AEL is to promote and support systemic reform in mathematics and science education in 
Kentucky, Tennessee, Virginia, and West Virginia. 

ARC Center
The ARC Center promotes the wide-scale and effective implementation of standards-based 
mathematics curricula. The Center consults with school and districts and provides information and 
resources to support teacher enhancement, leadership development, and public awareness of 
mathematics. 

Ask Dr. Math! 
Ask Dr. Math is an Internet project based at Swarthmore College and staffed mainly by 
Swarthmore students, staff, and faculty where questions about Mathematics from K-12 students 
and their teachers are answered. 

AskERIC 
This site is under development for use as an automated information outlet for the AskERIC 
project, a pilot project of the ERIC system and the Department of Education. The Educational 
Resources Information Center (ERIC) is a federally-funded national information system that 
provides access to an extensive body of education-related literature. ERIC provides a variety of 
services and products at all education levels. AskERIC is an Internet-based question-answering 
service for teachers, library media specialists, and administrators. Anyone involved with K-12 
education can send a message to AskERIC. Drawing on the extensive resources of the ERIC 
system, AskERIC staff will respond with an answer within 48 working hours. Many of these 
resources are accessible on this link. 

Aunty Math - Fun Math Challenges for Kids! 

Balanced Assessment in Mathematics Project 
Balanced Assessment in Mathematics is a National Science Foundation project charged with 
developing new approaches to the assessment of mathematical competence in the elementary and 
secondary grades. This project has created a type of mathematics assessment that contrasts 
sharply with traditional forms of testing, which rely primarily on multiple-choice questions. 
Balanced Assessment focuses on rich, mathematically complex work that requires students to 
create a plan, make a decision, or solve a problem -- and then justify their thinking. 

Blue Web'n Applications: Mathematics Resources 
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In our daily work designing applications for Internet and Videoconferencing, we see a multitude 
of web pages for students, educators, and librarians. This webspace is our attempt to share the best 
of these sites in an organized manner. In addition to the Mathematics Resources they also have 
Mathematics Activities. 

Calculus&Mathematica Distance Education Program 
The Calculus&Mathematica Distance Education Program (C&M DEP) runs on the electronic 
highway to bring top rural and inner city high school students to the university and to send top 
university undergraduates to rural and inner city high schools to form a human, electronic 
community devoted to mathematics learning. 

The California Math Show 
The California Math Show is a portable, interactive math exhibit based on the idea of symmetry. 
Some web pages developed by the California Math Show which are appropriate for teachers to 
use in the classroom include the 4 plane symmetries, reflections, Symmetric tessellations, 
Symmetric polyhedra and Designs with Circles. 

California Mathematics Framework 

California Mathematics Project 
The California Mathematics Project (CMP) vigorously pursues its mandate to improve the quality 
of mathematics education in California for all students at all grade levels. To achieve this goal, the 
CMP directs, through its seventeen regional sites, collaborative professional development 
programs founded on the idea that increased teacher understanding of mathematics and effective 
pedagogies for teaching mathematics are the keys to improving student achievement. 

Canadian Forum on Education in Mathematics 
The Canadian Forum for Education in Mathematics was designed to bring together participants in 
mathematics education in Canada (government, teachers - kindergarten through graduate school 
and industry) with the intent of providing a unique opportunity to talk about mathematics from 
elementary school to the workplace. 

Canadian Mathematics Society's List of Projects for Science Fairs 
To date there have not been a lot of mathematics projects in the science fairs and we believe that 
one reason for this might be that it is not at all clear what a mathematics project might involve. To 
help shed some light on this problem we have prepared a list of possible projects and many 
references on topics that could make exciting and interesting projects. 

Centre for the Advancement of Science and Mathematics Education
Centre for the Advancement of Science and Mathematics Education (CASME) is a non-profit, 
education development agency dedicated to the professional development of science, mathematics 
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and technology education in South Africa. 

Center for Research in Mathematics & Science Education 
Established in 1985 within the College of Sciences at SDSU, the Center for Research in 
Mathematics and Science Education (CRMSE) brings together researchers interested in studying 
how individuals acquire knowledge in mathematics and science. 

Center of Excellence for Science and Mathematics Education (CESME) 
The Center of Excellence for Science and Mathematics Education (CESME) is located at the 
University of Tennessee at Martin in Martin, Tennessee. The mission of the CESME is to 
encourage and support the improvement of science and mathematics education at all levels. The 
purpose of this WWW site is to serve as a resource for teachers who are looking for ways to 
improve their science or mathematics teaching. 

Center for Polymer Studies 
The Center for Polymer Studies (CPS) is a scientific visualization research center in the Physics 
Department at Boston University devoted to interdisciplinary research in aspects of polymeric, 
random, or fractal systems. CPS utilizes expertise in interdisciplinary physics research to develop 
experimental and computational materials for K-12 and undergraduate education. Of interest to 
mathematics teachers are their programs: Patterns In Nature and The Dance of Chance. 

Centre for Teaching Mathematics 
The Centre for Teaching Mathematics is a research and resource development Centre of The 
University of Plymouth, England. Its broad aims are to promote the teaching and learning of 
mathematics in a way that will motivate students and make the subject interesting. These activities 
are reflected in the main activities of the Centre: the development of new teaching resources and 
strategies, research into the teaching and learning of mathematics, the implications of technology 
in the teaching and learning of mathematics, curriculum development, provision of courses for 
teachers and students. 

CESAME - Center for the Enhancement of Science and Mathematics Education 
CESAME brings together the resources of teachers, scientists, engineers, and mathematicians in 
order to improve Massachusetts school children's access to, excitement about, and understanding 
of mathematics and science. 

Challenger Center for Space Science Education 
Challenger Center for Space Science Education is a not-for-profit organization committed to 
promoting science, math and technology education. Partnering with museums, science centers, 
schools, universities and communities across North America, Challenger Center uses the theme of 
space exploration to: create positive learning experiences, foster interest in math, science and 
technology, and motivate young people to explore. 
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Cisco Education Archive 
The educational resource center sponsored by Cisco Systems Incorporated which provides 
information helping educators and schools connect to the wealth of educational resources 
available on the World Wide Web, as well as connections to resources worldwide that 
demonstrate the power of networking in education. The Cisco Educational Archive and Resources 
Catalog home page (CEARCH) offers "one-stop shopping" to access hypermedia resources of 
interest to educational organizations. 

Classroom Compass 
Classroom Compass is a collection of ideas and resources for teachers interested in improving 
instruction in science and mathematics. To make these subjects more accessible to more students, 
teachers must engage students in real problems and tie lessons to what students already know, 
while analyzing and measuring what they are learning. The Classroom Compass examines such 
issues, offering suggestions and discussing ways of thinking about effective instruction. 

Community of Mathematics Learners
The goal of the project is to deepen the teachers' understanding of mathematical ideas that 
underlie the curriculum they teach and to share exemplary curricular materials and teaching 
methods. Particular attention will be given to exploring ways of connecting mathematical ideas to 
real life problems and to sharing classroom experiences among participants. 

Connect 
CONNECT is Colorado's NSF-funded statewide systemic initiative in mathematics and science. 

Connected Mathematics Project (CMP) 
This website has been designed to help teachers, administrators, parents, and students learn more 
about this middle school curriculum. The curriculum comprises 24 student units (8 in each grade 
level) and each unit typically focuses on one major content strand in mathematics -- number, 
geometry and measurement, probability, statistics, or algebra. 

Core-Plus Mathematics Project 
The Core-Plus Mathematics Project (CPMP) is a five-year project funded by the National Science 
Foundation to develop student and teacher materials for a complete three-year high school 
mathematics curriculum for all students, plus a fourth-year course continuing the preparation of 
students for college mathematics. The curriculum builds upon the theme of mathematics as sense-
making. Throughout it acknowledges, values, and extends the informal knowledge of data, shape, 
change, and chance that students bring to situations and problems. 

Cornell Theory Center Math and Science Gateway 
The Cornell Theory Center Math and Science Gateway is a service of the Cornell Theory Center 
which is committed to providing a wide range of educational services to the national community. 
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This Gateway provides links to resources in mathematics and science for educators and students 
in grades 9-12. It includes an extensive section for secondary school educators, containing 
information on curriculum, lesson plans, software for the classroom, and how to set up web 
servers in the schools. 

Delaware Mathematics Coalition 
The Delaware Mathematics Coalition is an alliance of Delaware leaders representing education, 
government, business, and the community dedicated to support efforts to improve the 
mathematical literacy of the citizens of the State of Delaware. 

Dynamical Systems and Technology Project 
This project is a National Science Foundation sponsored project designed to help secondary 
school and college teachers of mathematics bring contemporary topics in mathematics (chaos, 
fractals, dynamics) into the classroom, and to show them how to use technology effectively in this 
process. At this point, there are several interactive papers available. These are designed to help 
teachers understand the mathematics behind such topics as iterated function systems (the chaos 
game) and the Mandelbrot and Julia sets. 

E-MAIL MATH 
Email math involves using the electronic mail service of the internet in order to exchange math 
story problems with other math classes in Canada or around the world. 

E-MATH - A Guide to E-mail Based Volunteer Programs Designed to Help Students Master 
Challenging Mathematics, Science and Technology 

Early Mathematics Placement Testing (EMPT) 
We are a high school mathematics intervention program designed to help high school students 
make decisions about taking mathematics courses. The Ohio EMPT Program tests are 
administered to high school sophomores, juniors, and seniors to give them an indication of where 
they stand in terms of mathematics knowledge. 

EASYMATHS SA - Mathematics Web Association of South Africa 
This is a free South African Community Website with mathematics resources for teachers, parents 
and learners. 

Educational Resources for K-12 Mathematics Teachers 
This site at the University of Utah contains a very nice well-organized collection of annotated 
links to various sites of resources for K-12 mathematics teachers. 

Eisenhower High Plains Consortium for Mathematics and Science 
The mission of HPC is to promote and support systemic reform in mathematics and science 
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education in the seven-state region. To facilitate change, HPC collaborates with state departments 
of education, postsecondary institutions, National Science Foundation (NSF)-funded initiatives, 
and other state and federal agencies. 

Eisenhower National Clearinghouse 
The purpose of the Eisenhower National Clearinghouse (ENC) is to provide K-12 teachers with a 
central source of information on mathematics and science curriculum materials and to encourage 
the adoption and use of such materials in order to support national goals to improve teaching and 
learning in mathematics and science. The United States Department of Education funds ENC 
through a contract with The Ohio State University. 

E P G Y: Education Program for Gifted Youth 
The Education Program for Gifted Youth (EPGY) is a continuing project at Stanford University 
offering computer-based courses in mathematics and the mathematical sciences for bright young 
students through the Stanford Continuing Studies Program. They have been actively involved in 
the education of gifted students since the late 1950s and have been working with computer based 
education since the mid 1960s. 

EQUALS Programs 
The EQUALS programs at the Lawrence Hall of Science provide workshops and curriculum 
development for teachers, parents, counselors, administrators, and other educators. These 
programs include the six day EQUALS Workshop in mathematics and equity, one and two day 
SEQUALS Workshops on a variety of educational topics, and the Family Math Program. 
EQUALS programs work to increase access and equity in mathematics for traditionally under-
represented students, including females, students of color, those from low-income families, and 
those from language minority groups. 

Erdos 4 Kids 
An electronic journal for the exploration of open problems in mathematics. 

Explorer 
The Explorer is part of the Unified Network Informatics Technology for Education (UNITE) 
efforts at the University of Kansas. The Explorer is part of a research and development effort to 
establish an on time and user friendly means of delivering a full range of information resources to 
educators and students. This site includes information on software, lab materials, lesson plans, 
video tapes, etc. for the teaching of mathematics at the k-12 grade levels. 

EXTEND - Perspectives on Mathematics Education 
EXTEND is a national Internet forum on mathematics education intended to involve new 
constituencies, to engage new voices, and to examine new perspectives. Major topics will be 
explored through forum reports, position papers, and reader commentary: 
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Access | Expectations | Articulation | Technology | Accountability 

These topics are addressed from many perspectives, including those of educators and employers, 
business leaders and public officials. To contribute to the discussion, send e-mail to: 
extend@stolaf.edu. In addition, EXTEND provides information on innovative programs and links 
to important documents related to reform of mathematics education in schools, colleges, and 
universities. 

Family Math 
Family Math is a program developed by EQUALS, at Lawrence Hall of Science, University of 
California, Berkeley, California. The goal of FAMILY MATH is to encourage underrepresented 
groups (especially girls and minority students) to enter careers that use mathematics. FAMILY 
MATH is, of course, family-based. 

Fermi Questions 
Fermi questions emphasize estimation, numerical reasoning, communicating in mathematics, and 
questioning skills. Students often believe that "word problems" have one exact answer and that 
the answer is derived in a unique manner. Fermi questions encourage multiple approaches, 
emphasize process rather than "the answer", and promote non-traditional problem solving 
strategies. 

Figure This! 
Mathematics Challenges for Families provides interesting
math challenges that middle-school students can do at home with
their families. 

Florida Atlantic University - Teacher Enhancement Project 

The Formula For Success - A Business Leader's Guide to Supporting Math and Science 
Achievement 

This guide offers strategies for how businesses can work with schools to improve math and 
science achievement. 

Freudenthal Institute 
The Feudenthal Institute was founded (under the name IOWO) in 1971 and at present forms part 
of the Department of Mathematics and Computer Science at Utrecht University. The Fi is also 
part of the Center for Science and Mathematics Education. The Fi is internationally renowned as 
an institute for the development of mathematics and computer science education. Research 
projects, conducted by the Fi for the Netherlands Department of Education, have resulted in the 
implementation of new curricula for secondary education. New curricula for primary education 
were influenced and developed by the institute in a more informal manner. 
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Function 
Function is a mathematics refereed journal addressed principally to students in the upper years of 
secondary schools, and more generally to anyone who is interested in mathematics. 

Games Pages from the Centre for Innovation in Mathematics Teaching at the University of Exeter 
Pages concerning games for the mathematics classroom; on mathematical games, their rationale 
and ways of using them in the classroom. 

Genesee Area Mathematics/Science/Technology Center 
The Genesee Area Mathematics/Science/Technology Center seeks to harness community 
resources for supporting the dedicated parents, students, and educators. GAMSTC seeks to 
provide these resources so that all learners will excel in and seek career pathways in mathematics, 
science, and technology. 

GirlTECH '95 
GirlTECH `95 was an innovative four-week teacher training program at The Rice School/La 
Escuela Rice. During this program, twenty teachers were given intensive training in developing 
and presenting materials related to gender equity and computer technology. One of the features of 
this site is a collection of lesson plans. 

Glenn T. Seaborg Center for Teaching and Learning Science and Mathematics 

Global Schoolhouse 
The Global Schoolhouse is a project funded in part by the National Science Foundation and 
supported by many local and national businesses. The project consists of connecting schools and 
students nationally and internationally using the Internet and modeling classroom applications of 
Internet tools and resources. Collaborative research is conducted between the schools and students 
interact via using a variety of Internet tools including live video conferences using Macintosh and 
(80386/80486 based) personal computers. 

GoMath 
Gomath is an internet site oriented to help high school students (10 - 12th grades) of all levels 
with math skills. Our specially designed programs offer an interactive guide through a course and 
help students build up math skills as well as confidence. Here at GoMath.COM we are trying to 
create the most dynamic and useful math site on the Web. Our features are designed to empower 
students with math skills and to allow teachers, parents, and students to significantly improving 
mathematics and science education in elementary and secondary schools in America. 

Helping Your Child Learn Math 
This article by Patsy F. Kanter contains activities for children aged 5 through 13. 
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Honest Open Logical Debate (HOLD) on math reform 

Houghton Mifflin Mathematics Center 
The Houghton Mifflin Math Center contains math resources for teachers, students and parents. 
Included, for example, is a bibliography for experiences of math through literature for students in 
grades K-2, brain teasers for grades 3 and above, and many math links. 

Hrothgar Project 
The Hrothgar Project is an effort started by the Center for Advanced Computing Research 
(CACR) at Caltech to explore the utility of high end (university research caliber) computers 
within high school curricula. 

The Hub - Regional Alliance for Mathematics and Science Education 
The Hub is an Internetworked resource for mathematics and science education funded by the 
Eisenhower Regional Consortia and operated by TERC on behalf of the Regional Alliance for 
Mathematics and Science Education Reform. The Hub provides services that can help you to 
publish reports, curricula, projects in progress, requests for proposals. The Hub is also an 
important educational resource. The Hub publish newsletters, curriculum materials, and software 
in support of the greater educational community as well as provide references to valuable 
information from across the internet. 

Infinity
The online version of the University of Queensland maths journal for high school students. 

Institute for Technology in Mathematics 
The Institute for Technology in Mathematics has been a pilot program under the New Jersey 
Department of Higher Education with two major objectives: to initiate curriculum transformation 
at the secondary level in mathematics by using technology and to prepare a cadre of teachers who 
would serve as leaders and resource people in their school district in providing encouragement 
and technical assistance to their colleagues. Check out their Lesson Plans for the Geometer's 
Sketchpad. 

INSTRUCT - Implementing the NCTM School Teaching Recommendations Using Collaborative 
Telecommunications 

INSTRUCT is intended to provide online teacher professional development for planning, 
instruction and assessment of your mathematics classes. 

Integrated Math Tools Project 
Integrated Math Tools Project is a joint effort of the University of Massachusetts Dartmouth and 
the Technical Educational Research Center, Cambridge, MA, on a project to revamp the teaching 

http://archives.math.utk.edu/k12.html (15 of 33) [01/07/2002 22:19:00]

http://www.rahul.net/dehnbase/hold/
http://www.eduplace.com/math/
http://oscar.cacr.caltech.edu/Hrothgar/
http://ra.terc.edu/alliance/HubHome.html
http://www.maths.uq.edu.au/%7Einfinity/
http://www.wpunj.edu/icip/itm/
http://www.wpunj.edu/icip/itm/Lessonpl/sketch/sketch.html
http://www.wpunj.edu/icip/itm/Lessonpl/sketch/sketch.html
http://instruct.cms.uncwil.edu/
http://instruct.cms.uncwil.edu/
http://www.umassd.edu/Public/People/MBurke/IMT/IMTproject.html


Mathematics Archives - K12 Internet Sites

of mathematics in grades K-6. This project involves the development of curriculum to support 
mathematics as captured by the NCTM standards of 1989. The University of Massachusetts 
Dartmouth's part in the project is to develop a series of software "tools" for use by teachers and 
students in the new curriculum. 

Integrated Resource Packages - British Columbia 
Curriculum materials for 

❍     MATHEMATICS K TO 7 
❍     MATHEMATICS 8 TO 10 
❍     Introductory Mathematics 11 and Principles of Mathematics 11 and 12 
❍     Applications of Mathematics 11 and 12 

The Interactive Mathematics Program 
The Interactive Mathematics Program (IMP) is a four-year, problem based mathematics 
curriculum for high schools. IMP is designed to meet the needs of both college-bound and non-
college-bound students. The fundamental principles of IMP reflect major changes currently taking 
place in mathematics education. National reports issued by experts and professional organizations 
recognize that existing ways of teaching mathematics are inadequate in meeting the needs of 
today's public school students. 

Internet Resources in Mathematics, Science and Technology Education 
This page organized by the Office for Mathematics, Science and Technology Education, 
University of Illinois at Urbana-Champaign contains a well-organized collection of links to 
resources on the Internet. 

Introduction to Math and Spreadsheets 

K12 Mathematics Curriculum Center 
The K12 Mathematics Curriculum Center's mission is to support school districts as they build an 
effective mathematics education program using curriculum materials developed in response to the 
National Council of Teachers of Mathematics' Curriculum and Evaluation Standards for School 
Mathematics. 

Kansas Outreach School in Mathematics (KOSM) 
The school's goal is to help students to excel in mathematics. It enrolls students primarily from 
eighth through tenth grade, although students of other grades may also be admitted. The Outreach 
School does not substitute for the standard school curriculum, but rather assists middle and high 
school students and teachers in improving and enhancing the available mathematics education. 

Kassel Project from the Centre for Innovation in Mathematics Teaching at the University of 
Exeter 
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The main aim of this project is to carry out research into the teaching and learning of Mathematics 
in different countries, and ultimately to make recommendations about good practice in helping 
pupils acheive their mathematical potential. The project has grown out of collaborative work 
between the Centre for Innovation in Mathematics Teaching (CIMT) at the School of Education, 
University of Exeter in England, and the Mathematics Education Group at Kassel University in 
Germany. Our initial interest was centred on finding appropriate ways to use applications in the 
teaching of Mathematics, but this has now widened to encompass all major strands of 
Mathematics teaching in secondary schools. 

Kentucky Virtual High School
The Kentucky Virtual High School is a statewide educational service delivering high school 
courses and online learning opportunity to Kentuckians. KVHS courses are delivered to public 
high schools through the Kentucky Education Technology System. 

Kids Web - Mathematics Page 
The Mathematics Page of the Kids Web is a collection of sites which are very simple to navigate 
and contain information about mathematics of interest to K-12 students. 

Learning through Collaborative Visualization 

The Lockheed Martin/UCF Academy for Mathematics and Science 
The Lockheed Martin/UCF Academy for Mathematics and Science is dedicated to systemic 
improvement of mathematics and science teaching and learning in the K-8 schools of Central 
Florida. The Academy design is consistent with national curriculum, instruction, assessment and 
teacher preparation standards. Moreover, the Academy is committed to the creation of a network 
of school-based leadership in mathematics and science education as well as to the support of all 
teachers in their efforts to enhance the quality of mathematics and science education. 

Marketplace - The UNL Center for Science, Mathematics and Computer Education 

MARS - Mathematics Assessment Resource Service 
The Mathematics Assessment Resource Service, works with districts and states on performance 
assessment design and implementation, and on professional development for designers and 
teachers. The aim is to help the local leadership develop local capability to meet local needs. 

Materials World Modules 
The Materials World Modules (MWM) is a National Science Foundation funded project to 
produce a series of interdisciplinary educational modules centered on aspects of materials science. 
The modules themselves are a collaboration among materials science researchers, educational 
researchers, and high school science and mathematics teachers. The modules are intended for use 
in high school science and math classrooms. Some of the modules are also suitable for use in 
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junior high settings. 

Math Homework Help 
In addition to providing homework help for a fee, this site has a math dictionary, a list of various 
formulas for high school mathematics including trig identities, geometry formulas, postulates, and 
theorems and practice problems from algebra. 

Math League 
The Math League is dedicated to bringing challenging mathematics materials to students. The 
Math League specializes in math contests, books, and computer software designed to stimulate 
interest and confidence in mathematics for students from the 4th grade through high school. Over 
1 million students participate in Math League contests each year. 

Math and Science Course Bulletin 
A publication of courses, workshops, conferences, and awards as well as specialized in-service 
offerings in and out of Washington State which are of particular interest to teachers of math and 
science in Washington. 

Math & Science Pavilion 
The Mathematics & Science Pavilion of Virginia Public Education Network provides an 
opportunity for you to explore the wealth of mathematics and science resources (projects, lesson 
plans, images, calculator activities). It is part of the Electronic Academical Village, a storehouse 
for information on academic subjects studied in schools. Please feel at home and enjoy this 
treasure house compiled together by the math, science, and technology educators of Virginia! 

Math Central 
Math Central is site for K-12 mathematics students and teachers. It is a facility at the University 
of Regina Department of Mathematics and Statistics and is maintained by mathematics and 
education students and faculty. Math Central is designed to aid in the implementation and 
maintenance of the new mathematics curriculum in Saskatchewan. 

Math Forum 
Formerly called the Geometry Forum, the Math Forum has as its goal to build a community that 
can be a center for all who have an interest in mathematics education. They work towards this 
goal in several ways: hosting of newsgroups, organizing a collection of links to various 
mathematics resources, and involvement with the development and evaluation of Internet math 
materials. 

Math Magazines
This site from Southwest Texas State University contains copies of two math magazines: Math 
Reader that is targeted for elementary students from grade 3 to 5 and Math Explorer that is 
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targeted for students from grade 6 to 9. 

Math Night Resource Page
This page gathers together resources used for math nights at various schools in Ames, Iowa as 
well as serving as an index to site on the web that we think might be useful. 

Math Talk
Math is meant to be talked about. Interesting problems are meant to be shared. One person's 
solution to a problem should be critically reviewed by another. The student body of the Maine 
School of Science and Mathematics is proud to present Math Talk , a journal written by high 
school mathematicians for high school mathematicians. 

Math Teacher Link 
Math Link is a new website based at the University of Illinois that is designed to deliver 
professional development opportunities and classroom resources to teachers of mathematics, 
statistics and related subjects at the high school and lower division college levels. 

Math Projects for Science Fairs 
Katherine Heinrich the Canadian Math Society (CMS) President (1996-98) has put together a list 
of possible math projects for science fairs. 

Math Talk 
Math is meant to be talked about. Interesting problems are meant to be shared. One person's 
solution to a problem should be critically reviewed by another. The student body of the Maine 
School of Science and Mathematics is proud to present Math Talk , a journal written by high 
school mathematicians for high school mathematicians. 

Math Vantage 
Math Vantage is a series of videotapes and print materials that brings middle level mathematics to 
life. The videotapes produced for the Nebraska Math and Science Initiative project by the 
Nebraska Educational Television Network are high-energy, fast-paced presentations illustrating 
key math concepts and applications. The target audience is grades 6-9, but much of the material is 
applicable for other grades as well. 

Mathematical Digest 
Mathematical Digest is a quarterly magazine for high school pupils in South and Southern Africa. 

Mathematical Education on Merseyside 
Mathematical Education on Merseyside is a Registered Charity dedicated to the enjoyment of 
mathematics. The aim is to being together in common projects everyone concerned with the lively 
development of mathematics in secondary schools of every type in and around Merseyside. 
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Mathematical Experience Through Image Processing 
The National Council of Teachers of Mathematics has identified a number of features that the 
grade 5-8 curriculum should include in order to help motivate students to stay interested in math. 
The goal of the METIP project is to use digital image processing to help meet these objectives. In 
particular they have developed applications that run on 386/486/Pentium based PC's under 
Microsoft Windows that allow students to manipulate digitized images of their choice. Teachers 
aid in learning by discussing the concepts students have explored on the computer. The METIP 
Project currently has a number of programs that allow students to explore mathematics with 
image processing. 

Mathematical Mayhem 
Mathematical Mayhem is a non-profit mathematical journal written by and for high school and 
undergraduate university students. 

Mathematically Correct 
This web site is devoted to the concerns raised by parents and scientists about the invasion of our 
schools by the New-New Math and the need to restore basic skills to math education. 

Mathematics and Science Center 
The Mathematics & Science Center is a unique educational partnership in central Virginia. 
Students teachers and parents are challenged after school hours by innovative programs. Weekday 
programs in mathematics, science, and emerging technologies enrich the student's classroom 
work. 

Mathematics & Science Pavilion of Virginia
The Mathematics & Science Pavilion of Virginia Public Education Network provides an 
opportunity for you to explore the wealth of mathematics and science resources (projects, lesson 
plans, images, calculator activities). It is part of the Electronic Academical Village, a storehouse 
for information on academic subjects studied in schools. 

Mathematics and Science Teaching (MAST) Center 
The MAST Center at the University of Northern Colorado is committed to equitable and systemic 
reform in the teaching and learning of science, mathematics, and technology in elementary, 
middle, and secondary schools, colleges, and univerisity. MAST Center's Activites include the 
CONNECT project, MAST Hotline, RMTEC, and the Colorado's U S WEST Teacher Network. 
The MAST Center has over 20 activities that are focused on pre-service and inservice instruction 
for mathematics and science teachers. 

Mathematics Education Partnership Program 
The Mathematics Education Partnership Program (MEPP) is a National Security Agency outreach 
program to promote mathematics and science education. Working within the Office of the NSA 
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Chief Scientist, the MEPP staff coordinates the activities of hundreds of Agency volunteers. Much 
effort is concentrated on helping local area schools through three main programs. 

Mathematics Glossary - Middle Years 
The definitions included here are those that are used in the Saskatchewan Education document 
"Mathematics 6-9: A Curriculum Guide for the Middle Level". Various mathematics dictionaries 
may have different definitions. These definitions are designed to be meaningful to middle level 
mathematics teachers. A French version is also available. 

Mathematics in Context 
Mathematics in Context (MiC) is an NSF-funded, comprehensive middle-school mathematics 
curriculum for grades 5-8 that reflects the philosophy and pedagogy of the NCTM standards. Each 
of the 40 units consists of mathematical tasks and problems embedded in real-life contexts that are 
designed to stimulate mathematical thinking and promote discussion among students. Students 
explore mathematical relationships; develop and explain their reasoning and informal strategies 
used to solve each problem; how and when to use technology, such as graphing calculators, and to 
listen to, understand, and value each other's strategies. 

The Mathematics Learning Forums 
Become a part of a growing, nationwide community of educators interested in mathematics 
reform and the standards of the National Council of Teachers of Mathematics (NCTM). The 
Mathematics Learning Forums provide a unique experience for elementary and middle school 
teachers to reflect on and refine their mathematics teaching practices through on-line seminars. 

Mathematics Problem Solving Task Centres 
This site has been designed to assist teachers and students who use Task Centres. The aims for the 
A.C.T.(Mathematics Task) Centre are to give students a successful mathematical experience, to 
develop problem-solving strategies within the students and to encourage teachers to use concrete 
materials to teach mathematics with students above Year 3. 

Mathématique du secondaire 
This page contains suggestions by Xavier Hubaut, Professor at the Free University of Brussels, 
for additional topics to be used in secondary mathematics which are aesthetic, applicable or 
amusing. Topics include projective geometry, conic sections, polyhedra, complex numbers, 
Escher, and applications. 

Mathmagic 
Mathmagic is a K-12 telecommunications project developed in El Paso, Texas. It provides strong 
motivation for students to use computer technology while increasing problem-solving strategies 
and communications skills. MathMagic posts challenges in each of four categories (k-3, 4-6, 7-9 
and 10-12) to trigger each registered team to pair up with another team and engage in a problem-
solving dialog. When an agreement has been reached, one solution is posted for every pair. 
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Mathman 
Publisher of books and videotapes; Don's Materials. 

MathMol - Mathematics and Molecules K-12 
MathMol is being developed at the NYU/ACF Scientific Visualization Center with assistance 
from the NYU Collaborative for Excellence in Teacher Preparation, District 2 in Manhattan and 
the YMCA Beacon Technology Center. The purpose of MathMol is to provide the K-12 
educational community with information and materials dealing with the rapidly growing fields of 
molecular modeling and 3-D visualization. As the program gains momentum, databases and 
activities will be posted for educational use. Many activities will permit students to work 
interactively with molecular and mathematical images. Pages will be updated as information and 
activities are developed. 

MathNerds 
MathNerds is a free service offering assistance in many areas of mathematics. 

MathScape 
The MathScape: Seeing and Thinking Mathematically Curriculum Center is a national center 
whose mission is to support schools and districts using the MathScape: Seeing and Thinking 
Mathematically curriculum. 

MathsNet 
MathsNet is a collection of WWW pages about mathematics education, information technology 
and the Internet. You will find resources here on using information technology tools in school or 
college with students - and some straightforward "sums" too. Besides pages on logo, spreadsheets 
and graphs, there are also pages dedicated to users of specific educational software like WinLogo, 
Excel and Omnigraph. There are iteractive pages, animations, puzzles and articles, and the 
inevitable list of links to other good sites. The age range covered at present is mainly 11-16, thus 
including secondary school (UK), though many materials are suitable for younger pupils too. 

MEPP - Mathematics Education Partnership Program 
The Mathematics Education Partnership Program (MEPP) is a National Security Agency outreach 
program to promote mathematics and science education. 

MegaMath - Los Alamos National Laboratory 
The MegaMath project is intended to bring unusual and important mathematical ideas to 
elementary school classrooms so that young people and their teachers can think about them 
together. 

MESA - Mathematics, Engineering, Scientific Achievement 
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MESA, one of the country's oldest and most successful educational programs to assist 
disadvantaged and underrepresented students become math and science professionals. A program 
of the University of California, MESA works with over 21,000 students throughout California 
from elementary through university levels. MESA is funded by the state legislature, corporate 
contributions, and grants. MESA four components programs---the MESA Schools Program 
(MSP), Success Through Collaboration (STC), MESA California Community College Program 
(MESA CCCP) and MESA Engineering Program (MEP)---provide academic advising, group 
study, career exploration, parent involvement, and other services for students. 

Michigan Gateways 
Michigan Gateways: The Television Program for Teachers of Mathematics and Science is a 
television series aimed at helping K-12 educators open gateways to mathematics and science for 
their students. The award winning Michigan Gateways series also appeals to everyone who is 
concerned about how math and science education evolve as our children prepare for success in the 
21st century. Michigan Gateways is broadcast by satellite and offered on Michigan's public 
broadcasting stations on varying schedules. 

Mid-Atlantic Eisenhower Consortium for Mathematics and Science Education 
This site is designed primarily to support mathematics and science educators and reform efforts in 
the region, but the content should appeal to and benefit educators across the nation. The site's 
content focuses on six priorities: Equity Issues; Informal Education; Public Outreach; and 
Curriculum, Standards, & Assessment. 

Missouri Middle School Mathematics
A National Science Foundation project to support investigation and implementation of innovative 
middle school mathematics curricula. 

Mu Alpha Theta 
Mu Alpha Theta was formed to engender keener interest in mathematics, to develop sound 
scholarship in the subject and promote enjoyment of mathematics among high school and junior 
college students. 

❍     MU'S NEWS - Florida Association of Mu Alpha Theta 

National Alliance of State Science and Mathematics Coalitions 
NASSMC advocates the establishment and growth of state coalitions. It provides assistance and 
support in establishing coalitions, coordinates coalition activities nationally, links its member 
coalitions to state-level networks of other national organizations, and leverages human and 
financial resources. 

National Center for Improving Student Learning and Achievement in Mathematics and Science 
(NCISLA) 
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The mission of the National Center for Improving Student Learning and Achievement in 
Mathematics and Science (NCISLA) is to craft, implement in schools, and validate a set of 
principles for the design of classrooms that promote understanding in both mathematics and 
science. 

National Center for Research in Mathematical Sciences Education 
Most of the work of the National Center for Research in Mathematical Sciences Education 
(NCRMSE) is represented in the Annotated Bibliography available at this site. 

Networking Infrastructure for Education - National Center for Supercomputing Applications 
The National Science Foundation, through the Networking Infrastructure for Education (NIE) 
program, seeks to explore the impact of networks on school communities. We describe here one 
such effort, a supplement to an on-going effort NSF-funded activity of the Education Group of the 
National Center for Supercomputing Applications based on educational affiliations as a 
mechanism to introduce and support computational science in the K-12 curriculum. 

The New Jersey Mathematics Coalition Home Page 
The New Jersey Mathematics Coalition was created to facilitate and encourage improvement in 
the teaching and learning of mathematics as recommended in national reports including the 
Curriculum and Evaluation Standards for School Mathematics and Professional Standards for 
Teaching Mathematics of the National Council of Teachers of Mathematics, collectively referred 
to as the Standards, and Everybody Counts and Counting on You of the Mathematical Sciences 
Education Board and the Board on Mathematical Sciences 

New York State High School Regents Exam Prep Center
Practice questions and old Regents Exams. Covers topics in Mathematical Reasoning, Numbers & 
Numeration, Operations, Modeling/Multiple Representation, Measurement, Uncertainty 
(Probability), Patterns & Functions. 

North Carolina - Mathematics Curriculum Matrix 

The Northern Ireland Mathematics Forum 
This site contains material produced in Northern Ireland which should be of interest to 
mathematics teachers at secondary level and those who train them. Included are Graphic 
Calculator Resources and Hypotenuse which is the Northern Ireland Mathematics Teachers' 
Journal. 

Northwest Math Interaction 
The Northwest Math Interaction (NWMI) is an effort of the Continuing Outreach Program of the 
IAS /Park City Mathematics Institute. The PCMI sponsors a summer institute in Park City, Utah 
for teachers, university mathematicians and undergraduates. The NWMI is made up of Puget 
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Sound secondary teachers who have completed the two-year geometry program at Park City and 
who are introducing new ways of teaching geometry in the classroom. 

NRICH Maths - the Online Maths Club 
NRICH provides extracurricular mathematics for young people and ideas to help teachers run 
maths clubs. NRICH is about enjoying maths and working with other people on challenging 
problems. 

NSF Sponsored Summer Workshop for Secondary School Teachers 

Ohio Mathematics and Science Coalition 
The Ohio Mathematics and Science Coalition (OMSC) is an advocacy group comprised of 
individuals from the education, business, and public sectors, working with the common goal of 
revitalization and improvement of mathematics, science, and technology education, from 
preschool to beyond graduate school. The OMSC mission is to facilitate collaboration for 
continuous, systemic, and sustainable improvement in mathematics, science and technology 
(MST) education for Ohio's nearly 2 million students. 

Ontario Mathematics Gazette 
Ontario Mathematics Gazette is the major periodical for mathematics education in Ontario. 
Interesting, relevant articles are written by some of the most outstanding mathematicians and 
educators in Ontario and North America. 

Ontario Science Centre 
The Educational Programs section at the Ontario Science Centre, "your partner in math, science 
and technology education", is offers quality programs and workshops which have been presented 
to millions of students and teachers since their opening in 1969. 

OSU Math Ed Center k-12 Resources 

PALMS - Partnerships Advancing Learning in Math and Science 
PALMS will be the vanguard of education reform in Massachusetts. 

PBS MATHLINE 
PBS MATHLINE is the first discipline-based educational service the Public Broadcasting Service 
(PBS) offers on its new telecommunications highway. Combining computing and 
telecommunications technologies, public television is creating an information highway on which 
there will be much more than the traditional broadcast programs usually associated with 
television. With electronic communication via PBS Online, public television's new computer 
network, PBS will be offering interactive data services in addition to interactive video and voice 
services for education. As an umbrella service for students, teachers, parents, policymakers, and 
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the public, PBS MATHLINE will support the nation in pursuit of its national education goal to be 
first in the world in mathematics achievement. PBS MATHLINE services are based on the 
mathematics standards set by the the National Council of Teachers of Mathematics (NCTM) and 
endorsed by the National Education Goals Panel. 

Pennsylvania Governor's School for the Sciences 
The Pennsylvania Governor's School for the Sciences (PGSS) first opened at Carnegie Mellon 
University in the summer of 1982. This rigorous five-week summer program was established to 
provide talented Pennsylvania high school students with enrichment experiences in the sciences 
and mathematics and to encourage them to pursue careers in science and technology. 

Plane Math 
This Instructional Design Document was generated as part of InfoUse's project entitled "An 
Internet-Based Curriculum on Math and Aeronautics for Children with Physical Disabilities" 
which was funded through a cooperative agreement with NASA. The stated mission of this 
project is "To stimulate and motivate students with physical disabilities in grades 4-7 to pursue 
aeronautics-related careers via the development and delivery of accessible math education 
materials on the Internet." 

Project 2061
Project 2061 is the long-term initiative of the American Association for the Advancement of 
Science working to reform K-12 science, mathematics, and technology education nationwide. 
Included on the site are benchmarks and a collection of evaluations of mathematics texts. 

Project MATHEMATICS! 
Project MATHEMATICS! produces videotape-and-workbook modules that explore basic topics 
in high school mathematics in ways that cannot be done at the chalkboard or in a textbook. The 
goal of the project is to attract young people to mathematics through high-quality instructional 
modules that show mathematics to be understandable, exciting, and eminently worthwhile. 

Project Skymath 
The University Corporation for Atmospheric Research (UCAR) has received funding from the 
National Science Foundation to prepare a middle school mathematics module incorporating real-
time weather data. The goal of the pilot project is to demonstrate that acquiring and using current 
environmental and real-time weather data in middle school classrooms, in ways that embrace the 
dynamic and the uncertain natures of these data, will promote the teaching and learning of 
significant mathematics, consistent with the standards set by the National Council of Teachers of 
Mathematics. 

ProMath 
The purpose of ProMath is to give Lexington area high school students an opportunity to work on 
interesting, challenging mathematical problems and to develop their problem solving skills and 
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taste for individual work in Mathematics. The organizers of ProMath believe that working on non-
standard problems is the best (maybe the only) way to understand the true nature of Mathematics 
and would like to share this belief with high school students and with the community at large. 
They hope to be able to identify and encourage young mathematical talent. 

PUMP - Pittsburgh Urban Mathematics Project 
The PUMP (Pittsburgh Urban Mathematics Project) Algebra Project is a collaboration between 
members of the Anderson Research Group and a group of teachers in the Pittsburgh Public 
Schools. It is an attempt to make high school Algebra accessible to all students through the use of 
situational curriculum materials and an intelligent computer based tutoring system. 

Quandaries and Queries 
Have any nagging math problems you can't solve, or just curious about something? Ask us! We'll 
try to solve your problem and return an answer to you. Questions and answers are also stored in a 
data base that you can examine either through a table of contents (arranged by level and topic), or 
through a search. 

Quantum 
Quantum is a lively, handsomely illustrated bimonthly magazine of math and science (primarily 
physics). In addition to its feature articles, Quantum's departments include At the Blackboard (the 
beauty and usefulness of equations), In the Lab (hands-on science), Toy Store (mathematical 
amusements), Kaleidoscope (a collection of snippets designed to consolidate your grasp of a 
given topic), How Do You Figure? (challenging problems in physics and math), Brainteasers (fun 
problems requiring a minimum of math background), Looking Back (biographical and historical 
pieces), and Gallery Q (an exploration of links between art and science). 

Renewing Mathematics Teaching Through Curriculum
Renewing Mathematics Teaching Through Curriculum is a federally funded project that will give 
Southwest Michigan communities a head start in implementing a highly acclaimed mathematics 
curriculum that will change the way high school mathematics is taught. 

Resources for Math Teachers 
Resources include guides to using journals, algebra tiles, math bags, transformational geometry, 
and unit plans. 

The Right Angle
The Right Angle is a High School Mathematics Newsletter published by the Undergraduate 
Program Office in the Department of Mathematics at Texas A&M University. 

The Role of Story Problems in Transition from Arithmetic to Algebra 
The purpose of this project is to provide ourselves and others with electronic access to a large 
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collection of story problems from as many cultures and historical periods as possible. 

SAMI - Science and Math Initiatives 
SAMI is a clearing house of resources, funding, and curriculum for rural math and science 
teachers. 

Saxon Publishers, Inc. 
Saxon Publishers publish educational textbooks and other teaching materials for the primary and 
secondary education markets (Grades K-12) as well as for the home study market. Their goal is to 
develop a web site that can be used as a means of communication between themselves and 
members of the Internet community as well as a forum for the exchange of ideas, techniques, and 
methods for improving education in America. 

School Science and Mathematics Association 
The School Science and Mathematics Association is dedicated to improving instruction at all 
levels in and between science and mathematics by providing leadership in the field. Its primary 
work and publications address the needs of all of those involved in the science and mathematics 
teaching and learning processes. 

SciMathMN 
SciMathMN is a partnership of education, business and government pursuing statewide 
improvement in the teaching and learning of K-12 mathematics and science. 

Science and Mathematics Consortium for Northwest Schools 
The Science and Mathematics Consortium for Northwest Schools is one of the ten "Regional 
Eisenhower Consortia" established by Congress and administered by the U.S. Department of 
Education. We intend this web site to be used by teachers and other educators to: 1) access 
information and resources that may be time-consuming to find elsewhere; and 2) enhance their 
ability to teach mathematics and science. 

Secondary Mathematics Assessment Database 
This Web site in Queensland, Australia provides an opportunity for secondary maths teachers to 
share quality assessment items. The emphasis is on non-traditional assessment, though you will 
find innovative traditional exam questions here also. 

The Shodor Education Foundation, Inc. 
The Shodor Education Foundation, Inc. is a non-profit education and research corporation 
dedicated to reform and improvement of mathematics and science education by appropriate 
incorporation of computational and communication technologies. Beginning in 1989 as the 
Shodor Education Trust, and since its incorporation as a public 501(c)(3) foundation, the focus 
has been to identify specific needs in the education reform movement that can be addressed by 
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modeling and simulation technologies. 

Show-Me Center 
The Show-Me Center, in partnership with five NSF-sponsored middle grades curriculum 
development satellites (University of Wisconsin, Michigan State University, University of 
Montana, Institute for Research on Learning, Educational Development Center) and publishers 
(Dale Seymour Publications, Creative Publications, and McDougal-Littel) provides information 
and resources needed to support selection and implementation of standards-based middle grades 
mathematic curricula. 

Six through Eight Mathematics (STEM) Project 
The Six Through Eight Mathematics (STEM) project is a mathematics curriculum project for 
grades 6-8 located at the University of Montana in Missoula, Montana. STEM is developing a 
national level curriculum to be used by all students. It will include a complete set of student, 
teacher, and assessment materials. The materials are being developed over a 60-month period and 
are scheduled for commercial publication for the school year 1997-98. 

Skymath National Weather Report Module 
This is an overview of a unit in which students produce a national weather report and a report on 
their understanding of the phenomena under study. It is a highly condensed description. This unit 
focuses on the display and making sense of numerical and graphical data, discerning patterns, 
making conjectures based on the analysis of data, and the analysis of data sets with more than one 
variable. It introduces some fundamental concepts of statistics and a variety of statistical formats 
for displaying data. It builds extensively on measurement skills and the use of scales and symbol 
systems and provides opportunities for computation and use of calculators. Throughout the unit, 
students are engaged in mathematical reasoning, problem-solving, and communicating about 
mathematics. 

SMART -- Science and Mathematics Advancement and Resources for Teachers 
SMART -- Science and Mathematics Advancement and Resources for Teachers is an initiative of 
the Los Angeles Educational Partnership. The 1994-95 SMART Catalog places hundreds of 
enriching professional development opportunities and resources at your fingertips. Its goal is to 
empower you to raise your students' level of mathematics and science achievement by enhancing 
your own knowledge and skills. 

Stepping Stones to Mathematical Modeling 
The purpose of this site is to facilitate the teaching and learning of mathematical modeling in 
secondary school mathematics classes. 

System Dynamics in Education Project 
The goal of the System Dynamics in Education Project is to develop classroom projects, complete 
with modeling software examples when applicable, that might assist a teacher and the students in 
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making the educational challenge easier and more meaningful. 

Teacher Talk 
Teacher Talk is an electronic mailing list for the use of K-12 Saskatchewan mathematics teachers. 
It is intended for open discussion in the teaching of mathematics, with topics as wide ranging as 
the participants wish. 

Teachers Using Technology in Mathematics 
The purpose of the Teachers Using Technology in Mathematics project is to help teachers use 
multimedia-based technologies and existing software to improve their teaching. The overarching 
goal is to improve student learning and motivations through the appropriate use of multimedia in 
connection with lessons that center on big ideas in mathematics and the application of these ideas 
in other subject areas, especially art. To achieve this goal the University of Iowa, Cedar Rapids 
schools and Iowa City schools have joined together in a working partnership. 

Teaching Mathematics and Its Applications 
This IMA journal provides interesting and stimulating material which is of practical use in the 
teaching of mathematics in secondary education, and includes a micromaths section which deals 
with different aspects of the role played by the microcomputer in mathematics teaching. 

Technology And Mathematics Education (TAME) Forum 
The principal aim of the TAME Forum is to develop and support a network of mathematics 
educators at primary and secondary schools in their attempts to incorporate technology assisted 
approaches to mathematics teaching and learning. This support will extend to providing the 
following services: moderate an electronic forum (newsgroup) for mathematics educators to share 
ideas, problems and sample materials relevant to the TAME theme; maintain/support a collection 
of low cost software suitable for schools; information about projects currently in progress relevant 
to the TAME theme; provide links to other WEB resources of value to mathematics educators in 
schools. 

Technology Tools for Secondary School mathematics 
Course materials developed by Roger Day at Illinois State University. 

Technology Tools for Science and Mathematics Learning 
Technology Tools for Science and Mathematics Learning is a statewide inservice professional 
development program in advanced learning technologies for science and mathematics teachers, 
grades 3-12. 

Tennessee State Frameworks 

TERC 
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TERC is a nonprofit research and development organization committed to improving mathematics 
and science learning and teaching. 

Test Masters Study Guides 
Test Masters Study Guides are for state assessment exams and are organized by states. 

Texas Statewide Systemic Initiative 
Resources for strenghtening mathematics, science and technology education in local communities. 

TIMSS - Third International Mathematics and Science Study 
With data on half a million students from 41 countries, the Third International Mathematics and 
Science Study (TIMSS) is the largest, most comprehensive, and most rigorous international study 
of schools and students ever. The report, Pusuing Excellence, is a synthesis of initial findings 
from TIMSS on the U.S. eighth grade mathematics and science education, providing a 
comparative picture of education in the United States and the world that sheds new light on 
education in the U.S. through the prism of other countries. Also available for study are findings 
and sample lessons from the TIMSS Videotape Classroom report of 8th grade mathematics with 
Germany, Japan, and the U.S. 

Tools for Understanding 
This site is intended for educators who teach mathematics and are interested in integrating 
common technologies into their daily instruction. Our target audience includes intermediate and 
middle-grade teachers (particularly those who teach remedial math classes) and secondary special 
educators. While much of this site focuses on mathematics, there are a number of lessons and 
activities that are intended to blend mathematics with writing and make use of mathematical 
reasoning in other content areas such as social studies. 

TSM: Technology for Secondary and College Mathematics 
TSM is an activity based at Oundle School designed to promote a better understanding of the use 
of technology in the teaching of mathematics at secondary level. The main software and hardware 
providers are involved, together with a team of experienced tutors. 

U.S. Department of Education 
This WWW server is provided under the auspices of the U.S. Department of Education's (ED) 
Institutional Communications Network (INet) project, managed and operated by the Education 
Information Resources Division of the Office of Educational Research and Improvement 
(OERI/EIRD). Contains a list of educational resources available on the Internet. 

University of California, Irvine, K-16 SCIENCE EDUCATION - Mathematics Page 
This page contains a number of links to sites which provide information of use to the K-16 
mathematics teachers. This is part of a project which opproximately 100 K-12 teachers, 
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representing more than 90 schools in Orange County, California, will be contributing for the 
benefit of all teachers. These teachers will be evaluating the science resources on the network 
according to their applicability in the classroom as they are sorted via criteria listed in the 
California Science Framework. 

University of Hawaii, Math Dept., Curriculum Research and Development Group 
The Curriculum Research & Development Group is the organized research unit in the University 
of Hawaii that gives attention to the functions of elementary and secondary education in Hawaii 
and elsewhere in the University's service area. The CRDG has a permanent staff of educators and 
contest scholars, plus a number of associated, part-time scholars from this and other universities. 
Its function is to examine the total scholarship of the universe of knowledge and to adapt selected 
parts of it for use in elementary and secondary schools. This page is from the Mathematics 
Department of the CRDG and contains information about the Hawaii Algebra Learning Project 
and Geometry Learning Project. 

University of Toronto Mathematics Network 
Sponsored by the Mathematical Sciences Departments at the University of Toronto: Department 
of Computer Science, Department of Mathematics, Department of Statistics, and others, the 
Network is designed to encourage active, hands-on participation in mathematics, provide a forum 
for communication and mathematical discussion, and provide exposure to active mathematics in 
many diverse fields. 

Vermont State Mathematics Coalition 
The Vermont State Mathematics Coalition will be a resource throughout the state for schools, 
parents, businesses and government. 

Virginia Mathematics and Science Coalition 
The Virginia Mathematics and Science Coalition is an alliance of leaders of the education, 
corporate, and public policy sectors, working together to revitalize mathematics and science 
education, pre-kindergarten through graduate school. 

Virginia Public Schools - Mathematics Standards of Learning 

Voluntary National Tests 
President Clinton proposed in his State of the Union Address on February 4, 1997, a voluntary, 
annual reading test in English at grade 4 and a math test at grade 8. These tests will, for the first 
time in history, provide parents and teachers with information about how their students are 
progressing compared to other states, the nation, and other countries. 

Wonderful Ideas 
Wonderful Ideas is a newsletter featuring math activities, lessons, and games for teaching, 
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learning, and enjoying mathematics. At the site, there is a collection of activities and problems for 
teachers and students to print out for their use. 

Word Problems For Kids 
This Web Site contains word problems for students and teachers. The problems are classified into 
grade levels from Grade 5 to Grade 12. THIS IS NOT A TEST, but a set of carefully selected 
problems which can help you improve your problem solving skills. 

The World-Wide Web Virtual Library: Educational Technology 
This is a long list of links to various sites related to Eduactional Technology which is maintained 
by TECFA ("Technologies de Formation et Apprentissage"), a teaching and research unit within 
the School of Psychology and Education (Faculte de psychologie et des sciences de l'education), 
University of Geneva. 

Zimaths 
Zimaths is an electronic journal which would educate Zimbabwean schoolkids about the virtues of 
real maths, as opposed to the spiceless variety taught in most schools. 

Acknowledgments: Many of the descriptions of the sites given above are taken or abstracted from 
information provided by the sites. 
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Limits and Continuity 
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Applications of Differentiation

Integration 

Applications of Integration 

Sequences and Series 

 

Information
What? | Who? | How? | Awards | Help Page 
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For Undergraduates
While most of the materials on the Mathematics Archives are accessible to undergraduate 
students, the WWW pages in the following categories are designed to give undergraduate 
students information written specifically for them. 

❍     Societies 
❍     Undergraduate Projects and Research 
❍     Summer Programs, etc. 
❍     Competitions 
❍     Careers in Mathematics 
❍     Undergraduate Publications 
❍     Other WWW Sites 

Societies 

●     The professional society SIAM sponsors a home page which presents a number of articles and 
essays written by undergraduate students and gives information about summer internships. 

●     One of the pages on MAA Online is The MAA Student's Page which contains information on 
student competitions, employment in mathematics, meetings of interest to students, etc. 

●     Pi Mu Epsilon is an honorary national mathematics society whose purpose is the promotion of 
scholarly activity in mathematics among students in academic institutions. 

●     Kappa Mu Epsilon is a specialized honor society in Mathematics. KME was founded in 1931 to 
promote the interest of mathematics among undergraduate students. Its chapters are located in 
colleges and universities of recognized standing which offer a strong mathematics major. The 
chapters' members are selected from students of mathematics and other closely related fields who 
have maintained standards of scholarship, have professional merit, and have attained academic 
distinction. Both men and women are eligible for membership. 

●     Mu Alpha Theta's mission: " ...dedicated to engendering keener interest in mathematics, the 
development of strong scholarship in the subject and promoting the enjoyment of mathematics 
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among high school and junior and community college students." 

●     Student Mathematical Societies in the UK and Ireland 

Undergraduate Projects and Research 

●     The Furman University Electronic Journal of Undergraduate Mathematics is an online-only 
journal designed to encourage undergraduate research in the field of mathematics. 

●     LMS Undergraduate Project Archive is a site established by the London Math. Society to make 
available to hard-pressed academics a good stock of topics for undergraduate project work that 
have been used successfully in other institutions. Ideally this would mean, for each project, a clear 
description of the work involved in the project, a good set of appropriate references and some 
indication of the length, level and prerequisites of the project. 

●     Abstracts, participants and prizes of the Undergraduate Research Poster Session at the San 
Francisco Math Meetings (Jan. 1995). 

●     Agnes Scott College's list of Recent Independent Studies in Mathematics 

●     Reed College's Recent Senior Theses in Mathematics. 

●     St. Mary's College of Maryland's Student Projects 

●     Williams College's Student Thesis Abstracts 

Continued Fractions 
A senior Honor's Project at Calvin College by Adam Van Tuyl which gives the history, theory, 
applications and bibliography on the thery of continued fractions. In the section on applications 
there are a number of interactive programs that convert rationals (or quadratic irrationals) into a 
simple continued fraction, as well as the converse. 

The Egyptian Fraction: The Unit Fraction Equation 
Results from the Wayne State University Student Research Program. 
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If you have a student project on the WWW, let us know and we'll include a link here. 

Summer Programs, etc. 

●     Math Forum - Undergraduate Research Programs in Mathematics. The Math Forum hosts a 
growing database of announcements for undergraduate math research programs, including: - 
Research Experiences for Undergraduates (REU) - Other Summer Programs (non-REU) - 
Research Semester Programs 

●     Mathematics Advanced Study Semesters (MASS) is a new semester-long program at Penn State 
which provides a comprehensive mathematical environment for a group of talented undergraduate 
students selected from U.S. colleges and universities and brought to the University Park campus. 
The program combines advanced learning with research initiation. It may be characterized as a 
"domestic study abroad" program (Fall semesters only.) 

●     AHPCRC Internship Program: The primary objective of this internship program funded by the 
National Science Foundation is to promote undergraduate research in high performance 
computing (HPC) in fluid dynamics, including parallel computing and advanced visualization 
techniques. The projects are supervised by faculty in aerospace engineering and mechanics, 
chemical engineering and materials science, and computer science. It is also the objective of this 
program to encourage the participants to pursue graduate studies in HPC and its applications in 
engineering and sciences. 

●     A list of Tentative 2001 REU Sites has been posted by the National Science Foundation. 

●     The (Math) REU FAQ is a guide to Math REU programs written by a student, Andy Miller, who 
participated in a couple of REU programs. 

●     The George Washington University Summer Program for Women in Mathematics (SPWM) is a 
four-week intensive program for mathematically talented undergraduate women who are 
completing their junior year and may be contemplating graduate study in the mathematical 
sciences. The goals of this program are to communicate an enthusiasm for mathematics, to 
develop research skills, to cultivate mathematical self-confidence and independence, and to 
promote success in graduate school. 

●     The Carleton/St. Olaf Colleges Summer Mathematics Program for Women is an NSF/NSA 
funded program to encourage and support women in their study of mathematics. The goals of the 
program include: introducing students to new areas of mathematics; honing students' 
mathematical reasoning, proof writing, problem solving, and presentation skills; building self-
confidence, encouraging enthusiasm for mathematics, and increasing awareness of careers in the 

http://archives.math.utk.edu/undergraduates.html (3 of 7) [01/07/2002 22:19:50]

mailto:help@archives.math.utk.edu
http://forum.swarthmore.edu/students/college/urp/
http://www.math.psu.edu/mass/
http://www.arc.umn.edu/education/
http://www.nsf.gov/home/crssprgm/reu/reu98dms.htm
http://www.math.berkeley.edu/%7Eamiller/reu/reufaq.htm
http://www.gwu.edu/~math/spwm.html
http://www.mathcs.carleton.edu/smp/


Mathematics Archives - Undergraduates

mathematical sciences; connecting students into a supportive network of other female college 
math majors, graduates and professionals. 

●     Initiated by Paul Erdös, Lászsló Lovász, and Vera T. Sós, the program Budapest Semesters in 
Mathematics provides a unique opportunity for North American undergraduates. Through this 
program, mathematics and computer science majors in their junior/senior years may spend one or 
two semesters in Budapest and study under the tutelage of eminent Hungarian scholar-teachers. 

Competitions 

National Competitions: 

●     William Lowell Putnam Mathematical Competition 

●     William Lowell Putnam Mathematical Competition - Past Problem Sets 

Regional Competitions: 

●     California State University, Fresno - Mathematics Field Day

Careers in Mathematics 

●     The Mathematical Association of America contains information on careers in mathematics on 
their page Resources for Undergraduates in Mathematics. In addition, there is information on 
graduate programs on mathematics including some new professional masters degrees programs. 

●     The American Mathematical Society (AMS) and the Society for Industrial and Applied 
Mathematics (SIAM) provide career information and services to the mathematics community. 
Their Mathematics Careers Bulletin Board allows you to learn about the careers of 
mathematicians in nonacademic positions. 

●     The Bureau of Labor Statistics provides information on average salaries, career opportunities, 
description of positions, etc. for mathematics majors. 

●     Jobs in Mathematics from Dartmouth College contains primarily information on the employment 
of mathematicians with Ph.D.'s. 
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●     Check out Careers in Mathematics from the Department of Mathematics at Purdue University. 

●     Information on Careers in Mathematics is available from Department of Mathematics at Towson 
State University. 

●     Check out the Online Career Center from Northern Michigan University. 

●     Westfield State College's Career Information Page provides information about mathematical 
careers in Actuarial Field, Business and Management, Education, Engineering, Government, Law 
Enforcement, Operations Research and Statistics. 

●     Check out Joining the World of the Mathematician from the Department of Mathematics at 
Colgate University which provides, in addition to some WWW links, some titles of books 
concerning what type of work mathematicians do. 

●     The Department of Mathematics at the University of Canterbury (New Zealand) has a WWW 
page CAREERS IN MATHEMATICS AND STATISTICS which provides information on recent 
job vacancies in non-academic areas. 

●     The Association for Women in Mathematics publishes the pamphlet Careers in Mathematics. 

Undergraduate Publications 

●     Mathematical Musings is an on-line journal based at St. Cloud State University, St. Cloud, MN. 
We are interested in (1) mathematical student research and (2) student problem solving. We want 
to create a site where students can present ideas that have intrigued and stimulated them, or 
questions that they would like answered or would like to propose. 

●     The Furman University Electronic Journal of Undergraduate Mathematics is an online-only 
journal designed to encourage undergraduate research in the field of mathematics. 

●     MAT 007 I News is a recreational mathematical newsletter edited by undergraduate 
mathematicians of the Department of Mathematics at the University of Toronto. 

●     Mathematical Mayhem is a non-profit mathematical journal written by and for high school and 
undergraduate university students. 

●     Mathematical Spectrum welcomes original student contributions and awards annual prizes for the 
best ones published. 
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●     mathNEWS - The University of Waterloo Faculty of Mathematics Student Newspaper. 

●     Le Journal de Maths des Élèves de l'École normale supérieure de Lyon is a journal containing 
articles written by students and instructors at the latter school. Articles are about math subjects 
which are interesting, relevant and amusing and are introductions to these subjects. Written in 
French. 

●     Rose-Hulman Institute of Technology Undergraduate Mathematics Journal is devoted entirely to 
papers written by undergraduates on topics related to mathematics. 

●     Studies in Mathematical Science - A Collection of Undergraduate Research from Miami 
University of Ohio. 

Other WWW Sites 

●     Alice T. Schafer Mathematics Prize For Excellence in Mathematics by an Undergraduate Woman 

●     Understanding Mathematics - a study guide The author believes that many students struggle with 
mathematics only because they don't know what it means to understand Mathematics and how to 
acquire that understanding. The purpose of this page is to help the student learn how to approach 
mathematics in a more effective way. 

●     The Top Fifty Graduate Programs in Mathematics 

●     Best Graduate Programs in Mathematics from U.S.News. Also includes information on the best 
graduate programs in Algebra, Applied Mathematics, Geometry/Topology, Logic, Mathematical 
Statistics and Number Theory. 

●     Student Corner from the Math Ed Center at Oklahoma State University. 

●     Applied Math Resources - This is a search of a database of schools with Applied Mathematics 
Programs at the graduate level. Each school supplied their areas of concentration for inclusion in 
the database. 

●     The Most Common Errors in Undergraduate Mathematics - A list distributed to students by a 
professor at Vanderbilt University who was tired of seeing these same old errors over and over 
again. 
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●     Women And Mathematics - WAM is an advising and mentoring program whose purpose is to 
stimulate interest in mathematics among all students, regardless of their career choices. It is a 
program to motivate and inspire students, especially young women, towards careers in 
mathematics, science, and technology. By sharing experiences from their careers and lives, WAM 
consultants create excitement for learning and open new doors for growth and direction. WAM 
makes a difference for students. 

●     Conference on Undergraduate Mathematics - Rose-Hulman Institute of Technology 

●     Hudson River Undergraduate Mathematics Conference - HRUMC 

●     Nebraska Conference for Undergraduate Women in Mathematics 

●     APICS - Mathematics and Statistics Committee runs an annual undergraduate conference and 
student competition and tries to take a vigorous interest in issues related to the science curriculum 
in schools and universities. 

●     Muskingum College's Learning Strategies Database - Content-Specific Learning Strategies for 
Mathematics 

●     MathNerds is a free service offering assistance in many areas of mathematics. 
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University, College and Community College

Mathematics and Math Related Departments 

From this page, you can access the Mathematics Departments of various community colleges, colleges 
and universities which have a presence on the Internet. Since the number of such Departments is quite 
large, we have decided against publishing a single very long list and have organized the lists 
alphabetically based on the first letter of the name of the school: 

| A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z | 

Some of the schools are listed in several places in the lists above. For example, the University of 
Tennessee is listed both on the T and U lists. 

On these lists, we attempt to identify the exceptional teaching and math resources which these 
departments have made available on the Internet. 

The entries from this list were obtained from many sources including: 

●     Penn State University's List which is recognized as the premier list of math resources on the 
Internet and which is mirrored at many sites. 

●     Florida State University's List which was the first such major list on the WWW. 
●     Australian Math Society - Information about Australian Mathematics Departments 
●     CAMEL's List of sites in Canada. 
●     Cellule de Coordination Documentaire Nationale pour les Mathématiques - List of sites in France 
●     Heriot-Watt University's List of sites in the United Kingdom. 
●     Irish Mathematical Society's list of Mathematics Departments in Ireland. 
●     List of Mathematics Departments in Italy 
●     List of Mathematics Departments in Japan 
●     Korean Mathematical Society's list of Mathematical Departments in Korea. 
●     Lista de servidores matemáticos en México 
●     Polish Academy of Science's list of Mathematics Departments in Poland. 
●     Moscow State University's list of Mathematical Sites in Russia and ex-USSR. 
●     Shortcuts to Departments of Physics, Engineering, and Mathematics maintained by Fred 

Lemmerhirt, Waubonsee Community College 
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The WWW site Mathematicians of the African Diaspora maintains a listing of Mathematics Departments 
of the Historically Black Colleges and Universities and the Math Departments of universities in Africa. 
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●     Biosciences (5) 
●     Chemistry (8) 
●     Communications (16) 
●     Controls and Systems (101) 
●     Earth Sciences (5) 
●     Economics and Finance (3) 
●     Electronics (34) 
●     General (64) 
●     Image Processing (4) 
●     Mathematics (92) 
●     Mechanical Engineering (21) 
●     Neural Network and Fuzzy Logic (15) 
●     Physics (3) 
●     Signal Processing (71) 
●     Statistics and Probability (17) 
●     System ID (5) 
●     Visual Basic (117) 
●     C and C++ (22) 
●     Fortran (17) 
●     Other (3) 
●     Java (58) 
●     Learning (19) 
●     IDL+PVWave (15) 
●     Excel (19) 
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●     Books (3) 
●     C and C++ (12) 
●     Fortran (14) 
●     Other (4) 
●     Java (3) 
●     Linear Algebra M-files (5.x)  
●     Linear Algebra M-files (4.2)  
●     Approximation/interpolation m-files (5.x)  
●     Approximation/interpolation m-files (4.2)  
●     Solving DDEs with MATLAB - The information on this page deals with the 

solution of delay differential equations (DDEs) with constant delays using 
MATLAB . Included are a tutorial on using the MATLAB dde23 solver to 
solve DDES, a manuscript containing technical details for the solver, and 
a manuscript dealing with the event location procedures used in dde23. In 
addition, the necessary M-files for the solver as well as the M-files for the 
problems discussed in the tutorial are available. 

●     A Matlab Differentiation Matrix Suite - This is a software suite designed for 
MATLAB 5 consisting of seventeen functions for solving differential 
equations by the spectral collocation (a.k.a. pseudospectral) method. It 
includes functions for computing differentiation matrices of arbitrary order 
corresponding to Chebyshev, Hermite, Laguerre, Fourier, and sinc 
interpolants. It also includes FFT-based routines for Fourier, Chebyshev 
and sinc differentiation. Auxiliary functions are included for incorporating 
boundary conditions, performing interpolation using barycentric formulas, 
and computing roots of orthogonal polynomials. 

●     Biharmonic Equation - The biharmonic equation is used to model the 
deflections arising in two dimensional rectangular orthotropic symmetric 
laminate plates. The plate can be subjected to external perpendicular 
force(q) and one is interested in the resulting deflections. Various 
boundary conditions can be applied to the problem. The edges can be 
simply supported, clamped, or free. In this work, an automatic procedure 
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is defined which produces the difference equations for each edge 
boundary case. The procedure is illustrated, using MATLAB, with 
numerical results for problems with and without exact analytical solutions. 
We define an automatic procedure to generate the difference equations 
for approximating the solution to the biharmonic equation under various 
boundary conditions. 

●     cumsimp.m  - Simpson-rule column-wise cumulative summation. 
Numerical approximation of a function F(x) such that Y(X) = dF/dX. 

●     deriv.m  - Column-wise derivative estimation. Computes 5-point 
discrete derivative estimates for each column of the input matrix U. 

●     DFIELD, PPLANE - The programs DFIELD and PPLANE are described in 
some detail in the manual Ordinary Differential Equations using MATLAB. 
There are several versions of the software available for use with various 
editions of MATLAB. 

●     DiffMan - DiffMan is a MATLAB toolbox for solving ordinary differential 
equations on manifolds, based on the concept of 'Coordinate Free 
Numerics'. This is, loosely speaking, the idea that (whenever possible) it is 
important to formulate numerical algorithms generically, independently of 
special representations and coordinate systems. DiffMan inherits its basic 
design philosophy from the C++ package SOPHUS. 

●     Numerical Integration Toolbox  - This toolbox provides routines for 1-D, 
2-D, and n-D Numerical Integration. 

●     ODESuite - These pages present a suite of programs for the solution of 
initial value problems y0 = F(t;y) on a time interval [t0;tf], given initial 
values y(t0) = y0 . The solvers for stiff problems allow the more general 
form M(t)*y0 = f(t;y) with a mass matrix M(t) that is non-singular and 
(usually) sparse. As in many environments, the typical problem in Matlab 
is solved interactively and the results displayed graphically. Generally, 
functions defining the differential equations are not expensive to evaluate. 
The typical stiff problem is either of modest size or has a highly structured 
Jacobian. In Matlab , linear algebra and the built- in array operations are 
relatively fast, and the language provides for sparse arrays. Matlab 
handles storage dynamically and retains copies of arrays. 

●     Push bound - The push bound problem is a very interesting one. When we 
push at a plate, sometime all of the plate goes ahead, sometime some 
place bounds. C. V. Coffman and R. J. Duffin[1], R. J. Duffin[2] and P. R. 
Garabedian[3] did some good work in this field. Here, what we are 
considering is, for square plates, when we push at a given point, which 
points will bound. Using difference method and MATLAB, we deal with 
common material (like glass, steel, ...) and composite material square 

 

http://www.mathtools.net/MATLAB/Calculus/index.html (2 of 3) [01/07/2002 22:22:55]

http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathtools.net/files/net/cumsimp.zip&location=http://www.mathtools.net/MATLAB/Calculus/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathtools.net/files/net/deriv.zip&location=http://www.mathtools.net/MATLAB/Calculus/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://math.rice.edu/~dfield/&location=http://www.mathtools.net/MATLAB/Calculus/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.ii.uib.no/diffman/&location=http://www.mathtools.net/MATLAB/Calculus/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathtools.net/files/net/nittbx.zip&location=http://www.mathtools.net/MATLAB/Calculus/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://wwwce1.kat.lth.se/software/odesuite.htm&location=http://www.mathtools.net/MATLAB/Calculus/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.csee.wvu.edu/~trapp/push_bound.htm&location=http://www.mathtools.net/MATLAB/Calculus/index.html


> MATLAB > Calculus

plates. 
●     quadr.m,quads.m  - m-files for 1-dimensional integration which are 

faster, more reliable and more universal than those currently available. 
They are both vectorized in the best MATLAB sense while fully adaptive to 
local function behavior. 
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●     MATLAB (464) 
●     Visual Basic (117) 
●     C and C++ (22) 
●     Fortran (17) 
●     Other (3) 
●     Java (58) 
●     Learning (19) 
●     IDL+PVWave (15) 
●     Excel for Scientists and Engineers - Information on Excel for Scientists 

and Engineers book. Also some Tips and tricks. 
●     BMS Tutorial for Spreadsheet Data Analysis - A tutorial for Physiology 

students that illustrates the use of some of the advanced features of MS 
Excel to analyze data. 

●     EXCEL 5 for Windows - This document deals with version 5 of the Excel 
spreadsheet package for PCs running Microsoft Windows. It covers 
creating, editing and printing a spreadsheet, as well as formulae, functions 
and sorting. 

●     Excel Basics - Check your basic knowledge of Excel with the examples 
here. If you don't know these 21 Excel features, you may be missing some 
fundamental capabilities in using this tool. 

●     Excel Help Page - Recently added tutorials:- Return on Investment (ROI) 
and Return on Equity (ROE) Business Model Forecasting Techniques 
Comparative Ratio Analysis Business Solutions Pivot Table Example from 
December 1998 Journal of Accountancy article - "Add Perspective to 
Spreadsheets" 

●     Excel Tutorials - A very comprhensive Excel tutorial page, including a 
Business Solutions Tutorial, Chart and Graph Tutorial, VBA Fundumental 
and Advanced Tutorial, and many more. 

●     Formatting Data In Microsoft Excel  - This Tutorial Workbook contains a 
series of hands-on exercises in formatting an Excel spreadsheet. (PDF) 
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●     Help for Microsoft Excel Solver Users - We maintain this Web site as a 
service to all users of the Microsoft Excel Solver. Its content reflects our 
experience helping users for almost four years. 

●     Interactive Examples For Excel2000 - The pages in the /Interact directory 
allow to see formulas in action. Not only can you see actual Excel 
spreadsheets using the formulas, but you can change the variables. 
Through your web browser, you can actually see and work with the Excel 
formulas described on my web site. 

●     Introductory Exercises in Excel  - This document contains a series of 
exercises which give an introduction to the Excel spreadsheet program 
(version 5). (PDF) 

●     Microsoft - Excel 2000 Tour - Discover better ways to analyze data and 
find solutions using Microsoft Excel 2000 and its streamlined spreadsheet 
creation tools, enhanced analysis tools, and powerful Web integration. 

●     Microsoft online support-search - Search the Microsoft Knowledge Base of 
technical support information and self-help tools for Microsoft products. 

●     Orientation in Excel - An Excel tutorial, built as a series of assignments for 
the student. 

●     Sheffield - Excel - Excel Help Index from the University of Sheffield. 
●     Tools Options Guided Tour - Tools Options Guided Tour is a WinHelp file 

going into detail about all the options in the Excel 5 Options dialog on the 
Tools menu. 

●     Underground Guide Series - A "behind-the-scenes" tour of Excel that 
helps you get real productivity out of your favorite spreadsheet. In their 
irreverent, off-the-wall style, the authors separate spreadsheet gold from 
marketing hype and show you how to take advantage of Excel features 
you won't find covered anywhere else in the known universe (not even in 
the manual). 

●     Visual Guide for MS Excel - Visual Guide for MS Excel is an animated 
spreadsheet tutorial designed to help you assess your knowledge, and 
focus on personally relevant topics. 

●     Weblinks Help File for Excel - The Microsoft® Excel 97 Weblinks Help file 
adds hyperlinks to Microsoft Knowledge Base articles in many Excel Help 
topics. So if you need more information on these help topics, expertise 
from Microsoft Support Technicians can be obtained with just a click. 

●     Writing Formulae With Microsoft Excel  - This document contains a 
series of exercises in creating and editing formulae in an Excel (version 5) 
spreadsheet. (PDF) 
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●     MATLAB (464) 
●     Visual Basic (117) 
●     Fortran (17) 
●     Other (3) 
●     Java (58) 
●     Learning (19) 
●     IDL+PVWave (15) 
●     Excel (19) 
●     Yechiel's Preferred C and C++ Sources - Yechiel's Preferred C and C++ 

Books and Internet Sites 
●     Free programming books - Free programming books covering C++, Java 

etc. 
●     Component Connection - This chapter discusses several of the issues that 

arise when you move from C++ to Java. Since many (if not most) Java 
programmers come from a C++ background, it is natural to want to carry 
over the skills, techniques, and code acquired in this language. Although 
C++ and Java were designed to address the programming needs of two 
very different environments, many of the same coding techniques, 
algorithms, and optimizations apply to both. However, as explained in Part 
One, Java is not "the Internet version of C++." While there are many 
similarities between the two languages, there are also several differences. 
This chapter reviews those differences and shows ways to handle some of 
the more challenging ones. 

●     C++ Streams - Internals and Applications - Although the syntax of the C++ 
language is based on C, many of the features and concepts of the 
language are quite different. In some cases, entirely new concepts have 
been introduced. The idea of data streams is one of these new concepts. 
A C++ stream is an abstract representation of data flow from one location 
to another. The origin of the data is usually called a producer or source, 
and the destination is usually referred to as a consumer or sink. Streams 
can be designed to handle the transfer of data in any format, from simple 
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fundamental types like int, char, char *, long, and double, to complex 
objects containing many classes and derivations. C++ streams are most 
often constructed from the combination of two base classes. In the current 
implementation of C++, these base classes are streambuf and ios. Under 
this design, the streambuf class object provides for the buffering and 
orderly passing of information from the producer to the consumer. The ios 
class object is then respo 

●     LEARN C/C++ TODAY - This is a list of a few C and C++ language 
tutorials available to users. The list includes interactive tutorials, public-
domain code collections, books etc. 

●     NML Code Generator Instructions - Instructions for using the NML Code 
Generator to create C++ or Java NML definitions. 

●     Guide to C++ Classes - Runtime errors will inevitably occur in any 
complex software system. Independent of what may be done to recover 
from the error, it is important that information about the nature of the error 
be recorded to allow a human operator to later ascertain whether the 
software or the operating environment needs to be modified. A 
mechanism for recording of textual information pertaining to an error is 
provided by the OTC_Logger class. Error messages can be logged at a 
number of priorities, with messages being displayed to the standard error 
output. If required, error messages can also be saved to a file. By deriving 
from the OTC_Logger class you can capture the error messages and 
optionally save or cause them to be displayed using an alternate 
mechanism. For example, you may wish to have messages passed on to 
the UNIX syslog facility. 

●     Short C++ tutorial for C users - From Belgium, Eric Brasseur walks the 
reader through the first hours of a C programmer's fresh acquaintance 
with C++, introducing features like references, operators overloading, new 
and delete ("they are much more sweet than ... malloc and free") up to 
multiple inheritance. 

●     Porting C++ to Java - This paper is addressed to people who are 
considering porting their existing C++ code to Java. It provides a step-by-
step approach to porting C++ to Java effectively. 

●     C++ Primer  - Prices, description, reviews and more, about the book 
"C++ Primer" by Lippman/Lajoie. This book explains how to program in 
C++. It covers the latest ANSI/ISO standard and explains how to use C++ 
templates. 

●     Industrial Strength Programming - Here is a book that teaches not only 
language but also programming itself. The author of this book shares his 
experience in programming, teaches how to write reliable and 
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maintainable code, easy to understand by other members of the team; 
knowing advanced programming techniques such as synchronization in a 
multithreaded environment, effective use of virtual memory, debugging 
techniques, etc. 

●     TTT - The TTT System is a suite of files and programs aimed at providing 
you (the learner) with an interactive, World Wide Web based online course 
in the fundamentals of programming using the C++ programming 
language. 

●     The C++ Standard Library - A Tutorial and Reference - See and download 
all of the examples from the book "The C++ Standard Library - A Tutorial 
and Reference" by Nicolai M. Josuttis. 

●     Introduction to Object-Oriented Programming Using C++ - This tutorial is a 
collection of lectures to be held in the on-line course 'Introduction to 
Object-Oriented Programming Using C++'. In this course, object-
orientation is introduced as a new programming concept which should 
help you in developing high quality software. Object-orientation is also 
introduced as a concept which makes developing of projects easier. 

●     From The Ground Up: A Guide to C++ - From The Ground Up: A Guide to 
C++. This site is a tutorial for learning the programming language C++. 
The site makes extensive use of Java. It also has clever scheme of 
remembering where you were if you return to the tutorial many times. The 
tutorial is geared towards Pascal programmers converting to C++, and 
only covers C++ basics (classes and operator overloading are the most 
advanced topics). 

●     Fatbrain - Fatbrain.com is the Internet's most comprehensive bookstore 
for professionals. Recently named the number two fastest-growing public 
company in Silicon Valley, Fatbrain.com offers a world-class selection of 
books, training materials and print-on-demand documentation for 
business, finance, math, science and technology experts. Our industry 
experience and in-depth knowledge of authors, topics and trends help 
customers find the best resources for their needs. Fatbrain.com contains a 
comprehensive section on C. 

●     C - Tutorials - This is the tutorial section of 'cprogramming.com'. It 
contains: PROGRAMMING IN C/C++ tutorial; GRAPHICS 
PROGRAMMING tutorial. 

●     C++ Programming for Scientists - C++ tutorial for scientists. Course notes 
: ANSI C, C++ as a better C, C++ classes and objects, objects in scientific 
computing, inheritance & polymorphism, templates, exceptions & 
observations, programming examples, scientific library examples. 

●     Books reviews with grades - This page is a collection of reviews on C++ 
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books for advanced users. 
●     An Introduction to C++ - This is the first installment in a series called 

"Objective Viewpoint" that will teach you about C++. 
●     Gillius's C++ Programming - C/C++ focused page with tutorials ranging 

from language syntax to game development. Has FREE C/C++/Pascal 
source code and free games with source code. 

●     A TOUR OF C PROGRAMMING - This tutorial gives a complete 
understanding of the basics of C programming. The goal of this "guide to 
C" is to cover the basics of the language pretty thoroughly. After that will 
be introduced some more advanced things. 
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Mathtools.net > C++ > Calculus Add Link ... Email page to friend 

 
●     MATLAB (18) 
●     Fortran (14) 
●     Other (4) 
●     Java (3) 
●     MODEL - MODEL is a numeric simulation library written to simulate 

systems of rate equations describing Vertical Cavity Surface Emitting 
Lasers (VCSELs). Try it if you need an easy way to solve some systems 
of ordinary differential equations. 

●     The Godess project - This is a Generic Ordinary Differential Equation 
Solver System written in C++. The solver is an initial value solver for 
ODEs and DAEs, with rootfinding etc. The goal of the project is to improve 
the state-of-the-art for timestepping methods when solving initial value 
problems. I was responsible for the code during my Ph.D. studies and 
successfully worked on Runge-Kutta methods (mostly implicit ones). 

●     Only C++ - This is the C++ page of the Numeric Physic WWW site, where 
you can find the source code of many programs that deal with differential 
equations. 

●     KASKADE - A C++ toolbox for the solution of linear scalar elliptic and 
parabolic problems in 1, 2, and 3 dimensions using adaptive finite element 
methods. The toolbox includes extensions for handling systems of 
equations as well as example algorithms for nonlinear methods used in 
obstacle, porous media, or Stefan problems. The core of the program 
consists of a variety of multilevel/multigrid preconditioners for the linear 
systems involved. The iterative solvers included in the package include: 
conjugate gradient (with and without 3-term recurrence), conjugate 
residual (with and without 3-term recurrence), several relaxation routines 
(Jacobi, SSOR, etc.), GMRES, bi-conjugate gradients, BiCGStab, the 
Sonneveld CGS algorithm, conjugate gradients for normal equations, and 
a nonlinear relaxation routine. Preconditioner methods include: Jacobi 
type, symmetric Gauss-Seidel, incomplete LU-factorization, multilevel with 
Jacobi-type smoothing, multilevel with symmetric Gauss-Seidel 
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smoothing, additiv+. It can be compiled with g++ 2.6.3 or later. The 
package is documented in extensive programmer's and user's guides in 
PostScript format. 

●     Diffpack - A collection of C++ object-oriented class libraries designed for 
the numerical solution of partial differential equations. The package also 
includes several UNIX utilities for general software management and 
numerical programming. The goal of Diffpack is to provide an environment 
for the rapid prototyping of simulators based on PDEs which also offers a 
high level of efficiency. 

●     A++/P++ - A++ is a C++ array class for numerical computation designed 
to work with structured grid computations, including work on overlapping 
grids and adaptive mesh refinement. P++ is the parallel version of the 
serial class A++. A++/P++ was designed to simplify the development of 
numerical software, specifically to allow an application developed in the 
serial environment to be run on parallel machines with little or no 
additional effort. It is also intended as a partial solution to a growing crisis 
in the development of large numerical codes that are required to run on 
many different serial and complex parallel architectures. The A++/P++ 
distribution (35 Mb uncompressed) includes the source code and the 
documentation. Requirements for compilation and installation include a 
C++ compiler ( g++ will do) and a C and/or a Fortran compiler. The 
graphics visualization facilities of A++/P++ additionally require the Plotmtv 
software. The use of P++ requires a communication library. It presently w 

●     Clenshaw-Curtis-Quadrature - A presentation of the Numerical Automatic 
Integrator method, which is called "Chebyshev Series Expansion" in one 
dimension. The package includes source code. 

●     Automatic Differentiation - We want to calculate a value f(t1,...,tn) that 
depends on parameters t1,...,tn. But, in addition, we want to calculate the 
first and possibly second derivatives of f(t1,...,tn) with respect to t1,...,tn. 
For example, we want to find the maximum or minimum of f(t1,...,tn) and 
want to use an optimization method involving derivatives. The aim of the 
automatic differentiation package is to allow us to calculate the derivatives 
using a program that is just a minor modification of the program that 
calculates f. This greatly reduces the work involved and greatly increases 
the chances of getting the correct answer. 

●     ADOL-C (Automatic Differentiation of CC++) - The package ADOL-C 
facilitates the evaluation of first and higher derivatives of vector functions 
that are defined by computer programs written in C or C++. The resulting 
derivative evaluation routines may be called from C/C++, Fortran, or any 
other language that can be linked with C. The numerical values of 
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derivative vectors are obtained free of truncation errors at a small multiple 
of the run time and randomly accessed memory of the given function 
evaluation program. 

●     DE-Quadrature - Numerical Automatic Integrator for Improper Integral. 
Method: Double Exponential (DE), Transformation dimension: one. 

●     Diffpack - Diffpack is a comprehensive development framework for multi-
physics simulation. It is available on a wide range of hardware platforms. 

●     PVODE - PVODE is a portable solver for ordinary differential equation 
systems. It is based on robust mathematical algorithms, and targeted at 
large systems on parallel machines. A closely related solver called 
KINSOL has been developed for systems of nonlinear algebraic 
equations, and another is in progress for systems of differential-algebraic 
equations. 
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●     MATLAB (19) 
●     Banks (1) 
●     Collection (6) 
●     Databases (1) 
●     Documentation (7) 
●     Education (23) 
●     Equipment (1) 
●     Financial Data and Services (625) 
●     Journals (51) 
●     Markets (25) 
●     Organizations (41) 
●     Personal Finance (139) 
●     Research (12) 
●     Risk Management (62) 
●     Software and Tools (509) 
●     Tutorials (20) 
●     Web resources (15) 
●     C and C++ (7) 
●     Fortran (10) 
●     Industry Stories (5) 
●     Java (18) 
●     IDL+PVWave (2) 
●     Excel (54) 
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Downloading Solutions
Interested? Go ahead and download the program. It's absolutely free. We hope you have more fun 
than ever with mathematics and that it really helps you out!

There are two versions you can download. 

Version 1.05 for Windows

The last commercial release is Version 1.05. This is the last official version we actually used to 
sell (now it's free). It is fully tested and very reliable. We wish all other math software could be so 
stable...

Download version 1.05 (957K)

Version 2.0 Beta for Windows

Although the development is stopped since Elan has merged with another company to form 
ClicNet Télécommunications, there is a beta version of Solutions V2.0 available. It contains a lot 
of new interesting features. It has not been as fully tested as V1 but it is reliable. Hint: We use V2 
over V1 ;-)

Download Solutions V2.0 (749K) 
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http://www.qbc.clic.net/Elan/download.html [01/07/2002 22:28:18]

http://www.clic.net/Elan/dl/solv1.zip
http://www.clic.net/
http://www.qbc.clic.net/Elan/v2features.html
http://www.clic.net/Elan/dl/solv2.zip
http://www.qbc.clic.net/Elan/index.html


features - Derive

 

Derive™ 5

The Mathematical Assistant for Your PC

For college and university level mathematics educators, 
Derive 5 offers an easy to use, powerful CAS teaching tool 
with maximum computational power and 3-D graphing 
capability at an affordable price.

As a teaching tool, it provides the freedom and ease-of-use 
necessary to explore and document different approaches to 
solving problems. As a research tool, it provides an efficient 
and reliable environment for symbolically solving a wide range 
of mathematical problems. 

Derive is a trusted mathematical assistant relied upon by 
students, educators, engineers and scientists around the 
world. It does for algebra, trigonometry, calculus and linear 
algebra what the scientific calculator does for arithmetic. It 
eliminates the drudgery of performing long and tedious 
computations. Derive can solve both symbolic and numeric 
problems, and then plot the results as 2D graphs or 3D 
surfaces. 

Mathematical worksheets
Derive makes it easy to 
document mathematical 
investigations, and share them 
with others. Create, edit, print 
and save your explorations as 
formatted mathematical 
worksheets. In addition to 
mathematical expressions, 
worksheets can include 2D 
and 3D plot images, text and 
OLE objects. Write 
mathematical worksheets as Rich Text Format (RTF) files for 
use in word-processing programs. Enter mathematical 
expressions in a straight-forward, linear manner. Math 
symbols and Greek letters are available by clicking on 

 

 

Where to Buy
US & Canada 

●     Buy online* 
●     Buy from a 

Dealer 

International 

* Site license orders can 
only be placed through a 
Derive Dealer.

●     Bid 
Specifications 

●     Configurations 
●     Support 
●     Reviews 
●     Discussion 

Groups 

Other Products:

muLISP™
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dockable toolbars. Elements of vectors and matrices are 
entered using a spread-sheet like template. Limits, derivatives, 
integrals, sums, etc. are easily calculated using templates so 
you don't have to remember complicated function names or 
argument lists. In the worksheet, Derive displays expressions 
in easy to read, two-dimensional mathematical format. With 
the click of a mouse, subexpressions can be selected for 
operations such as simplifying, expanding, or factoring. 

Mathematical features
Derive can algebraically 
simplify, expand and factor 
symbolic expressions. 
Equations, inequalities, and 
systems of polynomial 
equations can be solved for 
their real and complex roots. 
Perform numeric operations 
exactly with no round-off error or approximately to thousands 
of digits of precision. Derive applies the rules of trigonometry, 
calculus, matrix algebra and vector calculus to solve your 
toughest math problems. In addition to the built-in capabilities, 
Derive comes with an extensive library of utility files that define 
functions for solving first and second order ordinary differential 
equations (both exactly and numerically), and for computing 
Bessel, Fresnel, elliptic integrals and other special functions. 
Utility files are automatically loaded on demand, so these 
functions are always available for use. Naturally you can 
create your own utility files by defining functions using either a 
functional or procedural programming style, as appropriate. 
For the latter, Derive provides flexible loop, block, and if-then-
else control constructs as well as the ability to define default 
values for arguments. 

2D graphs 
Plot multiple 2D graphs to 
analyze and explore equations 
in both Cartesian and polar 
coordinate systems. Control 
the aspect ratio, scale and axis definition of your plot, and 
optionally view the real and imaginary parts. Trace the graph 
and view precise coordinates of points on the curve. Derive 
can even plot Boolean combinations of inequalities involving 
two variables! 

 

DERIVE 
for DOS
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3D surfaces
Rotate and zoom multiple 
shaded 3D surfaces in real-
time. Plot 3D surfaces using 
parametrically defined 
functions or sets of data 
points. Display surfaces in 
rectangular, spherical or cylindrical coordinate systems. 
Determine coordinates of points on surfaces using movable 
highlighted cross lines. 2D graphs and 3D surfaces can be 
annotated with descriptive text, sent to the clipboard or printer, 
or exported in popular formats such as TIFF, JPEG, and BMP. 

System Requirements 
Windows® 95, 98, ME, NT, 2000 or XP compatible PC 
(minimum RAM and processor requirements are the same as 
the operating system requirements), CD ROM Drive, and less 
than 4 MB of disk space. 
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New! Mathcad 2001i is here. 

Special Promotions 
(good only in US & Canada)
 

 
Mathcad Makes The Wall Street 
Journal 

MathSoft Announces Mathcad 
2001i 

MathSoft Announces Axum7 

MathSoft Prepares Students for 
the 2003 School Year With 
Interactive StudyWorks! Math 
Software 

 

 

MathSoft is the leading provider of math, science and engineering software 
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MathSource: The Library of Mathematica-Related Materials

 

[ Applications | Enhancements | Publications | General | What's New ] 

MathSource for Mathematica 2.2 and earlier is also available. 

Query: 

Search: 

MathSource is a vast electronic library of Mathematica materials, including 
immediately accessible Mathematica programs, documents, and examples. 
Established in 1990, MathSource offers a convenient way for Mathematica 
developers and users to share their work with others in the Mathematica 
community. In MathSource you can either browse the archive or search by 
author, title, keyword, or item number.

●     Submit your own material to MathSource. 

●     Look at the guide to linking to MathSource resources (includes information on 
linking to MathSource for Mathematica 2.2). 

●     Give us your comments on MathSource or any material in MathSource. 

●     Go the the main Wolfram Research site. 
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Orientation

When you first start Mathematica, you should see a "splash" screen with the Mathematica logo, version, 
and license information. When the program loads, you should see several objects on the screen. We will 
now describe what they are and what they do.

You may wish to turn on your speakers (or bring headphones if you are in an STC). 
Mathematica uses audio cues to notify the user of errors, finished calculations, etc.

Notebooks

A notebook is a collection of Mathematica statements, output, and graphics. The concept is like that of a 
"document" in a word processor. You enter information and commands into the notebook window, and 
the output (if any) is displayed there. 
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If the notebook has been modified since it was last saved, an asterisk (*) will appear in the title bar. To 
save your work, choose File->Save As... or File->Save. 

If Mathematica is ready for new input, the cursor will flip sideways (see above). Just start typing to 
enter information. Try typing this (don't press return yet):

2 + 2

To tell Mathematica to evaluate this expression, hold down Shift and type Return. Since Mathematica is 
also a word processor, it needs to know if you want to evaluate the expression, or just insert a carriage 
return-linefeed. This can be quite confusing to the new user.

System Evaluate Linefeed

Macintosh Enter or Shift-Return Return

Windows Shift-Enter Enter

X Shift-Return Return

Next, look at the blue symbols along the right side of the notebook. Each group of statements enclosed 

by the triangle-brackets ( ) is called a cell. The cell is the smallest unit of work in Mathematica. A cell 
may contain input or output, math or comments, text or graphics. 

Cells in Mathematica are like execution groups in Maple.

Palettes
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You should see a box with a lot of symbols floating on the right side of your 
Mathematica window. This is called a palette. Palettes allow you to easily insert 
complicated mathematical notation. For example, to compute the cube root of 34, you 

could click on the  . Type 34, which should appear under the root sign. Then 
click on the small square above the root, and type 3 in the box. Finally, evaluate the 
expression.

Using the default palette, you can enter fractions, integrals, summations, matrices, 
subscripts, and most greek letters. Of course, there are many other palettes available - 
choose File->Palettes to see a list. 

Kernels

Mathematica is actually split into two conceptual pieces, the front-end and the kernel. When you start 
Mathematica, you are actually only starting the front-end.

The front-end handles input and output to the user, access to the file system, and creates graphics on 
your screen. Most users will deal primarily with the front-end.

The kernel does nearly all computation (excluding graphics rendering). When you evaluate any 
expression, the kernel does the hard work and sends the results back to the front-end, which then 
displays it in an attractive format for the user.

Most users will run the front-end and the kernel on the same computer. If your computer is connected to 
a network, you can run the kernel on a more powerful machine, while running the front-end on your 
favorite computer. To learn how to do this, choose Kernel->Kernel Configuration Options, click Add, 
and then click Help.

How to stop a runaway calculation:

●     Macintosh - Command-Comma or Control-C
●     Windows and X - Alt-Comma or Control-C

This will bring up a menu that allows you to view the state of the kernel, abort the 
calculation, etc.

Help system

Mathematica has an excellent help system. To get general help, choose Help->Help Browser. Browse 
among the topics listed. 
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Mathematica comes with an excellent resource, The Mathematica Book. It is available through the Help 
Browser. See also the Getting Started section, which contains several excellent tutorials. 

Next:Doing Math
Previous:Introduction
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Doing Math

Arithmetic

Basic arithmetic operations are easy to enter in Mathematica. You may use your choice of notation, and 
you may choose to enter symbols via the palettes or the keyboard. 

Keystrokes Input Output Comments

4, ,+, ,4
3,-,1,6

4+4
3-16

8
-13

Addition, subtraction.
Spaces are optional.

4,*,4
4, ,4
4,4
4,Esc,*,Esc,4

4*4
4 4
44

4 4

16
16
44
16

Multiplication.
A space can mean multiplication as well...
...but you should be careful.
You can also use the symbol.
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3,/,4

3,Esc,d,i,v,Esc,4

3,Ctl-/,4

3/4

3 4 Exact division.

3,^,5
3,Ctl-^,5

3^5
35

243
243

The text version
The symbolic version

3,^,(,1,/,2,)
Ctl-@,3
N,[,Ctl-@,3,Ctl-Space,]

3^(1/2)

N[ ] 1.73205 An approximation.

%,Ctl-^,2 %2 3. Square last output.

Mathematica's data restrictions are as follows:

●     Integers can be of any size, up to your computer's memory.
●     Real and complex operations are carried out with arbitrary (limitless) precision, up to your 

computer's memory, unless N is used.
●     See Help->Help Browser: Numerical Computation->Numerical Precision->N, and section 1.4.9 

of The Mathematica Book.

●     Mathematica does not set limits on the size of matrices, as Maple does.
●     N[...] is just like Maple's feval

. 

If you want to use double precision, you must explicitly say so. See above.

Algebra

Mathematica is more than a calculator, of course. We will now try out some of Mathematica's Computer 
Algebra System (CAS) features. 

Keystrokes Input Output Comments

a a a All names are symbols.

a,=,4 a=4 4 Defining a constant.

Esc,a,l,p,h,a,Esc,=,3 =3 3 Greek letters (see palettes).
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(,x,+,1,),Ctl-^,2 (x+1)2 (x+1)2 An expression.

E,x,p,a,n,d,[,%,] Expand[%] 1+2x+x2 Algebraic expansion....

S,i,m,p,l,i,f,y,[,%,] Simplify[%] (x+1)2 ...and simplification.

From this point onward, we will assume that you know how to enter keystrokes. 

Input Output Comments 

p=x3+3x2+3x+1 x3+3x2+3x+1
p is now an alias for the expression.
This is not mathematical equality.

Solve[p==0]
{{x->-1},
{x->-1},
{x->-1}}

Solve the equation p==0. Mathematica returns 
a set of transformation rules. 
The system has three identical solutions.

p /. x->2 27 Substitute 2 for x (temporarily).

p==0 /. x->2 False 27 does not equal 0.

Transformation rules are like the subs command in Maple.

Go exploring in the Algebra Palette:
File->Palettes->AlgebraicManipulation.

Next:Functions
Previous:Orientation
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Functions

Using them

A function in Mathematica is a formalized, named transformation rule. A function may return a symbol, 
a real number, a complex matrix, another function.... Any mathematical object is an acceptable value for 
a function. We have seen several built-in functions so far: Solve, Expand , and N are a few examples. A 
function may be written using mathematical notation, it may be created using programming constructs 
(like for, if/then, etc.), or it could even be written in another language entirely (Fortran, C, etc.). 

All built-in Mathematica functions are named with InitialCapitalLetters (FullSimplify ) and some use 
abbreviations (NDSolve - Numerical Differential Equation Solver). 

Creating them

Input Output Comments
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f[x_]:=x2 (none) A simple function definition. Note the underscore (_) that follows 
the dependent variable name.

f[2]
f[y+z]

4
(y+z)2

The function works with numbers
and expressions.

f[f[f[2]]] 16348 You can nest functions.

?f
Global 'f
f[x_] := x2 What is f?

g[x_,y_] := x*y (none) You can have as many arguments as you like.

Clear[f] (none) Deletes the definition of f.

Procedural Functions

You may wish to create more complex functions. Suppose that you wanted to count to 100, and print 
out a list of each number that is divisible by the argument. Here is one way that you could do it:

sillyCount[n_] := ( Do[ If[Mod[i,n]==0, Print[i]] ,{i,100}]; )

For more information on programming in Mathematica, see the online help.

Next:Graphics
Previous:Doing Math
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Graphics

2-D Graphics

Input Output Comments

Plot[Sin[x2],{x,0,2Pi}] A simple plot. 

Plot[Tan[x], {x, -2Pi, 2Pi}]
If the plot has singularities, 
Mathematica will try to choose a 
suitable scale....

Plot[
   Tan[x],
   {x, -2Pi, 2Pi},
   PlotRange -> {-10,10}]

...or you can set it manually.
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Plot[
   {Sin[x],Sin[2x],Sin[3x]},
   {x, 0, 2Pi}]

You can plot multiple functions 
by 
including them in curly brackets.

Show[GraphicsArray[
   {Plot[Sin[x],{x,0,Pi}],
   Plot[Sin[2x],{x,0,2Pi}]
   }]]

Plot two plots, side-by-side.

ParametricPlot[
   {Cos[7t], Sin[11t]},
   {t, 0, 2Pi}]

Parametric plot.

For more information, see section 1.9.1 in The Mathematica Book. 

3-D Graphics

Input Output Comments

Plot3D[
   Sin[x y],
   {x,0, 3},
   {y, 0, 3}]

A basic surface plot.

Plot3D[
   Sin[x y],
   {x, 0, 3},
   {y, 0, 3},
   PlotPoints -> 40]

You can get a finer plot if you 
increase the number of sample points.

Plot3D[ Sin[x y],
   {x, 0, 3},
   {y, 0, 3},
   ViewPoint -> {1, 1, 0}, 
   PlotPoints -> 40,
   Boxed -> False,
   Axes -> False]

A variety of options. 
Most important is the ViewPoint option,
which tells where to put the "camera".

For more information, see section 1.9.7 of The Mathematica Book.
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Further Reading

If you have enjoyed working with Mathematica, you will almost certainly enjoy The Mathematica Book. 
It is available on the web, through Stat/Math Center Sales, at your local bookstore, and in the online 
help.

In addition, be sure to wander through the Wolfram Research Documentation Center, where you will 
find reference works on any topic imaginable.

You can find other people who use Mathematica in the following usenet newsgroups:

●     comp.soft-sys.math.mathematica
●     sci.math.symbolic (Mostly Maple discussion, but some Mathematica)

In addition, your local bookstore or library probably has several books about Mathematica or one of its 
applications. WRI keeps a list of current books on their website.

Up:Introduction
Previous:Graphics
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Calculus graphics -- Douglas N. Arnold

(animated GIF version)

    

     

GRAPHICS FOR THE CALCULUS 
CLASSROOM

Douglas N. Arnold

     

     

 

These are excerpts from a collection of graphical demonstrations I developed for first year calculus. 
Those interested in higher math may also want to visit my page of graphics for complex analysis. This 
page is on the list of the most frequently linked math pages according to MathSearch. 

Viewing instructions. The animations on this page use the animated GIF format. There is also a Java 
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version of this page. The Java animator allows you to start and stop the animation, advance through the 
frames manually, and control the speed. Also the animation is a bit smoother, and the frames shuttle (first 
to last and then backward to first, etc.), which is a bit nicer. Unfortunately, the Java versions of the 
animation usually take much more time to load, and the Java animator has been know to crash browsers, 
especially on machines without much memory. An older version of this page using the MPEG animation 
format is available, but no longer actively maintained, and so not recommended.

 Differentials and differences

This animation expands upon the classic calculus diagram above. The diagram illustrates the local 
accuracy of the tangent line approximation to a smooth curve, or--otherwise stated--the closeness of the 
differential of a function to the difference of function values due to a small increment of the independent 
variable. (In the diagram the increment of the independent variable is shown in green, the differential--
i.e., the product of the derivative and the increment--in red, and the difference of function values as the 
red segment plus the yellow segment. The point is that if the green segment is small, the yellow segment 
is very small.) A problem with the diagram is that when it is drawn large enough to be visible the 
increment is too large to make the point. For example, here the yellow segment is about 30% of the green 
segment. This animation overcomes that problem by showing two views of the diagram, each changing 
as the increment varies. In the left view the ``camera'' is held fixed, and so the diagram becomes very 
small, while in the right view the ``camera'' zooms in so that the diagram occupies a constant area on the 
screen, and the relationship between the segment lengths can be clearly seen. Note how the yellow 
segment becomes very small in the second view (while the green segment appears to be of constant 
length due to the zoom). Note also that as we move in the difference between the purple curve and the 
blue tangent line becomes insignificant. 

 Computing the volume of water in a tipped 

glass

These images concern the computation of a volume by integrating cross-sectional areas. The first image 
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reviews the basic principle. The other images treat a specific volume, that of the wedge of water formed 
when a cylindrical class of equal height and diameter is tipped until the water line runs through the center 
of the base. The pictures are frozen frames from AVS, and can only convey a rough idea of the 
interactive classroom presentation (which typically lasts about 30 minutes). 

●     The principle
●     The wedge of water formed by tipping a glass
●     Cross sections perpendicular to the waterline at the base 
●     Three different ways to slice the same volume

And now for the quiz: Compute the percentage of the glass filled by water using each of the the three 
slicings depicted in the last slide and verify that they all lead to the same answer.

Archimedes' calculation of  

In the third century B.C., Archimedes calculated the value of  to an accuracy of one accuracy of one 
part in a thousand. His technique was based on inscribing and circumscribing polygons in a circle, and is 
very much akin to the method of lower and upper sums used to define the Riemann integral. His 
approach is presented in the following sequence of slides. 

●     Calculating the area of a circle 
●     Inscribed hexagon 
●     Triangulation
●     A lower bound for the area
●     Circumscribed hexagon: an upper bound for the area
●     Refining the bounds with dodecagons 
●     Table of results
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 How the ball bounces

As a way to help students appreciate functions, their applications, and their graphs, I involve them in a 
small project to describe the functions determined by the height of a bouncing ball. Although I start by 
dropping a real tennis ball from one meter above ground, a better quantitative idea of the function can be 
obtained from a computer animation, including a meter stick and clock. The students view the animation 
(in slow motion, with manual frame advance, etc.) and try to construct the graph of the function. As a 
homework assignment they are asked to determine the function algebraically. This is a piecewise 
quadratic and helps the students to realize that piecewise defined functions do exist outside of calculus 
books.

●     Animation of a bouncing ball 
●     Animation of the ball with a graph of its height 
●     Animation of the ball with a graph of its height and velocity 
●     the Mathematica file used to construct the animations
●     the student worksheet (PostScript file)

 Secants and tangents

This is a pretty straightforward animation depicting the geometric convergence of secant lines to the 
tangent line. The slope of the secant (which converges to the derivative) is also displayed. I use various 
variations on this demo during the early part of a calculus course. 

●     Animation of secants approaching a tangent 
●     The same animation with the tangent shown 
●     Secants passing through a point of non-differentiability 
●     Secants approaching a vertical tangent--another form of non-differentiability 
●     The Mathematica file used to construct the animations.
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 Zooming in on a tangent line

This animation is a version of the common demonstration that a smooth curve becomes indistinguishable 
from its tangent line when viewed under a sufficiently high power microscope. Students can easily 
demonstrate this themselves using a graphics calculator equipped with a zoom button. In this animation, 
we provide some extra distance queueing by showing the grid and striping the tangent line. Here is the 
Mathematica file used to construct the animations. 

 A trigonometric limit

An elegant geometric proof which is well within the reach of a beginning calculus student is the proof of 
the fundamental trigonometric limit

The proof is based on a diagram depicting a circular sector in the unit circle together with an inscribed 
and a circumscribed triangle. From the fact that the sector has area exceeding that of the inscribed 
triangle but less than that of the circumscribed one is lead to the inequalities

 

The proof then follows from the "squeeze theorem."

I usually spend about 15 minutes on this proof, including lots of class participation. The diagram is built 
up in three steps: first the sector only, then with the inscribed triangle, and finally with both triangles. 
Here are some instructions for creating it in class. During the presentation I make frequent recourse to 
plotting software to verify the various inequalities. For example this plot, constructed from this 
MATLAB file, convincingly verifies the second set of inequalities.
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 The limit

These are some simple graphs which are useful in a discussion of limits. The first three functions all have 
limit -5 as x approaches 1, emphasizing the irrelevance of the value of the function at the limit point 
itself. The last function has different left and right hand limits at 1, and so the limit does not exist. The 
graphs were constructed with this MATLAB file.

 A nowhere differentiable function

A brief graphical exploration of a continuous, nowhere differentiable function fits very well in the first 
semester of calculus, for example, to provide a strong counterexample to the converse of the theorem that 
differentiability implies continuity; or to show that it is only differentiable functions which look like 
straight lines under the microscope. Given good classroom graphics facilities such an exploration is easy, 
but it is almost hopeless without them. This plot of such a function was produced with a few lines of 
Matlab code following Weierstrass's classical construction. In class I zoom in on this graph several times 
to reveal its fractal nature. Consequently I used a very fine point spacing. On a slower machine it is 
preferable to use fewer points, and decrease the point spacing as you zoom in.

 2.718281828459045235360287471352662

Students are often puzzled by the appearance of the number e, which is given above (to 35 decimal 
places). A simple explanation of its origin arises from the fact that e is the only number for which the 
tangent to the graph of y=ex through the point (0,1) has slope exactly 1. The important result that the 
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function f(x)=ex is its own derivative follows easily from this fact and the elementary laws of exponents. 
This animation here simply shows the graph of y=ax, but with varying a. By manipulating the frame 
advance, you can adjust a so that the tangent has slope close to 1. The second animation is similar to the 
first, but drawn on a larger scale, and from it one can read off the first few decimal places of e. Here is 
the Mathematica file used to construct the animations. 

 The intersection of two cylinders

Here's a demonstration by my colleague David Sibley illustrating the computation of the volume of the 
region formed by two intersecting cylinders.

Last modified July 2, 1997 by Douglas N. Arnold, arnold@ima.umn.edu
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Welcome to the Complex, Technology 
Based Problems in Calculus Home Page

What we're all about:

We offer complex, technology-based problems in calculus with applications in science and engineering. 
These problems have a higher level of complexity than traditional text book problems and foster use of a 
computer algebra system. Each problem set includes discussions of related teaching issues and solutions 
worked in Mathematica. 

 

Each problem is provided in the following three formats: 

 .html = . Mathematica notebook in HTML format with figures translated to GIF files. 
This is readable by any standard WWW viewer, but a Netscape will probably work best. 
Translated to HTML by nb2html. 

 .ma = . Mathematica notebook (ver. 2.2) (ASCII). Download this version after viewing 
the HTML format. 

 .asc = . Text as ASCII. This contains all the text of statement of problem, comments and 
solutions. 

How to search: 

 By category: Choose from categories that best describe the problem type desired. 
 Full text word search: All problems with the string you enter will be listed. 
 Keyword search: All problems come with a list of key words provided by the author(s). All 

matches will be listed. 
 Alphabetically: If you know the file name for a problem set, you can find it in alphabetical 

order. 

Here are the problems.

And here are the problem developers. 
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Go to the Rose-Hulman Math Department Home Page. 

Go to the Rose-Hulman's Home Page. 

This page is maintained Aaron Klebanoff. Questions, comments, etc. should be directed to 
Aaron.Klebanoff@Rose-Hulman.Edu. 

 
Support: The production of this material is supported by the National Science Foundation under Division of Undergraduate Education grant 
DUE-9352849: Development Site for Complex, Technology-Based Problems in Calculus with Applications in Science and Engineering and the 
Arvin Foundation of Columbus IN. 
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Interactive Learning in Calculus and 
Differential Equations with Applications
Click on this picture for a description of how it was generated.

The Mathematics Department at Indiana University of Pennsylvania (IUP) 
established a computerized learning environment, consisting of a classroom with 
31 Macintosh Centris 650s and a laboratory with 12 Macintosh LCs, all 
equipped with Mathematica. Mathematica's notebook feature enables science 
students to actively learn calculus and differential equations with guided 
discovery and exploration. The project was funded through a National Science 
Foundation Instrumentation and Laboratory Improvement grant, number DUE-
9351896. IUP's project has several significant attributes. 

●     The Mathematics Department is fully implementing this curriculum in all 
sections of its science calculus sequence and in the two-semester 
differential equations sequence. 

●     Eleven faculty, comprising approximately one third of IUP's mathematics faculty, are 
coinvestigators. 

●     The curricular revisions are being coordinated with the science departments at IUP, who are also 
integrating active learning and technology in their courses. This collaboration, based on common 
pedagogical goals and software, will bring more scientific applications into mathematics courses 
and strengthen the use of mathematics in science courses. 

●     All students in the Mathematics Department are involved. Mathematics and Applied Mathematics 
majors are required to take Differential Equations, and Mathematics Education majors have a unit 
devoted to the project in the teacher preparation course, Computers and Calculators in Secondary 
Mathematics. 

Check back later at this location for more Mathematica notebooks relating to calculus, ordinary 
differential equations, and partial differential equations. Some of the topics covered are: 

●     Finding Areas with the Gauss-Green Formula, 
●     Newton's Method and Fractals, 
●     Vibrating Drumheads 
●     The Drag Force on a Sphere

(This notebook predates our project, but it fits in, so we are including it anyway) 
●     Advanced Mathematics for Applications

(This is a collection of 26 Mathematica notebooks from our course of that name.) 
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In order to disseminate these Mathematica notebooks, one of the PIs in this grant wrote a program, 
math2html, to convert Mathmematica notebooks to HTML documents. This program is available to the 
public. 

Presentations: 
1.  "Mathematica in the Classroom", Francisco Alarcon and Charles Bertness, Lock Haven 

University, February 21, 1994. 
2.  "IUP's Mathematica Network", Rebecca Stoudt, poster session on "Computer Laboratories in 

Mathematics Education", American Mathematical Society/Mathematical Association of America 
Joint Meeting, Cincinnati, Ohio, January 1994. 

3.  "Restructuring the First Differential Equations Course for Mathematics and Science Majors using 
Mathematica", Francisco Alarcon, in the MAA session "New Methods for Teaching Ordinary 
Differential Equations", American Mathematical Society/Mathematical Association of America 
Joint Meeting, Cincinnati, Ohio, January 15, 1994. 

Francisco Alarcon, Don Balenovich, Charles Bertness, Gerald Buriok, Dan Burkett, Arlo Davis, H. 
Edward Donley, Gary Stoudt, Rebecca Stoudt 

Related Topics

●     Imperial College's Transitional Mathematics Project 
●     The Consortium for Ordinary Differential Equations Experiments 
●     PWS Publishing Differential Equations Resource Center 
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News/Announcements: 
●     Summer C&M courses available through NetMath 

❍     Register here if you are interested. 
●     Apply to work for Calculus&Mathematica for next fall! 

❍     Applications can be found at the link "Apply to C&M" on the sidebar on this 
webpage or at http://www-cm.math.uiuc.edu/stud/apply.html
Applications will be due on April 29. If you have any questions, please email 
lead@cm.math.uiuc.edu 

●     Lab hours 
❍     Spring semester hours for lab in 239 Altgeld are: 8a -11p M -Th, 8a -5p F, 12p -5p 

Sat, and 12p -11p Sun. 
❍     Spring semester hours for C&M in 24 Illini Hall are : 10a -5p MWF, and 11a -3p 

T, Th. 
❍     The lab schedule for 239 Altgeld and 24 Illini Hall can be found here. 

●     Mathematica News 
❍     Mathematica for students through ccso is now available. It can be obtained from

http://www.cso.uiuc.edu/software/sls 
The cost is $25 wtihout media (45 MB download) or $30 with the CD. It expires 
on 8/26/02 at which time it needs to be renewed. It will be renewed most likely at 
$25 again and will last until the following August.

http://www-cm.math.uiuc.edu/ [01/07/2002 22:47:17]

http://www-cm.math.uiuc.edu/what/index.html
http://www-cm.math.uiuc.edu/what/history.html
http://www-cm.math.uiuc.edu/what/people.html
http://www-cm.math.uiuc.edu/what/comments.html
http://www-cm.math.uiuc.edu/what/faq.html
http://www-cm.math.uiuc.edu/main.html
http://www-cm.math.uiuc.edu/class/index.html
http://www-cm.math.uiuc.edu/stud/hwtips.html
http://www-cm.math.uiuc.edu/stud/hwex.html
http://www-cm.math.uiuc.edu/stud/apply.html
ftp://cm.math.uiuc.edu/pub/CM_Lessons/
http://cm.math.uiuc.edu/help/
http://www-cm.math.uiuc.edu/staff/schedule.html
http://www-cm.math.uiuc.edu/staff/gradetips.html
http://www-cm.math.uiuc.edu/staff/itips.html
http://www-cm.math.uiuc.edu/staff/applystaff.html
http://www-cm.math.uiuc.edu/staff/down.html
http://cm.math.uiuc.edu/timecard/
http://cm.math.uiuc.edu/coursespace
http://netmath.math.uiuc.edu/home.html
http://socrates.math.ohio-state.edu/
http://www.matheverywhere.com/
http://netmath.math.uiuc.edu/summer
http://www-cm.math.uiuc.edu/stud/apply.html
mailto:lead@cm.math.uiuc.edu
http://www-cm.math.uiuc.edu/staff/schedule.html
http://www.cso.uiuc.edu/software/sls


By Subject: Algebra

Stat/Math By Subject General Algebra

Search:  In:       

General Algebra
If you've never used math software before, we suggest using Maple for this 
task - read our review.
This topic covers high-school and college level algebra. It does not 
coverAbstract (Modern) or Linear Algebra.

●     Algebra Calculation With Matlab 
❍     Basic arithmetic with Matlab 

●     Algebra Calculation With Maple 
❍     Algebra Examples 
❍     Using Variables -from Getting Started with Maple 
❍     Operations on Vectors and Vector fields in Maple 

●     Algebra Calculation With Mathematica 
❍     Symbolic Algebra 
❍     Algebratic Equations 

●     Other useful algebra links 
❍     Algebra Online 

Permission to use this document is granted so long as the author is acknowledged and notified. 
Please send comments and suggestions to:statmath@indiana.edu 

Copyright 1995-1999, Indiana University. 
Last modified: Monday, 03-Apr-2000 16:14:32 EST 
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By Subject: Linear Algebra

Stat/Math By Subject Linear Algebra

Search:  In:       

Linear Algebra
●     Linear Algebra With Matlab 

❍     More Matrices with Matlab 
❍     Archive of M-files for Linear Algebra 
❍     ATLAST M-files 

●     Linear Algebra With Maple 
❍     Linear Algebra With Maple 
❍     FTP archive of Linear Algebra packages 

●     Linear Algebra With Mathematica 
❍     ATLAST Notebooks for linear algebra 

●     Other Linear Algebra Resources 
❍     The Matrix Market - visual repository of sparse matrices 
❍     Dr. Math - Linear Algebra Q+A - from The Math Forum 
❍     ATLAST- Augment the Teaching of Linear Algebra through 

Software Tools 

See also - Numerical Analysis - Linear Algebra 

Permission to use this document is granted so long as the author is acknowledged and notified. 
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By Subject: Algebra

Stat/Math By Subject Abstract Algebra

Search:  In:       

Abstract Algebra
●     Abstract Algebra With Maple 

❍     Packages for abstract algebra with Maple 
❍     A package for Algebraic Curves in Maple 

●     Abstract Algebra With Mathematica 
❍     Solving the Quintic 

●     Other Abstract Algebra Resources 
❍     Math Forum: Abstract Algebra 
❍     Abstract Algebra Online 
❍     Algebraic Number Theory Archives 
❍     Combinatorics - Various uses of abstract algebra. 
❍     Atlas of Finite Group Representations 
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Please send comments and suggestions to:statmath@indiana.edu 
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Stat/Math By Subject Calculus

Search:  In:       

Calculus
●     General Help 

❍     Various Calculus Topics 
❍     Calculus Graphs 
❍     Differential Equations 
❍     Calculus Links 
❍     More Links 

●     Calculus with Matlab 
❍     Integrations in Matlab 
❍     How SIMULINK performs simulations 

●     Calculus with Maple 
❍     Plotting Integral Functions 
❍     How to do Least Squares problems in Maple 
❍     Calculus and Analytical Geometry with Maple 
❍     Calculus 1, 2and 3 with Maple 

●     Calculus with Mathematica 
❍     Calculus and Mathematica 
❍     FAQs for Calculus 
❍     Calculus Operations 
❍     Some Multivariable Calculus Ideas Using Mathematica 
❍     Practical examples of integration 
❍     Pracitcal examples of Partial Derivatives 

See also: Differential Equations 
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Stat/Math - Differential Equations

Stat/Math By Subject Differential Equations

Search:  In:       

Differential Equations
●     General 

❍     A review of the ODE solvers of Axiom, Derive, Maple, 
Mathematica, Macsyma,MuPAD and Reduce 

❍     Differential Equations Course 
❍     HPC issues in PDE's 

●     Matlab 
❍     Getting Started with the PDE Toolbox 
❍     The Partial Differential Equation Toolbox in Matlab 

●     Maple 
❍     ODE Examples 
❍     ODE Handbook 
❍     ODEs with Maple 
❍     ODE2 Package (and graphics gallery). 

●     Mathematica 
❍     Interactive Learning with ODEs and PDEs 

See also: Numerical Computing - Differential Equations 

Permission to use this document is granted so long as the author is acknowledged and notified. 
Please send comments and suggestions to:statmath@indiana.edu 

Copyright 1995-1999, Indiana University. 
Last modified: Monday, 03-Apr-2000 16:12:36 EST 

URL /~statmath/bysubject/differential.html 

http://www.indiana.edu/~statmath/bysubject/differential.html [01/07/2002 22:53:05]

http://www.indiana.edu/~statmath/search/index.html
http://www.indiana.edu/~statmath/index.html
http://www.indiana.edu/~statmath/index.html
http://www.loria.fr/~zimmerma/ComputerAlgebra/
http://www.loria.fr/~zimmerma/ComputerAlgebra/
http://www.cms.uncwil.edu/~herman/m361.htm
http://www.ccs.uky.edu/csep/PDE/PDE.html
http://www.indiana.edu/~statmath/math/matlab/pde/index.html
http://www.mathworks.com/products/pde/
http://lie.uwaterloo.ca/handbook_odes.html
http://www.math.ncsu.edu/~marlin/MapleStuff/MA341Maple.html
http://www.math.macalester.edu/ODE/ODE.html
http://www.indiana.edu/~statmath/bysubject/numerics.html#diffeq
http://www.indiana.edu/


Mathematics Archives MSDOS Software for Advanced Calculus

 

Windows/MSDos Software Collection for 
Advanced Calculus 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Fourier Series Slide Show 

 Fourier Series 

 Line Integral 

 P. C. Convolution 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Advanced Differential Equations 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 DELP 

 LIE 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Calculus 

The following icons indicate the type of package:

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 A Quick Tour of MAPLE 

 AMP - Algebraic Manipulation Program 

 ANUM 

 Are You Ready for Calculus 1 

 Are You Ready for Calculus 2 

 Are You Ready for Calculus 3 

 Calculus Calculator 

 Calculus and Diff. Equations 

 Composition of Functions 

 Derive 

 Diff 

 Findpoly 

 FORM 

 Formula Wizard 

 Function Visualizer 
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 Functions Slide Show 

 Gdraw 

 Graphmatica 

 Interactive Demos & Teaching Aids 

 JKGRAPH 

 JKMath 

 Knox Packages 

 Limits 

 MAFIA 

 Mat-X 

 Mathcad Demo 

 Mathematics Plotting Programs 

 Mathomatic 

 Mathtool 

 Mercury 

 MicroCalc 

 Natural Language Math. Calculus Tutor Demo 

 Numerical Integration 

 PFSA Symbolic Algebra Program 

 Polar, Param and Polpm 

 Polyroot 

 Root Finder 

 Sequences and Series 

 Slide Show for Newton's Method 

 SymbMath 

 TSNUM 

 Taylor Series 

 Taylor Series Slide Show 

 Transitional Mathematics Project 

 Transmath 

 Trouble Slide Show 

 Ultimate Calculator 
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 VisualMethodos 

 W.B. Loewer Plotting Programs 

 YFUNX 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
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You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
College Algebra 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Algebra Editor 

 Are You Ready for College Algebra v.1.02 

 Are You Ready for Intermed. Algebra v.1.0 

 Complex Numbers v.1.10 

 Formula Wizard 

 LINSYS 

 Linear Systems v.1.05 

 Mathomatic 

 Polynomial Teacher 

 Polyroot 

 Prof. Weissman's Algebra Tutorial v.2.12 

 Prof. Weissman's Pre-Calculus Tutorials 

 RPN Calculator 

 SOLVEQ 

 TSDRAW v.1.6 
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 Transitional Mathematics Project 

 Transmath 

 XYSee 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
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Windows/MSDos Software Collection for 
Complex Variables 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 CAL v.4.0 

 Complex Analysis: F(Z) Files, Maple Worksheets, Mathematica Notebooks 

 Complex Functions v.0.08 

 Dynamical Systems 

 Fractint v.19.5 

 YABMP v.0.97 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Discrete Mathematics 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Catbox 

 Colourful Mathematics 

 Extended Precision Integers 

 Graph Theory 

 ISETL 

 LINSOLVE 

 LP100 

 Matrix Program 

 Models 

 Propositional Logic Program 

 Simplex Method 

 TSDRAW 

 Truth Tables Maker 

 Truth Tables 

 Venn Diagrams 
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 Voting Methods 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
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Windows/MSDos Software Collection for 
Graphing 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Composition of Functions 

 Conics 

 Cyclo 

 Drawfn3d - 3d Parametric Surfaces Drawing Program 

 Drawfunc - 2d Parametric Curves Drawing Program 

 Fortune 

 Function Visualizer 

 Gnuplot 

 Graf-It! 

 Graphmatica 

 Identify The Function 

 Implicit Functions 

 MATHPLOT: Math. Function Plotting Program 

 Master-Graph 

 MathViews for Windows/32 
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 Mathgraf 

 Polar Equations 

 Polar, Param and Polpm 

 Powergraph 

 TechPlot: Technical Plotting & Data Proc. 

 Trouble 

 Twiddle 

 Ultimate Calculator 

 W.B. Loewer Plotting Programs 

 WPLOT 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Linear and Matrix Algebra 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 A Quick Tour of Maple 

 AMP - Algebraic Manipulation Program 

 ANUMR 

 CLA 

 CMAT - Matrix Calculator 

 Calculus Calculator 

 Derive 

 FORM 

 GP-PARI for DOS and OS/2 

 JKMath 

 Knox Packages 

 LGSOLV 

 LINSYS 

 Linear Algebra 

 MATLAB 
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 Mat-X 

 MathViews for Windows/32 

 Mathcad Demos 

 Matrices and Linear Equations Programs 

 Matrix Calculator 

 Matrix Package 

 Matrix Program 

 MINIMAT 

 NUMERICAL METHODS 

 Populus 

 Small Matrix Toolbox for C Programmers 

 SymbMath 

 Transitional Mathematics Project 

 Transmath 

 Two D Maps 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Modelling 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Analysis 

 ArborVt 

 Automatic Differentiation of Fortan Programs 

 Curacao 

 Curve Fitter 

 Curvefits 

 DAUBWAVE 

 DELP 

 Ecological Modeling 

 FFT of Very Long Series 

 Fit2.exe 

 Interpolation 

 Lateblight 

 MENSTRUA 

 MathViews for Windows/32 
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 Mathcad Demos 

 Mlab 

 Netwrk4 

 Nonlinear Analysis Regression Program 

 Orbits 

 Owl 

 Parabola 

 Population Analysis System - POPSYS 

 Populus 

 Predictor 

 Ramas 

 Resistan 

 Spectrum 

 TechPlot - Tech. Plotting & Data Analysis 

 VisualMethodos 

 W.B. Loewer Plotting Programs 

 WPLOT 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 

http://archives.math.utk.edu/software/msdos/modelling/.html (2 of 2) [01/07/2002 22:55:41]

http://archives.math.utk.edu/software/msdos/modelling/mathcad/.html
http://archives.math.utk.edu/software/msdos/modelling/mathcad/.html
http://archives.math.utk.edu/software/msdos/modelling/mlab/.html
http://archives.math.utk.edu/software/msdos/modelling/mlab/.html
http://archives.math.utk.edu/software/msdos/modelling/netwrk/.html
http://archives.math.utk.edu/software/msdos/modelling/netwrk/.html
http://archives.math.utk.edu/software/msdos/modelling/nonlin25/.html
http://archives.math.utk.edu/software/msdos/modelling/nonlin25/.html
http://archives.math.utk.edu/software/msdos/modelling/orbits/.html
http://archives.math.utk.edu/software/msdos/modelling/orbits/.html
http://archives.math.utk.edu/software/msdos/modelling/owl/.html
http://archives.math.utk.edu/software/msdos/modelling/owl/.html
http://archives.math.utk.edu/software/msdos/modelling/winparab/.html
http://archives.math.utk.edu/software/msdos/modelling/winparab/.html
http://archives.math.utk.edu/software/msdos/modelling/popsys/.html
http://archives.math.utk.edu/software/msdos/modelling/popsys/.html
http://archives.math.utk.edu/software/msdos/modelling/populus/.html
http://archives.math.utk.edu/software/msdos/modelling/populus/.html
http://archives.math.utk.edu/software/msdos/modelling/predict/.html
http://archives.math.utk.edu/software/msdos/modelling/predict/.html
http://archives.math.utk.edu/software/msdos/modelling/ramas/.html
http://archives.math.utk.edu/software/msdos/modelling/ramas/.html
http://archives.math.utk.edu/software/msdos/modelling/rsistn62/.html
http://archives.math.utk.edu/software/msdos/modelling/rsistn62/.html
http://archives.math.utk.edu/software/msdos/modelling/spectr21/.html
http://archives.math.utk.edu/software/msdos/modelling/spectr21/.html
http://archives.math.utk.edu/software/msdos/modelling/techplt1/.html
http://archives.math.utk.edu/software/msdos/modelling/techplt1/.html
http://archives.math.utk.edu/software/msdos/modelling/vismet/.html
http://archives.math.utk.edu/software/msdos/modelling/vismet/.html
http://archives.math.utk.edu/software/msdos/modelling/wlplt/.html
http://archives.math.utk.edu/software/msdos/modelling/wlplt/.html
http://archives.math.utk.edu/software/msdos/modelling/wplot/.html
http://archives.math.utk.edu/software/msdos/modelling/wplot/.html
http://www.math.utk.edu/%7Ehusch/
mailto:husch@math.utk.edu
http://archives.math.utk.edu/uploading.txt


Mathematics Archives MSDOS Software for Modern Algebra

 

Windows/MSDos Software Collection for 
Modern Algebra 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 A Quick Tour of MAPLE 

 CMAT - Matrix Calculator 

 Division Algorithm 

 FORM 

 GAP - Groups, Algorithms & Programming 

 GP-PARI for DOS and OS/2 

 PFSA - Symbolic Algebra Program 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Number Theory 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Aliquot 

 Calc 

 GAP - Groups, Algorithms & Programming 

 GP-PARI for DOS and OS/2 

 MPQSHD prime factorization program 

 Malm - a collection of UBASIC programs 

 NUMBERS calculator 

 UBASIC 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Numerical Analysis 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 ANUM 

 Automatic Differentiation of Fortran Programs 

 Formula Wizard 

 LGSOLV 

 Matrix Package 

 NUMERICAL METHODS 

 Numerical Recipes Pascal Shareware Diskette 

 PRAXIS 

 Small Matrix Toolbox for C Programmers 

 Spectrum 2.1 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 
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You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Numerical Partial Differential Equations 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 FEMIS 

 Laplace Equation in Two Dimensions 

 MGLAB.FOR 

 Quickfield - 2D Finite Element Analysis 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Ordinary Differential Equations 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 A Quick Tour of MAPLE 

 Are You Ready for Ordinary Diff. Equations 

 Biograph 

 Calculus & Differential Equations 

 Chaos Demonstrations 

 Chaos Simulations 

 Chaotic Dynamics Workbench 

 Chaotic Mapper 

 DEGraph 

 Formula Wizard 

 Graphing Separable Equations 

 Graphmatica 

 Logistic 

 MAFIA 

 MicroCalc 
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 Midshipman Differential Equations Program 

 MLab 

 Models 

 ODE Workbench 

 ODE 

 ODEcalc 

 ODE's Slide Show 

 Ordinary Linear Differential Eq. 

 Phaser: Animator/Simulator for Dyn. Systems 

 Populus 

 Slopes 

 SymbMath 

 Transmath 

 VisualMethodos 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Partial Differential Equations 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Calculus and Differential Equations 

 Partial Differential Equations Slide Shows 

 Quickfield - 2D Finite Element Analysis 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 

This page is best viewed with either Netscape 4.0 (or higher) or Microsoft's Internet Explorer 4.0 (or higher)
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Windows/MSDos Software Collection for 
Probability 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Bayes' Theorem 

 Buffon 

 Formula Wizard 

 Galton's Box 

 ISETL Probability Package 

 Interactive Demos & Teaching Aids 2 

 JKMath 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Windows/MSDos Software Collection for 
Statistics 

The following icons indicate the type of package: 

Freeware or Public Domain

Shareware with all features enabled

Shareware with some features disabled

Commercial Software

Demo of Commercial Software

List of Packages

 Correlation 

 DSTATTAB 

 Easystat 

 Epistat 

 Execustat 

 Formula Wizard 

 Histograms 

 Kwikstat 

 LAB STATS 

 Mlab 

 Nonlin 

 Prof. Weissman's Statistic Tutorials 

 Pvalue for Windows 

 Simstat 

 Statdisk 
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 Xlisp-Stat 

This collection is maintained by Larry Husch. If you know of any Windows/MSDOS programs which are 
not listed in this collection and which you think are useful in the teaching of mathematics, then write 
Larry. 

You are invited to submit materials to be stored on the Mathematics Archives; this may include software, 
reviews of software or teaching materials utilizing technology. For more information on uploading 
materials, read this. 
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Topics in Mathematics

Algebra 

●     About - The Human Internet - College Algebra  
ADD. KEYWORDS: Tutorial, Inequalities, Absolute Values and Exponents, Fractional and Negative 
Exponents, Polynomials, Factoring Polynomials, Rational Functions, Compound Fractions, 
Solving Equations, Word Problems, Solving Quadratic Equations, Quadratic Formula, Complex 
Numbers, Inequalities, Quadratic Inequalities, Graphing Equations and Circles, Lines, Functions, 
Applications of Functions 

●     Algebra 
ADD. KEYWORDS: Algebra Postulates, Function Basics, Composite Functions, Even and Odd 
Functions, Inverse Functions, Linear, Quadratic, and Cubic Functions, Monotonic Functions, 
Periodic Functions 

●     Algebra 
ADD. KEYWORDS: Tutorial, Real Number System, Numerical Representations In Algebra, Algebraic 
Techniques, Quadratic Equations and Inequalities, Graphing, Functions, Polynomial Functions, 
Exponential and Logarithmic Functions, Linear Algebra, Discrete Algebra 

●     Algebra1: Graphing Linear Equations   
ADD. KEYWORDS: Tutroial, Online quizzes, Ordered Pairs, Graphing Equations, Horizontal Lines, 
Vertical Lines, Slope, Equations And Slope, Find Equation of Line, Scatter Plots, Parallel Lines,
Perpendicular Lines, Solve A System
SOURCE: T. K. O'Brien
TECHNOLOGY: Javascript, Java applet

●     Algebra Flash!  
ADD. KEYWORDS: Simultaneous Equations, Linear Equations, Quadratic Equations
SOURCE: David Hellam, Szymon Rutkowski, Kuwait English School
TECHNOLOGY: Javascript, Flash, Excel 

●     Algebra for the Sciences  
ADD. KEYWORDS: Course Materials, Demonstrations, Projects, Estimation, Geometry, Lines, 
Quadratics, Exponentials, Logarithms, Systems
SOURCE: Karla Oty, Brett Elliott, et al., Southeastern Oklahoma State University 

●     Algebra Online 
ADD. KEYWORDS: Lesson Plans 

●     Algebra/Graphing/Statistics Learning Units 
ADD. KEYWORDS: Lesson Plans, Equation of a line, Data Plots 

●     Algebra Learning Units 
ADD. KEYWORDS: Lesson Plans, Beginning Modeling for Linear and Quadratic Data 

●     Algebra Modules / Lessons 
ADD. KEYWORDS: Tutorials 
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●     Algebra on the Internet  (Algebra I)
ADD. KEYWORDS: Tutorial, Course Materials
SOURCE: Zee Haddad, Springfield Technical Community College 

●     Algebra Resource  
ADD. KEYWORDS: Algebra Review Sheet and Common Formulas, Algebra Review Practice 
Problems, Conics Review
SOURCE: Department of Mathematics, Sierra College 

●     Algebra Survival Kit 
ADD. KEYWORDS: Published book 

●     Algebra Through Modeling with the TI-82, 83 Calculators 
ADD. KEYWORDS: Tutorial
SOURCE: Tony Peressini and John Luker, University of Illinois
TECHNOLOGY TI-82 and TI-83 Graphing Calculator 

●     Algebra Through Problem Solving  
ADD. KEYWORDS: Tutorial, Pascal Triangle, Fibonacci and Lucas Numbers, Factorials, Arithmetic 
and Geometric Progressions, Mathematical Induction, Binomial Theorem, Combinations and 
Permutations, Polynomial Equations, The Factor and Remainder Theorems, Integral Roots, 
Rational Roots, Symmetric Functions, Determinants, Vandermonde and Related Determinants, 
Inequalities 
SOURCE: Abraham P. Hillman, University of New Mexico and Gerald L. Alexanderson, Santa 
Clara University
TECHNOLOGY: PDF Reader 

●     Algebra Topics    
ADD. KEYWORDS: Linear Functions, Percentages, Signed Numbers, Inequalities, Absolute 
Value/Inequalities, Exponents, Factoring, Complex Numbers, Fractions, Rational 
Expressions..simplify, Introduction to Algebra, Interactive Algebra, Basic Skills, Prealgebra, 
Arithmetic, Intro Algebra, PreCalculus, Intermediate Algebra, College Algebra 
SOURCE: Wyatt Washburn, University of Arkansas Community College / Batesville 

●     Algebra Word Problems  
●     Algebra.help   

ADD. KEYWORDS: Tutorials, Worksheets, Calculators, Algebra Basics, Basic Word Problems, 
Proportion Basics, Simplifying Equations/Expressions, Simplifying Multiple Signs, Combining 
Like Terms, Using the FOIL Method, Simplifying Exponents, Simplifying Using the Order of 
Operations, Substitution, Factoring, Greatest Common Factor(GCF), Difference Between Two 
Squares
TECHNOLOGY: Java applets, Server side include programs

●     AskERIC Lesson Plans - Algebra 
●     Building Blocks for Algebra 

ADD. KEYWORDS: Lesson Plans, Publication 
●     Casio TEAMS Grant - Algebra Lessons 

ADD. KEYWORDS: Lesson Plans, Casio Calculator 
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●     College Algebra Activities and Worksheets  
ADD. KEYWORDS: Activities and worksheets for in-class cooperative learning in groups, individual 
assignments, or homework. 
SOURCE: Harel Barzilai, Salisbury University 

●     College Algebra Online   
ADD. KEYWORDS: Course materials, Animations, Tutorials, Cartesian Plane, Graphing Equations, 
Lines in the Plane, Functions, Graphs of Functions, Manipulating Graphs, Combinations of 
Functions, Inverse Functions, Linear Equations and Modeling, Solving Equations Graphically, 
Complex Numbers, Solving Equations Algebraically, Solving Inequalities, Linear Models and 
Scatter Plots, Quadratic Functions, Higher Order Polynomials, Rational Functions, Exponential 
Functions, Logarithmic Functions, Properties of Logarithms, Exponential and Logarithmic 
Equations, Exponential and Logarithmic Models, Nonlinear Models and Scatter Plots
SOURCE: Jeff Brown and Russ Herman, University of North Carolina, Wilmington 
TECHNOLOGY: Java applets, Asymetrix Toolbooks, Real Video, Animated gifs 

●     Dan's math@home lessons - Basic Skills Topics 
ADD. KEYWORDS: Tutorials, Simplifying Expressions, Solving Linear Equations, Coordinates and 
Graphing
SOURCE: Dan Bach, Diablo Valley College 

●     DAU Math Refresher  
ADD. KEYWORDS: Tutorial, Tests, Basic Arithmetic, Fractions, Exponentials & Logarithms, 
Equations, Series, Functions, Domains & Ranges, Intercepts, Limits, Graphing of Functions, 
Derivatives, Integrals 

●     Easymaths  
ADD. KEYWORDS: Tutorials, Worksheets, Diagnostic tests 
SOURCE: Mathematics Web Association 

●     EMR - Exercises in Math Readiness 
ADD. KEYWORDS: Tutorial, Real Numbers, Symbol Manipulation, Expanding Binomials, 
Polynomials and Roots, Partial Fraction Decompositions 

●     A Constant Rate of Change - Using Linear Interpolation 
ADD. KEYWORDS: Tutorial 

●     GCSE Mathematics 
ADD. KEYWORDS: Tutorial, Drill problems, Negative Numbers, Ratios, Fractions, Graphs, 
Probability, Algebra, Trigonometry, Functions and Sequences 

●     GoMath Tutorials  
ADD. KEYWORDS: SAT, Quadratic Equations, Pythagorean Theorem, Parallel and Perpendicular 
Lines, New Operational Symbols, Linear Equations, Coordinate Geometry, Circles, Inequalities, 
Simple Factorization, Slopes, Roots, Word Problems 

●     Gomath.com - Algebra   
ADD. KEYWORDS: Factorials, Associative & Distributive Property, Prime Factorization, GCF & 
LCM, Scientific Notation, Laws of Exponents, Logarithm, Solving Equation with one variable, 
Ratio & Proportion, Polynomial (Addition/Subtraction), Polynomial (Multiplication), Solving 
Quadratic Equations, Slope, Equation & Y-intercept, Distance & Midpoint, Pythagorean 
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Theorem, Word Problem - Interest Problem, Inequality, Absolute Value Equation & Inequality
SOURCE: Cubic Science, Inc
TECHNOLOGY: Server side programs 

●     Harcourt Animated Math Glossary  
ADD. KEYWORDS: Shockwave 

●     Hawai'i Algebra Learning Project 
ADD. KEYWORDS: Curriculum Materials, Professional Development, NCTM Standards 

●     Interactive Algebra   
●     Interactive Mathematic Miscellany and Puzzles - Arithmetic and Algebra   

ADD. KEYWORDS: Evolution of Algebraic Symbolism, Fundamental Theorem of Algebra, 
Mathematical Induction, Weierstrass Product Inequality 

●     Intermediate Algebra Online  
ADD. KEYWORDS: Course Materials, Lecture Notes
SOURCE: Joyce Quella and David Urion, Winona State University 

●     Internet Projects for Algebra I 
●     An Introduction to Complex Numbers 

ADD. KEYWORDS: Tutorial, Polar Representation, De Moivre's Formula, Theorem of d'Alembert, 
Polynomials 

●     Learning about Algebra tiles 
ADD. KEYWORDS: Polynomials 

●     Linear Equation Solver    
●     Math 095 

ADD. KEYWORDS: Tutorial, Angles, Approximating Roots, Area, Common Factors, Complex 
Fractions, Coordinate Geometry, Equations of lines, Difference of Cubes, Difference of Squares, 
Equations of lines, Equations: Linear, Quadratic, Exponents, Factoring, Difference of Cubes, 
Difference of Squares, Geometry, Imaginary Numbers, Inequalities, Logarithms, Parabolas, 
Pythagorean Theorem, Quadratic Equations, Quadratic Inequalities, Radicals, Systems of 
Equations 

●     Math Connects 
ADD. KEYWORDS: On-line course assignments, In-service, Patterns, Functions, Algebra 

●     Math Forum - K-12 Algebra  
ADD. KEYWORDS: Classroom Materials, Software, Newsgroups 

●     Math Notes.Com - Intermediate Algebra  
ADD. KEYWORDS: Drill Problems, The Real Numbers, Rational Expressions, Linear Equations and 
Inequalities, Roots and Radicals, Linear Equations and Inequalities in Two Variables, Functions, 
Quadratic Equations and Inequalities, Systems of Linear Equations, Graphs of Nonlinear 
Functions and Conic Sections, Polynomials, Exponential and Logarithmic Functions 

●     Math Notes.Com - Introductory Algebra  
ADD. KEYWORDS: Drill Problems, Prealgebra Review, Rational Expressions, The Real Number 
System, Linear Equations and Inequalities in Two Variables, Solving Equations and Inequalities, 
Linear Systems of Equations and Inequalities, Exponents and Polynomials, Roots and Radicals, 
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Factoring, Quadratic Equations 
●     Math.com - Algebra   

ADD. KEYWORDS: The Language of Algebra, Order of Operation, Writing Equations, Writing 
Inequalities, The Basics of Algebra, Exponents, Evaluating Expressions, Like Terms, 
Simplifying, Equations and Inequalities, Solving Equations, Two Step Equations and Inequalities, 
Graphing Equations and Inequalities, Slope and y-intercept, Linear Equation 
SOURCE: Math.com 
TECHNOLOGY: Javascript. 

●     Mathematics Explorations I & II  
ADD. KEYWORDS: Projects involving activities at NASA 
SOURCE: Capital Community College, NASA - AMATYC - NSF 
TECHNOLOGY: Adobe Acrobat Reader 

●     Mathematics on The Beach 
ADD. KEYWORDS: CBL - Calculator Based Labs 

●     Mathematics with Alice 
ADD. KEYWORDS: Tutorial 

●     Maths Online   
ADD. KEYWORDS: Drawing plane and coordinate system, Variables, terms, formulae, and identities, 
Equations, Analytic geometry, Functions 

●     Maths Online - Sets    
●     MathMax - The Bittinger System of Instruction  

ADD. KEYWORDS: Supplementary materials for texts, Exercises, Quizzes, Chapter reviews 
SOURCE: Addison Wesley Longman, Marvin L. Bittinger 
TECHNOLOGY: Javascript, InterAct Math plug-in

●     NASAexplores 
ADD. KEYWORDS: Lesson Plan, Space Shuttle, Formulas, Graphs
SOURCE: Marshall Space Fight Center and is supported by NASA departments.
TECHNOLOGY: Adobe Acrobat Reader 

●     National Library of Virtual Manipulatives for Interactive Mathematics - Algebra   
 

ADD. KEYWORDS: Tangrams, Lets Make a Deal, Reflection, Triomino, Coin Problem, Multiple Base 
Blocks, Pentominoes, Polyominoes, Tangrams, Towers of Hanoi
SOURCE: Lawrence O. Cannon, James T. Dorward, E. Robert Heal, Leo Edwards, Utah State 
University
TECHNOLOGY: Java applets 

●     Notes for College Algebra and Geometry  
●     On line Math 191 - College Algebra 

ADD. KEYWORDS: Tutorial, Solving Equations, Functions and their Graphs, Synthetic Division, and 
Exponential & Logarithmic Functions 

●     On-Line Math Learning Center - On-line Quizzes  
ADD. KEYWORDS: Solving Equations, Problems Solving, Inequalities, Exponents, Polynomials, 
Factoring, Rationals 
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●     OzeGame - Senior Level  
ADD. KEYWORDS: Algebra Problems
SOURCE: The Web Classroom
TECHNOLOGY: Javascript 

●     Partnership for Excellence - Rediscovering Algebra I  
ADD. KEYWORDS: Lesson Plans, Course Materials
SOURCE: Partnership for Excellence Project, University of South Carolina Spartanburg 

●     Partnership for Excellence - Rediscovering Algebra II  
ADD. KEYWORDS: Lesson Plans, Course Materials
SOURCE: Partnership for Excellence Project, University of South Carolina Spartanburg 

●     Professor Freedman's Math Help   
ADD. KEYWORDS: Syllabus, Math Anxiety, Learning Styles, Tutorials, Fun Stuff 

●     Project Interactivate - Functions   
ADD. KEYWORDS: Lesson Plans, Graphs and Functions, Coordinate Systems 

●     PUMP Algebra Curriculum Home Page 
ADD. KEYWORDS: Computer based tutoring system 

●     Quick Review of Algebra 
ADD. KEYWORDS: Tutorial 

●     NY State HS Regents Exam Prep Center - Mathematics A   
ADD. KEYWORDS: Sample Questions, Mathematical Reasoning, Numbers & Numeration, 
Operations, Modeling/Multiple Representation, Problem Solving with Algebra & Geometry, 
Measurement, Proportions, Uncertainty (Probability), Patterns & Functions 
SOURCE: New York High School Regents Exam Prep Center 
TECHNOLOGY: Javascript. 

●     Project Interactivate - Activities - Function and Algebra Concepts    
ADD. KEYWORDS: Functions, Special properties of linear functions, Graphs and the coordinate plane, 
and Reading graphs
SOURCE: The Shodor Education Foundation, Inc. 
TECHNOLOGY: Java Applet 

●     Project-Based Instruction in Mathematics for the Liberal Arts  
ADD. KEYWORDS: Course materials, Linear functions, Least Squares Line, Linear Modeling, 
Statistics and probability, Non-linear functions, Managing money with the exponential function, 
The logistic function – constrained growth and decay
SOURCE: M.B. Ulmer, University of South Carolina Spartanburg 
TECHNOLOGY:Adobe Acrobat Reader 

●     Roots    
ADD. KEYWORDS: Roots of complex numbers
SOURCE: Jerzy Kocik, Southern Illinois University 
TECHNOLOGY: Java applet 

●     S.O.S. Mathematics - Algebra 
ADD. KEYWORDS: Tutorial, Fractions, Quadratic Equations, Partial Fractions
SOURCE: Mohamed A. Khamsi, Helmut Knaust, Nancy Marcus, Michael O'Neil, Luis G. Valdez 
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Sanchez from University of Texas at El Paso 
●     SCORE Mathematics - Algebra and Functions  

ADD. KEYWORDS: Lesson Plans, Standards 
SOURCE: SCORE - Schools of California Online Resources for Education 

●     SCORE Mathematics - Algebra I 
ADD. KEYWORDS: Lesson Plans, Standards 
SOURCE: SCORE - Schools of California Online Resources for Education 

●     SCORE Mathematics - Algebra II 
ADD. KEYWORDS: Lesson Plans, Standards 
SOURCE: SCORE - Schools of California Online Resources for Education 

●     SMILE Program Mathematics Index 
ADD. KEYWORDS: Lesson Plans 

●     Supplemental Technology (TI-85 Based) Exercises for "Clustered" College Algebra at Texas 
Tech University 
ADD. KEYWORDS: Exercises in Basic Calculation, Basic Graphing, Solving Linear Systems 

●     Understanding Algebra   
ADD. KEYWORDS: Tutorial, Word Problems, Graphing and Straight Lines, Systems of Linear 
Equations, Polynomials, Rational Expressions, Exponents and Roots, Quadratic Equations
SOURCE: James Brennan, Boise State University
TECHNOLOGY: Java applets, Javascript. 

●     Web-based Are You Ready Quiz/Reviews  
ADD. KEYWORDS: Online quizzes
SOURCE: Brian Hassard, University of Buffalo 

●     WebAlgebra  
ADD. KEYWORDS: Tutorials with quizzes, Trigonometry, Calculus
SOURCE: Larry Dornhoff, University of Illinois 

●     WebMath   
ADD. KEYWORDS: Graphing, Simplifying Expressions, Polynomials, Factoring Polynomials, 
Quadratic Equations 

●     Word Problems For Kids   
●     Worksheet library ~ Algebra  

ADD. KEYWORDS: Worksheets, Expanding and Factorising, Solving simple equations, Transposing, 
Graphs of Equations, Quadratics, Simultaneous Equations 
SOURCE: Mike Robinson, Sheffield Hallam University 
TECHNOLOGY: Adobe Acrobat Reader
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Topics in Mathematics

Calculus 

●     Calculus Resources On-Line 
ADD. KEYWORDS: Initiatives, Projects and Programs, Articles, Posters, Discussions, Software, 
Publisher sites, Other listings of calculus resources 

●     Aid for Calculus  
ADD. KEYWORDS: Solving problems in calculus 

●     AP Calculus on the Web  
ADD. KEYWORDS: Textbooks, 1998 Syllabus, Approved Calculators, Resources 

●     Are You Ready for Calculus? What you should know!  
●     Area of a Circle  

SOURCE: Tom Richmond, Western Kentucky University
TECHNOLOGY: Animated Gif 

●     Basic EXCEL-skills for calculus and differential equations 
ADD. KEYWORDS: Sample worksheets, Sample problems / skills 

●     Better File Cabinet  
ADD. KEYWORDS: Database of calculus problems
SOURCE: Eric Hsu and University of Texas at Austin 

●     Bisection Method Tutorial    
●     Cal Poly Linked Curriculum Program Interdisciplinary Projects 

ADD. KEYWORDS: Projects 
●     Calculus  
●     Calculus I Home Page 

ADD. KEYWORDS: Sample CBL Experiment: Newton's Law of Cooling, TI-85 Programs and CBL 
Experiment Data, Mathematica Notebooks 

●     Calculus 1 - Problems and Solutions  
ADD. KEYWORDS: Problems, Tutorial
SOURCE: Pheng Kim Ving 

●     Calculus and Differential Equations 
ADD. KEYWORDS: Collection of articles, Curvature, Intrinsic and Extrinsic, Radial Paths in 
Schwarzschild Spacetime, Integrating the Bell Curve, Compressor Stalls and Mobius 
Transformations, Dual Failures with General Densities, The Limit Paradox, Proof That PI is 
Irrational, Simple Proof that e is Irrational, etc. 

●     Calculus Applets for the Georgia Tech Syllabus   
ADD. KEYWORDS: Course Materials, Experiments 

●     Calculus Applied to the Real World  
ADD. KEYWORDS: Tutorials, Tests 
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●     Calculus at Pitt 
ADD. KEYWORDS: Course Materials, Mathematica, Tutorials, Lab Materials 

●     Calculus&Mathematica 
ADD. KEYWORDS: Course Materials, Mathematica 

●     Calculus&Mathematica Remote 
ADD. KEYWORDS: Course, Mathematica 

●     Calculus Concepts Using Derive® for Windows 
ADD. KEYWORDS: Lab Manual 

●     Calculus: Difference Equations to Differential Equations   
ADD. KEYWORDS: Course Materials 

●     Calculus for Biology I   
ADD. KEYWORDS: Course Materials, Lecture notes, Laboratories, HW Problems
SOURCE: Joseph M. Mahaffy, San Diego State University 
TECHNOLOGY: Adobe Acrobat Reader, Excel, Java applets 

●     Calculus for Biology II  
ADD. KEYWORDS: Course Materials, Lecture notes, Laboratories, HW Problems
SOURCE: Joseph M. Mahaffy, San Diego State University 
TECHNOLOGY: Adobe Acrobat Reader, Excel, Maple 

●     Calculus for Kinetic Modeling    
ADD. KEYWORDS: Course Materials, Finding Zeroes of Polynomial Functions, TIFs & TSFs for 
Polynomial Functions , Background from CKM Workspace , Finding Tangent Lines Examples, 
TSFs and Graphical Reprsentations, The Product and Quotient Rules, Chain Rule, D-Rules & 
TSFs, Exponential & Logarithmic Functions, Dissolution Models, Antidifferentiation, Area and 
the Riemann Integral, Fundamental Theorem of Calculus, Integrals, Area & Reversing D-Rules 
SOURCE: John Pais, Saint Louis College of Pharmacy
TECHNOLOGY: Java applets 

●     Calculus-Help.com 
ADD. KEYWORDS: The Problem of the Week, Virtual Cheat Sheet 
SOURCE: W. Michael Kelley
TECHNOLOGY: Flash plugin 

●     Calculus Learning Units 
ADD. KEYWORDS: Lesson Plans, Newton's Law of Cooling, Calculator Based Laboratory 

●     Calculus Lecture Notes - University of Toronto  
●     Calculus Offered On Line  

ADD. KEYWORDS: Course materials for 1st semester calculus
SOURCE: Don Piele, University of Wisconsin-Parkside
TECHNOLOGY: Mathematica 

●     Calculus Offered On Line  
ADD. KEYWORDS: Course materials for 2nd semester calculus
SOURCE: Don Piele, University of Wisconsin-Parkside
TECHNOLOGY: Mathematica 
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●     Calculus on the Web - COW   
●     The Calculus Page  

ADD. KEYWORDS: Problems with solutions, Tips on preparing for exams, Mathematica Animations 
●     Calculus Reform at Cornell 

ADD. KEYWORDS: Cooperative Learning and Projects 
●     Calculus Reform: Sample Materials 

ADD. KEYWORDS: Course Materials, Calculator Programs 
●     Calculus Review - San José State University  

ADD. KEYWORDS: Tutorials, On-line quizzes
SOURCE: Linda Valdés, San José State University 
TECHNOLOGY: Javascript 

●     Calculus Technology Initiative  
ADD. KEYWORDS: Lecture Notes, Animations
SOURCE: Arek Goetz, San Francisco State University 
TECHNOLOGY: Quicktime, Real Video, Power Point 

●     Calculus with Maple V 
ADD. KEYWORDS: Maple lessons, Homework 

●     Calculus with Maple V 
ADD. KEYWORDS: Course Materials, Maple, Lab Materials, Projects 

●     Calculus Workshops and Maple Labs 
ADD. KEYWORDS: First Year Integrated Engineering Curriculum, Maple, Lab materials 

●     Calculus WWW-server 
ADD. KEYWORDS: Course Materials, Maple, Matlab, Projects, Applications 

●     CalculusQuest 
ADD. KEYWORDS: Course Materials 

●     Casio TEAMS Grant - Calculus 
ADD. KEYWORDS: Lesson Plans, Casio Calculator 

●     Complex, Technology Based Problems in Calculus Home Page 
ADD. KEYWORDS: Problem sets, Mathematica 

●     Computer Labs for Math  
ADD. KEYWORDS: Graphing Polynomial Functions, Graphing Trigonometric Functions, One- and 
Two-sided Limits, Tangent and Secant Lines, Zeros of Derivatives, Graphing and Derivatives, 
Mean Value Theorem, Newton's Method, Riemann Sums, Numerical Integration, 1-1 and Inverse 
Functions, Review of Exponential and Logarithmic Functions, Inverse Trigonometric Functions, 
Hyperbolic Functions, Volumes of Solids of Revolution, Arc Length of Curves, Symbolic 
Integration, Taylor Polynomials, Parametric Functions
SOURCE: Michael R. Anderson, West Virginia State College
TECHNOLOGY: LaTeX, Adobe Acrobat Reader, Derive, MuPad, JKGraph 

●     Computer-based Calculus  
ADD. KEYWORDS: Mathcad, Maple, Lab materials 

●     The Connected Curriculum Project - Montana State University    
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ADD. KEYWORDS: Models, Data, and Curve Fitting, Estimation and Limits, Sequences and Discrete 
Dynamical Systems, Derivatives and Differention, Graphing, Optimization, Integrals and 
Integration, Differential Equations and Continuous Models, Series, Numerical Methods, 
Calculators, Maple, Mathematica 

●     The Connected Curriculum Project - Duke University  
●     CRAFTY - MAA Subcommittee on Calculus Reform and The First Two Years   

ADD. KEYWORDS: Publications, Meetings, Calculus Reform Projects, Technology, Problems
SOURCE: Martin Flashman, Humboldt State University 

●     Dan's math@home lessons - Calculus 
ADD. KEYWORDS: Tutorial, Limits, Tangent Lines and Derivatives, Differentiation Rules, Related 
Rates, Max-Min Problems, Antiderivatives, Integration Rules, Calculus of Areas, Fundamental 
Thm of Calculus
SOURCE: Dan Bach, Diablo Valley College
TECHNOLOGY: Animated gifs 

●     DAU Math Refresher  
ADD. KEYWORDS: Tutorial, Tests, Basic Arithmetic, Fractions, Exponentials & Logarithms, 
Equations, Series, Functions, Domains & Ranges, Intercepts, Limits, Graphing of Functions, 
Derivatives, Integrals 

●     Dave Slomer's Calcu-Page 
ADD. KEYWORDS: Lesson plans, Assignments for students, TI85, TI86, TI92 

●     Derivative Module 
ADD. KEYWORDS: Motion, Speed, Velocity, Acceleration 

●     Developing Intuition for Concepts in Calculus through Numerical List Manipulation 
ADD. KEYWORDS: Article, Matlab, Mathematica, Maple, APL, HP48G, TI85 

●     Dr. Vogel's Gallery of Calculus Pathologies  
●     e-Calculus 

ADD. KEYWORDS: Tutorial 
●     e the EXPONENTIAL - the Magic Number of GROWTH  

ADD. KEYWORDS: Article, Area under the curve 1/x, The truncated Harmonic series, Euler's gamma 
constant, Biological growth models, Age dependent population module 
SOURCE: Keith Tognetti, University of Wollongong 
TECHNOLOGY: Adobe PDF, postscript and dvi readers 

●     EducETH - Interaktive Materialien    ( in German) 
ADD. KEYWORDS: Bisection Method, Finding Maxima and Minima, Finding area under a curve, 
Tangent Lines 
SOURCE: Werner Hartmann and EducETH.ch at ETHZ 
TECHNOLOGY: Java applets 

●     Experiments in Mathematics Using Maple 
ADD. KEYWORDS: Tutorial, Maple Worksheets 

●     EXPONENTIAL GROWTH AND DECAY  
●     Finding Roots of Functions Using The Bisection Method and Newton's Method  
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●     Function calculator  
ADD. KEYWORDS: Evaluate functions, Calculate derivatives, Integrals, Taylor Series expansions, 
Roots and Extrema 

●     Function Plotter   
ADD. KEYWORDS: Taylor Polynomials 

●     The Gamma Function 
ADD. KEYWORDS: Weierstrass' formula, the Psi function, Euler's constant, Stirling's formula 

●     Gavin's Calculus Projects  
●     Geomath 

ADD. KEYWORDS: Tutorial, Differentiation, Integration 
●     Geomath - Further Integration

ADD. KEYWORDS: Tutorial 
●     Graphing Applets for Calculus   

ADD. KEYWORDS: Newton's method, Riemann sums, Modulus of continuity, Fixed Points, 
Fundamental Theorem of Algebra, Newton-Raphson Method, Lagrange Multipliers, Secant Lines, 
Simpson's Rule 

●     Harvey Mudd College Mathematics Tutorials 
ADD. KEYWORDS: Antiderivatives, Arc Length, Chain Rule, Computing Integrals by Completing the 
Square, Computing Integrals by Substitution, Continuity, Differentiating Special Functions, First 
Derivative, Fundamental Theorem of Calculus, Infinite Series Convergence, Integration by Parts, 
L'Hopital's Rule, Limit Definition of the Derivative, Mean Value Theorem, Partial Fractions, 
Product Rule, Quotient Rule, Riemann Sums, Second Derivative, Special Trigonometric Integrals, 
Tangent Line Approximation, Taylor's Theorem, Trigonometric Substitution, Volume 

●     IntegGrapher   
ADD. KEYWORDS: Riemann Sums 

●     The Integrator  
ADD. KEYWORDS: Integration, Integrals, Mathematica 

●     Interactive Calculus Activities  
ADD. KEYWORDS: MathView Notebooks 

●     Interactive Calculus - Parametric Equations  
●     Interactive Calculus Software with Applications in Business and Economics  

ADD. KEYWORDS: Lab activities, Asymptotes, Families of Functions, From Data To Models, 
Compound Interest, Tangents and Slopes, Definition of Derivative, Inverses, Concavity, 
Optimizing Costs, Optimizing Revenue and Profits (including Elasticity of Demand), Taxes and 
the Optimization of Profit, Inventory Costs, Accumulation, Definite Integral, Numerical 
Integration, Linear Regression, Partial Derivatives, Taylor Polynomials 
SOURCE: Jean Marie McDill, California Polytechnic State University, Agnes M. Rash, St. Joseph's 
University 
TECHNOLOGY: Adobe PDF reader 

●     Interactive EXCEL 

http://archives.math.utk.edu/topics/calculus.html (5 of 10) [01/07/2002 23:00:38]

http://wims.unice.fr/~wims/wims.cgi?lang=en&module=tool%2Fanalysis%2Ffunction.en&cmd=new
javascript:ld()
javascript:interAct()
http://www.sunsite.ubc.ca/LivingMathematics/V001N01/UBCExamples/Plot/calc.html
javascript:ld()
javascript:jva()
javascript:interAct()
http://xavier.gourdon.free.fr/Constants/Miscellaneous/gammaFunction.html
javascript:ld()
http://www.math.lsa.umich.edu/~glarose/courseinfo/calc/calcprojects.html
javascript:ld()
http://www.ucl.ac.uk/Mathematics/geomath/1stlevel.html
javascript:ld()
http://www.ucl.ac.uk/Mathematics/geomath/level2/fint/MHfi.html
javascript:ld()
http://www.math.gatech.edu/~carlen/applets/index.html
javascript:ld()
javascript:jva()
javascript:interAct()
http://www.math.hmc.edu/calculus/tutorials/
javascript:ld()
http://www.math.unl.edu/~jorr/java/html/IntegGrapher.html
javascript:ld()
javascript:jva()
javascript:interAct()
http://www.integrals.com/
javascript:ld()
javascript:interAct()
http://www.jcu.edu/math/faculty/spitz/calculus/
javascript:ld()
javascript:interAct()
http://members.aol.com/kchs99/calc/index.html
javascript:ld()
http://www.sju.edu/%7Earash/pages/research.html
javascript:ld()
http://math.la.asu.edu/~kawski/conferences/EXCEL/index.htm
javascript:ld()


Mathematics Archives - Topics in Mathematics - Calculus

ADD. KEYWORDS: Excel worksheets, Calculus, Curve fitting, Partial Differential Equations, Heat 
Equation, Parabolic and Elliptic Partial Differential Equations, Discrete Dynamical Systems 

●     Interactive Learning in Calculus and Differential Equations   
ADD. KEYWORDS: Instructional, Mathematica, Gauss-Green formula, Newton's method, vibrating 
drumheads, multivariable calculus, orthogonal curvilinear coordinates, complex numbers, drag 
force on a sphere 

●     Interactive Web-Based Materials for Calculus Using LiveMath   
ADD. KEYWORDS: 2-dimensional Graphing, 3-dimensional Graphing, Polar Graphing, Fourier Series, 
Surface in Spherical Coordinates, Numerical Integration, Symbolic Integration, Riemann sums, 
Fundamental Theorem of Calculus, Limit Demonstration, Polar Integration 
SOURCE: Brian Gill, Seattle Pacific University 
TECHNOLOGY: LiveMath 

●     Interactive Mathematics  
ADD. KEYWORDS: Tutorial, LiveMath, Derivative, Applications of the Derivative, Differentiating 
Transcendental Functions, Integration, Application of Integration, Methods of Integration, 
Differential Equations, Fourier Series 

●     Internet Calculus - University of Pittsburgh 
ADD. KEYWORDS: Mathematica, Distance Learning 

●     Intersection of Cylinders   
ADD. KEYWORDS: Finding volumes 

●     Java Laboratory   
ADD. KEYWORDS: Definition of derivative, Riemann Sums, Fixed Points 

●     Java Powered Calculus   
ADD. KEYWORDS: Tutorial, History of Calculus 

●     Karl's Calculus Tutor 
ADD. KEYWORDS: Tutorial 

●     Manipula Math with JAVA   
ADD. KEYWORDS: Limits, Riemann Sums, Volumes, Circle of Curvature, Cycloids 

●     Maple Explorations for Differential Calculus  
●     Materials for Calculus  
●     Math 1205 - Calculus  

ADD. KEYWORDS: Course Materials, Tutorials, Limits, Derivatives, Applications of the Derivative 
SOURCE: James E. Shockley, Virginia Tech 
TECHNOLOGY: Quicktime Plug-in 

●     Math Forum - Calculus  
ADD. KEYWORDS: Classroom materials, software, newsgroups 

●     Math Lessons    
ADD. KEYWORDS: Finding Minimum, Integration and Differentiation, Fair Division, Voting, Venn 
Diagrams, Understanding Graphs, Equations of Lines, Acceleration, Intersecting Lines, Parabolas, 
Tangent Lines 
SOURCE: Faculty from Washington State University 
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TECHNOLOGY: Java applets and Javascript 
●     MATH-abundance 

ADD. KEYWORDS: Tutorials, Limits of Functions and Continuity, Asymptotes, Derivative and 
Differentiation, Problems 

●     Mathematica Self-Tutor for Calculus 
ADD. KEYWORDS: Tutorials, Mathematica Notebooks 

●     Mathematics Explorations I & II  
ADD. KEYWORDS: Projects involving activities at NASA 
SOURCE: Capital Community College, NASA - AMATYC - NSF 
TECHNOLOGY: Adobe Acrobat Reader 

●     Mathematical Modules in Biology and Chemistry 
ADD. KEYWORDS: Epidemiology, Course Materials
SOURCE: Meghan A. Burke and Sean F. Ellermeyer from Kennesaw State University 

●     Maths Online   
ADD. KEYWORDS: Differentiation, Power series, Nowhere differentiable functions, Integration, 
Fourier seriesi, Limiting processes 

●     The MathServ Calculus Toolkit  
ADD. KEYWORDS: Computing Limits, Derivatives, and Integrals, Newton's Method, Power Series, 
Solid of revolution, Direction Field, Quadrature Formulas, Arc length, Center of mass 

●     MCP Project 
ADD. KEYWORDS: Lab Manual, Chemistry, Physics, MathCAD 

●     Moving Man Project   
ADD. KEYWORDS: Distance, Velocity, Acceleration 

●     Microsoft Excel Interactive Projects 
ADD. KEYWORDS: Maximzing Area, Projectile Motion
SOURCE: Hollylynne Drier Stohl and Center for Technology and Teacher Education, University of 
Virginia
TECHNOLOGY: Excel 

●     MSTE Java Lessons - Calculus   
ADD. KEYWORDS: Numerical Integration Activity, Methods for Estimating Roots, Solving Systems 
of Equations
SOURCE: Nicholas Exner, University of Illinois at Urbana-Champaign 
TECHNOLOGY: Java Applets 

●     Multivariable Calculus Maple Laboratories  
ADD. KEYWORDS: Dot Products, Parametric Curves, Polar Curves, Integration, Plotting Surfaces, 
Surface Extrema, Sequences and Series, Koch Snowflakes
SOURCE: Murphy Waggoner, Simpson College 
TECHNOLOGY: Maple 

●     Numerical Integration Tutorial    
●     Occasional Maple Worksheets for Calc II 

ADD. KEYWORDS: Maple, Integration Check, Numeric Integration, Error Bounds for Numeric 
Integration, Animating Taylor Series, Working with Power Series as Functions, Producing Slope 
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Field Diagrams 
●     Partnership for Excellence - Rediscovering Calculus: A Reformed View  

ADD. KEYWORDS: Lesson Plans, Course Materials
SOURCE: Partnership for Excellence Project, University of South Carolina Spartanburg 

●     Pathological example for Newton's method   
●     Project CALC: Calculus As a Laboratory Course  
●     Project INTERMATH Topics - Calculus  

ADD. KEYWORDS: Curriculum Materials, Throwing a Baseball, Shooting an Arrow, Bungee 
Jumping, Determining the Center of Mass, Estimating Cut/Fill for a Earthmoving Project, 
Managing Water Storage, Earthquake damage to a Water Tower, Modeling a Firefighting 
Situation, Estimating HMO Patient Costs, Developing a Plan for Air Delivery of Supplies, Linear 
Regression in a Physics Lab, Modeling Economic Production, Predicting Oxygen Consumption, 
Describing Motion of a Pendulum, Designing a Railway Headway, Structural Analysis of a 
Bridge, Modeling the Trajectory of a Missile, Managing Waste Water, Avoiding Aircraft 
Collisions/Water Treatment, Monitoring the Flow of Water in a Town, Analyzing Water Purity, 
Modeling the Suspension System of a Car, Resonance in an Aircraft, Dissolved Oxygen, Spelling, 
Optimizing Technology, Artillery Fire Control
SOURCE: COMAP, Carroll College, Georgia College & State University, Harvey Mudd College, 
Macalester College, University of Redlands, Texas Southern Consortium, West Point 
TECHNOLOGY: Adobe Acrobat Reader 

●     Project Links: Calculus  
ADD. KEYWORDS: Applications in Mechanics, Applications in Chemistry, Tutorial 

●     Reform Calculus Resources  
ADD. KEYWORDS: In-Class Activities, Long-Term Student Projects, Capsules & Tutorials
SOURCE: Harel Barzilai, Salisbury University 

●     The Roller Coaster or Brachistochrone Problem  
●     S.O.S. Mathematics - Calculus 

ADD. KEYWORDS: Tutorials, Techniques of Integration, Taylor Polynomials, Series 
●     Sigma  

ADD. KEYWORDS: Finite Sums, Infinite sums 
●     SIMPLE HARMONIC MOTION  

ADD. KEYWORDS: Tutorial 
●     Solution Finder   

ADD. KEYWORDS: Newton's Method 
●     Surfin' Sinefeld: Flash Animated Precalculus, Calculus and Statistics Activities   

ADD. KEYWORDS: Graphing, Derivatives, Quizzes 
SOURCE: Ralph Irons, Central Shenandoah Valley Regional Governor's School
TECHNOLOGY: Flash plugin 

●     Taylor Series - Why We Want Them and How We Find Them  
●     Technology Modules (TI-85 Based) to Supplement the Instruction of Calculus I at Texas Tech 

University  
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●     TILU Table of Integrals Look Up  
ADD. KEYWORDS: Mathematica, Common Lisp 

●     Topics in Integral and Differential Calculus   
ADD. KEYWORDS: Tutorial, Introduction to Functions, Polynomial Functions, Trigonometric 
Functions, Exponential & Logarithmic Functions, The Derivative, Some Differentiation Formulas 
& the Chain Rule, Differentiating Trigonometric Functions, Some Max-Min Problems, The 
Definite Integral of a Continuous Function, Taylor Polynomials and Taylor Series, Plane Vectors, 
The Spring 
SOURCE: Teresinha Kawasaki, University of Texas at Austin 
TECHNOLOGY: Java Applets, WebEQ, TCL 

●     Trigonometric Integrals 
ADD. KEYWORDS: Tutorials 

●     UBC Calculus Online    
ADD. KEYWORDS: Course Materials, Course Notes, Labs, In class demonstrations: Falling Balls, 
Slope, Powers of x, Polynomials, Scaling, Radioactive Decay, Zoom, Secant Lines, Derivative as 
a function, Vertical Scaling, Critical Points, The Chain Rule, Implicit Differentiation, 
Exponentials, 
Logarithms, Derivatives of Exponentials, Radioactive Decay, Newton's Law of Cooling, 
Trigonometry, Derivatives of Trigonometric Functions, Oscillations, Harmonic Motion, 
Superposition, Inverse Tangent, Linear Approximations, Newton's Method, Euler's Method, 
Direction Fields, Epidemics 
SOURCE: Department of Mathematics at the University of British Columbia 
TECHNOLOGY: Java Applets 

●     UBC Calculus Online   
ADD. KEYWORDS: Course Materials, Course Notes, Labs, In class demonstrations: How Archimedes 
found the area of a circle, Finding areas of simple shapes, How the area changes, Lower and 
Upper Sums, The Fundamental Theorem of Calculus, Average value of a function, Volumes, Arc 
Length, Change of variables, The Trapezoidal Rule, Simpson's Rule, Introduction to Differential 
Equations, Initial Value Problems, Orthogonal Trajectories, The Logistic Equation, Logistic 
Growth with Harvesting, Predators and Prey, Center of Mass, Standard Deviation, The Normal 
Distribution, Series, Taylor Series, Series for sine and cosine 
SOURCE: Department of Mathematics at the University of British Columbia 
TECHNOLOGY: Java Applets 

●     The University of Minnesota Calculus Initiative  
ADD. KEYWORDS: Lab Materials, Applications 

●     USAF Mathematica Notebook Library 
ADD. KEYWORDS: Mathematica, Animations 

●     USMA MA205 Home Page  
ADD. KEYWORDS: Course Materials, MathCad Worksheets 

●     USNA Calculus I Homepage 
ADD. KEYWORDS: Course Materials, Computer Projects, Maple 

●     USNA Calculus II Homepage 
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ADD. KEYWORDS: Course Materials, Computer Projects, Maple 
●     The Vector Cross Product - A JAVA Interactive Tutorial  

ADD. KEYWORDS: Calculus, interactive pages 
●     Visual Calculus   

ADD. KEYWORDS: Tutorial, online quizzes, drill problems, calculators, software, visualization 
●     Wallis' Product  

ADD. KEYWORDS: Calculus, history, pi, interactive pages 
●     Web-based Are You Ready Quiz/Reviews  
●     Webcalc  

ADD. KEYWORDS: Course Materials, Lab Materials 
●     WebMath - Calculus- Derivatives  
●     WIMS - WWW Interactive Mathematics Server  

ADD. KEYWORDS: Online exercises, Taylor Series, Epsilon-Delta definition of limits, 
Maxima/Minima, Finding roots 

●     Worksheet library ~ Calculus  
ADD. KEYWORDS: Worksheets, Differentiation and Integration 
SOURCE: Mike Robinson, Sheffield Hallam University 
TECHNOLOGY: Adobe Acrobat Reader 

●     World Web Math - Calculus (MIT) 
ADD. KEYWORDS: Tutorial 

●     Wright State Calculus Laboratory Program 
ADD. KEYWORDS: Mathematica Notebooks 

●     Writing Assignments in Calculus  
●     Writing Assignments in Calculus  
●     www.calculus.net  

ADD. KEYWORDS: Problem Sets, Lab Projects, Homework, VRML and Calculus 
●     xFunctions xPresso   

ADD. KEYWORDS: animated graphs, parametric curves, derivatives, Riemann sums, integral curves, 
and 3D graphs. 
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Topics in Mathematics

Pre-Calculus 

●     Analytic Geometry (in a plane) 
ADD. KEYWORDS: Tutorial, Conic sections
SOURCE: Johan Claeys 

●     Ballistic Trajectories 
ADD. KEYWORDS: Tutorial, Parametric Curves, Maple 

●     The Coffeecup Caustic   
SOURCE: Roy Williams from California Institute of Technology
TECHNOLOGY: Java applet 

●     Conic Sections   
●     Conic Sections 

SOURCE: Gershon Elber from the Technion, Israel Institute of Technology 
●     Conic Sections   

SOURCE: Mark Sutherland
TECHNOLOGY: Java applet 

●     The Conic Sections as the locus of Perpendicular Bisectors   
SOURCE: Key Curriculum Press
TECHNOLOGY: JavaSketchpad, Java applet 

●     Conics as Sections of a Cone with Mathematica 
SOURCE: Gary S. Stoudt from Indiana University of Pennsylvania
TECHNOLOGY: Mathematica 

●     Conics from Jalacy Software   
ADD. KEYWORDS: Conic Sections
SOURCE: Brian and Aidan Cully
TECHNOLOGY: Java applet, Software 

●     Coniques [in French]   
ADD. KEYWORDS: Properties of Conic Sections
SOURCE: Gérard Chevet
TECHNOLOGY: Java applet 

●     The Connected Curriculum Project - Connected before Calculus - Montana State University 
  

ADD. KEYWORDS: Boyle's Law, The Sound of Trigonometry, Calculators, Maple, Mathematica 
●     Dan's math@home lessons - Precalculus 

ADD. KEYWORDS: Tutroial, Factoring, Solving quadratic equations, Graphing parabolas, 
Trigonometry, Solving triangles, Functions and graphs, Exponential and log functions.
SOURCE: Dan Bach, Diablo Valley College
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TECHNOLOGY: Animated gifs 
●     DAU Math Refresher  

ADD. KEYWORDS: Tutorial, Tests, Basic Arithmetic, Fractions, Exponentials & Logarithms, 
Equations, Series, Functions, Domains & Ranges, Intercepts, Limits, Graphing of Functions, 
Derivatives, Integrals 

●     Easymaths  
ADD. KEYWORDS: Tutorials, Worksheets, Diagnostic tests 
SOURCE: Mathematics Web Association 

●     Ellipse Game   
SOURCE: John Banks from La Trobe University
TECHNOLOGY: Java applet, Server-side program 

●     EMR - Exercises in Math Readiness
ADD. KEYWORDS: Tutorial, Graphing Polynomials, Graphing' Rational Functions, Graphical 
Methods for Solving Inequalities, Conic Sections, Exponents and Exponential Functions, 
Logarithms 

●     Encyclopaedia Brittanica - Analytic geometry 
ADD. KEYWORDS: History, Solid analytic geometry, Special curves, Tangents and normals to curves, 
Conic Sections
SOURCE: Encyclopaedia Brittanica 

●     Equations with Roots 2 and 5: A Pedagogical Exploration with a Relation Grapher 
SOURCE: James W. Wilson from the University of Georgia 

●     Experiments in Mathematics Using Maple 
ADD. KEYWORDS: Tutorial, Maple Worksheets 

●     ExploreMath.com  
ADD. KEYWORDS: Analytic Geometry, Inequalities, Systems, Trigonometry, Comples Numbers, 
Exponentials, Logarithms 

●     Exponential and Logarithmic Functions 
ADD. KEYWORDS: Tutorial 

●     Exponential Growth 
ADD. KEYWORDS: Tutorial, Bank accounts, Population growth, Catagious Disease, Maple 

●     Famous Curves Index   
ADD. KEYWORDS: Evolute, Involute, Pedal Curve, Caustic, History (too many to list!) 

●     FHS Precalculus Study Page 
ADD. KEYWORDS: Tutorial, Linear & Quadratics, Polynomial Functions, Inequalities, Functions, 
Exponents & Logs, Analytic Geometry, Trig Functions, Trig Equations & Apps, Triangle Trig, 
Trig Formulas, Polar & Complex, Sequences & Series, Limits & Rational Functions, Derivatives 
& Slope, Calculus 

●     Geomath 
ADD. KEYWORDS: Tutorial, Power functions, Exponentials, Logarithms 

●     Harvey Mudd College Mathematics Tutorials 
ADD. KEYWORDS: Algebra Review, Binomial Theorem, Complex Numbers, Computing Limits, 
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Functions and Transformations of Functions, Review of Trig, Log, Exp 
●     Instructional Unit on Conic Sections  

ADD. KEYWORDS: Circle, Ellipse, Hyperbola, and Parabola, Geometric Constructions, Geometry 
Sketchpad, Polar Coordinates 

●     Interactive Mathematics  
ADD. KEYWORDS: Tutorial, LiveMath, Algebra, Trigonometry, Logarithms, Complex Numbers, 
Systems of Equations, Graphs 

●     An Introduction To Conic Sections 
ADD. KEYWORDS: Tutorial, Ellipses, Circles, Hyperbolas, Applications, Rotation of axes
SOURCE: James A. Sellers 

●     Java Applets in Mathematics [in French]   
ADD. KEYWORDS: Conic Sections, Parametric Curves, Polar Coordinate Graphs 

●     Manipula Math with Java - Conics   
ADD. KEYWORDS: Focus of Parabola, Ellipsograph, Problem of Hyperbola, Drawing Hyperbola, 
Drawing Parabola, Reflective Properties of Ellipses, Reflective Properties of Hyperbolas, Two 
Ellipses, Trace of Shadow
SOURCE: IES - International Education Software
TECHNOLOGY: Java Applets 

●     Math 1015 Pre-Calculus  
ADD. KEYWORDS: Course Materials, Online Recorded Lectures, Polynomials, Solving equations and 
inequalities, Circles, Functions, Lines, Composition of functions, Synthetic Division, Graphing, 
Inverse functions, Exponential and Logarithmic Functions, Linear Systems, Matrix Algebra, 
Cramer's Rule, Ellipses and Hyperbolas
SOURCE: Virginia Tech 
TECHNOLOGY: RealAudio 

●     Math 108 Pre-Calculus 
ADD. KEYWORDS: Tutorial, Geometry Review, Long Division, Synthetic Division, Using Synthetic 
Division, The Fundamental Theorem of Algebra, Factored Polynomials, The Rational Roots 
Theorem, Descartes Rule of Signs, Bounds, Trigonometry, Polar Coordinates, Complex Numbers, 
Conic Sections, Sequences and Series 

●     Math 131 Supplementary Material Menu 
ADD. KEYWORDS: Tutorial, Solving Linear Equations, Lines in the Plane, Linear Modeling, 
Functions, Graphs of Functions, Translations of Functions, Quadratic Functions, Polynomial 
Functions, Rational Functions, Exponential Functions, Logarithmic Functions, Properties of 
Logarithms, Solving Exponential and Logarithmic Equations, Exponential and Logarithmic 
Applications, Linear Inequalities, Linear Programmming, Matrices and Systems of Linear 
Equations, 3D Demo of Row Operations, The Inverse of a Square Matrix 

●     Math and Problem-solving 
ADD. KEYWORDS: Find sizes and distances of earth, moon and sun 

●     Math Forum - Pre-Calculus  
ADD. KEYWORDS: Classroom materials, software, newsgroups 

●     Mathematics Explorations I & II  
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ADD. KEYWORDS: Projects involving activities at NASA 
SOURCE: Capital Community College, NASA - AMATYC - NSF 
TECHNOLOGY: Adobe Acrobat Reader 

●     Mathematical Modules in Biology and Chemistry 
ADD. KEYWORDS: Epidemiology, Course Materials
SOURCE: Meghan A. Burke and Sean F. Ellermeyer from Kennesaw State University 

●     Mathématikos - Les Courbes du plan [in French]   
ADD. KEYWORDS: Parametric curves
SOURCE: Jean-Paul Quelen, professeur de mathématiques au lycée Jean Monnet - Strasbourg
TECHNOLOGY: Java Applets 

●     The MathServ Calculus Toolkit  
ADD. KEYWORDS: Factoring polynomials, Solutions of polynomials, Fitting a polynomial, Shifting 
and scaling functions, Finding inverses 

●     Mathworld - Analytic Geometry 
ADD. KEYWORDS: Definitions, List of Theorems
SOURCE: Eric W. Weisstein 

●     Occurrence of the Conics 
ADD. KEYWORDS: Applications of the conics
SOURCE: Jill Britton from Camosun College 

●     Parabola Explorer   
ADD. KEYWORDS: Graphing parabolas
SOURCE: 7Stones Mathematical Ideas in Science
TECHNOLOGY: Flash plugin 

●     Parabolas   
ADD. KEYWORDS: Paper folding
SOURCE: James P. Dildine from the University of Illinois, Urbana-Champaign
TECHNOLOGY: Geometer's Sketchpad, JavaSketchpad 

●     Partnership for Excellence - Functions: A Connecting Thread for Mathematics  
ADD. KEYWORDS: Lesson Plans, Course Materials
SOURCE: Partnership for Excellence Project, University of South Carolina Spartanburg 

●     Physics Tutorials - Logarithms 
●     Precalculus -- Preparing Students for Calculus 

ADD. KEYWORDS: Published Text 
●     Precalculus and Mathematica  

ADD. KEYWORDS: Mathematica labs and exams
SOURCE: Donald G. Hazlewood, Southwest Texas State University 
TECHNOLOGY:Adobe Acrobat Reader and Mathematica 

●     Precalculus at UW  
ADD. KEYWORDS: Course Materials, Text, Additional Problems
SOURCE: D.H. Collingwood and K.D. Prince, University of Washington 
TECHNOLOGY:Adobe Acrobat Reader 
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●     Pre-Calculus Learning Units 
ADD. KEYWORDS: Lesson Plans, Graphs of Parabolas 

●     Precalculus Quiz Generator and Grader  
●     The Precalculus Weblet  

ADD. KEYWORDS: Course materials 
●     Project-Based Instruction in Mathematics for the Liberal Arts  

ADD. KEYWORDS: Course materials, Linear functions, Least Squares Line, Linear Modeling, 
Statistics and probability, Non-linear functions, Managing money with the exponential function, 
The logistic function – constrained growth and decay
SOURCE: M.B. Ulmer, University of South Carolina Spartanburg 
TECHNOLOGY:Adobe Acrobat Reader 

●     The Reflective Property of the Parabola 
SOURCE: Marc Frantz from Indiana University - Purdue University, Indianapolis 

●     SCORE Mathematics - Mathematical Analysis 
ADD. KEYWORDS: Lesson Plans, Standards 
SOURCE: SCORE - Schools of California Online Resources for Education 

●     Sherware Precalculus Tools Page  
ADD. KEYWORDS: Projects 

●     Surfin' Sinefeld: Flash Animated Precalculus, Calculus and Statistics Activities   
ADD. KEYWORDS: Graphing, Exponential, Logarithmic and Trigonometric Functions, Quizzes 
SOURCE: Ralph Irons, Central Shenandoah Valley Regional Governor's School
TECHNOLOGY: Flash plugin 

●     Spirograph  
ADD. KEYWORDS: Interactive pages 

●     Spirograph   
●     Topics in Precalculus  
●     Tracés animé  

ADD. KEYWORDS: Generate graphs of a parametrized family of functions. 
●     Triangles and Parabolas 

ADD. KEYWORDS: Finding a parabola which is tangent to three lines
SOURCE: Jemma Giddings from the University of Georgia
TECHNOLOGY: Geometer's Sketchpad 

●     2d curves   
●     A Visual Dictionary of Special Plane Curves   

ADD. KEYWORDS: Caustics, Envelope, Evolute, Involute, Inversion, Conic Sections, Mathematica 
Notebooks, Geometry Sketchpad 

●     WIMS - WWW Interactive Mathematics Server  
ADD. KEYWORDS: Online exercises, Polynomials, Functions, Composition of Functions 

●     Worksheet library ~ Functions  
ADD. KEYWORDS: Trigonometry, The Exponential Function, The Natural Logarithm 
SOURCE: Mike Robinson, Sheffield Hallam University 
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Mathematics Archives - Topics in Mathematics - Pre-Calculus

TECHNOLOGY: Adobe Acrobat Reader 
●     Zona Land ... More Mathematics than Science   

ADD. KEYWORDS: Functions, Graph Paper, Trigonometry, Geometry, Fractals, VRML 
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Mathematics Archives - Topics in Mathematics - Statistics

Topics in Mathematics

Statistics 

●     Adventures in Statistics 
ADD. KEYWORDS: measurement, graphing, computation, data analysis, and presentation of results 

●     AMS's Materials Organized by Mathematical Subject Classification  
ADD. KEYWORDS: Electronic Journals, Preprints, Web Sites, Databases 

●     AP Statistics  
●     Applets for the Cybergnostics project   

ADD. KEYWORDS: Chi-square Demonstration, Exponential Demonstration, Binomial Demonstration, 
Normal Approximation to the Binomial, Marden's regression, conditional probability, Confidence 
interval, Correlation demo, Power, F Demonstration 

●     AskERIC Lesson Plans - Statistics 
●     Basic Principles of Statistical Analysis 

ADD. KEYWORDS: Tutorial, Basics Concepts of Statistical Models, Mixed Model, Choosing between 
Fixed and Random Effects, Estimating variances and Covariances, Estimating Fixed Effects, 
Predicting Random Effects, Inference space 

●     Basic statistics for clinicians 
ADD. KEYWORDS: Hypothesis testing, 2.Interpreting study results: confidence intervals, Assessing 
the effects of treatment: measures of association, Correlation and regression
SOURCE: Gordon Guyatt, Roman Jaeschke, Nancy Heddle, Deborah Cook, Harry Shannon, and 
Stephen Walter, of the McMaster University Health Sciences Centre

●     Berrie's Statistic's Page    
ADD. KEYWORDS: Poisson distribution, Mean and Variance in the Normal Distribution, Graph of the 
Normal Distribution, Binomial Distribution, Central Limit Theorem 

●     Bibliography for Computational Probability and Statistics  
●     Briefbook of Data Analysis 

ADD. KEYWORDS: Amdahl`s Law, ANOVA, Analysis of Variance, Attenuation, Average, 
Bandwidth, Baud, Bayes Theorem, Bayesian Statistics, Benchmarking, Bessel Functions, Beta 
Distribution, Bias, Binning, Binomial Distribution, Bivariate Normal Distribution, Boolean 
Algebra, etc. 

●     Center for Industrial Statistics  
●     Central Limit Theorem Applet    
●     Chance Database  

ADD. KEYWORDS: Course Materials, Teaching Aids, Newsletter, Newspaper and Magazine Articles 
●     Computing Studio  

ADD. KEYWORDS: Mean, Median, Variance, Standard Deviation, Covariance 
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Mathematics Archives - Topics in Mathematics - Statistics

●     Confidence Interval Applet    
●     Correspondence Analysis 

ADD. KEYWORDS: Data Analysis, Factor Analysis, Contingency tables
SOURCE: F.X. Micheloud 

●     CTI - Statistics  
ADD. KEYWORDS: Publications, Guide to Software for Teaching, Newsletter, Software Reviews, 
Articles, Educational Software, Mailing List, Meetings 

●     The CUWU Statistics Program   
●     Data Analysis Briefbook 

ADD. KEYWORDS: Glossary, Statistics, Computing, Analysis. 
●     Data Analysis Learning Units 

ADD. KEYWORDS: Lesson Plans, Fractions and Probability 
●     The Data and Story Library  
●     Data Archives on the Net  

ADD. KEYWORDS: Datasets 
●     Data Surfing on the World Wide Web  

ADD. KEYWORDS: Datasets 
SOURCE: Robin Lock, St. Lawrence University 

●     DAU Stat Refresher  
ADD. KEYWORDS: Tutorial, Tests, Probability, Random Variables, Expectations, Distributions, Data 
Analysis, Linear Regression, Multiple Regression, Moving Averages, Exponential Smoothing, 
Clustering Algorithms 

●     Discussiones Mathematicae Probability and Statistics  
ADD. KEYWORDS: Published Journal
SOURCE: Technical University of Zielona Góra 

●     DOCUMENTA MATHEMATICA - Extra Volume ICM 1998 - Section: 12. Probability and 
Statistics 
ADD. KEYWORDS: Articles
SOURCE: DOCUMENTA MATHEMATICA, Proceedings of the International Congress of 
Mathematicians
TECHNOLOGY: Postscript and DVI readers 

●     ESAIM : Probabilités et Statistique 
ADD. KEYWORDS: Journal 

●     Exact power for the Fisher Exact Test   
●     Exploring Data   

ADD. KEYWORDS: Tutorials, Course materials, Boxplots, Confidence Intervals, Curve Fitting, 
Datasets, Dotplots, Histograms, Hypothesis Testing, Linear Regression, Looking for Patterns, 
Measures of Location, Measures of Spread, Normal Distribution, Normal Plots, Probability, 
Sampling, Scatterplots, Stemplots
SOURCE: Rex Boggs and Education Queensland 

●     FAQ: Numerical Analysis and Associated Fields Resource Guide  
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Mathematics Archives - Topics in Mathematics - Statistics

ADD. KEYWORDS: Books, Software 
●     Globally Accessible Statistical Procedures  

ADD. KEYWORDS: Regression, confidence interval, histogram, central limit theorem, binomial 
distribution, interactive pages 

●     Graphical Data Analyisis Course by Jeff Banfield  
ADD. KEYWORDS: Splus, Graphical Perception, Dot Charts, Scatter Plots, Scatter Plot Smoothing, 
Spatial Data and Response Surfaces, Coplots, Dynamic Graphics, Comparing Groups 

●     A Guide to Statistical Software  
ADD. KEYWORDS: Software Reviews 

●     Hyperstat - ein interaktives, hypertextbasiertes Statistikskript für die Varianzanalyse 
ADD. KEYWORDS: Matrix Algebra, Linear Models, Variance Analysis, Regression Analysis, Tutorial 

●     HyperStat Online  
ADD. KEYWORDS: Tutorial, Describing Univariate Data, Describing Bivariate Data, Introduction to 
Probability, Normal Distribution, Sampling Distributions, Point Estimation, Confidence Intervals, 
The Logic of Hypothesis Testing, Testing Hypotheses with Standard Errors, Power, Introduction 
to Between-Subjects ANOVA, Factorial Between-Subjects ANOVA, Within-Subjects ANOVA, 
Prediction, Chi Square, Distribution-Free Tests, Measuring Effect Size 

●     Institute of Mathematical Statistics  
ADD. KEYWORDS: Society, Publications, Meetings, Resources, Statistics departments 

●     Institute of Statistical Mathematics 
ADD. KEYWORDS: Journal, Software & Data Library 

●     Introduction to Descriptive Statistics  
●     Introduction to Factor Analysis 

ADD. KEYWORDS: Tutorial, Chemistry 
●     Introduction to Linear Regression   

ADD. KEYWORDS: Graphing best fit lines
SOURCE: 7Stones Mathematical Ideas in Science
TECHNOLOGY: Shockwave plugin 

●     Introductory Statistics: Concepts, Models, and Applications 
ADD. KEYWORDS: Lecture Notes, SPSS 

●     Introductory Statistics Demonstrations 
ADD. KEYWORDS: Animations, Variance and Standard Deviation, Z-Scores, Z-Scores and 
Probability, Sampling Distributions, Standard Error, Standard Error and Z-score Hypothesis 
Testing, Confidence Intervals, Power, Analysis of Variance (ANOVA) 

●     Intuitive Biostatistics: Interpreting Nonsignificant P values 
ADD. KEYWORDS: Chapter from book
SOURCE: HJ Motulsky, Intuitive Biostatistics 

●     Java Applets  
ADD. KEYWORDS: Histograms, Normal Approximation to Binomial, Normal Density, T Distribution, 
Area Under Normal Curves, Z Scores and the Normal Distribution, Binomial Probabilities, 
Brownian Motion, Central Limit Theorem, A Gamma Process, Let's Make a Deal Game, 
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Mathematics Archives - Topics in Mathematics - Statistics

Confidence Intervals, Regression, Statistics Tools, Statiscope Summarizing data, T-test, Models 
●     Java Applets for Statistics    

ADD. KEYWORDS: The sample space model, Calculator(mean and deviation), Multiplication rule for 
counting, Permutations and Combinations, Tossing a balanced coin n times, Tossing a coin with 
p=P(H), Rolling a pair of dice, Venn diagram(Addition Rule), Rolling a balanced die n times, 
Binomial distribution, Conditional Probability, Total Probability and Bayes Rule, Normal curve, 
Standard Normal Distribution, Normal approximation to Binomial Distribution
SOURCE: Shangrong Deng, Southern Polytechnic State University
TECHNOLOGY: Java applets 

●     The Journal of Basketball Studies   
ADD. KEYWORDS: Basketball's Bell Curve, Applications of Statistics 

●     Journal of Statistics Education 
ADD. KEYWORDS: Electronic Journal 

●     Journal of Statistics Education - Information Service  
ADD. KEYWORDS: Education Resources, Newsgroups, Data Resources, Software, Organizations 

●     K-12 Statistics  
ADD. KEYWORDS: NCTM Statistics Standards, Lesson Plans 

●     Kovach Computing Services 
ADD. KEYWORDS: Commercial Statistical Software, Excel, Population Dynamics Simulation, 
Circular Statistics 

●     List of Undergraduate Textbooks 
ADD. KEYWORDS: Introductory Statistics and Mathematical Statistics Textbooks, Reviews 

●     Math Forum - Probability & Statistics  
ADD. KEYWORDS: Classroom materials, software, newsgroups 

●     Mathematics Explorations I & II  
ADD. KEYWORDS: Projects involving activities at NASA 
SOURCE: Capital Community College, NASA - AMATYC - NSF 
TECHNOLOGY: Adobe Acrobat Reader 

●     MathLink - Probability and Statistics  
ADD. KEYWORDS: Three Door Puzzle, Descriptive Statistics, Linear Regression, Chi-Square, 
Exponential Fit, Guessing Correlations 

●     Mathworld - Probability and Statistics
ADD. KEYWORDS: Definitions, List of Theorems 

●     MSTE Technology Tutorials - Statistics    
ADD. KEYWORDS: Buffon Needle, Cereal Box Problem, Cliff Hanger, Estimation of Pi, Monty's 
Dilemma, Random Birthday, Relative Prime, Simulated Fishtank, Webdice, Triangle Dice 
SOURCE: Nicholas Exner and George Reese, University of Illinois at Urbana-Champaign 

●     National Library of Virtual Manipulatives for Interactive Mathematics - Data Analysis & 
Probability    
ADD. KEYWORDS: Scatterplot, Histogram, Box Model
SOURCE: Lawrence O. Cannon, James T. Dorward, E. Robert Heal, Leo Edwards, Utah State 
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Mathematics Archives - Topics in Mathematics - Statistics

University
TECHNOLOGY: Java applets 

●     NetMul   
ADD. KEYWORDS: Multivariate analysis, software, interactive pages 

●     Online Data  
ADD. KEYWORDS: Data Archives, Data Sets 

●     Online Hypothesis Tests Tutorial   
●     Mathématikos - Probabilités et statistiques [in French]   

ADD. KEYWORDS: Binomial law, Poisson distribution, Normal distribution, Galton board, Random 
number generator, ...
SOURCE: Jean-Paul Quelen, professeur de mathématiques au lycée Jean Monnet - Strasbourg
TECHNOLOGY: Java Applets 

●     MSTE Java Lessons - Statistics    
ADD. KEYWORDS: Buffon Needle, Cereal Box Problem, Cliff Hanger, Estimation of Pi, Monty's 
Dilemma, Random Birthday, Relative Prime, Simulated Fishtank, Webdice, Triangle Dice 
SOURCE: Nicholas Exner and George Reese, University of Illinois at Urbana-Champaign 
TECHNOLOGY: Java Applets 

●     Partnership for Excellence - Statistics: A Math Unifier  
ADD. KEYWORDS: Lesson Plans, Course Materials
SOURCE: Partnership for Excellence Project, University of South Carolina Spartanburg 

●     Probability/Statistics Object Library    
ADD. KEYWORDS: Geometric Models, Bernoulli Trials, Finite Sampling Models, Set Theory and 
Combinatorics, Dice Experiments, Games of Chance, Poisson Process, Random Walk, Interacting 
Particle Systems, Special Distributions, Random Samples, Point Estimation, Interval Estimation, 
Hypothesis Testing 
SOURCE: Kyle Siegrist, Dawn Duehring, University of Alabama in Huntsville 
TECHNOLOGY: Java Applets 

●     Probability and Statistics 
ADD. KEYWORDS: Collection of articles, Evaluating Probabilities of Boolean Events, The Gambler's 
Ruin, Area Under the Bell Curve, The Poisson Distribution and Queues, Ratio Populations, Ratios 
of Normal Distributions, Failure Rates, MTBFs, All That and Boolean Expansion as Linear 
Interpolation, etc. 

●     Project Interactivate - Statistics   
ADD. KEYWORDS: Lesson Plans, Mean, Median and Mode, Histograms and Bar Graphs 

●     Project INTERMATH Topics - Probability and Statistics  
ADD. KEYWORDS: Curriculum Materials, Calling for Artillery Fire Reliability Problem, Electrical 
Circuit Analysis, Modeling Electrical Current, Estimating Water Forces on a Dam, Predicting 
Stock Market Performance, Measuring the "Safeness" of Air
SOURCE: COMAP, Carroll College, Georgia College & State University, Harvey Mudd College, 
Macalester College, University of Redlands, Texas Southern Consortium, West Point 
TECHNOLOGY: Adobe Acrobat Reader 

●     Prophet StatGuide 
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Mathematics Archives - Topics in Mathematics - Statistics

ADD. KEYWORDS: Software, Glossary, Modeling 
●     Regression Applet    
●     Rice Virtual Lab in Statistics   

ADD. KEYWORDS: Simulations, Demonstrations, Case Studies, Analysis Lab 
●     SCORE Mathematics - Probability and Statistics 

ADD. KEYWORDS: Lesson Plans, Standards 
SOURCE: SCORE - Schools of California Online Resources for Education 

●     SCORE Mathematics - Probability and Statistics - Advanced 
ADD. KEYWORDS: Lesson Plans, Standards 
SOURCE: SCORE - Schools of California Online Resources for Education 

●     SCORE Mathematics - Statistics, Data Analysis and Probability  
ADD. KEYWORDS: Lesson Plans, Standards 
SOURCE: SCORE - Schools of California Online Resources for Education 

●     SEQuaL - Statistics Education through Quantitative Literacy  
ADD. KEYWORDS: NCTM Standards, Workshops, Lesson Plans, Software 

●     SEL - Statistique En Ligne [in French]   
ADD. KEYWORDS: Simulations, Articles, Lexicon, Tutorial
SOURCE: Claudine Robert from INRIA Rhtne-Alpes, Bernard Ycart et al. from Université René 
Descartes
TECHNOLOGY: Java applets 

●     SFU Statistics - Innovations in Teaching Statistics 
ADD. KEYWORDS: Computer demonstrations, Datasets for teaching, Consulting problems, Journals, 
Interactive Textbooks 

●     SIAM - World of Mathematics and Computing - Statistics   
●     Simple Regression   
●     SMILE Program Mathematics Index 

ADD. KEYWORDS: Lesson Plans 
●     Some Experimental Interactive Statistics Pages  

ADD. KEYWORDS: Correlation, scatter plots, histograms, interactive pages 
●     The Sports Data Page  

ADD. KEYWORDS: Datasets 
SOURCE: Robin Lock, St. Lawrence University 

●     Statistical Inference on the TI-82/83/86/89/92+ 
ADD. KEYWORDS: Discrete and Continuous Random Variables, Binomial, Poisson, Geometric, 
Hypergeometric, Normal, T, Chi Square, F Distributions, Confidence Intervals, Hypothesis Tests, 
Anova, Projects 
SOURCE: David K. Neal, Western Kentucky University 

●     The Statistical Instruction Internet Palette (SIIP)  
ADD. KEYWORDS: Dr. B's Wide World of Web Data, Data Gallery, Equation Gallery, Scatterplots, 
Computation 

●     Statistical Methods for Rater Agreement  
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Mathematics Archives - Topics in Mathematics - Statistics

ADD. KEYWORDS: Raw agreement indices, Odds ratio and Yule's Q, Tests of marginal homogeneity, 
Tetrachoric and polychoric correlation, Latent trait models, Latent class models, Loglinear, 
association, and quasi-symmetry models, Kappa coefficients, Methods for Likert-type or interval-
level data 
SOURCE: John Uebersax 

●     Statistical Tests  
ADD. KEYWORDS: Probability Distributions: Binomial, Normal, Student-t, Chi-Square; One-Sample 
and Matched-Pairs tests: Sign Test, McNemar's Test, Wilcoxon Matched-Pairs Signed-Ranks 
Test, Student-t test for one sample; Two-Sample tests: Median Test, Binomial proportions, 
Wilcoxon Test, Student-t test for two samples; Multiple-Sample tests: Friedman Test; 
Correlations: Rank Correlation coefficient, Correlation coefficient, Comparing Correlation 
coefficients; Categorical data (Chi-square tests): Chi-square test for known distributions, Chi-
square test for equality of distributions 

●     Statiscope   
ADD. KEYWORDS: Descriptive Statistics 

●     Statistics  
ADD. KEYWORDS: Data Sources, Job Announcements, Departments, Divisions and Schools of 
Statistics, Statistical Research Groups, Institutes, and Associations, Statistical Archives and 
Resources, Software, Journals, Mailing Lists, News Groups 

●     Statistics and Statistical Graphics Resources by Michael Friendly, York University  
ADD. KEYWORDS: Societies, Statistics Departments, SAS, SPSS, LispStat, S Plus, Mathematica, 
Data Visualization & Statistical Graphics, Psychometrics, Online courses, Data, Categorical Data 
Analysis, Software 

●     Statistics for Engineers 
ADD. KEYWORDS: Course Notes, Bayes' Theorem, Probabilities and Odds, Counting Theorem, 
Permutation and Combination, Probability Distributions, Mean, Variance and Standard Deviation 
of Binomial Distributions, Hypergeometric Distribution, Poisson Probability Distribution 

●     Statistics Glossary 
ADD. KEYWORDS: Basic Definitions, Presenting Data, Sampling, Probability, Confidence Intervals, 
Hypothesis Testing, Paired Data, Correlation and Regression, Design of Experiments and 
ANOVA, Categorical Data, Non-parametric Methods, Time Series Data 

●     Statistics Learning Units 
ADD. KEYWORDS: Lesson Plans, Compound Interest Formula, Data 

●     Statistics - The Study of Stability in Variation  
ADD. KEYWORDS: WWW textbook, calculators, interactive pages 

●     Statistics.Com  
ADD. KEYWORDS: Software & Other Tools, Courses, Employment & Career Info, Teaching 
Statistics, Getting Statistical Data 

●     STATLETS   
ADD. KEYWORDS: Plot, Summarize, One Sample Analysis, Two Sample Analysis, Analysis of 
Variance, Regression Analysis, Time Series Analysis Rates and Proportions, Quality Control 

●     StatLib 
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ADD. KEYWORDS: Applied Statistics algorithms, ASA Statistical Computing Section Archive, 
Datasets Archive, Designs Archive, Software, Genstat, Meetings, Software for Graphical 
Modelling, Data and Story Library 

●     Statnotes: An Online Textbook 
ADD. KEYWORDS: Lecture Notes, ANOVA, ANCOVA, Correlation, Correspondence Analysis, 
Partial Correlation, Discriminant Function, Analysis, Multiple DA, Factor Analysis, Logistic 
Regression, 
Log-linear Models, Logit, and Probit, MANOVA/MANCOVA, Path Analysis, Regression 
Analysis, Structural Equation, Modeling 
SOURCE: G. David Garson, North Carolina State University 

●     Stats 101   
ADD. KEYWORDS: Student's t-Test, ANOVA, Simple Least Squares, Spearman's Rank Correlation, 
Statistical Methods Decision Tree 

●     Statsoft  
ADD. KEYWORDS: Electronic textbook, ANOVA/MANOVA, Canonical Analysis, Classification 
Trees, Cluster Analysis, Correspondence Analysis, Data Mining Techniques, Discriminant 
Function Analysis, Experimental Design, Principal Components and Factor Analysis, General 
Linear Models, General Stepwise Regression, Graphical Analytic Techniques, Multiple 
Regression, Log-Linear Analysis of Frequency Tables, Multidimensional Scaling, Neural 
Networks, Nonlinear Estimation, Nonparametric Statistics, Partial Least Squares, Power Analysis, 
Process Analysis, Quality Control Charts, Reliability and Item Analysis, Structural Equation 
Modeling, Survival/Failure Time Analysis, Time Series Analysis 
SOURCE: StatSoft, Inc. 

●     SticiGui©: Statistical Tools for Internet and Classroom Instruction with a Graphical User 
Interface   
ADD. KEYWORDS: Course Materials 

●     Stochastic Finite Elements: A Spectral Approach 
ADD. KEYWORDS: Published Book 

●     Surfin' Sinefeld: Flash Animated Precalculus, Calculus and Statistics Activities   
ADD. KEYWORDS: Graphing, Means, Medians, Measures of Spreads, Three and four door problems, 
Quizzes 
SOURCE: Ralph Irons, Central Shenandoah Valley Regional Governor's School
TECHNOLOGY: Flash plugin 

●     SURFSTAT Australia   
ADD. KEYWORDS: Summarising and Presenting Data, Producing Data, Variation and Probability, 
Statistical Inference, Control Charts 

●     TI-83 Graphing Calculator Manual for Moore's The Basic Practice of Statistics  
SOURCE: David K. Neal, Western Kentucky University 

●     The Titanic: What Can Numbers Tell Us About Her Fatal Voyage? 
ADD. KEYWORDS: Spreadsheets, Databases 

●     Tools for Teaching and Assessing Statistical Inference  
ADD. KEYWORDS: Course Materials, Distributions, Measures of center, Variability, Drawing 
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samples, Sampling distributions, Confidence intervals, p-values, Sampling distributions, 
Confidence
intervals
SOURCE: Joan Garfield and Bob delMas, University of Minnesota; Beth Chance, California 
Polytechnic State University
TECHNOLOGY: Macintosh and Windows Software- Sampling SIM, Standard Distributions

●     Triogram Models  
ADD. KEYWORDS: Function Estimation, Bivariate Splines, Bivariate Regression, Log-Density 
Estimation, Modeling Data, ANOVA 

●     USDA-NASS Kids Page 
ADD. KEYWORDS: Agricultural Statistics 

●     Using Internet Data Meaningfully  
ADD. KEYWORDS: Worksheets
SOURCE: Helen Skala, University Wisconsin - La Crosse 

●     Virtual Laboratories in Probability and Statistics   
ADD. KEYWORDS: Descriptive Statistics, Probability Spaces, Combinatorics, Distributions, Expected 
Value, Special Distributions, The Sample Mean, Interval Estimation 

●     Web Interface for Statistics Education   
ADD. KEYWORDS: Tutorials, Glossaries, Discussion Groups 

●     WebStat   
ADD. KEYWORDS: Summary Statistics, Z tests (one and two sample) for Population Means, T Tests 
(one and two sample) for Population Means, Chi-square Test for Population Variance, F Test for 
Comparing Population Variances, Regression 
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Limits - Numerical 

Tutorial which is an introduction to limits from a numerical point of view. 
❍     A Javascript exploration in getting numerical evidence for determining a limit. 
❍     A Javascript demonstration which gives three examples which show problems for 

generating numerical evidence for the determination of a limit. 
❍     A Javascript demonstration which shows the need for considering both right-hand and left-

hand limits. 
❍     A Javascript exploration in getting numerical evidence for determining an infinite limit. 
❍     Computer programs which will generate numerical evidence for determining a limit. Also, 

●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer programs which will generate numerical evidence for determining a limit. 
❍     Computer programs and the problems they have for generating numerical evidence for the 

determination of a limit. Also, 
●     TI-86 Graphing Calculator [Using Flash] 

Limits - Graphically 

Tutorial which is an introduction to limits from a graphical point of view. 
❍     A LiveMath notebook to explore graphically the verification of the epsilon-delta definition 

of limit. 
❍     Using graphing calculators to graphically demonstrate the epsilon-delta definition of limits

[Using Flash] 
❍     Computer programs to graphically demonstrate the epsilon-delta definition of limits. Also, 

●     TI-85 Graphing Calculator 
❍     Using TI-85 graphing calculators to graphically demonstrate the epsilon-delta definition of 

limits. 
❍     Computer programs and the problems that have in graphically investigating limits. Also, 

●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer program to evaluate limits with the greatest integer function. Also, 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     A LiveMath notebook to explore the verification of the epsilon-delta definition of limit. 

Formal Definition of Limits 

Tutorial on the formal definition of limits. 
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❍     Drill in finding delta given epsilon. 
❍     Drill in verifying limits using the definition of limits. 

Limits - Symbolically 

Tutorial which is an introduction to limits from a symbolic point of view. 
❍     Limit theorems [Using Flash] [Using HotEqn] [Using IBM Professional TechExplorer] 
❍     LiveMath notebooks to explore functions which involve the Greatest Integer Function; 

application of squeeze theorem. 
❍     Drill on evaluating limits. 
❍     A quiz on evaluating limits using the limit theorems and graphs. 
❍     Maple and the evaluation of limits. 
❍     Maple and the limit theorems. 
❍     Maple and finding limits of piecewise defined functions. 

Continuous Functions 

Tutorial which is an introduction to continuous functions. 
❍     A quiz on using the definition of continuity. 
❍     A LiveMath Notebook on exploring continuity of a piecewise defined function. 
❍     Drill in determining when a piecewise defined function is continuous. 
❍     A LiveMath notebook illustrating the problem of using computers to determine graphically 

whether a function is continuous. 
❍     Computer programs and problems of using computers to determine graphically whether a 

function is continuous. 
❍     Graphically exploring functions with possible removable discontinuities

●     with the TI86 graphing calculator [Using Flash] 
●     with the TI85 graphing calculator. 

Properties of Continuous Functions 

Tutorial on the Intermediate Value Theorem, the Bisection Method and the Extreme Value 
Theorem. 

❍     Javascript page illustrating the bisection method for finding roots. 
❍     Computer programs which numerically illustrate the bisection method. 
❍     Computer programs which graphically illustrate the bisection method. 
❍     A quiz on using concepts involving continuity of functions and its consequences. 

Horizontal Asymptotes 
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Tutorial on horizontal asymptotes. 
❍     Javascript generated evidence for horizontal asymptotes. 
❍     Javascript module on numerically determining horizontal asymptotes. 
❍     A LiveMath notebook on graphically determining horizontal asymptotes. 
❍     Drill in finding horizontal asymptotes. 
❍     Computer programs which can be used to gather numerical evidence for horizontal 

asymptotes. Also, 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer programs and problems in gathering numerical evidence for determining 
horizontal asymptotes. Also, 

●     TI-85 Graphing Calculator 

Vertical Asymptotes 

Tutorial on vertical asymptotes. 
❍     A Javascript exploration in getting numerical evidence for determining an infinite limit. 
❍     A LiveMath notebook to explore graphically vertical asymptotes. 
❍     Drill on finding vertical asymptotes. 
❍     Computer programs which can be used to gather numerical evidence for vertical 

asymptotes. Also, 
●     TI-85 Graphing Calculator 

❍     Determine the roots and vertical asymptotes of rational functions using a TI-85 graphing 
calculator. 
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Tangent Lines 

Tutorial on tangent lines as an introduction to the derivative. 
❍     A LiveMath notebook illustrating the tangent line as the limit of secant lines. 
❍     A JavaScript exploration of the numerical estimates of the slope of the tangent line to the 

graphs of various functions. 
❍     An animation demonstrating the estimation of the slope of the tangent by zooming in. 
❍     A LiveMath notebook which compares graphically a function with its linear 

approximation. 
❍     Javascript module which compares numerically a function with its linear approximation. 
❍     Computer programs that graphically illustrate the tangent line as the limit of secant lines. 

Also, 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Another computer program that graphically illustrates the tangent line as the limit of secant 
lines. 

❍     Computer programs that plot a tangent line to the graph of a given function. Also, 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Another computer program that plots the graph of a function together with the tangent line 
at a given point. 

Linear Approximations 

Tutorial on the accuracy of a linear approximation. 
❍     A LiveMath Notebook which can be used to determine accuracy of using a linear 

approximation. 
❍     Computer programs that can be used to determine accuracy of using a linear 

approximation. Also, 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

Definition of Derivative at a Point 

Tutorial on the definition of derivative at a point. 
❍     Using the definition of derivative at a point, calculate the derivative of a quadratic at a 

point.
[Using HotEqn] [Using IBM Techexplorer] [Using IBM Pro.Techexplorer] 

❍     Using the definition of derivative at a point, calculate the derivative of a square root of a 
function at a point.
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[Using HotEqn] [Using IBM Techexplorer] [Using IBM Pro.Techexplorer] 
❍     Using the definition of derivative at a point, calculates the derivative of a rational function 

at a point.
[Using HotEqn] [Using IBM Techexplorer] [Using IBM Pro.Techexplorer] 

❍     A LiveMath Notebook illustrating how to use the definition of derivative to calculate the 
derivative of a quotient at a specific point. 

❍     A LiveMath Notebook which, using the definition of derivative at a point, investigates the 

derivative of x2/3 at x = 0. 
❍     A LiveMath Notebook illustrating how to use the definition of derivative to calculate the 

derivative of a radical at a specific point. 
❍     Computer programs that numerically investigate the behavior of the Newton quotient of a 

function at a point. 
❍     Computer programs that numerically investigate the behavior of the Newton quotient of a 

function at a point. In this case, the function is not differentiable at the given point. 
❍     Computer programs that numerically investigate the behavior of the Newton quotient of a 

function at a point. In this case, the function is not differentiable at the given point but the 
limit of the symmetric difference quotient exists. 

Definition of Derivative 

Tutorial on the definition of derivative. 
❍     Using the definition of derivative, calculate the derivative of a quadratic at a point.

[Using HotEqn] [Using IBM Techexplorer] [Using IBM Pro. Techexplorer] 
❍     Using the definition of derivative, calculate the derivative of a square root of a function at 

a point.
[Using HotEqn] [Using IBM Techexplorer] [Using IBM Pro. Techexplorer] 

❍     Using the definition of derivative, calculate the derivative of a rational function at a point.
[Using HotEqn] [Using IBM Techexplorer] [Using IBM Pro. Techexplorer] 

❍     A LiveMath Notebook illustrating how to use the definition of derivative to calculate the 
derivative of a quadratic. 

❍     A LiveMath Notebook illustrating how to use the definition of derivative to calculate the 
derivative of a quotient. 

❍     A LiveMath Notebook illustrating how to use the definition of derivative to calculate the 
derivative of a radical. 

❍     Drill problems for finding the derivative of a function using the definition of a derivative. 

Differentiation Formulas 

Tutorial on elementary differentiation formulas, their derivation and use. Includes the Power 
Formula. 
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❍     A LiveMath Notebook illustrating how to use the definition of derivative to obtain the 
power rule. 

❍     A LiveMath Notebook illustrating the use of the formula for the derivative of a sum. 

Derivative of the Exponential Function 

Tutorial on the calculation of the derivative of the exponential function. 
❍     A LiveMath notebook illustrating the finding of the derivative of an exponential function 

at x = 0. 
❍     JavaScript exploration of the numerical estimates of the slope of the tangent line to the 

exponential function. 

Product Rule 

Tutorial on the Product Rule. 
❍     A LiveMath notebook which illustrates the use of the product rule. 
❍     Drill problems for differentiation using the product rule. (Algebraic and exponential 

functions). 

Quotient Rule 

Tutorial on the Quotient Rule. 
❍     A LiveMath notebook which illustrates the use of the quotient rule. 
❍     Drill problems for differentiation using the quotient rule. 

Derivatives of the Trigonometric Functions 

Tutorial on the calculation of the derivatives of the trigonometric functions. 
❍     Drill problems for differentiation using the product rule. (Emphasis on trigonometric 

functions). 
❍     Drill problems for differentiation using the quotient rule. (Emphasis on trigonometric 

functions). 

The Chain Rule 

Tutorial on the Chain Rule. 
❍     A LiveMath notebook illustrating the use of the chain rule. 
❍     Drill problems for differentiation using the chain rule. 
❍     Computer program that graphically illustrates the chain rule. 
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Derivatives of Functions 

❍     A list of differentiation formulas. 
❍     Drill problems for differentiation using the product rule. 
❍     Quiz on finding the derivative of functions. 
❍     Using the TI85 graphing calculator to plot approximating the graph of a derivative with the 

Newton quotient. 
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Derivatives and Graphing 

Tutorial on using the derivative to detect increasing and decreasing functions. Local maximum 
and local minimum are also defined. Emphasis on graphical analysis. 

❍     A LiveMath notebook that draws the graph of a function and its derivative. 
❍     Computer programs that draw the graph of a function and its derivative. Also, 

●     TI-86 Graphing Calculator [Using Flash] 
❍     

Computer programs that draw the graph of a function and its derivative. Also, 
●     TI-85 Graphing Calculator 

❍     Computer programs that draw the graphs of a function and its derivative to illustrate the 
First Derivative Test. 

❍     Computer programs that numerically find a critical point of a function. 
❍     Computer programs that graphically, find a critical point of a function. 
❍     Computer programs and the problems with finding graphically the critical points of a 

function. 

Tutorial on using the second derivative to detect concavity of functions. Inflection points are also 
defined. Emphasis on graphical analysis. 

❍     A LiveMath Notebook that draws the graph of a function and its second derivative. 
❍     Computer programs that draw the graph of a function and its second derivative. Also, 

●     TI-85 Graphing Calculator 
❍     Computer programs that draw the graph of a function and its second derivative. 
❍     Quiz which tests the ability to determine graphically information about a function and its 

derivatives. 
❍     Quiz which tests the ability to determine information about the graph of a function from 

information about its derivatives. 
❍     Quiz on determining which graph is the graph of a function, its derivative and its 2nd 

derivatives. 

Tangent Lines and Parametric Curves 

Tutorial on finding tangent lines to parametric curves. 
❍     A LiveMath Notebook illustrating the finding of the equation of a tangent line to a 

parametric curve. 
❍     Drill problems on finding the derivative and the equation of the tangent line to a 

parametric curve. 
❍     Using the TI-85 Graphing Calculator to find and graph the tangent line to a parametric 

curve. Also, 
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Tutorial on finding tangent lines to polar curves. 

Implicit Differentiation 

Tutorial on implicit differentiation. 
❍     Drill on finding the derivative and the equation of the tangent line at a given point. 
❍     Drill problems for finding a derivative by implicit differentiation. 
❍     A LiveMath Notebook illustrating implicit differentiation. 
❍     Computer programs that plot the graph of a relation and calculate the derivative. 
❍     Computer programs that plot the graph of a relation and tangent lines at various points. 
❍     Computer programs that plot the graphs of a family of hyperbolas and an orthogonal 

family of hyperbolas. 

Derivatives of Inverse Functions 

Tutorial on finding the derivatives of inverse functions. 
❍     Drill on finding the derivative and the tangent line to the inverse of a function. 

Logarithmic Differentiation 

❍     Drill on applying logarithmic differentiation. 

Derivatives and Inverses of Trigonometric Functions 

Tutorial on finding the derivatives of the inverse trig functions. 

Differentials 

Tutorial on differentials. 
❍     Drill on using differentials to approximate expressions. 

Maxima and Minima 

Tutorial on finding the maxima and minima of a function on a closed interval. 
❍     Drill on finding the maxima and minima of a function on a closed interval. 

L'Hospital's Rule 
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❍     Drill on applying L'Hospital's Rule. (Using finite limits) 
❍     Drill on applying L'Hospital's Rule. (Using infinite limits) 

Mean Value Theorem 

Tutorial on the Mean Value Theorem; includes Rolle's Theorem and the First Derivative Test. 
❍     Drill on applying the Mean Value Theorem. 
❍     Drill on using the First Derivative Test. 
❍     Drill on determining the intervals of concave upward and concave downward and the 

inflection points of a function. 
❍     Computer programs that can be used to illustrate the Mean Value Theorem. Also, 

●     TI-85 Graphing Calculator 

Optimization Problems 

❍     Java applets illustrating the solution to finding the maximum area of a rectangle which can 
be inscribed in a semicircle. 

❍     Java applet illustrating the solution to finding the longest ladder which can be carried 
through a hallway with a corner. 

❍     Java applet illustrating the solution to finding the shortest time to move through the desert 
to a town. 

❍     Java applet illustrating the solution to finding the shortest ladder that can lean over a fence 
against a building. 

Newton's Method 

Tutorial on Newton's Method. 
❍     Drill problems on the use of Newton's Method. 
❍     Computer programs that numerically illustrate the use of Newton's Method. 
❍     Computer programs that graphically illustrate the use of Newton's Method. 
❍     Computer programs that Graphically illustrate the use of Newton's Method and the 

problems with using Newton's Method. 
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Antiderivatives / Indefinite Integrals 

A tutorial on antiderivatives and indefinite integrals. Covers the Uniqueness Theorem, inverse 
property and applications of indefinite integrals. 

❍     Table of Elementary Indefinite Integrals 
❍     An example illustrating the evaluation of an indefinite integral using properties of 

indefinite integrals.
[using Flash] 

❍     Drill on evaluating simple integrals using the Table of Elementary Integrals.
[Using Java] [Using IBM TechExplorer] [Using IBM Pro. TechExplorer] 

❍     Drill on evaluating simple integrals with initial conditions.
[Using Java] [Using IBM TechExplorer] [Using IBM Pro. TechExplorer] 

❍     Application of indefinite integrals.
[using Flash] 

❍     Another application of indefinite integrals.
[using Flash] 

A tutorial on slope fields with an interactive JAVA applet to explore slope fields. 

❍     An interactive LiveMath notebook that graphs the slope field for a function and graphs 
antiderivatives. 

❍     A computer program that graphs the slope field for a function. 
❍     Another computer program that graphs the slope field for a function and graphs 

antiderivatives. 
❍     An animation illustrating the different solutions for indefinite integrals using slope fields. 
❍     Using a TI-86 graphing calculator to graph slope fields and the antiderivative of a function.

[using Flash] 
❍     TI-85 graphing calculator programs to graph slope fields. 

Areas 

A tutorial on how to find areas and approximation to areas by using inscribed and circumscribed 
rectangles. 

❍     An animation illustrating the approximation of the area under the sine function by 
inscribed and circumscribed rectangles. 

❍     An animation illustrating the approximation of the area under a parabola by inscribed and 
circumscribed rectangles. 

❍     A computer program that illustrates the approximation of the area of a circle using 
inscribed polygons. 

❍     An animation showing the approximation of the area of a circle using inscribed polygons. 
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❍     A computer program that graphically illustrates the Monte Carlo Method to find areas. 

Riemann Sums 

A tutorial on riemann sums from the graphical point of view followed by a tutorial from a 
symbolic or algebraic point of view. 

❍     A tutorial on summations and summation notation. 
❍     Drill in finding Riemann Sums of linear functions (using IBM TechExplorer) 
❍     An example of a sum evaluated using the TI-85 or TI-86 graphing calculator. 
❍     Another example of a sum evaluated using the TI-85 or TI-86 graphing calculator. 
❍     An interactive LiveMath Notebook to evaluate Riemann Sums. 
❍     Using a graphing calculator to evaluate Riemann Sums. 
❍     Computer software that graphically illustrates the use of Riemann sums to approximate the 

area bounded by the graph of a function and the x-axis and a couple of lines. 
❍     Computer software that graphically and numerically approximate an area. 
❍     Computer software that graphically and numerically approximate an area by evaluating 

upper and lower Riemann sums. 

Definite Integrals 

A tutorial on the definition of definite integrals, properties of definite integrals, relationship 
between definite integrals and areas and the use of technology to evaluate definite integrals using 
the definition. 

❍     A Flash movie illustrating the evaluation of a definite integral using the definition.
[using Flash] [using Java] 

❍     A Flash movie illustrating the finding the area by using the definition of a definite integral. 
❍     Using a computer algebra system and Riemann sums to evaluate definite integrals. 
❍     Computer software that can symbolically evaluate an integral using Riemann Sums. 

Fundamental Theorem of Calculus 

Tutorial on the Fundamental Theorem of Calculus. 
❍     Examples illustrating use of the Fundamental Theorem of Calculus to evaluate definite 

integrals. 
❍     Drill problems on evaluating definite integrals using the Fundamental Theorem of 

Calculus.
[Using Java] [Using IBM TechExplorer] [Using IBM Pro. TechExplorer] 

❍     A interactive Java applet to graphically illustrate the Fundamental Theorem of Calculus. 
❍     An animation illustrating the Fundamental Theorem of Calculus.

[Using animated gifs] [Using LiveMath] 
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❍     Using the graphing calculator to illustrate graphically the Fundamental Theorem of 
Calculus. 

❍     An interactive LiveMath Notebook illustrating graphically the Fundamental Theorem of 
Calculus. 

❍     A Maple animation illustrating graphically the Fundamental Theorem of Calculus. 
❍     Computer programs that graphically illustrate the Fundamental Theorem of Calculus. 
❍     Computer algebra systems and to what extent does Maple "knows" the Fundamental 

Theorem of Calculus. 
❍     An interactive LiveMath Notebook which can be used to investigate to what extent the 

program MathView "knows" the Fundamental Theorem of Calculus. 
❍     An interactive LiveMath Notebook which evaluates the derivative of a function which is 

an integral with variable limits. 

Techniques of Integration - Substitution 

Tutorial on integration using the method of substitution. 
❍     Drill problems for integration using the method of substitution. 
❍     Quiz on substitutions and elementary integrals. 
❍     Drill on evaluating certain integrals.

[Using Java] [Using IBM Techexplorer] [Using IBM Pro. Techexplorer] 
❍     Drill problems for integration using the method of trigonometric substitution. 
❍     Using Maple to illustrate the method of substitution. 

Techniques of Integration - Integration by Parts 

Tutorial on using Integration by Parts. 
❍     Some drill problems using Integration by Parts.

[Using Java] [Using IBM TechExplorer] [Using IBM Pro. TechExplorer] 
❍     Some drill problems using Integration by Parts.

[Using Java] [Using IBM TechExplorer] [Using IBM Pro. TechExplorer] 
❍     Some drill problems using Integration by Parts.

[Using Java] [Using IBM Pro. TechExplorer] 
❍     Some more drill problems using Integration by Parts. 
❍     Derivation of Integration by Parts formula (uses dynamic html). 
❍     Using Maple to illustrate the method of Integration by Parts. 

Techniques of Integration - Reduction Formulas 

Tutorial on deriving and using recursion or reduction formulas. 
❍     Drill problems for evaluating trigonometric integrals using recursion or reduction 
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formulas. 
❍     Using Maple to obtain some reduction formulas. 

Techniques of Integration - Partial Fractions 

Tutorial on the method of Partial Fractions. 
❍     Examples illustrating the the method of Partial Fractions. 
❍     Some drill problems

[Using Java] [Using IBM TechExplorer] [Using IBM Pro. TechExplorer] 
❍     Drill problems for integration using the method of Partial Fractions. 

Techniques of Integration 

❍     Using Maple to evaluate indefinite integrals. 

Numerical Integration 

Tutorial on numerical integration. 
❍     An animation illustrating graphically the Trapezoidal Rule. 
❍     Using a graphing calculator to illustrate the use of the Trapezoidal Rule. 
❍     Computer programs that graphically illustrate the use of the Trapezoidal Rule. 
❍     An animation illustrating graphically Simpson's Rule. 
❍     Using a graphing calculator to illustrate the use of the Simpson's Rule. 
❍     Computer programs that graphically illustrate the use of Simpson's Rule. 
❍     Computer programs that numerically illustrate the use of Simpson's Rule. 
❍     TI-85 graphing calculator programs for numerical integration. 
❍     An interactive LiveMath Notebook to approximate integrals using the Midpoint Rule. 
❍     Computer programs that provide a graphical illustration of the Midpoint Rule. 

Tutorial on numerical integration and error bounds. 

Improper Integrals 

Tutorial on improper integrals over unbounded intervals. 
❍     Drill problems on evaluating improper integrals over unbounded intervals. [Using 

Java][Using IBM Pro. Techexplorer] 
❍     Drill problems on evaluating improper integrals over unbounded intervals. 

Tutorial on improper integrals of functions with discontinuities. 
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Area Between Two Curves 

Tutorial on finding the area bounded by the graphs of two or more functions. 
❍     Using a TI-85 graphing calculator to find the area between two curves.

Discussion [Using Flash] [Using Java] 
❍     Drill problems on finding the area bounded by the graphs of two or more functions. 
❍     Computer programs that graphically illustrate the area between two curves. 
❍     Tutorial on finding the area bounded by a parametric curve.

[Using Flash] [Using Java] 
❍     Computer programs that graphically illustrate the area bounded by a parametric curve. 
❍     Computer programs that graphically illustrate the area bounded by a parametric curve. 
❍     Tutorial on finding the area bounded by a polar curve. 
❍     Computer programs that graphically illustrate the area between two curves in polar 

coordinates. 

Volumes 

Tutorial on the slab or washer method for finding volumes. 
❍     Animation illustrating the slab or disk method for finding volumes. 
❍     Computer programs that draw the solid of revolution of an area rotated about the x-axis. 
❍     Computer programs that graphically illustrate the slab method for finding volumes. 

Tutorial on the cylindrical shell method for finding volumes. 
❍     Computer programs that graphically illustrate the cylindrical shell method for finding 

volumes. 

Arc Length - 1 

Tutorial on arc length. 

Average Value of a Function 

Tutorial on finding the average value of a function. 

Work 

Tutorial on work. 

Moments and Center of Mass 
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Tutorial on moments and center of mass. 
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Sequences 

Tutorial on sequences. 
❍     Using computer programs to plot the graph of a sequence. Also, 

■     using the TI-85 graphing calculator to plot sequences.
Discussion [Using Flash] [Using Java] 

■     Using computer programs to generate a table of values of a sequence. 

Series 

Tutorial on introductory material on series. 
❍     Interactive Javascript module on generating a table of values for geometric series. 
❍     Interactive MathView notebook evaluating the partial sums of a geometric series. 

❍     Drill problems on geometric series, nth term test, and telescoping series. 
❍     Using computer programs to generate a table of values of partial sums. 
❍     Using computer programs to plot the graph of the sequence of partial sums. 

Tutorial on the Integral Test. 
❍     Error estimates using the Integral Test. 
❍     Drill problems on using the integral test. 

Tutorial on Comparison Test for testing convergence of series. 

Tutorial on the Limit Comparison Test. 
❍     Drill problems on using the limit comparison test. 

Tutorial on alternating series. 
❍     Drill problems on using the alternating series test. 

Tutorial on the Ratio Test. 
❍     Drill problems on using the ratio test. 

Tutorial on absolute convergence. 

Drill problems on determining which test to use for convergence of a series. 

Power Series 

Tutorial on Power Series. 
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Tutorial on differentiation and integration of power series. 

Tutorial on Taylor polynomials. 
❍     Using computer programs to plot the graphs of a function and of several of related Taylor 

Polynomials. 
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Introduction to Functions 

Tutorial which is an introduction to functions including the four representations of a function, 
domain, and range. 

❍     Drill on finding domains of functions. 
❍     Computer program to visualize a function as "a collection of arrows from the domain to 

the range." 

Piecewise Defined Functions 

Tutorial on piecewise defined functions. 
❍     A LiveMath Notebook to explore the graphing of a piecewise defined function. 
❍     Drawing the graph of a piecewise defined function with 

●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer programs that will drawing the graph of a piecewise defined function. 

Even and Odd Functions 

Tutorial on even and odd functions. 
❍     A LiveMath Notebook to visualize when a function is symmetric with respect to the y-

axis. 
❍     A LiveMath Notebook to visualize when a function is symmetric with respect to the origin. 
❍     A LiveMath Notebook to determine which function in a family of functions is odd. 
❍     A quiz on determining which functions are even, odd or neither. 
❍     Computer programs to determine graphically whether a function is even or odd or neither. 

Polynomials 

Tutorial on polynomial functions. 
❍     A LiveMath Notebook to compare a polynomial of degree n with a monomial of degree n. 
❍     A LiveMath Notebook to compare polynomials of different degrees. 
❍     Finding the roots of polynomials with 

●     TI-86 Graphing Calculator [Using Flash] 

Rational Functions 

Tutorial on rational functions. 
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Geometric Transformations of Functions 

Tutorial on the translation, compression, stretching and reflection of graphs of functions. 
❍     A Java applet to explore graphically the effect of transforming a graph with translations, 

vertical and horizontal stretching and reflections. 
❍     A quiz to explore graphically the effect of transforming a graph with translations, vertical 

and horizontal stretching and reflections. 
❍     Given a function, draw the graphs of functions obtained by shifting the graph of a given 

function using the 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer programs that will easily draw the graphs of functions obtained by shifting the 
graph of a given function. 

❍     Computer programs that will easily draw the graphs of functions obtained by shifting the 
graph of a given function. 

Algebra of Functions 

❍     A LiveMath Notebook on the graphing of the sum of two functions. 
❍     Drawing the graph of the sum of two functions with a 

■     TI-86 Graphing Calculator [Using Flash] 
■     TI-85 Graphing Calculator 

Composition of Functions 

Tutorial on the composition of functions. 
❍     A LiveMath Notebook computing the composition of functions. 
❍     A Java applet illustrating the geometrical construction of the composition of two functions 
❍     Computer programs which, given the equations of two functions, easily draws the graphs 

of the compositions of these functions. Also, 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer program which when given the graphs of two functions will draw the graphs of 
the compositions of these functions. 

❍     Drill problems on writing a function as the (nontrivial) composition of two other functions. 

Trigonometric Functions 

❍     A listing of trigonometric identities. 
❍     Computer programs that draw the graphs of trigonometric functions, sine and cosine, 
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considered as circular functions. 
❍     Computer programs that draw the graph of the tangent function considered as circular 

functions. 

Exponential Functions 

Tutorial on exponential functions. 
❍     A Javascript module to approximate a number raised to an irrational power. 
❍     A LiveMath animation of a family of exponential functions. 
❍     A LiveMath Notebook which can be used to determine which of exponential functions or 

polynomial functions grows more rapidly. 
❍     Computer programs which can be used to determine which of exponential functions or 

polynomial functions grows more rapidly. Also, 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     LiveMath animations to explore graphically and symbolically the effect of transforming 
exponential functions. 

❍     A Java applet to explore graphically symbolically the effect of transforming exponential 
functions. 

❍     A LiveMath Notebook to approximate the exponential function y = ex by the polynomials 

y = (1 + x/n)n. 

Inverses of Functions 

Tutorial on inverses of functions. 
❍     A Flash movie illustrating the use of the horizontal line test and the finding the equation of 

the inverse of a function. 
❍     Using Maple to find explicitly the inverse of a function and verify that it is the inverse. 
❍     A LiveMath Notebook to investigate which polynomials of degree 3 have inverses. 
❍     Drill on finding the inverses of functions. 
❍     Drill in finding the inverses of functions (includes inverse trigonometric functions). 
❍     Computer programs that will draw the graph of a function and its inverse. Also, 

●     TI-85 Graphing Calculator 

Logarithms 

Tutorial on logarithms. 
❍     A LiveMath animation of a family of logarithmic functions. 
❍     LiveMath animations to explore graphically and symbolically the effect of transforming 
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logarithmic functions. 
❍     A Java applet to explore graphically and symbolically the effect of transforming 

logarithmic functions. 
❍     Computer programs that draw the graphs of the exponential and logarithm functions in 

order to visualize that they are inverses of each other. 

Parameters and Functions 

Tutorial on familes of functions with parameters. 
❍     A LiveMath animation to investigate a parameterized family of functions. 
❍     A LiveMath animation of a parameterized family of exponential functions. 
❍     A LiveMath animation of a family of logarithmic functions. 
❍     Computer programs which graph a family of functions with a parameter. Also, 

●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer programs which graph a family of functions with two parameters. Also, 
●     TI-86 Graphing Calculator [Using Flash] 

Parametric Equations 

Tutorial on parametric equations. 
❍     A LiveMath notebook to explore the graphing of a system of parametric equations in the 

plane. 
❍     Animation illustrating the drawing of the cycloid. 
❍     A LiveMath animation of a family of parametric equations in the plane. 
❍     Computer programs which graph a system of parametric equations in the plane. Also 

●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer programs which graph a system of parametric equations in the plane. 
❍     Computer programs which graph a triangle using a system of parametric equations in the 

plane. 

Polar Coordinates 

Tutorial on polar coordinates. 
❍     Computer programs which graph a function in polar coordinates. Also, 

●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator [Using Flash] 

❍     Computer programs that can be used to graph a family of functions with parameters in 
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polar coordinates. 
❍     Computer programs that can be used to graph a family of functions with parameters in 

polar coordinates. 

Graphing with Technology 

Tutorial on how computer programs and graphing calculators plot the graphs of functions and 
some of the problems that this method of plotting has. 

❍     Problems in using a computer to draw the graph of a function. In this example, changing 
the number of points used in drawing the graph changes the graph significantly. 

❍     Slide show on which the page above is based. 
❍     A LiveMath notebook showing some problems in using a computer to draw the graph of a 

function. In this example, zooming in shows some features of the graph otherwise missed. 
❍     Computer programs and their problems in drawng the graph of a function with a 

discontinuity. 
❍     Computer programs and their problems in drawng the graph of the rational power of a 

variable. 
❍     Computer program that will plot the graph of a finite collection of ordered pairs. 

Solving Equations 

Tutorial on finding the intersections of the graphs of two functions. 
❍     A LiveMath notebook to graphically find the intersections of the graphs of two functions. 
❍     Computer programs to find the roots of an equation graphically by zooming in. 
❍     Find the coordinates of the points of intersections of two graphs using the 

●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Finding the roots of polynomials with 
●     TI-86 Graphing Calculator [Using Flash] 

❍     Drill in solving equations involving trigonometric functions. 
❍     Computer programs that can be used to solve an inequality graphically. 
❍     Computer programs that can be used to solve an inequality graphically. 
❍     Computer programs that can be used to solve an inequality graphically. 
❍     Computer programs that can be used to solve an inequality symbolically. 

Curve Fitting 

Tutorial on curve fitting. 
❍     A Java applet which finds and graph the least squares regression line, quadratic and cubic 

models which best approximates the data. 
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❍     Computer programs to find and graph the least squares regression line. Also, 
●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer programs to find and graph the exponential model which best approximates the 
data. Also, 

●     TI-86 Graphing Calculator [Using Flash] 
●     TI-85 Graphing Calculator 

❍     Computer programs to find and graph the third degree polynomial model which best 
approximates the data. 

Conic Sections 

❍     Computer programs that draw the graphs of various conic sections. 
❍     Computer programs that draw the graphs of various conic sections using polar coordinates. 
❍     A review of the concept of eccentricity through examining the effects of changing the 

value of the variable e in the polar equation of an ellipse. 
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●     Black-Scholes and Beyond: Options Pricing Models - This book is aimed 

at the MBA student, advanced undergraduate, and practitioner who want to 
delve into the details of option pricing models but wish to avoid a highly 
mathematical treatment. The book is replete with precise examples used to 
explain every theory in the book. Hundreds of graphs and diagrams, all 
developed in MATLAB, illustrate the subtleties of the subject. 

●     Pricing Derivative Securities; An Interactive Dynamic Environment with 
Maple V and MATLAB - Directed at an audience of MBA and advanced BBA 
students, this book teaches the core theoretical concepts of options pricing. 
The book starts by introducing the simplest model of an equity market. The no-
arbitrage condition is defined and, in a subsequent chapter, is used to value 
simplified financial assets. Gradually, the book extends the simple model to a 
more realistic situation, permitting the valuation of more complicated 
securities. MATLAB programs help readers visualize payoffs and respond to 
various constraints and conditions. 

●     Numerical Methods in Finance: A MATLAB-Based Introduction - By 
Paolo Brandimarte. ISBN 0-471-39686-9. Written for students and 
practitioners of financial engineering and economics, this book covers the 
basics of finance and numerical analysis while bridging the gap between 
financial theory and computational practice with MATLAB. Topics covered 
include classical numerical analysis methods; optimization, including 
stochastic and integer programming; simulation, including low discrepancy 
sequences; and partial differential equations. An introduction to MATLAB is 
provided an appendix. In addition, MATLAB is used to solve numerous 
examples throughout the text. 
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●     Understanding Linear Algebra Using MATLAB - Written as a supplement 

to an elementary linear algebra text, this book covers linear algebra topics, 
while focusing on MATLAB as a tool to study and implement the subject. 
Each topic covered in the book has a MATLAB introduction and a MATLAB 
exercise section. 

●     Differential Equations with Graphical and Numerical Methods - Written for 
a sophomore-level course in differential equations, this text introduces first-
order systems in the first chapter and uses them as the main focus for the 
treatment of ordinary differential equations covered in the next six chapters. 
This allows an early and unified introduction of graphical and numerical 
methods along with analytical methods. The numerical and graphical theme is 
sustained in the chapters on partial differential equations and Fourier Series. 
MATLAB M-file examples for the topics covered are given in an appendix. 

●     Introduction to Differential Equations and Dynamical Systems, 2e - This 
second-edition text is intended for use in a differential equations course for 
students of pure and applied mathematics, physical sciences, and 
engineering. The odd-numbered chapters cover the core theory of differential 
equations with basic applications, while even-numbered chapters include 
extended applications from engineering and the physical sciences. In 
addition, the text includes optional coverage of dynamical systems. Where 
appropriate, the author has integrated technology into the text, primarily in the 
exercise sets. 

●     Numerical Analysis, 7e - This seventh-edition text is written for junior-level 
mathematics, science, and engineering courses on the theory and application 
of numerical approximation techniques. Topics covered include solving linear 
systems, matrix algebra, approximation theory, eigenvalues, and differential 
equations. Examples in the text are solved using MATLAB. 

●     MATLAB 5.3 Programming and Its Application in Mathematical 
Computations - Written in Chinese, this book focuses on programming in 
MATLAB. Topics covered include MATLAB graphics, programming M-files, 
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GUI design, and interfacing MATLAB with other languages and programs. 
Exercises and examples throughout the book are solved using MATLAB 

●     Modellistica Numerica per Problemi Differenziali - Numerical Modeling for 
Problem Differentials 

●     Numerical Methods with MATLAB: Implementation and Application - This 
book is an introduction to MATLAB and numerical methods, written for 
undergraduate students of engineering, applied mathematics, and science. 
The text is a modern exposition of classic numerical methods using MATLAB. 
The fundamental theory of each method is briefly developed. Rather than 
providing a detailed numerical analysis, the behavior of the methods is 
exposed by carefully designed numerical experiments. It teaches how the 
core techniques of numerical methods are used to solve otherwise unsolvable 
problems of modern technological significance. MATLAB is used to solve 
examples throughout the book. 

●     Guide to Scientific Computing, 2e - Designed for students taking a first 
course in numerical mathematics who need a low-level entry to the subject, 
this book provides an introduction to many of the problems of scientific 
computing, and the wide variety of methods used for their solutions. The book 
gives an appreciation of the need for numerical methods for the solution of 
different types of problems, and discusses basic approaches. Practical 
justification of the methods is presented through computer examples and 
exercises. The book includes an introduction to MATLAB, including 
explanations of functions and M-files. 

●     Mathematics with MATLAB - Written in German, this book is designed for 
the mathematical education of engineering students. It demonstrates the 
applications of MATLAB in mathematical areas of importance to engineers. 
Topics covered include Fourier and Laplace transformations, optimization 
(nonlinear programming), and statistics. Example problems are solved using 
MATLAB and toolboxes. 

●     A MATLAB Companion for Multivariable Calculus - Written to accompany 
a multivariable calculus class, this book covers a range of topics from vectors 
to the divergence theorem. The examples show the use of multivariable 
calculus and MATLAB in a number of applications, including economics, 
physics, and biology. An introduction to MATLAB allows the student to get 
started with programming M-files. MATLAB and the Symbolic Toolbox are 
used to solve the many exercises and examples throughout the book. 

●     Introductory Linear Algebra With Applications, 7e - Designed for a course 
at the freshman or sophomore level, this book emphasizes the computational 
and geometrical aspects of linear algebra. This edition incorporates 
recommendations from The Linear Algebra Curriculum Study Group on how 
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to improve instruction in linear algebra. It also has new sections including 
Introduction to Wavelets, Dynamical Systems, and Introduction to Fractals. 
Exercises are divided into three groups: routine, theoretical, and those using 
MATLAB. In addition, chapter 12 provides a brief introduction to the 
capabilities of MATLAB for solving linear algebra problems. 

●     Matrix Theory and Applications with MATLAB - This book is designed for 
an advanced course on linear algebra and covers the basics of the subject - 
from a review of matrix algebra through vector spaces to matrix calculus and 
unitary similarity. It integrates MATLAB throughout the text. Each chapter 
includes a MATLAB subsection that discusses the various commands used to 
do the computations and offers codes for the graphics and algorithms used in 
the text. All material is presented from a matrix point of view. The treatment 
includes optional subsections covering applications. The final chapters move 
beyond basic matrix theory to discuss more advanced topics, such as 
decompositions, positive definite matrices, graphs, and topology. 

●     Spectral Methods in MATLAB - This text provides a hands-on introduction to 
spectral methods in MATLAB. It is built around 40 short and powerful 
MATLAB programs. Users of this book include advanced undergraduate and 
graduate students studying numerical methods for PDEs, numerical analysts, 
engineers, and computationally oriented physical scientists in all areas. The 
reader must have reasonable exposure to linear algebra, PDEs at the 
practical (not theoretical) level, and MATLAB. This book presents the key 
ideas along with many figures, examples, and short, elegant MATLAB 
programs for readers to adapt to their own needs. It covers ODE and PDE 
boundary value problems, eigenvalues and pseudospectra, linear and 
nonlinear waves, and numerical quadrature. 

●     Modern Matrix Algebra - This book provides an introduction to the basic 
algebraic, geometric, and computational tenets of linear algebra at the 
sophomore level. A spiral approach gradually introduces the abstract 
foundations of the topics involved?linear combination, closure, subspaces, 
linear independence/dependence, and bases. Numerous conceptual and 
numerical examples, as well as MATLAB examples, provide hands-on 
explorations of computations and concepts. 

●     A Primer for Finite Elements in Elastic Structures - By W. F. Carroll, ISBN 
0-471-28345-2 This book disassembles the entire finite element method for 
civil engineeringstudents and professionals, detailing its supportive theory and 
its mathematicaland structural underpinnings in the context of elastic 
structures andthe principle of virtual work. The book opens with a discussion 
of matrixalgebra and algebraic equation systems. In the early chapters one-
dimensionalelements are described, while subsequent chapters describe in 
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depth manytwo-dimensional structural finite elements, including the geometry, 
mechanics,transformations, and mapping needed for them. An appendix 
describes howto use MATLAB to perform the matrix operations required for 
the finiteelement method, such as matrix addition, multiplication, inversion, 
partitioning,rearrangements, and assembly. 

●     A First Course in Linear Algebra with Applications, 3e - By Hal G. Moore 
& Adil Yaqub. ISBN 0-12-505760-1 Written for introductory linear algebra 
courses, this text presents the theory and applications of linear algebra. 
Topics covered include linear equations, matrices, determinants, vector and 
inner-product spaces, transformations, and eigenvalues. MATLAB is used to 
solve exercises on these topics throughout the text. 

●     Accuracy and Stability of Numerical Algorithms - By Nicholas Higham, 
ISBN 0-89871-355-2 A practical source for an advanced course or as a 
reference for specialists,this book gives a thorough, up-to-date treatment of 
the behavior of numericalalgorithms in finite precision arithmetic. The text 
combines algorithmicderivations, perturbation theory, and rounding error 
analysis. Softwarepracticalities are emphasized with particular reference to 
LAPACK andMATLAB. Topics also include floating-point summation, block 
LU factorization,condition number estimation, the Sylvester equation, powers 
of matrices,finite precision behavior of stationary iterative methods, 
Vandermondesystems, and fast matrix multiplication. 

●     Advanced Engineering Mathematics With Mathematica and MATLAB: 
Volume I and II - By Reza Malek-Madani, ISBN 0-201-59881-7 (Vol I) ISBN 0-
201-32549-7 (Vol II) 

●     Advanced Engineering Mathematics with MATLAB, 2e - By Thomas L. 
Harman / James B. Dabney & Norman John Richert, ISBN 0-534-37164-7 

●     Analisi Matematica 2: Calcolo Differenziale - Written in Italian, this text 
contains elements of differential calculusfor a second course in mathematical 
analysis. General theory is presented,and details on specific methods are 
included. The book is intended toprovide students with information for 
applying mathematical analysis toanalytical mechanics. Problems and 
exercises help the reader analyze andunderstand the theory presented. 

●     Analisi Numerica Metodi Modelli Applicazioni - By Valeriano Comincioli, 
ISBN 88-386-0646-3 Offering a new approach to applied mathematics 
through numerical analysis,this book introduces science and engineering 
students to modeling andproblem solving using the methods, tools, and 
concepts of numeric computation.Modern mathematical standards of 
numerical analysis are combined withan understanding of the needs of the 
computer scientist working on practicalapplications. Where different methods 
for solving a problem are presented,comparisons of their applicability and 
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limitations are discussed. An appendixintroducing MATLAB is included. 
●     Applied Numerical Analysis Using MATLAB - By Laurene V. Fausett, ISBN 

0-13-319849-9 
●     Applied Numerical Analysis, 6e - By Curtis F. Gerald & Patrick O. 

Wheatley, ISBN 0-201-87072-X Written as a text for sophomores and juniors 
in engineering, science,mathematics, and computer science, and for the 
practicing engineer, itcan also serve as a valuable reference book. This text 
incorporates abalance of theory with techniques and applications, including 
optionaltheory-based sections in each chapter. Sections discuss the use of 
MATLAB.The breadth of topics, such as partial differential equations, 
systemsof nonlinear equations, and matrix algebra, provide comprehensive 
andflexible coverage of all aspects of numerical analysis. 

●     Applied Numerical Linear Algebra - By James W. Demmel, ISBN 0-89871-
389-7 Designed for use by graduate students in a variety of engineering 
andscientific disciplines, and for use as a research reference, this 
comprehensivetext book covers the solutions of linear systems, least squares 
problems,eigenvalue problems, and the singular value decomposition. The 
author,who helped design the widely used LAPACK and ScaLAPACK linear 
algebralibraries, draws on this experience to present state-of-the-art 
problemsolving techniques, including recommendations of which algorithms to 
usein a variety of practical situations. 

●     ATLAST Computer Exercises for Linear Algebra - By Steven J. Leon / 
Eugene Herman & Richard Faulkenberry, ISBN 0-13-270273-8 This book 
contains a valuable set of exercises and projects for teachingundergraduate 
linear algebra. They are the result of the ATLAST Project(Augmenting the 
Teaching of Linear Algebra through the use of SoftwareTools) , an NSF-
funded series of workshops to encourage and facilitatethe use of software in 
teaching linear algebra. This collection representsthe input and ideas of the 
350 contributors who participated in ATLASTworkshops from 1992 to 1995. 
This book may serve as a companion book forthe text, Linear Algebra with 
Applications, 5e. 

●     Calcolo Numerico-Esercizi - By Marco Frontini & Aldo Tagliani, ISBN 88-
251-7056-4 This workbook, written in Italian, presents problems designed to 
helpstudents prepare for exams in numeric computation. The use of MATLAB 
inthe example solutions trains the student to be more aware of the 
numericalissues and techniques and, therefore, more aware of the strengths 
andlimitations of the methods. Each problem is theoretically introduced,aimed 
at showing the connection between theory and practice. 

●     Cálculo numérico para computación en Ciencia e Ingeniería: Desarrollo 
práctico con MATLAB - By Ignacio Martin Llorente & Victor M. P García, 

http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html (5 of 17) [01/07/2002 23:09:34]

http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1626.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1531.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1330.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1347.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1397.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1570.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1570.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html


> MATLAB > Books and Tutorials > Mathematics

ISBN 84-7738-586-6 
●     Computer in Mathematical Study: Maple, MATLAB and LaTeX - By V.N. 

Govorukhin & V.G. Tsybulin. ISBN 5-272-00220-2 Written in Russian and 
intended for senior-level students and researchers, this book is designed for 
an introductory course in symbolic and numerical calculation in mathematics. 
The book aims to demonstrate the use of MATLAB and Maple in scientific 
computing. A chapter introducing MATLAB and examples solved using 
MATLAB, Simulink, the Partial Differential Equation Toolbox, and the 
Symbolic Math Toolbox are included in the text. 

●     Conformal Invariants, Inequalities, and Quasiconformal Maps - By Glen 
D. Anderson / Mavina K. Vamanamurthy & Matti K. Vuorinen, ISBN 0-471-
59486-5 This book presents a unified treatment of conformal invariants in 
geometricfunction theory with application to conformal and quasiconformal 
mappingproblems. It bridges the gap between classical theory of special 
functionsand modern topics in geometric function theory. The book contains 
manyexercises with full or partial solutions. Included is an appendix of 
computerprojects using MATLAB. 

●     Differential Equations and Boundary Value Problems: Computing and 
Modeling - By C. Henry Edwards & David E. Penney, ISBN 0-13-382094-7 
This text focuses on the mathematical modeling of real-world phenomenaas 
the goal and constant motivation for the study of differential equations.This 
book contains all of the chapters from the book Differential 
Equations:Computing and Modeling, also written by the authors (see separate 
listing), plus additional chapters covering power series methods, Fourier 
seriesmethods, and eigenvalues and boundary value problems. A number of 
computerprojects are included that illustrate the use of MATLAB. 

●     Differential Equations: Matrices and Models - By Paul Bugl, ISBN 0-02-
316540-5 This book provides a modern study of differential equations. Matrix 
algebrais presented along with many of the elementary numerical techniques 
neededfor computer implementation of its procedures. The author reviews 
modelsthat generate the differential equations and presents methods used 
tocalculate the solution. MATLAB commands that a student might use are 
listedin the first appendix. A supplemental lab manual, Explorations in 
DifferentialEquations Using MATLAB, provides the student with problems and 
projectsfor exploration and experimentation. The manual can be ordered from 
PrenticeHall using ISBN 0-13-374760-3. 

●     Differential Equations: Modeling with MATLAB - By Paul Davis, ISBN 0-13-
736539-X 

●     Dynamic Optimization - By Arthur E. Bryson, Jr., ISBN 0-201-59790-X 
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Dynamic optimization is the process of determining control and state 
historiesfor a dynamic system over a finite time period to minimize a 
performanceindex. The book starts with a review of parameter optimization 
and thentreats dynamic optimization, first with fixed final time and no 
constraints,next with terminal contraints, and finally with terminal constraints 
andopen final time. This is followed by chapters on linear-quadratic 
problemsand dynamic programming. The book concludes with chapters 
covering neighboring-optimalfeedback control, inequality constraints, and 
singular problems. An appendixis included that provides a short history of 
dynamic optimization. 

●     Elementary Linear Algebra with Applications, 3e - By Richard O. Hill, Jr., 
ISBN 0-03-010347-9 This third edition covers the basic concepts of linear 
algebra, givingstudentsboth an understanding of the theory and an 
appreciation of theapplicationsthat motivate the theory. The text contains 
numerous examplesand a varietyof exercises to help the student learn and 
understand thematerial. A briefintroduction to MATLAB is included in the 
appendix, inaddition to severalMATLAB projects. 

●     Elementary Linear Algebra, 3e - By Roland Larson & Bruce Edwards, ISBN 
0-669-39641-9 Intended for use in an introductory course in linear algebra, 
this bookbalances theory with examples, applications, and geometric 
intuition.The primary goal of this text is to present the main ideas of linear 
algebraclearly and concisely. This edition covers new topics including 
partitionedmatrices and LU decomposition, eigenvalues, least-squares and 
mathematicalmodels, as well as an appendix on mathematical induction 
which coversMATLAB. More than 2,900 exercises appear throughout the text. 
These includeMATLAB exercises found at the end of most chapters. 

●     Elementary Linear Algebra, 5e - By Stanley I. Grossman, ISBN 0-03-
097354-6 The fifth edition of this book offers approximately 2,000 problems, 
supportedby examples, with clear sequences of algebraic steps to guide 
students.The examples and applications are drawn from a variety of 
disciplinesto show students the relevance of linear algebra in their fields of 
study.More than 200 problems invite conjecture about linear algebra, and 
thereis at least one MATLAB "project problem" in each chapter that 
incorporatesall of the MATLAB and linear algebra principles up to that 
point.CompanionSoftware: A set of MATLAB M-files called the Elementary 
Linear AlgebraToolbox was developed by Cecelia Laurie to supplement the 
text. Pleasecontact the publisher for more information on obtaining these files. 

●     Elementary Linear Algebra, 7e - By Bernard Kolman & David R. Hill, ISBN 0-
13-085199-X 

●     Experiments in Computational Matrix Algebra - By David R. Hill, ISBN 0-

http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html (7 of 17) [01/07/2002 23:09:34]

http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1342.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1460.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1337.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1618.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1340.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html


> MATLAB > Books and Tutorials > Mathematics

394-35678-0 This linear algebra "laboratory" text is tightly coupled with 
MATLAB.It provides a substantial introduction to matrices, including a focuson 
matrix functions, linear systems and equations, eigenvalues, and 
applicationmodules. Throughout the text, MATLAB is used to reinforce these 
concepts. 

●     Fractals and Chaos with MATLAB - Fractals and Chaos with MATLAB 
Tsutomu Oguni 

●     Geometria Anal?tica e ?lgebra Linear - Written in Portuguese, this book 
provides an introduction to linear algebra. Topics covered include matrices; 
linear systems; norm, scalar, and vectorial products; linear transformations; 
conics; and polynomials. MATLAB is used to solve exercises at the end of 
each chapter. 

●     Handbook for Matrix Computations - By Thomas F. Coleman & Charles F. 
Van Loan, ISBN 0-89871-227-0 This introduction to MATLAB and LINPACK 
spans several levels of practicalmatrix computations and places a strong 
emphasis on examples and hands-onexercises. It is recommended for an 
introductory numerical methods courseor a graduate-level numerical analysis 
course. 

●     Industrial Mathematics: Modeling in Industry, Science, and Government - 
By Charles R. MacCluer, ISBN 0-13-949199-6 

●     An Introduction to Optimization - Designed as an introductory text to 
optimization methods and theory at the senior undergraduate and beginning 
graduate levels, this book helps students build a solid working knowledge of 
the field, including unconstrained optimization, linear programming, and 
constrained optimization. A variety of exercises, including MATLAB exercises, 
are provided at the end of each chapter. A solutions manual with complete 
solutions to the exercises, including MATLAB source listings, is available from 
the publisher to instructors who adopt this text. 

●     An Introduction to the Mathematical Theory of Waves - Written for 
undergraduate students in mathematics, engineering, and science programs, 
this book provides an introduction to basic terminology and concepts found in 
mathematical studies of wave phenomena. The book is divided into three 
parts: an introduction to one-dimensional waves and their visualization, 
traveling and standing waves, and waves arising from conservation laws. 
MATLAB functions are presented to animate solutions of examples in the 
book. 

●     Ingenieurmathematik mit Computeralgebra-Systemen - By Hans Benker, 
ISBN 3-528-05673-8 

●     Interior-Point Polynomial Algorithms in Convex Programming - By Yurii 
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Nesterov & Arkadi Nemirovskii, ISBN 0-89871-319-6 Written for users 
interested in optimization, this text presents the generaltheory of interior-point 
polynomial-time methods for convex programming.The authors try to 
demonstrate that all known polynomial-time interior-pointmethods can be 
explained on a general theory basis, and hence extendedinto a wide variety of 
nonlinear convex problems. This is shown by developingnew polynomial time 
interior-point methods for many important classesof problems. The theory 
presented in the text, including applicationsin control system design, are 
implemented in the LMI Control Toolbox developedby Pascal Gahinet, Arkadi 
Nemirovskii, Alan J. Laub, and Mahmoud Chilali.The toolbox may be 
purchased from The MathWorks. 

●     Introduction to Linear Algebra, 2e - By Gilbert Strang, ISBN 0-9614088-5-5 
This is a basic textbook for linear algebra, combining the theory withthe 
applications. Chapters include: Introduction to Vectors, Solving 
LinearEquations, Vector Spaces and Subspaces, Orthogonality, 
Determinants, Eigenvaluesand Eigenvectors, Linear Transformations, 
Applications, Numerical LinearAlgebra, and Complex Vectors and Matrices. In 
addition, a list of MATLABteaching codes are included at the end of the book. 

●     Introduction to Linear Algebra, 4e - By Lee W. Johnson / R. Dean Riess & 
Jimmy T. Arnold, ISBN 0-201-82416-7 The principal topics of this book on 
elementary linear algebra are matrixtheory and systems of linear equations, 
elementary vector-space concepts,and the eigenvalue problem. Intended for 
a freshman/sophomore level course,the text stresses both practical 
computation and theoretical principles.Acollection of MATLAB projects is 
included at the end of each chapter. 

●     Introduction to Partial Differential Equations with MATLAB - By Jeffery M. 
Cooper, ISBN 0-8176-3967-5 This advanced text/reference is an introduction 
to partial differentialequations that covers the traditional topics within a 
modern context.Techniques of numerical computation have been included 
along with carefullyselected nonlinear topics, such as nonlinear first-order 
equations. MATLABM-files are integrated in the exercise sets throughout the 
text. 

●     Introduction to Scientific Computing, 2e: A Matrix-Vector Approach 
Using MATLAB - By Charles F. Van Loan, ISBN 0-13-949157-0 

●     Inverse Problems: Activities for Undergraduates - By Charles W. 
Groetsch, ISBN 0-88385-716-2 

●     Iterative Methods for Linear and Nonlinear Equations - By C.T. Kelley, 
ISBN 0-89871-352-8 This book can be used as a tutorial, as a textbook for 
introductory coursesin nonlinear equations or iterative methods, or as source 
material foran introductory course in numerical analysis at the graduate level. 

 

http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html (9 of 17) [01/07/2002 23:09:34]

http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1517.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1343.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1509.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1606.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1606.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1623.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.mathworks.com/support/books/book1344.jsp?category=6&language=-1&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/Mathematics/index.html


> MATLAB > Books and Tutorials > Mathematics

Theauthor provides a complete analysis of the conjugate gradient and 
generalizedminimum residual iterations. In addition, recent advances include 
Newton-Krylovmethods, incorporation of inexactness and noise into the 
analysis, andnew proofs and implementations of Broyden's method. The 
computationalexamples and exercises are based on the MATLAB 
environment. 

●     Iterative Methods for Optimization - By C.T. Kelley, ISBN 0-89871-433-8 
●     Lectures on Finite Precision Computations - By Francoise Chaitin-Chatelin 

& Valerie Fraysse, ISBN 0-89871-358-7 For the advanced undergraduate and 
beginning graduate, this book combinestechniques from engineering and 
mathematics to describe the theory ofcomputability in finite precision. In the 
challenging cases of nonlinearproblems, theoretical analysis is supplemented 
by the use of MATLABCompanionSoftware: The authors have developed the 
PRECISE Toolbox, which consistsof MATLAB M-files to perform experimental 
mathematics. This toolbox isavailable via anonymous FTP at ftp.cerfacs.fr in 
/pub/algo/software/Qualcomp/PRECISE/. 

●     Linear Algebra - By Terry Lawson, ISBN 0-471-30897-8 This text blends 
theoretical and computational aspects of linear algebra,using each to 
enhance the other. The author introduces basic conceptsearly, reinforces 
them with exercises and extended applications, and emphasizesthe use of 
software to master basic algorithms and to perform computationsefficiently. A 
lab manual, MATLAB Labs for Linear Algebra (ISBN 0-471-14953-5), takes 
full advantage of MATLAB to support the conceptual developmentwithin the 
text. Sufficient material is provided for a variety of approachesto linear 
algebra. 

●     Linear Algebra and Differential Equations Using MATLAB - By Martin 
Golubitsky & Michael Dellnitz, ISBN 0-534-35425-4 The authors integrate 
linear algebra, ordinary differential equations,and the computer to help 
students understand these mathematical concepts,interweaving instructions 
on how to use MATLAB with examples and theory.The book begins by solving 
linear systems of equations and introducingmatrix algebra. Then it introduces 
simple ordinary differential equations.The text stresses the use of qualitative 
methods in solving nonlinearordinary differential equations. A chapter on 
bifurcation theory is included,as is an introduction to quasiperiodic and chaotic 
solutions. 

●     Linear Algebra and Its Applications, 2e Update - By David C. Lay, ISBN 0-
201-34774-1 Study Guide (ISBN 0-201-64847-4) that supplements this text 
and providesa brief introduction to MATLAB, a discussion of MATLAB 
commands as neededfor the exercises, and a complete index of MATLAB 
commands used in thetext. 
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●     Linear Algebra LABS with MATLAB, 2e - By David R. Hill & David E. 
Zitarelli, ISBN 0-13-505439-7 Intended for a sophomore level course in linear 
algebra, this supplementreinforces key concepts using a variety of class-
tested exercises andthe "discovery" method. Added to this second edition are 
approaches totopics that use more graphically oriented M-files to provide 
visualizationof concepts. In addition, many of the M-files have been enhanced 
to takeadvantage of the GUI tools available in MATLAB. Some files use the 
SymbolicMath Toolbox (available from The MathWorks) . 

●     Linear Algebra with Applications - By George Nakos & David Joyner, ISBN 
0-534-95526-6 

●     Linear Algebra with Applications, 4e - By Gareth Williams. Written for an 
introductory linear algebra course, this text balances the coverage of standard 
linear algebra topics with practical applications and computational techniques. 
Topics covered include linear equations, matrices, eigenvalues, vector 
spaces, linear transformations, Gauss-Jordan elimination, and numerical 
techniques. An introduction to MATLAB is provided in an appendix. 

●     Linear Algebra with Applications, 6e - By Steven J. Leon, ISBN 0-13-
849308-1 Written for first-year undergraduate courses in linear algebra, this 
text balances mathematical theory and applications, while stressing the 
important role that geometry and visualization play in understanding the 
subject. End-of-chapter tests, more applications, and revised examples are 
new to this sixth edition text. Topics covered include matrices, determinants, 
linear transformations, orthogonality, eigenvalues, and numerical linear 
algebra. A MATLAB tutorial is provided in an appendix. 

●     Linear Algebra with Applications, 6e - By Steven J. Leon. ISBN 0-13-
033781-1. Written for first-year undergraduate courses in linear algebra, this 
text balances mathematical theory and applications, while stressing the 
important role that geometry and visualization play in understanding the 
subject. End-of-chapter tests, more applications, and revised examples are 
new to this sixth edition text. Topics covered include matrices, determinants, 
linear transformations, orthogonality, eigenvalues, and numerical linear 
algebra. A MATLAB tutorial is provided in an appendix. 

●     Linear Algebra, 3e - By John B. Fraleigh & Raymond A. Beauregard, ISBN 0-
201-52675-1 Designed for use in a first undergraduate course in linear 
algebra, thistext introduces fundamental notions of linear algebra in the 
context ofRn. The book then covers vector geometry, application of matrix 
algebrato binary linear codes, linear transformations, eigenvalues, and 
eigenvectors.Throughout the text are exercises using The Student Edition of 
MATLAB.These exercises give an elementary tutorial on MATLAB. 

●     Linear Computation Software with MATLAB - By Tsutomu Oguni & Jack 
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Dongarra, ISBN 4-621-04442-7 
●     Mathematical Explorations with MATLAB - By Ke Chen / Alan Irving & 

Peter Giblin, ISBN 0-521-63920-4 
●     Mathematics for Business, Science and Technology - By Steven T. Karris. 

ISBN 0-9709511-0-8. Written for high school graduates preparing to take 
business or science courses at a community college or university or young 
students enrolled in continuing education courses, this book presents 
fundamental mathematics concepts solved using MATLAB and Excel. Topics 
covered include algebra, geometry, probability and statistics, random 
variables, curve fitting, and Markov chains. An introduction to MATLAB is 
included in an appendix. In addition, each chapter includes examples solved 
with MATLAB. 

●     Mathematik am Computer - Written in German, this book reflects the trend 
to use computers in mathematics, engineering, physics, and computer 
science education. This book includes a section on MATLAB that covers 
topics including matrix arithmetic, matrix operations, polynomials, graphics, 
and programming. 

●     Mathematik mit MATLAB: Aufgaben und Losungen - By Franz Bachmann 
/ Hans Rudolf Schärer & Louis-Sepp Willimann, ISBN 3-7281-2308-0 This 
book, written in German, provides a compact introduction to 
MATLAB,including matrix operations, graphical representations, M-files, and 
flowcontrol. The second part of the book contains a comprehensive set of 
exercisesdealing with mathematic fundamentals, graphics, linear algebra and 
geometry.All of the exercises in the last part of the book are solved using 
MATLAB.Companion software: The authors have developed a set of MATLAB 
M-filesthat are available on a CD-ROM bound into the book or may be 
retrievedfrom vdf.ethz.ch. 

●     MATLAB Esercitazioni di Calcolo Numerico Assistite da Calcolatore - By 
Franca Caliò & Marco Frontini, ISBN 88-251-0002-7 The authors of this text 
have combined their teaching experiences withnumeric computation tools to 
present students with methods to rapidlydefine solutions, collect relevant 
information, and verify results forthe various problems presented. A student 
who approaches problems in thisway is able to work through the definition 
and implementation of the algorithms,learning the complete numerical 
process. 

●     Matrices and MATLAB: A Tutorial - By Marvin Marcus, ISBN 0-13-562901-2 
This textbook is included in Prentice Hall's MATLAB Curriculum 
Series.Designed for a one-semester or two-quarter course in elementary 
matrixtheory, the text is suitable for undergraduate or graduate students 
whohave completed one year of calculus and are adept at high school 
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algebra.MATLAB is completely integrated into the study of elementary matrix 
theorypresented in this book. 

●     Matrix Computations, 2e - By Gene H. Golub & Charles F. Van Loan, ISBN 
0-8018-3739-1 This edition has been expanded to provide the necessary 
mathematical andalgorithmic skills to produce numerical software. There are 
many new additionsto the book, including chapters on high-performance 
computing using matrixmultiplication. These chapters show how to organize a 
calculation forvector processors and for computers with shared or distributed 
memories.Discussions of parallel vector methods for linear equations, least 
squares,and eigenvalues are also new additions to the text. 

●     Matrix Theory with Applications - By Jack L. Goldberg, ISBN 0-07-557200-
1 This text presents theory and provides examples for the study of 
matrices.Problem sets, argumentative problems, and problems using 
MATLAB are includedto support the theory presented. Most of the sections 
contain subsectionsdevoted to the use of MATLAB as the computational tool 
to illustrate thetheory covered in the text. 

●     Metodi Numerici e Statistici per le Scienze Applicate - This book covers 
topics in numeric computation and statistical analysis. The main numerical 
algorithms for solutions of linear systems, function approximation, 
optimization, integral calculus, and resolution differential equations are 
introduced. Basic concepts of probability theory and statistics are explained. 
Special attention is given to classical techniques such as Markov chains, 
cluster analysis, Monte Carlo simulation, and signal filtering. Many of the 
algorithms were developed and tested using MATLAB; the book contains 
source listings for each. 

●     Numerical Analysis, 2e - By David Kincaid & Ward Cheney, ISBN 0-534-
33892-5 This book introduces students with diverse backgrounds to the 
varioustypes of mathematical analysis that are commonly needed in 
scientificcomputing. The subject of numerical analysis is treated from a 
mathematicalpoint of view, offering a complete analysis of methods for 
scientificcomputing with careful proofs and scientific background. Included 
withthe standard topics typically covered in numerical analysis are topicssuch 
as the Chebyshev theory of best approximation, homotopy methods forsolving 
nonlinear equations, adaptive approximation, adaptive quadrature,Sard's 
theory for best approximation of functionals, delay differentialequations, and 
the multigrid method. 

●     Numerical Analysis using MATLAB and Spreadsheets - By Steven T. 
Karris. ISBN 0-9709511-1-6. This book presents the fundamentals of 
numerical analysis while teaching the reader to use MATLAB. Topics covered 
include root approximations, sinusoids, matrices, differential equations, linear 
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and parabolic regression, gamma and beta functions, and optimization 
methods. An introductory chapter on MATLAB is included. Numerous 
examples using MATLAB and the Symbolic Math Toolbox are presented 
throughout the book. 

●     Ripples in Mathematics: The Discrete Wavelet Transform - By A. Jensen 
& A. la Cour-Harbo. ISBN 3-540-41662-5. Written for undergraduate 
mathematics and engineering students and practicing engineers, this book 
presents the theory and application of the discrete wavelet transform. The 
book is based on an approach to discrete wavelets called lifting. The 
connections between lifting and filter theory are presented, and the wavelet 
packet transforms are defined. MATLAB is used to solve example problems 
and develop implementations of transforms throughout the book. The Signal 
Processing Toolbox is also used to solve examples. 

●     Numerical Linear Algebra - By Lloyd N. Trefethen & David Bau, III, ISBN 0-
89871-361-7 Designed for use in a graduate-level course in numerical linear 
algebra,this book is divided into forty lectures. Each lecture is built aroundone 
or two central topics, emphasizing the unity between ideas. One 
unusualaspect of this book is that it begins with QR factorization rather 
thanGaussian elimination, to provide a more solid and easier-to-
understandfoundation for the subsequent lectures. The last part of the book is 
devotedto iterative methods. 

●     Numerical Linear Algebra and Applications - By Biswa Nath Datta, ISBN 0-
534-17466-3 This book is written for a first course in numerical linear algebra. 
Itis designed to give students a firm grasp of the basic concepts of 
roundofferror, stability, condition, and accuracy, as well as an appreciationfor 
the core numerical linear algebra algorithms. At the beginning ofeach chapter, 
the author presents illustrative case studies from variousapplication areas in 
science and engineering to encourage students tostudy numerical linear 
algebra. An appendix of MATLAB M-files is includedas a basis for students to 
build on and develop more advanced algorithms.CompanionSoftware: The 
author has developed a set of MATLAB M-files called theMATCOM Program, 
which may be retrieved from The MathWorks anonymous FTPserver at 
ftp.mathworks.com in /pub/books/datta/. (Download the entiredirectory as a 
tar archive or a zip archive.) 

●     Numerical Methods for Engineers: With Programming and Software 
Applications, 4e - By Steven C. Chapra & Raymond P. Canale, ISBN 0-07-
243193-8 Written for undergraduate students of engineering, applied 
mathematics, and science, this book introduces the theory and applications of 
numerical methods. Topics covered include roots of equations, linear 
algebraic equations, optimization, curve fitting, and differential equations. 
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Problems from a vast range of engineering disciplines are covered, including 
areas such as biotechnology and biomedical. A tutorial to MATLAB is 
provided in an appendix. MATLAB is also used to solve many equations 
throughout the text. 

●     Numerical Methods Using MATLAB, 2e - By George Lindfield & John 
Penny, ISBN 0-13-012641-1 

●     Numerical Methods Using MATLAB, 3e - By John H. Mathews & Kurtis D. 
Fink, ISBN 0-13-270042-5 

●     Numerical Methods With MATLAB: A Resource for Scientists and 
Engineers - By G. J. Borse, ISBN 0-534-93822-1 This book is intended as a 
resource or "compendium of methods" suitablefor supplemental use in 
numerical methods and engineering problem-solvingcourses. This book 
details the main topics of numerical methods, suchas linear analysis, analysis 
of functions of one or several variables,data analysis and modeling, and the 
solution of ordinary and partial differentialequations. The author emphasizes 
the underlying operation, and the strengthsand weaknesses, of each 
technique. MATLAB is used throughout the bookto solve numerical problems. 
A MATLAB programming appendix presents MATLABtopics in the same 
sequence as the numerical methods of the text.CompanionSoftware: A disk 
containing MATLAB M-files and an interactive tutorialis bound in the book. 

●     Ordinary Differential Equations Using MATLAB, 2e - By John C. Polking & 
David Arnold, ISBN 0-13-011381-6 

●     Numerische Mathematik mit MATLAB: Eine Einf?hrung f?r 
Naturwissenschaftler und Ingenieure - Written in German, this book is 
intended for university students and industry engineers who want to become 
familiar with MATLAB in a quick, precise manner. The book begins with an 
introduction to MATLAB and demonstrates how to solve and visualize 
numerical algorithms and mathematical problems. Other topics include: 
MATLAB programming, interpolation of polynomials and splines, and solving 
systems of nonlinear equations. 

●     Practical Mathematics Using MATLAB 5 - By Gunnar Backstrom, ISBN 91-
44-00544-X The purpose of this text is to illustrate and explain the elements 
ofundergraduate mathematics required for science and engineering 
education,calculus, data analysis, and differential equations. At the same 
time,the text introduces and reviews the use of MATLAB in these areas. A 
chapteron the Symbolic Math Toolboxreviews its use for solving problems in 
symbolicalgebra, calculus, andordinary differential equations. (This book is 
alsoavailable in Swedish.) 

●     Praktisk matematik med MATLAB 5 - By Gunnar Backstrom, ISBN 91-44-
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00224-6 The purpose of this text is to illustrate and explain the elements 
ofundergraduate mathematics required for science and enginering 
education,calculus, data analysis, and differential equations. At the same 
time,the text introduces and reviews the use of MATLAB in these areas. A 
chapteron the Symbolic Math Toolboxreviews its use for solving problems in 
symbolicalgebra, calculus, andordinary differential equations. (This book is 
alsoavailable in English.) 

●     Probabilites et Statistiques avec MATLAB et Maple - Written in French, 
this book is intended for graduate mathematics students. The book begins 
with an introduction to the mathematical and programming capabilities of 
MATLAB, such as matrices, polynomials, and complex operations. It then 
covers topics in probability and statistics, including Monte-Carlo methods, 
Markov chains, Kolmogorov methods, confidence intervals, chi-square 
distribution, and Gaussian distribution. 

●     Templates for the Solution of Linear Systems: Building Blocks for 
Iterative Methods - By Richard Barrett / Michael Berry / Tony F. Chan / 
James W. Demmel / June Donato / Jack Dongarra / Victor Eijkhout / Roldan 
Pozo / Charles Romine & Henk van der Vorst, ISBN 0-89871-328-5 This book 
is written for computational scientists who would like to incorporatestate-of-the-
art computational methods for solving large sparse systemsof linear 
equations. Discussions of convergence and stopping criteria,tuning, and 
selection of method are included. Royalties from purchasedcopies will be 
added to a fund for students attending SIAM meetings. Thisbook is also 
located on NETLIB at netlib2.es.utk.edu in linalg/templates/.(This book is also 
available in Japanese.) 

●     The MATLAB 5 Mathematical System - The MATLAB 5 Mathematical 
System V.P. Dyakonov & I.V. Abramenkova 

●     Templates for the Solution of Linear Systems: Building Blocks for 
Iterative Methods - By Richard Barrett / Michael Berry / Tony F. Chan / 
James W. Demmel / June Donato / Jack Dongarra / Victor Eijkhout / Roldan 
Pozo / Charles Romine & Henk van der Vorst, ISBN 4-254-11401-X Written in 
Japanese, this book is for computational scientists who wouldlike to 
incorporate state-of-the-art computational methods for solvinglarge sparse 
systems of linear equations. Discussions of convergence andstopping criteria, 
tuning, and selection of method are included. (Thisbook also available in 
English.) 

●     Using MATLAB in Calculus - This book is to be used as a supplement to a 
calculus text in the standard calculus II and III courses. Its philosophy is to 
show how MATLAB can be used as a tool to do the calculus being studied. 
The goal of the book is to teach the student enough about MATLAB that he or 
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she can use it effectively upon completion of the calculus sequence. 
MATLAB's Symbolic Math Toolbox is introduced in a few appropriate places, 
such as in the context of using a computer algebra system to find 
antiderivatives. The MATLAB instruction contained in this book is given 
primarily by example, with MATLAB commands described in the context of 
the application. 

●     The MATLAB Project Book for Linear Algebra - By Rick L. Smith, ISBN 0-
13-521337-1 This book contains 34 linear algebra projects that are intended 
to becompleted by students on a computer using MATLAB. Also included is a 
MATLABtutorial. The book includes the major theorems and definitions of 
linear. 
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●     Yechiel's Preferred C and C++ Sources - Yechiel's Preferred C and C++ 

Books and Internet Sites 
●     Free programming books - Free programming books covering C++, Java etc. 
●     Component Connection - This chapter discusses several of the issues that 

arise when you move from C++ to Java. Since many (if not most) Java 
programmers come from a C++ background, it is natural to want to carry over 
the skills, techniques, and code acquired in this language. Although C++ and 
Java were designed to address the programming needs of two very different 
environments, many of the same coding techniques, algorithms, and 
optimizations apply to both. However, as explained in Part One, Java is not 
"the Internet version of C++." While there are many similarities between the 
two languages, there are also several differences. This chapter reviews those 
differences and shows ways to handle some of the more challenging ones. 

●     C++ Streams - Internals and Applications - Although the syntax of the C++ 
language is based on C, many of the features and concepts of the language 
are quite different. In some cases, entirely new concepts have been 
introduced. The idea of data streams is one of these new concepts. A C++ 
stream is an abstract representation of data flow from one location to another. 
The origin of the data is usually called a producer or source, and the 
destination is usually referred to as a consumer or sink. Streams can be 
designed to handle the transfer of data in any format, from simple 
fundamental types like int, char, char *, long, and double, to complex objects 
containing many classes and derivations. C++ streams are most often 
constructed from the combination of two base classes. In the current 
implementation of C++, these base classes are streambuf and ios. Under this 
design, the streambuf class object provides for the buffering and orderly 
passing of information from the producer to the consumer. The ios class 
object is then respo 

●     LEARN C/C++ TODAY - This is a list of a few C and C++ language tutorials 
available to users. The list includes interactive tutorials, public-domain code 
collections, books etc. 
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●     NML Code Generator Instructions - Instructions for using the NML Code 
Generator to create C++ or Java NML definitions. 

●     Guide to C++ Classes - Runtime errors will inevitably occur in any complex 
software system. Independent of what may be done to recover from the error, 
it is important that information about the nature of the error be recorded to 
allow a human operator to later ascertain whether the software or the 
operating environment needs to be modified. A mechanism for recording of 
textual information pertaining to an error is provided by the OTC_Logger 
class. Error messages can be logged at a number of priorities, with messages 
being displayed to the standard error output. If required, error messages can 
also be saved to a file. By deriving from the OTC_Logger class you can 
capture the error messages and optionally save or cause them to be 
displayed using an alternate mechanism. For example, you may wish to have 
messages passed on to the UNIX syslog facility. 

●     Short C++ tutorial for C users - From Belgium, Eric Brasseur walks the reader 
through the first hours of a C programmer's fresh acquaintance with C++, 
introducing features like references, operators overloading, new and delete 
("they are much more sweet than ... malloc and free") up to multiple 
inheritance. 

●     Porting C++ to Java - This paper is addressed to people who are considering 
porting their existing C++ code to Java. It provides a step-by-step approach to 
porting C++ to Java effectively. 

●     C++ Primer  - Prices, description, reviews and more, about the book "C++ 
Primer" by Lippman/Lajoie. This book explains how to program in C++. It 
covers the latest ANSI/ISO standard and explains how to use C++ templates. 

●     Industrial Strength Programming - Here is a book that teaches not only 
language but also programming itself. The author of this book shares his 
experience in programming, teaches how to write reliable and maintainable 
code, easy to understand by other members of the team; knowing advanced 
programming techniques such as synchronization in a multithreaded 
environment, effective use of virtual memory, debugging techniques, etc. 

●     TTT - The TTT System is a suite of files and programs aimed at providing you 
(the learner) with an interactive, World Wide Web based online course in the 
fundamentals of programming using the C++ programming language. 

●     The C++ Standard Library - A Tutorial and Reference - See and download all 
of the examples from the book "The C++ Standard Library - A Tutorial and 
Reference" by Nicolai M. Josuttis. 

●     Introduction to Object-Oriented Programming Using C++ - This tutorial is a 
collection of lectures to be held in the on-line course 'Introduction to Object-
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Oriented Programming Using C++'. In this course, object-orientation is 
introduced as a new programming concept which should help you in 
developing high quality software. Object-orientation is also introduced as a 
concept which makes developing of projects easier. 

●     From The Ground Up: A Guide to C++ - From The Ground Up: A Guide to 
C++. This site is a tutorial for learning the programming language C++. The 
site makes extensive use of Java. It also has clever scheme of remembering 
where you were if you return to the tutorial many times. The tutorial is geared 
towards Pascal programmers converting to C++, and only covers C++ basics 
(classes and operator overloading are the most advanced topics). 

●     Fatbrain - Fatbrain.com is the Internet's most comprehensive bookstore for 
professionals. Recently named the number two fastest-growing public 
company in Silicon Valley, Fatbrain.com offers a world-class selection of 
books, training materials and print-on-demand documentation for business, 
finance, math, science and technology experts. Our industry experience and 
in-depth knowledge of authors, topics and trends help customers find the best 
resources for their needs. Fatbrain.com contains a comprehensive section on 
C. 

●     C - Tutorials - This is the tutorial section of 'cprogramming.com'. It contains: 
PROGRAMMING IN C/C++ tutorial; GRAPHICS PROGRAMMING tutorial. 

●     C++ Programming for Scientists - C++ tutorial for scientists. Course notes : 
ANSI C, C++ as a better C, C++ classes and objects, objects in scientific 
computing, inheritance & polymorphism, templates, exceptions & 
observations, programming examples, scientific library examples. 

●     Books reviews with grades - This page is a collection of reviews on C++ 
books for advanced users. 

●     An Introduction to C++ - This is the first installment in a series called 
"Objective Viewpoint" that will teach you about C++. 

●     Gillius's C++ Programming - C/C++ focused page with tutorials ranging from 
language syntax to game development. Has FREE C/C++/Pascal source 
code and free games with source code. 

●     A TOUR OF C PROGRAMMING - This tutorial gives a complete 
understanding of the basics of C programming. The goal of this "guide to C" is 
to cover the basics of the language pretty thoroughly. After that will be 
introduced some more advanced things. 

 

 

http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html (3 of 4) [01/07/2002 23:09:59]

http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://library.advanced.org/3074/&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www1.fatbrain.com/catalogs/computing/subjects.asp?VM=C&SubjectCode=PGC&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.cprogramming.com/tutorial.html&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://math.nist.gov/pozo/c%2b%2bclass/&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.accu.org/bookreviews/public/reviews/0sb/advanced_c__.htm&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.acm.org/crossroads/xrds1-1/ovp.html&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.rit.edu/~jpw9607/&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html
http://www.mathtools.net/cgi-bin/redirect.pl?redirect=http://www.kutztown.edu/~mant2494/Cindex.htm&location=http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html


> MATLAB > Books and Tutorials > C and C++

New additions | Add Link | Feedback | Privacy | Trademarks | Powered by The MathWorks

Copyright © 2002 MathWorks, Inc. All rights reserved. 

http://www.mathtools.net/MATLAB/Books_and_Tutorials/C_and_C++/index.html (4 of 4) [01/07/2002 23:09:59]

http://www.mathtools.net/newlinks.html
http://www.mathtools.net/addlink.html
mailto:feedback@mathtools.net
http://www.mathtools.net/privacy.txt
http://www.mathtools.net/trademrk.txt


> MATLAB > Calculus > C and C++

 
Mathtools.net > MATLAB > Calculus > C and C++ Add Link ... Email page to friend 

 
●     MODEL - MODEL is a numeric simulation library written to simulate systems 

of rate equations describing Vertical Cavity Surface Emitting Lasers 
(VCSELs). Try it if you need an easy way to solve some systems of ordinary 
differential equations. 

●     The Godess project - This is a Generic Ordinary Differential Equation Solver 
System written in C++. The solver is an initial value solver for ODEs and 
DAEs, with rootfinding etc. The goal of the project is to improve the state-of-
the-art for timestepping methods when solving initial value problems. I was 
responsible for the code during my Ph.D. studies and successfully worked on 
Runge-Kutta methods (mostly implicit ones). 

●     Only C++ - This is the C++ page of the Numeric Physic WWW site, where you 
can find the source code of many programs that deal with differential 
equations. 

●     KASKADE - A C++ toolbox for the solution of linear scalar elliptic and 
parabolic problems in 1, 2, and 3 dimensions using adaptive finite element 
methods. The toolbox includes extensions for handling systems of equations 
as well as example algorithms for nonlinear methods used in obstacle, porous 
media, or Stefan problems. The core of the program consists of a variety of 
multilevel/multigrid preconditioners for the linear systems involved. The 
iterative solvers included in the package include: conjugate gradient (with and 
without 3-term recurrence), conjugate residual (with and without 3-term 
recurrence), several relaxation routines (Jacobi, SSOR, etc.), GMRES, bi-
conjugate gradients, BiCGStab, the Sonneveld CGS algorithm, conjugate 
gradients for normal equations, and a nonlinear relaxation routine. 
Preconditioner methods include: Jacobi type, symmetric Gauss-Seidel, 
incomplete LU-factorization, multilevel with Jacobi-type smoothing, multilevel 
with symmetric Gauss-Seidel smoothing, additiv+. It can be compiled with g++ 
2.6.3 or later. The package is documented in extensive programmer's and 
user's guides in PostScript format. 

●     Diffpack - A collection of C++ object-oriented class libraries designed for the 
numerical solution of partial differential equations. The package also includes 
several UNIX utilities for general software management and numerical 
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programming. The goal of Diffpack is to provide an environment for the rapid 
prototyping of simulators based on PDEs which also offers a high level of 
efficiency. 

●     A++/P++ - A++ is a C++ array class for numerical computation designed to 
work with structured grid computations, including work on overlapping grids 
and adaptive mesh refinement. P++ is the parallel version of the serial class 
A++. A++/P++ was designed to simplify the development of numerical 
software, specifically to allow an application developed in the serial 
environment to be run on parallel machines with little or no additional effort. It 
is also intended as a partial solution to a growing crisis in the development of 
large numerical codes that are required to run on many different serial and 
complex parallel architectures. The A++/P++ distribution (35 Mb 
uncompressed) includes the source code and the documentation. 
Requirements for compilation and installation include a C++ compiler ( g++ 
will do) and a C and/or a Fortran compiler. The graphics visualization facilities 
of A++/P++ additionally require the Plotmtv software. The use of P++ requires 
a communication library. It presently w 

●     Clenshaw-Curtis-Quadrature - A presentation of the Numerical Automatic 
Integrator method, which is called "Chebyshev Series Expansion" in one 
dimension. The package includes source code. 

●     Automatic Differentiation - We want to calculate a value f(t1,...,tn) that 
depends on parameters t1,...,tn. But, in addition, we want to calculate the first 
and possibly second derivatives of f(t1,...,tn) with respect to t1,...,tn. For 
example, we want to find the maximum or minimum of f(t1,...,tn) and want to 
use an optimization method involving derivatives. The aim of the automatic 
differentiation package is to allow us to calculate the derivatives using a 
program that is just a minor modification of the program that calculates f. This 
greatly reduces the work involved and greatly increases the chances of 
getting the correct answer. 

●     ADOL-C (Automatic Differentiation of CC++) - The package ADOL-C 
facilitates the evaluation of first and higher derivatives of vector functions that 
are defined by computer programs written in C or C++. The resulting 
derivative evaluation routines may be called from C/C++, Fortran, or any other 
language that can be linked with C. The numerical values of derivative vectors 
are obtained free of truncation errors at a small multiple of the run time and 
randomly accessed memory of the given function evaluation program. 

●     DE-Quadrature - Numerical Automatic Integrator for Improper Integral. 
Method: Double Exponential (DE), Transformation dimension: one. 

●     Diffpack - Diffpack is a comprehensive development framework for multi-
physics simulation. It is available on a wide range of hardware platforms. 
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●     PVODE - PVODE is a portable solver for ordinary differential equation 
systems. It is based on robust mathematical algorithms, and targeted at large 
systems on parallel machines. A closely related solver called KINSOL has 
been developed for systems of nonlinear algebraic equations, and another is 
in progress for systems of differential-algebraic equations. 
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Getting Started With MATLAB
Revised by Clinton Wolfe (June 1999)

Original by David Hart

Introduction

What is Matlab?
MATLAB is a computer program for people doing numerical computation, especially linear algebra (matrices). It
began as a "MATrix LABoratory" program, intended to provide interactive access to the libraries Linpack and
Eispack. It has since grown well beyond these libraries, to become a powerful tool for visualization, programming,
research, engineering, and communication.

Matlab's strengths include cutting-edge algorithms, enormous data handling abilities, and powerful programming
tools. Matlab is not designed for symbolic computation, but it makes up for this weakness by allowing the user to
directly link to Maple. The interface is mostly text-based, which may be disconcerting for some users.

Matlab is packaged as a core program with several "toolboxes", sold seperately. We will only cover the core
package. The current (June 1999) version is Matlab 5.3 release 11.

How to use this document
This document is intended to be used while sitting at a computer running either NT or the X windows system. It is
assumed that you will enter the commands shown, and then think about the result.

The reader of this document should have at least a passing familiarity with linear algebra and be comfortable using
computers. In order to be more broadly understood, we will not cover any engineering topics (e.g. signal processing,
spectral analysis), though Matlab is commonly used for these tasks. No previous math software experience is
necessary, though we will point out important differences between the various packages along the way.

If you are using Matlab over a text-based terminal (such as Telnet or SSH), you might want to follow the Using
Math Software under UNIX tutorial after you are finished with this one.

Throughout this document, we will use the following conventions.

Example Explanation

File - Open Choose the file menu, and select Open.

a = 5 Input to be typed at the Matlab prompt.
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a =
5

Output from Matlab.

An important tip.

Where to find Matlab
MATLAB is available for many different kinds of computers at Indiana University Bloomington.

• All Windows NT Student Technology Centers

• Ships, Nations, and DaVinci UNIX clusters

• Several of the large timesharing systems - see the availability chart for details.

A student edition is available from local bookstores for your personal Windows, Macintosh, and Linux systems.

How to Start and Exit Matlab
To start Matlab:

• On windows NT, choose Start Menu -Programs-Statistics-Math-Matlab.

• On Ships, Nations, Davinci, and all timesharing systems, type matlab to run it interactively.
Note that plots will be displayed in an X-window, if you have set the DISPLAY variable. You may also
type matlab -display hostname:0.

Note that Matlab typically takes 10-15 seconds to load.
Eventually, you should see:

To get started, type one of these: helpwin, helpdesk, or demo.
For product information, type tour or visit www.mathworks.com.

>>

The line >> is the Matlab prompt.
To exit Matlab, type (at the matlab prompt) quit or choose File-Exit MATLAB.
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Finding Your Way Around the Window

The Command Window
The Command window is where you can interact with Matlab directly. Try typing the following:
foo = ones(2)
The output should look like this:

foo =

1 1
1 1

This represents a 2x2 matrix of ones. Matlab inserts extra blank lines between practically everything. To turn off this
feature, type
format compact

Unlike Maple and Mathematica, previous input lines cannot be edited. You can recall previous input lines by typing
the "up" cursor button (similar to bash and DOSKEY).

Cutting, copying and pasting is supported using the standards for your operating system.

The Toolbar
Systems that support graphics have a toolbar at the top of the screen, like this:

The buttons have the following functions:

New File, Open File

Cut, Copy, and Paste

Undo last action

Workspace Browser. Use this to graphically edit variables.

Path browser. Use this to edit the paths that Matlab will look in for functions.

Simulink Library Browser (not covered in this tutorial).

Open help window.
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The Help System
Unfortunately for the new user, Matlab's help system is rather primitive.

Built-in Help
If you know the name of a Matlab function you need help with, type
help function-name
to see the "helpful" information contained in the function definition itself. If you don't know the name of the
function you need, try lookfor keyword . However, the search is very slow, and often deluges the user with a
great many unhelpful items. In addition, a search for a concept, such as "matrix" will almost never return what you
need.

You can get the same "helpful" information by choosing Help - Help Window, or typing helpwin .

HTML Help
A more useful (but more difficult to access) set of help files is included in HTML. To access it, choose Help-Help
Desk, or type helpdesk .
This will launch your system's default web browser and open a web page. This process can fail in entertaining ways
on UNIX systems. Even more frustrating, the system makes extensive use of Javascript, Adobe PDF, frames, and
Java, so lynx users may wish to avoid it altogether.

While the content is essentially the same as the built-in help, it is presented in a much less hostile format. The Java-
based full-text search and index-by-subject are two extremely useful features. In addition, the entire set of printed
manuals is available as Adobe PDF documents.

Most of the help files list function names in all capital letters.
This is extremely misleading - all built-in matlab functions are in small letters.

Syntax

How Matlab Works
Matlab works by executing the mathematical statements you enter in the command window. By default, any output
is immediately printed to the window.

You are also allowed to assign a name to an expression for your convenience. Keep in mind that the name you
assign is only a name, and it does not represent a mathematical variable (as it would in Maple, for example). Every
name must have a value at all times. If you try to read the value of an unassigned name, you will get an error.

Nearly everything in Matlab in a matrix, whether it looks like it or not. This takes some getting used to. We'll be
introducing matrix-style operations along with their scalar counterparts so you can understand the patterns that arise
in the syntax.

Symbols and Punctuation
Matlab was designed to use fairly standard notation. Try these examples on your own computer.
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Input Output Comments

2 + 3
7-5
34*212
1234/5786
2^5

ans = 5
ans = 2
ans = 7208
ans = 0.2173
ans = 32

Arithmetic works as expected. Note that the result is given the
name "ans" each time.

a = sqrt(2) a = 1.4142 You can choose your own names for things.

b = a, pi, 2 + 3i
b = 1.4142
ans = 3.1416
ans = 2.0000 + 3.0000i

You can use commas to put more than one command on a line.
Pi, i, and j are contants.

c = sin(pi)
eps

c = 1.2246e-016
ans = 2.2204e-016

"eps" is the current limit of precision. Anything smaller than eps
is probably zero. Note that Matlab understands (and expects you
to understand!) scientific notation.

d = [1 2 3 4 5 6 7 8 9]
e = [1:9]
f = 1:9

d = 1 2 3 4 5 6 7 8 9
e = 1 2 3 4 5 6 7 8 9
f = 1 2 3 4 5 6 7 8 9

"d", "e", and "f" are all vectors. They are equal. Note the use of
the ":" operator - it counts (by ones) from one number to the next.

g = 0:2:10
f(3)
f(2:7)
f(:)

g = 0 2 4 6 8 10
ans = 3
ans = 2 3 4 5 6 7
1 2 3 4 5 6 7 8 9

More uses of the colon. Note that you can use it to get slices of a
vector (or matrix, or cube, etc), or get the whole thing.

h = [1 2 3];
h'

(nothing)
ans = 1

2
3

A semi-colon ";" will prevent the output from being displayed. A
single quote " ' " computes the transpose of a matrix, or in this
case, switches between row and column vectors.

h * h'
h .* h
h + h

ans = 14
ans = 1 4 9
ans = 2 6 8

Operations on vectors. * is matrix multiplication, and so the
dimensions must line up correctly.
" .* " is entry-by-entry multiplication.

g = [ 1 2 3; 4 5 6; 7 8 9]
g = 1 2 3

4 5 6
7 8 9

Entering a matrix.

g(2,3)
g(3,:)
g(2,3) = 4

ans = 6
ans = 7 8 9
g = 1 2 3

4 5 4
7 8 9

Accessing matrix elements.
Note use of ":" to access an entire row.

g^2

g .^ 2

ans = 30 36 42
66 81 96

102 126 150
ans = 1 4 9

16 25 36
49 64 81

The first multiplies the matrix by itself. The second squares each
entry in the matrix.
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How to Control Output
Before we go any deeper into matrices, it would be wise to mention formatting issues.

The command to know is format .

• To control linespacing, use format compact .

• To see all 15 digits that were used in calculation, use format long .

• To see just 5 digits, use format short .

• To supress output completely, use a semi-colon at the end of the command.

To see other options, type help format .

Note that Matlab always uses "double" precision (about 15 digits) in its calculations. These commands merely adjust
the display.

More on Matrices

More ways of contructing matrices
Built-in Constructions
There are many built-in matrix constructions. Here are a few:

Input Output Comments

rand(2)

rand(2,3)

ans = 0.9501 0.6068
0.2311 0.4860

ans = 0.8913 0.4565 0.8214
0.7621 0.0185 0.4447

Generates a matrix with entries randomly distributed
between 0 and 1

zeros(2)

ones(2)

ans = 0 0
0 0

ans = 1 1
1 1

Generates a 2x2 matrix with all zero (or all ones)
entries.

eye(2) ans = 1 0
0 1

Identity matrix I.

hilb(3) ans = 1.0000 0.5000 0.3333
0.5000 0.3333 0.2500
0.3333 0.2500 0.2000

3x3 Hilbert matrix.

To get more information on these, look at the help page for special matrices- type help elmat .

Concatenation
New matrices may be formed out of old ones. Suppose we have
a = [1 2; 3 4]
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a = 1 2
3 4

Then we can make a new matrix in any of the following ways.

Input Output

[a, a, a] ans = 1 2 1 2 1 2
3 4 3 4 3 4

[a; a; a] ans = 1 2
3 4
1 2
3 4
1 2
3 4

[a, zeros(2); zeros(2), a'] ans = 1 2 0 0
3 4 0 0
0 0 1 3
0 0 2 4

Programming
Matrices may also be constructed by programming. Here is an example using two "for" loops.

for i=1:10,
for j=1:10,

t(i,j) = i/j;
end

end

Notice that there isn't any output, since the only line that would produce any (t(i,j) = i/j;) ends in a semi-
colon. Without the semi-colon, Matlab would print the matrix t 100 times!

We'll cover programming in more detail later.

More matrix operations
As we saw earlier, +, -, *, and / are defined in an intuitive manner for matrices. When there is ambiguity about
whether an operation will do matrix arithmetic (versus entry-by-entry arithmetic), note that ".*" (dot-star) will
multiply entry-by-entry, and "*" (star) will do matrix multiplication.

Scalars
A scalar is just a number. Matlab stores them internally as 1x1 matrices, but treats them as if they were numbers.

All operation involving a scalar and a matrix affect the matrix on an entry-by-entry basis, with one exception: the
power ("^") operator. With a as defined above, try these:
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Input Output Comments

b=2 b=2 Define b to be a scalar.

a + b
ans = 3 4

5 6
Addition works entry-by-entry.

a * b
ans = 2 4

6 8
So does multiplication.

a ^ b
ans = 7 10

15 22
This is matrix power - a*a

a .^ b
ans = 1 4

9 16
Entry-by-entry power.

Vectors
A vector is just a matrix with only one row (or column). Matlab makes a distinction between row vectors and

column vectors, and will complain if it doesn't get what it expects.

In all arithmetic operations, Matlab treats a vector as a matrix, so we already know how to multiply a vector by a
scalar. Matlab also gives you the following operations:

Input Output Comments

v = [1 2
3]
u = [3 2
1]

v = [1 2 3]
u = [3 2 1] Define a pair of vectors.

v * u Error The dimensions don't agree.

v * u' ans = 10 Taking the transpose works.

dot(v,u) ans = 10 The dot product is the same thing.

cross(v,u) ans = -4 8 -4 The cross product works only for 3-d vectors.

Matrices
Matlab has all the common operations built-in, as well as most of the obscure ones.

Input Output Comments

k = 16 2 3
5 11 10
9 7 6

k = 16 2 3
5 11 10
9 7 6

Define a matrix.

rref(k)
ans = 1 0 0

0 1 0
0 0 1

Row-reduced echelon form
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rank(k) ans = 3 The rank.

det(k) ans = -136 The determinant.

inv(k)
ans = 0.0294 –0.0662 0.0956

-0.4412 –0.5074 1.0662
0.4706 0.6912 -1.2206

Inverse of the matrix

[vec,val] = eig(k)

vec = -0.4712 –0.4975 -0.0621
-0.6884 0.8282 -0.6379
-0.5514 0.2581 0.7676

val = 22.4319 0 0
0 11.1136 0
0 0 -0.5455

Eigenvectors and eigenvalues of the matrix.
The columns of "vec" are the eigenvectors,
and the diagonal entries of "val" are the eigenvaules.

There are many more functions like these. Type help matfun to see them all.

Solving Equations
One of the main uses of matrices is in representing systems of linear equations. If a is a matrix containing the
coefficients of a system of linear equations, x is a column vector containing the "unknowns," and b is the column
vector of "right-hand sides," the constant terms, then the matrix equation

a x =b

represents the system of equations.

If you know a little linear algebra, you could use the Matlab commands from above to augment the matrix and then
find the row-reduced echelon form. However, Matlab provides a more simple mechanism for solving linear
equations:
x = a \ b
This can be read "x equals a-inverse times b."
Try it with
a = [1 2 3; 4 5 6; 7 8 10]; b = [1 1 1]';
You should get
x = -1 1 0
To verify this assertion, try this:
a*x, a*x - b, eps
The results are:
ans = 1 1 1
ans = 1.0e-015 *

-0.1110
-0.6661
-0.2220

ans = 2.2204e-016
Notice that a*x - b is very close to eps - which means that it is as close to zero as possible.

If there is no solution, a "least-squares" solution is provided (a*x - b is as small as possible). Enter
a(3,3) = 9; b = [1 1 0]';
(which makes the matrix singular and changes b) and enter the above commands again, using the up-arrow to recall
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them. Notice that the solution is quite inaccurate.

Saving and loading matrices
Unlike Maple and Mathematica, Matlab has no notion of a "worksheet." When you exit Matlab, you will not be
prompted to save your work.

If you would like a record of your work, you can turn on "logging" by typing

diary 'c:\scratch\session.txt' on NT machines
diary '~/session.txt' on UNIX.

Notice that output will be saved alongside your input, so the file can't be used directly as a script.

You may just want to save one or more matrices. The diary is a very clumsy way to do this.
To save the value of the variable "x" to a plain text file named "x.value" use
save x.value x -ascii
To save all variables in a file named "mysession.mat" in reloadable format, use
save mysession
To restore the session, use
load mysession
Then, to see the saved files from your session, on UNIX systems type the commands:

% more session.txt
% more x.value

Under Windows NT, open the appropriate file with Notepad.

Graphics

Matlab has outstanding graphics capabilities (you must be using a terminal which supports graphics to use them).
However, graphing in Matlab is conceptually different than graphing in Maple or Mathematica.

Graphics Concepts
Before looking at the plotting capabilities of Matlab, consider what a graph really is. A graph is a collection of
points, in 2,3 or even 4 dimensions, that may or may not be connected by lines or polygons. Most math software
packages hide this from the user by sampling a continuous function to generate the points.

Matlab is designed to work with matrices, rather than functions. Matrices are a convenient way to store a collection
of numbers - which is exactly what is needed when graphing. Thus all graphing commands in Matlab accept
matrices as their argument, rather than a function. If you are used to function-style plotting, Matlab may take some
getting used to. On the other hand, Matlab's approach makes it very easy to visualize data and to create graphics
based on lists of points.

Another unique feature of Matlab's graphics engine is the way in which it displays graphical output. In Matlab, there
is (usually) only one plotting window. Subsequent plotting commands will add to the old plot, unless you request a
new one be made. This allows a plot to be made, then adjusted later to suit your needs.
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Basic 2-D Graphics
Now that you understand a bit more about graphing, try these examples. Be sure to follow along exactly, or you may
not get the same results.

Input Output Comments

x = -10:0.5:10;
y = x .^ 2; (none) Create a 1x41 matrix that counts from -10 to 10,

and a 1x41 matrix made by squaring the entries of the first matrix.

plot(x,y) Plot the points. Each pair is plotted, so <x(1), y(1)> is a point, <x(2), y(2)> is a point,
etc.

t = 0:0.1:2*pi;
x = cos(t);
y = sin(t);

(none) Generate some new 1x63 matrices.

plot(x,y)
Plot the points. This is called a parametric plot. Notice that it replaces the previous
plot.

t = 0:pi/5:2*pi;
u = cos(t);
v = sin(t);

(none) Generate some new 1x11 matrices. This shows how to control the "resolution" of the
plot.

figure
plot(u,v)

Create a new plot window, and plot the points.
Notice how jagged the circle is, since we only used 11 sample points.

plot(x,y, 'ro-') Plot the hi-res version again in red, with circles at the data points, connected by lines.

plot(x,y, 'r-', u,v,'b*:') On the same plot, plot the hi-res version in red, and plot the lo-res version with blue
stars at the data points and dotted lines.

figure
subplot(1,2,1)
plot(x,y)
title('Fine Mesh')
subplot(1,2,2)
plot(u,v)
title('Coarse Mesh')

Create a new figure.
Divide it into one row, two columns, and pay attention to the first cell.
Plot.
Give the current plot a title.
Pay attention to the second cell.
Plot.
Give it a title.

See the following help files for more options and ideas: help plot, help comet, help semilogy and
help fill .
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Matlab provides very powerful features in the figure window. Use the toolbar at the top to add arrows, lines, and text
comments to your plot.

Basic 3-D Graphics

Input Output Comments

t = -4*pi:pi/16:4*pi;
x = cos(t);
y = sin(t);
z = t;

(none) Generate the data...

plot3(x,y,z) ... and draw a helix.

[x, y] = meshgrid(-
3:0.1:3,-3:0.1:3);
z = x.^2 - y.^2;

(none) Generate data for a surface plot.

mesh(x,y,z) Draw the surface using a mesh.

surf(x,y,z) Draw the surface as a "patched" surface.

plot3(x,y,z) Notice that it still plots, but as a set of arches.

Advanced Plotting
Of course, Matlab can do a lot more than these simple exercises. If you'd like to know more, try these help files:
help slice , help movie , help getframe , help graph2d , help graph3d , help graphics .

Programming

How to program
Matlab statements can be prepared with any editor, and stored in a file for later use. The file is referred to as a script,
or an "m-file" (since they must have names of the form foo.m). You may prefer to do this, if you use the same data
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repeatedly, or have an editor that you like to use. Writing m-files will make you much more productive.

Select File - New -M-file to open Matlab's built-in editor/debugger, or use your favorite editor. Then create the
following file, and save it as sketch.m:

[x y] = meshgrid(-3:.1:3, -3:.1:3);
z = x.^2 - y.^2;
mesh(x,y,z);

Next, in Matlab, be sure that the directory where the m-file resides is in the path. Check this by typing pathtool
and making sure that your directory is present. (Users without graphics can use addpath directory .)

Now enter
sketch
The result is the same as if you had entered the three lines of the file, at the prompt.

You can also enter data this way: if a file named mymatrix.m in the current working directory contains the lines

A = [2 3 4; 5 6 7; 8 9 0];

then the command mymatrix reads that file and generates A. However, for large matrices, Matlab's own save and
load commands are much safer to use.

Functions
Functions are like any other m-file, but they accept arguments, and they are compiled the first time they are used in a
given session (for speed).

Use your favorite editor to create a file named sqroot.m, containing the following lines.

function sqroot(x)
% Compute square root by Newton's method

% Initial guess
xstart = 1;

for i = 1:100
xnew = ( xstart + x/xstart)/2;
disp(xnew);
if abs(xnew - xstart)/xnew < eps, break, end;
xstart = xnew;

end

In Matlab enter the commands
format long
sqroot(19)
You should see the output from your function.

Two caveats:

A function has access to the variables in the "workspace" from which it was called, but the variables created within
the function (xstart and xnew, in the preceeding example) are local, which means that they are not shared with the
calling workspace. For more information, see the chapter "M-File Programming" in the manual, Using Matlab.
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• Note: if you edit a function during a session, use clear function_name to remove the compiled
version, so that the new one will be read.

Batch Programming
MATLAB may be ran in "batch mode," in a very similar way. If a file named "test.m" contains the (non-graphics)
commands you want processed, at the UNIX prompt type:

% matlab < test.m > homework.out

This is read, "Run MATLAB, with input from test.in, and output to test.out." The input file does not need to be
named "something-dot-m," but it must end with quit .

Programming ideas
The "m-files" which came with MATLAB provide lots of examples! To find their location, use path .This will also
lead you to some demos.

You might also try typing demo to get a feel for the breadth of tasks that can be accomplished with Matlab.

See help function for an exercise for programmers.

Further Reading
• The Matlab page should be especially useful.

• If you use UNIX, Using Math Software under UNIX may be helpful.

• Manuals for statistical and mathematical software are kept in the Swain Hall, Business/SPEA, Education,
and IUPUI University Libraries, and at the IU Center for Statistical and Mathematical Computing. The
manuals which come with Matlab are especially good, and provide much more information than this short
course.

• If you are affiliated with Indiana University, you may also get help from the Stat/Math Center.

Please send comments and suggestions to: statmath@indiana.edu
Copyright 1995-1999,Indiana University.Last Modified 26 May 1999.
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